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Copyright 2003 - 2025 by Proposal Kit, Inc. All rights reserved. 
 
This documentation may not be copied or distributed without the 
express written permission of Proposal Kit, Inc. 
 
Proposal Kit, Inc. makes no warranty and accepts no responsibility 
for suitability of any materials to licensee’s business. Proposal Kit, 
Inc. assumes no responsibility or liability for errors or inaccuracies. 
Licensee accepts all responsibility for results obtained. 
 
Adobe Illustrator, Adobe Acrobat and Adobe Photoshop are 
trademarks of Adobe Systems Incorporated. Macintosh and Apple 
are registered trademarks of Apple Computer Inc. All other 
products and brands are trademarks of their respective holders. 
Proposal Kit, Inc. makes no claim to any such marks willingly or 
otherwise. 
 
Proposal Pack Wizard works with all versions of Word that support 
macros and that are currently supported by Microsoft. While the 
Wizard still runs on obsolete versions of Word in most cases, not 
all features will work perfectly on outdated versions of Word, and 
we are not able to fix issues related to bugs or features missing in 
unsupported editions of Word and Windows. We do not test the 
Wizard on obsolete versions of Word, and we do not guarantee it 
will operate in obsolete versions. 
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WHAT’S NEW IN V17.14? 

 20 new Quick Start import lists added (770 total). 

 Added more chapter name mappings to the Select by AI 
feature. 

 Fixed a subscript out of range error that could occur during the 
preview of a line-item quote. 

 Added a notice to the project edit screen’s spreadsheets tab 
that those spreadsheets are legacy versions superseded by the 
line item quoting system. 

 Added additional error checking to line-item quote importing of 
Excel spreadsheets to pinpoint and report malformed Excel 
calculations that cause the import to fail (i.e. cells that display as 
#REF for example). 

 Added Bluesky to the default list of social media profiles. 

 Fixed an issue where the logo settings could be blanked out in 
the Preferences. 

WHAT’S NEW IN V17.13? 

 20 new Quick Start import lists added (750 total). 

 Added more chapter name mappings to the Select by AI 
feature. 

WHAT’S NEW IN V17.12? 
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 20 new Quick Start import lists added (730 total). 

 Added more chapter name mappings to the Select by AI 
feature. 

WHAT’S NEW IN V17.11? 

 Added more verbose message for older versions of Word if an 
error occurs calling an Excel rounding function. In some cases 
outdated versions of Office may need to have patches applied 
for missing functionality. 

WHAT’S NEW IN V17.10? 

 Added more chapter name mappings to the Select by AI 
feature. 

 10 new Quick Start import lists added (710 total). 

 Fixed issue with importing pre-made line item data from an 
Excel spreadsheet in the line-item quoting database 
Preferences that would show an empty sheet message. 

WHAT’S NEW IN V17.9? 

 Added more chapter name mappings to the Select by AI 
feature. 

 Fixed an issue with calculating spacer widths when no rows 
exist for a line item database that could display a subscript out 
of bounds error message. 

WHAT’S NEW IN V17.8? 
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 Added a search box to the Select by AI manual mapping screen 
to search for additional template not found by the partial 
matching. 

 Added more chapter name mappings to the Select by AI 
feature. 

WHAT’S NEW IN V17.7? 

 Added a new tab in the Pick Documents screen called ‘Select 
by AI’. This tab is designed to be used with a custom OpenAI 
GPT named ‘Business Proposal Outline Creator for Proposal Kit’. 
This allows you to ask the GPT to give you outlines for any type 
of proposal and the Wizard will convert those suggestions into a 
list of selected chapters in your project. 

  Added a Paste from Clipboard button on the Wizard’s setup 
screen to make it easier to paste in the activation code. 

WHAT’S NEW IN V17.6? 

 Updated the Security System and Communication Proposal 
layout to display in the full list of layouts instead of the From 
Customer Support section. 

 When importing a new Quick Start list is now unchecked if the 
project previously was associated with a sample proposal. 

 Fixed an error message that would occur when a spacer line 
was added to an empty line item database. Spacer lines can 
now only be added if at least one line item row exists. 

WHAT’S NEW IN V17.5? 

https://chatgpt.com/g/g-ythQ7pTv8-business-proposal-outline-creator-for-proposal-kit
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 Added View Image buttons to various screens that deal with 
images and logos in the Preferences and in the line item 
database for Image data types. This will show a preview of the 
image and details about the image. 

 Changed the behavior of the Clear Form buttons in the line item 
database screens to always clear every field instead of reverting 
back to the values when the form was entered. 

WHAT’S NEW IN V17.4? 

 Added the ability to insert spacer lines into the line item data 
rows. Spacer rows can use blank spaces or characters such as 
dashed lines and have colors applied. Use spacers to add 
additional breaks or groupings to your line item data rows. 

 Added an Example database showing use of the new spacer 
lines and a new manual chapter for spacer lines. 

 Added a Split Multi-Category Tables option to the line item 
database definitions to force each category on a template page 
to be put into its own Word table. By default, if all categories on 
a page have the same number of fields they will all be combined 
into a single Word table for all categories. 

 Added more error checking and a retry count on all calls from 
the Wizard to Excel in case Excel does not respond to Word. 

 More verbose messages are given if Word is unable to 
communicate with Excel. 

 Added progress bars to the importing of zip files for the line 
item database customer support screen. 
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 Added selected project templates to customer support line item 
database extract zip file. 

 Turned off Compile on Demand due to Word bug that can 
generate a 35010 error to reduce likelihood of error occurring. 

 Fixed issue with importing line item data from another project 
using the same line item database not picking up the line items. 

 Fixed issue with line item database global header fields causing 
extra blank lines being added to the end of the main line item 
table when multiple categories combined into a single table. 

WHAT’S NEW IN V17.3? 

 Added a backup and restore database definition screen with 
features that help identify which previous backups may want to 
be restored. Automatic backups are made whenever the Wizard 
automatically clones in a component database and whenever 
the user enters the Edit Definition screen. 

 Added ability to import custom premade lists into the DropDown 
list to speed up creation of custom lists. Premade lists are 
included for states, countries, races, ethnicities, genders and 
months. Also allows for customizing these premade lists and 
adding additional custom lists. 

 Added ability to use the word BLANK as the default List data 
type value which will output an empty string to the documents. 

 Added the component page databases to the list of external 
databases can be cloned from. Now they do not need to be 
loaded first to clone them into your database. 
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 Fixed Get More Suggestions button on Global Formatting 
screen wasn’t loading additional formatting suggestions. 

 Improved error checking descriptions when testing databases. 

 Added testing of database definition and require an error free 
test before allowing creation of a custom template in the Quote 
Templates screen. 

 Test List screen was returning one level to high. Now returns to 
add/edit screen. 

 Hid the Test Function button when adding new functions as 
needs to be saved into db def for being able to run tests. Only 
visible when editing functions. 

 Fixed issue with category specific images not being available for 
use as a default field image. 

 Fixed issue with Dropdown data type if no item selected was 
defaulting to the 1st item on the list.  

 Added more manual chapters to the line item database manual.  

WHAT’S NEW IN V17.2? 

 Added a new feature to the Quote Templates screen in the 
Preferences. This allows you to have the Wizard build a more 
custom-tailored custom template in the MyTemplates folder by 
selecting which fields to output and the order of fields. This 
makes for faster creation of customized Word tables.  
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 Added options on all Pick Documents screens and the Manage 
Templates screen in the Edit Styles to only show line item 
database enabled templates to help identify which templates 
are premade ready to use with the line item database system. 

 Added hidden weight fields to all product cost related built-in 
and component databases to help determine shipping charges. 
Hidden fields can be enabled for output or by adding tags to 
custom Word templates. 

 Set the Price and Rate field widths to 60 to make more room for 
the Description field in the cost related line item databases. 

 Added additional fields to most schedule related built-in and 
component databases so that all schedule related databases 
calculate days, weeks, months, and years to completion fields. 
User can then determine which one(s) to display in their output. 

 Added table borders to built-in custom component line item 
database templates that were missing in some schedule related 
files. 

 Fixed an issue where the default line item database was not 
being automatically set as the project database when a new 
project was created and the option to auto-assign the default 
database to new projects was enabled. 

 Added more chapters to the line item database manual. 

 When a database is disabled, it is immediately removed from 
the drop down list of available databases. 
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 If the default line item database is disabled it is also cleared 
from being the default database. 

 Added the database quote code onto a couple Preferences 
screens. 

WHAT’S NEW IN V17.1? 

 Fixed database count to not count disabled databases in project 
screen. 

 Added video library links to the line-item database project and 
Preferences screens. 

 Added links to line-item database video library to manuals. 

 Fixed Line Item Quote button in the Preferences not being 
visible depending on the Activation Code used. 

WHAT’S NEW IN V17.0? 

 Added a line item database system for quotes, schedules, 
business plan financials, etc. The new line item database system 
works for both Novice and Expert Edition users. Novice Edition 
users can use any of the premade quote and Sample Proposal 
databases as-is. Expert Edition users can customize any 
premade databases and create custom databases. 

 A new PDF manual has been added for the line item database 
system. 

 All the included Sample Proposals that used to use Excel 
spreadsheets for quotes, schedules and business plan 
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information have been converted to use the new line item 
database system. Importing any of these Sample Proposals will 
let you use that Sample Proposal’s custom line item database 
for your own projects. Expert Edition users can customize these 
databases. 

 The Wizard and the installers have been upgraded to new EV 
code signing certificates for enhanced Windows security.  

 Permission errors are captured better with an option to retry 
once the user closes the file that was trying to be deleted. 

 Changed all Twitter references to X in the Social Media tags. 

 The Excel spreadsheet linking feature is now disabled by 
default as the new line item database system takes precedent. 
The Excel linking feature can be turned on in the Preferences 
and used along with the new line item database system. Note 
that the new line item database system has features that allow 
for pulling in cell data from an Excel spreadsheet into the line 
item database which may be more useful. 

 Removed the legacy static Table of Contents creation option. 

 Turning on QuoteWerks document creation features will 
temporarily turn off the new line item quoting system. The line 
item system will be turned back on when QuoteWerks creation 
is turned off. 

 The 32-bit QuoteWerks direct connection API has been 
removed. QuoteWerks support is still included and works as it 
always has. The direct connection feature was a time saving 
option and since QuoteWerks never released a 64-bit API the 
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direct connection option has been removed as Word is primarily 
installed in the 64-bit version now. 

 The project database import/export feature has been removed. 

 The Word Insert Bug screens have been removed after 
Microsoft fixed their bug. 

 Minor bug fixes and enhancements. 

WHAT’S NEW IN V16.6? 

 Expanded the capabilities of the Excel spreadsheet linking tags 
to allow multiple columns within a tag in the format <<RS#-
#C#,#,#>>. Up to 2 additional columns can be included in the 
tag when the tag is an RS tag (which causes each new row to 
expand into a new table row). This puts all the columns within 
the same cell with delimiters that can be defined in the 
Preferences. 

 Added 2 new articles to the Read How-to Articles screen on the 
topics of using ChatGPT and Chat AI bots to aid in proposal 
writing. 

 Updated messages when the Word Insert Bug occurs that the 
bug has been patched by Microsoft and requires updating Word 
to the most recent version. 

 Added additional Word Insert Bug workaround code when using 
the MyTemplates folder files. 

WHAT’S NEW IN V16.5? 
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 9 new Quick Start import lists added (700 total). 

 Added a new post processing tool to the Edit screen list of tools 
to run the data merge and Excel spreadsheet linking operation. 
This allows you to easily link new or existing spreadsheets cells 
into an existing document during the editing process. Any data 
tags in the document will also be merged if the data is filled in 
the project screens. 

 Extended the Excel spreadsheet dynamic linking feature to work 
with custom templates and spreadsheets in the MyTemplates 
and MyProjectFiles folders. 

 Added a new workaround option for the Word Insert Bug. There 
is a new post processing tool in the edit documents and 
Preferences batch processing screens that will run a conversion 
process on a folder of Proposal Kit library templates. This 
conversion process recreates each file in a way that stops Word 
from crashing when assembling them using the standard Word 
InsertFile API function that is currently bugged in Microsoft 
Office. 

 Added another workaround option for the Word Insert Bug that 
will rebuild all templates in the Proposal Kit template library and 
turn off the Word Insert Bug workaround. This is another option 
to get the Wizard working normally until Microsoft fixes their 
InsertFile API functionality. 

 Added extra check to installers to provide a more descriptive 
message if users computer does not associate the .docx file 
extension with Microsoft Word. 
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 Added time to completion estimates to the document building 
progress bars. 

 Option to skip watching the tutorials and the training mode 
when running the Wizard for the first time. 

 Added startup checks to ensure file naming conventions and 
formats are correct on any custom files in the MyTemplates and 
MyProjectFiles folders. 

 Added removal of custom files copied from the MyTemplates 
and MyProjectFiles folders when using the Delete Old Files 
button. 

WHAT’S NEW IN V16.4? 

 Added two workaround options for a bug Microsoft introduced 
in their August 3, 2022 build that causes their InsertFile function 
to fail when assembling documents which causes an error 
message in the Wizard during document assembly. The Wizard 
will automatically detect the error and switch to one of the work 
arounds. A popup screen reminder will be displayed when the 
Wizard is run that the workaround is in use with instructions on 
how the workaround operates and how to rollback Office 365 to 
a working build. 
 
See this page for details: 
https://www.proposalkit.com/htm/troubleshooting.htm#q37 

 Fixed an issue with the post processing batch tool for changing 
the text in the footers to a different style. 

https://www.proposalkit.com/htm/troubleshooting.htm#q37
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 Fixed an issue with the auto-adding of the Multiple Choice 
Database mail merge tag into the selected template where it 
would not always insert the tag. 

 When upgrading from the Novice to Expert edition the Wizard 
will automatically be put into Expert Mode when the serial 
number is changed. 

WHAT’S NEW IN V16.3? 

 Added a new feature that allows for copying of custom files that 
are not part of the Proposal Kit system into each new project 
folder. This is called the MyProjectFiles folder and can be setup 
using a new Preferences screen. 

 Added new manual chapter How do I use the MyProjectFiles 
folder? 

 Outlook integration is now enabled in both 32-bit and 64-bit 
editions of Word. 

 Removal of the SalesForce API allowed for removal of the 2nd 
copy of the Wizard meant for S Mode use.  

 SalesForce API integration has been removed. 

WHAT’S NEW IN V16.2? 

 1 new Quick Start import list added (691 total). 

 On the Edit Current Document screen if there is only one file 
present in the screens it will be preselected. 



24 

 The QuoteWerks integration has been enabled for use in the 
64-bit Wizard however the direct API connection features still 
require using the 32-bit edition of Word. Most features will now 
work in the 64-bit edition. 

 Fixed an issue with the new custom positioning of the Title 
Page’s stock logo graphic when converting from graphic to text 
chapter headers. 

 Fixed an issue with stock logo being left aligned to page instead 
of margin when converting from graphic to text chapter 
headers. 

 Fixed an issue with the Grant Proposal Type database missing 
templates. 

 Fixed error message in conversion of documents into 
QuoteWerks compatible formats when international translations 
were turned on. 

WHAT’S NEW IN V16.1? 

 Added the ability to create custom color schemes. 

 When creating custom templates Wizard will ask if you want to 
put a shared copy in the MyTemplates folder to share between 
design themes. 

 When cloning a Proposal Pack design theme Wizard will now 
ask if you want it set to be the default design theme instead of 
having to manually select it. 
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 Added option to turn off setting of the document zoom size and 
other zoom related page view settings when opening 
documents. Zoom settings are also not applied anymore to 
documents opened temporarily in the background and any 
zoom setting related error messages are now suppressed. 

 The Edit Stock Template button will ask to open the shared 
MyTemplates folder copy if one exists instead of the stock 
template in the Pick Documents screen. 

 Changed tab sequence on the Company Data screen to be top 
down. 

 Cleaned up some unnecessary messages and added some 
extra tests to the document build process. 

 Design themes that use white header text will use a white color 
for the title page replacement text when replacing graphic 
headers with text. 

 Fixed an issue with the auto-copy of a template to the 
MyTemplates folder always adding a Multiple Choice tag if the 
Multiple Choice database is in use. Tag will now only be added 
if the template is attached to the tag and one or more 
paragraphs are associated with the tag. 

WHAT’S NEW IN V16.0? 

 Added support for the new Proposal Pack V19 and Proposal Kit 
Professional V22 products. 177 new chapter templates have 
been added and are now available in the Wizard. 
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 Added 19 more business situations to the Add Templates tab to 
accommodate the new chapter templates. 

 1 new Quick Start import list added (690 total). 

 Streamlined the Wizard home screen interface by removing the 
Create Document button which is a redundant button. The 
project screen now includes a 2nd button to save the project 
without building the project documents and instead of asking to 
build the documents when the original Ok, Save Project button 
was clicked that button now automatically builds the project 
documents. 

 The Team Editing feature is now automatically turned on by 
default in the Expert Edition. 

 The Team Editing screen now can change the order of chapters 
and remove chapters when the main project document is rebuilt 
without having to go back to the project screen to edit the 
chapter layout. 

 If multiple monitors are detected during startup the Wizard will 
ask if you want to turn on Multi-Monitor mode and will do so 
without having to turn it on in the Preferences. The Wizard will 
only ask this question once. 

 Updated the post-processing tool for converting chapter 
headers and the Edit Styles option to automatically convert 
graphic chapter headers to text so they reposition the chapter 
headers more in line with how the original logos were 
positioned vertically relative to the chapter header text. This 
eliminates the need to manually reposition chapter headers to 
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make them appear more visually appealing in many design 
themes. 

 Updated the post-processing tool for converting chapter 
headers so it also converts the Title Page’s Proposal graphic 
and repositions that graphic as well to be more visually 
appealing.  

 Updated the conversion of the Title Page graphic to text to read 
the resolution of the image in case it is in a non-standard DPI 
which would previously cause the graphic to be repositioned 
incorrectly. 

 Fixed a couple post-processing tools so if the setup screen for 
the tool was canceled it wouldn’t continue to perform that 
operation. 

WHAT’S NEW IN V15.18? 

 3 new Quick Start import lists added (689 total). 

 Added a new post processing tool that allows changing the 
entire color scheme of a document including documents that 
have been edited with custom colors. The tool will prescan all 
changeable elements (fonts, tables, borders, shapes) to identify 
up to 10 used colors and allows changing each to a new color. 

 Added the ability to create Font type presets. You can create up 
to 40 presets and each preset contains the settings for the 
entire set of 50 customizable font styles. This gives the ability to 
easily switch design themes and have different font types, sizes 
and colors created to go with different themes. 
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 All the font style settings and the new presets have been moved 
from the Options.ini database file to a new file FontStyles.ini. 

 Removed limit of 40 selectable items in a Multiple Choice 
Database list when creating custom sort ordered lists. Max 
allowable number can now be custom sorted. 

 Added 5 new categories (15 total) and 50 tags (150 total) to the 
Multiple Choice Database. 

 The Multiple Choice Database configuration can now auto-add 
the Multiple Choice tags into the templates when assigning a 
tag to a template. 

 The Multiple Choice system is updated to use the custom 
versions of templates found in the new MyTemplates folder if 
any exist. 

 Added the ability to delete the Word files for user added 
templates from the database. Stock templates can still be 
removed from the database listings but the Word documents for 
stock Proposal Pack templates will still not be deleted.  

 Added checks when removing templates from the database if 
they are in use in the Multiple Choice database and if a custom 
copy exists in the MyTemplates folder. 

 Defaulted the Wizard to using Word popup messages boxes. If 
running in a multi-monitor system and message boxes are 
displaying on the wrong monitor, there is now a Preferences 
checkbox to turn on Multi-Monitor Mode. This will use Wizard 
specific popup message boxes. However, this feature is not 
tested across all possible Wizard interactions. If Multi-Monitor 
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mode appears to have a locked-up screen turn this feature back 
off and contact us for assistance. 

 If the Show All Templates option is checked in the Add 
Templates screen, then changes are made to the template list 
outside this screen, the drop down lists will now reload with the 
current selections. 

WHAT’S NEW IN V15.17? 

 2 new Quick Start import lists added (686 total). 

 The Preferences tool for searching for template installations 
now allows browsing to any location to better accommodate 
custom installations. 

 The Pick Documents screens Presets adds an Update Preset 
button to streamline making updates to presets vs having to 
delete then readd a modified preset. 

 Added a new feature allowing users to copy their own versions 
of stock templates into a new folder MyTemplates. This allows 
users to keep their customized versions of chapter templates 
separate from the main library. This also allows a single 
customized copy of a chapter template to be used across 
multiple Proposal Pack design themes and for network setups 
to have customized versions per individual user when the main 
library is shared by everyone on a network. 

 The Multiple Choice selection screen when adding data for a 
project will now warn the user if they are selecting drop in data 
but did not select the page for that data yet in the project. 
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 Expanded sizes of Multiple Choice selection fields to 
accommodate long titles. 

 Expanded the maximum number of drop in content files in the 
Multiple Choice database from 300 to 2000. 

 Labels showing the count of how many data elements are 
selected added to the Multiple Choice selection screen. 

 Added an option to delete all paragraph data files created by 
the Wizard when resetting the Multiple Choice database to 
original settings. User has the option to backup the files in case 
they had been customized. 

 Added admin option to turn off Multiple Choice warning 
messages for missing data which may be non-issues depending 
on how the Multiple Choice system is setup and used in 
practice. 

 Fixed an issue where only about 65 items could be selected 
from all the Multiple Choice drop downs due to a string length 
limitation in Word saving to the .ini database files. Now up to 
2000 drop down items could be selected for a single project. 

 Fixed an issue in the database export/import with the new 
Social Media data values. 

WHAT’S NEW IN V15.16? 

 5 new Quick Start import list added (684 total). 
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 Added a post processing tool to the Preferences to batch 
update legacy Word .doc format files to .docx to help migrate 
old installs into the current version and formats. 

 Replaced Word’s default message popups with Wizard versions 
to fix an issue with use on dual monitors where sometimes Word 
popups from the Wizard would display on another monitor than 
the Wizard screens were open on. 

 Fixed error message that could occur with older installs of Word 
that were missing Word’s functions for retrieving the MAC 
address or IP address of the computer when the unique user id 
was being generated using a random number instead. 

WHAT’S NEW IN V15.15? 

 1 new Quick Start import list added (679 total). 

 Added a new post processing tool for changing table settings 
across the document(s). This tool will prescan the documents to 
determine what colors are used in the tables and will allow you 
to change the colors of the cells, margins and padding between 
cells, and border styles consistently across all tables. 

 Added button to remove custom ordering from a Multiple 
Choice list of paragraphs which resets the list to the order they 
were added to the database. 

 Widened drop down lists in the Multiple Choice selection screen 
to accommodate long paragraph titles. 
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 Fixed an issue with custom ordered lists with disabled entries 
causing enabled entries to not be shown at the end of a multi 
select drop down list in the Multiple Choice database. 

 Fixed an issue with the last entry on some Multiple Choice 
database entries being partially hidden and difficult to select. 

 Fixed an issue with positioning of some Multiple Choice drop 
downs on the screen when using between 5 and 10 drop 
downs. 

 Removed the saving of the Multiple Choice default selections in 
a Preset to avoid conflicts with changes to the Multiple Choice 
database after the Preset was created. 

 Added option to the Novice edition to show what post 
processing tools are available in the Expert edition. 

 Fixed an issue with older versions of Word being unable to 
determine the Mac address of the computer for generating a 
unique userid. The unique userid is still created via an alternate 
method but an error message is now suppressed. 

WHAT’S NEW IN V15.14? 

 Added new social media data tag support. 10 new tags 
<<SocialMedia[1-10]>> are now available to use in the Wizard 
interface and have been added to a number of templates in the 
recent Proposal Pack update. Templates with the new tags are 
Company History, About Us, Company Information, Contact Us, 
Social Media, Back Page and Back Page Generic. 
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 The new social media tags have an additional feature when 
embedded in the documents where the display text can be 
different than the underlying URL. 

 Reorganized the document post processing screens to group 
tools based on what they do (text tools, graphics tools, testing 
tools, structural tools and troubleshooting tools). 

 Added popup help descriptions of each document post 
processing tool. 

 Added a post processing batch tool to remove all hyperlinks 
from emails and URLs in the document. The text remains and 
only the clickable link and any URL font styling is removed 
(underline and color). 

 Added a post processing batch tool to remove page borders. 

 Added post processing batch tools to replace all the custom 
graphics that can be used in the MyGraphics folder. Tools are 
added to change out the Letterhead, Page Header, Title Page 
logo, Back Page watermark, Title page watermark, Body pages 
watermark and Description graphics.  

 Added post processing batch tools to load complex watermarks 
stored in external .docx format files such as are used in the 
MyGraphics folder for replacing the body pages watermark, Title 
Page watermark and Back Page watermark as well as the body 
pages headers and footers. 

 Added support to all the MyGraphics custom graphics and batch 
processing graphics tools to use both PNG and JPG format files. 
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If both JPG and PNG formats exist for a file the JPG format will 
be used first. 

 Improved document creation performance by turning off the 
crash logging system by default (reverting to its previous default 
state) and reducing the volume of progress bar refreshes. 

 8 new Quick Start import lists added (678 total). 

 If page borders are turned on (either via the Style Settings 
screen or using the Page Borders post-processing tool) and full 
size shape objects are used in the body pages then the full size 
shape objects will be removed top prevent the page borders 
from being hidden. 

 Updated all Proposal Pack version numbers from 18.3 to 18.4 to 
reflect the updates to all the template package products for the 
social media tags. 

 Removed the page header logo file, alternate header and 
alternate footer file options from the Edit Style’s Branding tab as 
these features are handled via the MyGraphics folder options. 
The Branding tab has been renamed Page Headers. 

 Fixed issue with batch data importing if a Nickname was used in 
a row that any subsequent rows that did not use a Nickname 
would not be imported. 

 Fixed issue with the category list drop down disappearing in a 
recent update. 

WHAT’S NEW IN V15.13? 
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 Added search capability to all company and client CRM 
database drop down lists and forms. Also added a search 
configuration screen to customize how the database searches 
are performed and to change the default options. 

 Moved most of the Windows registry key settings to the 
Options.ini database to make transferring between computers 
and network installations easier and to support the new 
removable USB drive install feature. 

 Added a removable USB drive installation feature. You can now 
install the Wizard and any Proposal Kit template package on a 
removable USB drive that can be plugged into any computer 
that has Word installed and maintain your entire Proposal Kit 
system on the removable USB drive. 

 Added a manual chapter How do I Install on a Removable 
Drive (USB)? 

 Replaced the numerical User Id setting in the Preferences with a 
system generated unique id string. 

 Tested on Windows 11. Updated references to Windows 11 
support. 

 Marked existing CRM database records with the last batch 
number they were used in. 

 Added Batch CRM Import screen option to only show records 
never used in any batch. 

WHAT’S NEW IN V15.12? 
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 A new startup screen is displayed when more than one 
Proposal Pack design theme is installed allowing the user to 
select which design to default to more easily. 

 Added a post-processing tool for adding up to 50 extra 
document sections to the start and/or end of a completed 
document. Sections are unlinked to allow inserting external 
content that requires independent page settings, headers 
and/or footers. 

 When updating existing projects and the company and/or client 
data is changed the Wizard will ask if you want to update the 
copy in the CRM database as well. 

 Installing the Wizard using the ZIP file installer into a OneDrive 
needed a fix due to Windows trying to use a hyperlink (https) 
path instead of a drive letter in some cases. The Wizard will now 
detect non-drive letter paths on the setup and if found will 
prompt the user to browse to a drive letter based path. 

 Suppressed an error that has a occurred a few times in foreign 
language installations decrypting UTF8 to Unicode data. If an 
error occurs it will silently return as much of the data that could 
be decrypted as possible. 

 Fixed a duplicate record import issue in the CRM record 
importing feature where it would increase the duplicate record 
count by 2 instead of 1 in the final report. 

 Fixed a project batch external data import issue where a 
duplicate record was not being detected and allowed a 
duplicate project to be created. 
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 If a Proposal Pack was deleted and the repair wizard is unable 
to locate it, or the user couldn’t browse to it the Wizard will give 
the user the option to disable the style in the database to allow 
the Wizard to continue running. 

 Added extra tests to the Wizard to compare the setup paths for 
multiple device or multiple user configurations using the same 
network or cloud based Wizard database. All root paths on all 
devices must be the same and the Wizard will test for this on 
each new setup and startup of each Wizard to ensure path 
integrity is maintained in the database. 

 Added option to turn off archiving of orphaned project folders in 
the Preferences > Files and Folders screen. Intended for use 
with multi-user setups using the same project folder so users 
who don’t see other users projects won’t archive those other 
users projects. 

 Added more documentation for network and cloud based 
installs. 

WHAT’S NEW IN V15.11? 

 Captured user button clicks and disabled all project screen 
buttons and form fields once the document generation starts 
and before the screen closes to prevent users from 
inadvertently stopping the document processing. 

 Fixed an obscure error where Word was not able to unlink a 
document section thinking it did not exist when it did. By 
suppressing the error, the document assembly continues 
without issue. 



38 

 Updated installers and Wizard setup to not allow reserved folder 
names in custom install paths such as “documents”, “word”, 
“spreadsheets”, “pdf”, “graphics” and “PNG_graphics”. Installing 
into existing directory structures that include subfolders with 
these names could cause expected errors. 

 Added a check to only allow one batch template project to be 
created for each batch. 

 5 new Quick Start import lists added (670 total). 

 Added a better informational message during system errors 
when generating documents to let the user know more clearly 
most errors are caused by user interference. 

WHAT’S NEW IN V15.10? 

 Updated all Proposal Pack version numbers from 18.2 to 18.3 to 
reflect the updates to all the template package products. 

 All 200 samples have been rebuilt. Most samples now use 
newer photo based Proposal Pack design themes. Some minor 
fixes were made to spelling and grammar errors in few samples. 

 5 new Quick Start import lists added (665 total). 

WHAT’S NEW IN V15.9? 

 Added a post processing tool to adjust the chapter header logo 
positions after they have been converted to graphics. This tool 
allows you adjust all the chapter header positions without 
having to restore the backup and redo the graphic to text 
conversion with the correct positioning. 
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 Post processing tool for converting graphics to editable text 
now supports settings in both points and inches. 

 If using graphic design theme Proposal Packs the text “(With 
Deposit)” and “(Without Deposit)” will be removed from the 
Table of Contents when including one of the Work Order forms. 

 Added Unselect All buttons to post processing batch forms for 
unselecting all selected tools. 

 Added a Silent Mode to post processing batch screens to 
suppress popup information messages. 

 Increased the Novice Edition limit of 15 chapters in a document 
to 50. 

WHAT’S NEW IN V15.8? 

 5 new Quick Start import lists added (660 total). 

 Added a feature to speed up data entry if your clients are in the 
same area. You can configure the Wizard to automatically copy 
the City, State, Zip Code, Country, and County from the 
Company Data to the Client Data screen. There is a new 
Preferences option to set this feature to Yes, No and Ask. 

 Added a new tab to the Edit Current Document for managing 
project backups. Features include making new backups for 
individual projects, restoring from any backup, and deleting 
backups. 

 Added support for changes in Proposal Kit Professional built-in 
design themes being changed to Global #4 and Classic #18. 
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 Added flag in the Preferences to turn off table borders globally 
for when using more than one design theme and you want to 
turn off table borders without individually disabling them in each 
installed design theme. 

 Added flag to the Fonts screen to dynamically set the color 
based on Color #3 of the current design theme. 

 Novice Edition users now have access to a handful of the 
document post processing tools. 

 Added a post processing tool to batch change all hyperlinks and 
email addresses to a single value while retaining the original 
text. This is useful for when creating fictional documents with 
URLs where you do not want the links to be broken by pointing 
them at a known URL. 

 Added a post processing tool to set all text in the document’s 
footers to a specific Word Style. 

 Added a post processing tool to change all the major body and 
header fonts in the document. This tool can be used with the 
tool to change chapter headers to editable text to also change 
the editable text font style as well. 

 Added a post processing tool to convert all the chapter headers 
in graphic design theme Proposal Packs to editable text to 
prevent having to change that setting in the Styles screen and 
rebuild the document from scratch. This tool will update the 
Table of Contents and convert the Title Page Proposal graphic 
to editable text. 

 Updated demo styles from line art to new photo design themes. 
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 If using graphic design theme Proposal Packs the text “(Long 
Version)” and “(Short Version)” will be removed from the Table 
of Contents when including one of the Non-Disclosure forms. 

 Fixed an issue where if an invalid URL or email address were 
entered Word would generate an error trying to convert it to a 
hyperlink. If an email or URL field does not appear to be valid 
the Wizard will not try to have Word convert it to a hyperlink. 

 Changed back to the default setting that keeps the Title Page 
and Back Page watermark pictures and shapes in the header vs 
moving them into the body. Some Word installs can get the 
ZOrder of the shapes wrong when moving them. This has no 
effect on the final printed or PDF versions of the documents. 

WHAT’S NEW IN V15.7? 

 Added support for 10 new Proposal Pack design themes (500 
total) now available from the Edit Styles screen drop down as 
new add-on designs. Add-on design themes are purchased 
separately. 

 3 new Quick Start import lists added (655 total). 

 Added a new document post-processing tool to allow changing 
the footer accent graphic. This tool can also add a footer accent 
graphic to a document that does not have a footer accent 
graphic. 

WHAT’S NEW IN V15.6? 

 Added support for 10 new Proposal Pack design themes (490 
total) now available from the Edit Styles screen drop down as 
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new add-on designs. Add-on design themes are purchased 
separately. 

 3 new Quick Start import lists added (653 total). 

 Added more debug logging messages during document 
creation. 

 Some forms had drop down lists that users could type their own 
information into that would result in index out of bound errors. 
All drop down lists on all forms are updated to prevent users 
from typing their own data into them. 

 The zoom percentage option has added the ability to set the 
zoom value to 0 which bypasses the setting of the zoom value 
when the Wizard opens Word documents. 

 Alternate settings for the footer accent graphic positioning have 
been removed from the Style Settings screen and consolidated 
into the MyGraphics folder features. 

WHAT’S NEW IN V15.5? 

 Added support for 10 new Proposal Pack design themes (480 
total) now available from the Edit Styles screen drop down as 
new add-on designs. Add-on design themes are purchased 
separately. 

 6 new Quick Start import lists added (650 total). 

 Added new manual chapter How do I do Project Tracking and 
Reporting? 
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 Added links to online help videos from help screens. 

 Added document processing tool for changing bullet points in 
generated documents. The bullet tool can also set a custom 
bullet point graphic for use in all future documents created by 
setting it up in the MyGraphics folder. 

 Added option for having the missing project folder test and 
repair feature to create missing folders in addition to searching 
for them or archiving projects with missing folders. 

 Added list of default program associated by Windows for use 
when opening .docx, .docm, .xlsx, .pdf and .xml files to the 
About screen to help troubleshoot if old or incompatible office 
software is being used with the Wizard operations. 

 Added popup question if project status changed without a date 
being set if the user wants to add the date or clear the field. 

 Fixed an issue where a couple XML format export files would 
not open from the Wizard screens if Excel was not the default 
program set for opening XML files such as when the 
MSOXMLED.exe program was set by Microsoft. 

 Improved speed of closing Manage Project screen and added 
progress bars. 

 Fixed an issue where if the table border style were set to a style 
that must have a width over the default width size (i.e., Thin 
Thick Thin Small Gap) but the border width setting is not set it 
would default to a thinner width and generate an error.  
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 Updated the project tracking status date screen to always 
update the date when the status has changed even if the date 
field did not change. 

WHAT’S NEW IN V15.4? 

 Added support for 10 new Proposal Pack design themes (470 
total) now available from the Edit Styles screen drop down as 
new add-on designs. Add-on design themes are purchased 
separately. 

 1 new Quick Start import lists added (644 total). 

 Added more comments to the crash reporting form. Added an 
extra field to help describe more details in crash reports. 

 Added option to skip updating OLE Excel links between 
spreadsheets and Word documents when cloning projects with 
linked files. 

 New project management screen added with expanded 
features. Now multiple projects can be cloned, deleted, and 
have their tracking statuses updated at once. The Clone Project 
button has been moved into the new screen. The clone, project 
status and tracking reporting are all Expert Edition features. 

 The Delete Project option now includes a new option to archive 
project files to a new archive folder to ensure work is not lost on 
any documents created for projects being deleted. 

 The Delete Project option now includes a new option to search 
for and archive orphaned project folders. Orphaned project 
folders are the hard drive folders containing the Word, Excel 
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and PDF documents created for a project but the project itself 
has been deleted from the Wizard database. 

 The Delete Project option has a new feature that will optionally 
delete orphaned project batches. Batches that are not linked to 
any projects (either due to not having any added in the first 
place or having them deleted) are considered orphaned 
batches. 

 The project status tracking reports are updated to include the 
user comments and you can control which projects are exported 
to the tracking report. Field widths are set wider for the longer 
data fields in the exported spreadsheet. 

 Open Project Folder and Refresh List buttons added to the 
Team Editing tab of the editing screen. 

 Added drop down for selecting projects from a batch in the 
Search Projects form and the project selection form. 

 Fixed issue with CompanyNickname field case in the example 
batch Excel import file. 

 Fixed issue with the status tracking dates potentially not being 
cleared out when a deleted project slot in the database is 
reused for a new project. 

 Added descriptions of new batch tools to manual. 

 Added links to new videos into related manual chapters. 

WHAT’S NEW IN V15.3? 
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 Added support for 10 new Proposal Pack design themes (460 
total) now available from the Edit Styles screen drop down as 
new add-on designs. Add-on design themes are purchased 
separately. 

 2 new Quick Start import lists added (643 total). 

 Added screens to the Company and Client CRM Database 
feature for mass deleting records and exporting records to an 
Excel compatible .XML file. 

 Added Preferences options for Team Editing mode for 
automatically creating, not creating, or asking Yes/No to create 
assembled documents during project save. 

 If Team Editing mode is turned on and assembled project 
documents not yet created, then the Edit screen will put you on 
the Team Editing tab first. 

 Added select all and unselect all buttons to batch processing 
screens. 

 Crash logging is now turned on by default. 

 Added form to send crash log report to customer service if a 
crash during document assembly was detected. 

 Added links to new videos into related manual chapters. 

WHAT’S NEW IN V15.2? 

 Added support for 10 new Proposal Pack design themes (450 
total) now available from the Edit Styles screen drop down as 
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new add-on designs. Add-on design themes are purchased 
separately. 

 5 new Quick Start import lists added (641 total). 

 Added example files for use with the company and client CRM 
database importing using files. 

 Added importing from Outlook to the Company Data screen and 
updated how QuoteWerks data is imported. 

 Added ability to import company and client data directly into the 
reusable CRM database from external files, QuoteWerks and 
Outlook. 

 Reorganized the interface for importing 3rd party company and 
client data to add all 3rd party options into a new popup screen. 

 Added Preferences options to individually toggle on/off the 
popup screens for importing client data at the point a new 
project is added. The same functionality is now available directly 
from the Company Data and Client Data screens. 

 Added Clear Form buttons to the Company Data, Client Data 
and reusable CRM Company and Client data screens. 

 Rebuilt the Preferences Batch Processing screen to match the 
Edit Current Documents screen with a list box of options vs 
checkboxes allowing for easier additions of new tools. Also 
added the ability to select individual Word documents to 
process from the selected folder instead of processing all 
documents in the folder. 
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 Added a Batch Processing tool that will swap out the main 
document body section’s watermark with either a custom 
watermarked defined in the MyGraphics folder’s Watermark-
Body.docx file or if that file doesn’t exist from the stock design 
theme’s Watermark-Body.docx file found in the 
Graphics/PNG_Graphics folder. This tool can be used to change 
the background design after a document has been changed or 
fix a problem that occurs on some installations of Word where 
the background watermark disappears during assembly. 

 Added a Batch Processing tool that will move any full size shape 
object in the main document body section to the rear of the 
ZOrder. This tool can be used to fix the ZOrder that occurs on 
some installations of Word randomly where Word will move a 
full size shape object to the front and hides the other elements 
behind it during assembly. 

 Added a Batch Processing tool to remove any full page shape 
objects in the document. This can be used to fix an issue with 
ZOrders out of order by removing unused shape objects. 

 Added a Batch Processing tool to automatically update the 
Table of Contents object. 

 Added ability to define which QuoteWerks field is used to 
determine if a quote is loaded. The default is using the 
“SoldToCompany” field in QuoteWerks. 

 Added links to new videos into related manual chapters. 

WHAT’S NEW IN V15.1? 
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 Added support for 10 new Proposal Pack design themes (440 
total) now available from the Edit Styles screen drop down as 
new add-on designs. Add-on design themes are purchased 
separately. 

 Added an About button to the Wizard home screen which will 
display more information about what edition and mode the 
Wizard is running in as well as information about Word and 
Windows. Buttons are included to check for updates to installed 
template packs and buttons for instructions on how to unlock 
features when not running in full feature modes. 

 Updated the VBA code signing certificate on the Wizard 
document and the EXE installers till 2023. 

 6 new Quick Start import lists added (636 total). 

 Added button to Manage Batch screen to reset the design 
theme if reusing projects created previously with a different 
design theme and the new batch is going to build the 
documents in a different design theme. 

 If a batch is currently setup then saving document projects will 
not automatically generate the documents as the project is 
saved as the assumption is any projects being edited will be 
generated during the running of the batch. 

 Added feature to the batch processing that allows user to either 
overwrite duplicate files in the external batch folder or create 
new copies. 
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 Added ability to change the design theme assigned to previous 
batches to recreate the documents in a different design theme 
when the batch is rerun. 

 Added more logging information to the crash log during 
document assembly. 

 Captured Unicode character values out of range to prevent 
error messages during foreign language translations. 

 Added links to new videos into related manual chapters. 

 Added to startup tutorial for the Edit Current Document screen. 

 Fixed issue when editing batch template from a previously run 
batch would change the index numbers of any projects created 
from that template. 

 Added new manual chapter Error! Reference source not 
found. 

WHAT’S NEW IN V15? 

 Added support for 10 new Proposal Pack design themes (430 
total) now available from the Edit Styles screen drop down as 
new add-on designs. Add-on design themes are purchased 
separately. 

 Several structural and database changes to the Wizard were 
required to complete the batch processing system that required 
a full version upgrade. Incremental patches are no longer 
possible to the previous version. 
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 The document batch processing system has been completed 
adding the ability to make batch updates to previous batches 
such as adding new pages to assembled proposals, letters, 
invoices, checklists, etc. and have them automatically added to 
all the projects in a previously run batch. 

 Generated documents now have the background graphics of 
the Title Page and Back Page moved out of the header and into 
the body of the page. This makes it slightly easier to replace 
them with your own and shows the full color during editing. 

 Added new messages when running restricted 10S version of 
Wizard why 3rd party integrations are disabled and how to 
ensure the proper Word software is installed to support them. 

 The Wizard installer defaults to linking the Desktop shortcut to 
the version without 3rd Party integrations to ensure users do not 
get errors when using incompatible editions of Word. The 
Preferences features have been updated to add compatibility 
tests which give instructions about what integration options will 
work and how to resolve incompatibilities. 

 Added button to Preferences > Integrations screen to test 
system compatibility for using 3rd Party integration features. 

 Added button to Preferences > Integrations screen to make a 
new Desktop shortcut link for running the integration enabled 
versions of the Wizard. 

 Added a new Document Processing tab to the Edit screen 
(Expert Edition only) that allows post processing cleanup and 
checking of project documents. This moves existing 
Preferences tools more easily accessible from the Edit screen. 
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 Added a document processing tool for testing for left over data 
and instructional tag text added to the Document Processing 
tab and Preferences batch processing screens. 

 Added a document processing tool to remove all body text in a 
document set to the Proposal Kit Important Body Text style. This 
is to support the creation of an editor’s version of a document 
that uses instructional text for writers that needs to be removed 
when the proposal writing is completed. 

 Added ability to import a contact from Outlook when creating a 
new project. 

 Added the ability to use the Wizard’s built-in Client CRM 
database as a data source for creating projects for a batch. 

 Addition of new Wizard CRM company and client records when 
a new project is created is skipped if the company name, first 
name and last name are all blank. 

 Added QuoteWerks option to turn off the missing template 
messages when creating QuoteWerks templates that do not use 
any stock Proposal Kit cost related pages. 

 Added new manual chapter How do the Edit Screen Document 
Processing Tools Work? 

 Added new manual chapter How do I Integrate with Outlook? 

WHAT’S NEW IN V14.11? 

 Added support for 10 new Proposal Pack design themes (420 
total) now available from the Edit Styles screen drop down as 
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new add-on designs. Add-on design themes are purchased 
separately. 

 5 new Quick Start import lists added (630 total). 

 As a part of the new batch system the ability to batch import 
contact data from a variety of sources was added to the Batch 
Projects screen. You can import contact data from Outlook, 
QuoteWerks, Excel and other file formats such as .txt, .csv and 
.xml. 

 Added new manual chapter: How do I Import Contacts for 
Batching Documents? 

 Template limit per document increased from 10 to 15 in the 
Novice Edition. 

 Added demo data to the company and client CRM database 
files to help people see what kinds of information typically go 
into those fields better. The Remove Demo tool will remove 
these demo records. 

 Added links to latest how-to videos into matching manual 
chapters for mail merge and file import tags. 

 Added an Integrations tab to the Preferences screen and moved 
the 3rd Party and QuoteWerks there. Also added a screen for 
Outlook configuration settings. 

 Due to versions of Word 2013 and earlier having outdated 
Outlook reference libraries that can cause compile errors all 
installs of the Wizard that detect Word 2013 and earlier will 
default to linking to the restricted 10S mode version of the 
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Wizard. The 10S mode version has 3rd party integrations such as 
QuoteWerks and Outlook disabled. 

 The clone a project feature was not incrementing the project 
number when numeric project numbers are being used. 

 Added a Batch Import folder to the Proposal Projects folder that 
contains example batch import files in various formats such as 
.xml, .xlsx, .csv and .txt. 

 Added Preferences option to toggle mail merging into 
document headers and footers which is defaulted to turned off. 
This will speed up document creation as by default templates 
do not include merge tags in document headers and footer 
shape objects. 

 Fixed some popups in the training mode of the Expert Wizard 
that would prompt to purchase the upgrade instead of 
prompting to enabling expert mode. 

WHAT’S NEW IN V14.10? 

 Added support for 10 new Proposal Pack design themes (410 
total) now available from the Edit Styles screen drop down as 
new add-on designs. Add-on design themes are purchased 
separately. 

 3 new Quick Start import lists added (625 total). 

 Added a new batching feature that allows you to select multiple 
projects and generate the documents for all the selected 
projects at once. 
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 Added new manual chapter How do I Batch Multiple Projects 
at Once? 

 Added support for running the Wizard on a secondary monitor 
in a dual monitor setup so the Wizard’s forms will all open on the 
same monitor. 

 Added an Ultrawide feature to the Edit Style > Table screen. 
This helps support creating documents that need very wide 
tables. When turned on the pages in the body section will be 
oriented in Landscape mode and all tables will be auto-fit to the 
width of the page. This option is recommended when building 
editable versions of the Federal Government Grant samples. 

 References to Office 365 have been changed to Microsoft 365. 

 Fixed an issue with importing complex table content where 
importing a Word template with some variations of tables with 
vertically merged cells would cause the cell color setting to fail 
with an error. 

 Added more verbose information to path test and repair feature. 

 The Import/Export feature will now create project folders for 
imported projects and clear the locked for editing flag if set in 
an imported project that has no files. This prevents the file test 
and repair tool from flagging imported projects that did not yet 
have folders or files created. 

WHAT’S NEW IN V14.9? 

 Added support for 10 new Proposal Pack design themes (400 
total) now available from the Edit Styles screen drop down as 
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new add-on designs. Add-on design themes are purchased 
separately. 

 17 new Quick Start import lists added (622 total). These 
business situation lists have been added in response to the 
companies recently requesting help for various covid-19 related 
situations they are now facing. 

 Word 2007 is no longer supported. References to Word 2007 
have been removed. While Word 2007 may still work in most 
cases we do not test the Wizard on it anymore and do not 
guarantee it will operate. Microsoft has ended all standard and 
extended support for Word 2007. If you experience any issues 
running the Wizard in this obsolete version of Word, you should 
upgrade to the current version of Office. 

 Added links to new videos in related chapters. 

 Added new manual chapter: How do I Add Invoice Linked to 
Existing Cost or Estimate? 

 Added more verbose information to some Preferences setting 
error messages to help diagnose mistakes in customizing the 
settings more easily. 

 Added reminder popup screen for Proposal Kit Professional 
users who have not selected or installed the 5th design theme of 
their choice. 

 Fixed an issue when adding additional templates to an existing 
project document and the graphic page header to editable text 
with logo page header option is turned on. This could result in 
the insertion point being off. 
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WHAT’S NEW IN V14.8? 

 Added support for 10 new Proposal Pack design themes (390 
total) now available from the Edit Styles screen drop down as 
new add-on designs. Add-on design themes are purchased 
separately. 

 Added hundreds of new currency codes and language formats 
to the Expert Edition currency translation feature. 

 Added 5 new business situations to the Quick Start list (605 
total). 

 The Wizard can now apply currency code translations to the 
Excel spreadsheets. When using the Excel Dynamic 
Spreadsheet linking feature the currency code translations in 
the spreadsheets will be applied to the Word document. For 
example, all currency cells in Excel spreadsheets can be 
changed from USD $ to the Euro symbol €, Pounds £, etc. 

 Added a button to edit the custom delimiter file in the Multiple 
Choice Database setup screen. 

 Fixed an issue with the stock line delimiter not working after a 
recent upgrade to Word in the Multiple Choice Database 
feature. 

 Added extra error checking and ease of use feedback to the 
Multiple Choice Database screens. 

 Wizard installers will now detect if the 64-bit edition of Office is 
installed and will point the Wizard desktop shortcut to the 64-bit 
version of the Wizard. 



58 

 Wizard installers will not prompt to reboot the computer after an 
install or uninstall which in the past could occasionally be asked. 

 The Proposal Pack product list has split out the sports related 
design themes into a new “Sports” category. 

 Added a checkbox option on the first tutorial to turn off all other 
tutorials. This is helpful for users reinstalling or who are familiar 
with the Wizard already. 

 Reduced lengths of strings used in Dynamic Excel Spreadsheet 
linking to potentially fix an occasional string to long error when 
expanding long ranges of tags. 

 Added links to videos to the related Wizard manual chapters. 

 Added new manual chapter How do I Create an Editable Copy 
of one of the Samples? 

 Added new manual chapter How do I Add Supporting 
Documents to my Project? 

 Added new manual chapter How to Edit Page Headers that are 
Graphics? 

WHAT’S NEW IN V14.7? 

 Added support for 10 new Proposal Pack design themes (380 
total) now available from the Edit Styles screen drop down as 
new add-on designs. Add-on design themes are purchased 
separately. 
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 Added a new feature to the Expert Edition to turn on exporting 
of Bookmarks or Headers as Bookmarks when saving Word 
documents as PDF files. 

 Added additional checks on Wizard startup to test that the 
Wizard has Read/Write access to its database files and registry 
key. A more verbose message will be displayed giving more 
clear instructions on how to resolve access rights issues. 

 Added extra error checking to catch customization mistakes. 

 Fixed an issue with international versions of Word that change 
the “Heading #” Style names so that the international versions 
can be added to the Table of Contents object. 

 Fixed an issue with the Orange and Grey predefined color 
scheme not having the correct color values. 

 Fixed an issue with graphics not being scaled down to fit in 
certain locations due to Word applying its own downscaling in 
some cases first. Typically, when using the “Business Plan” or 
other longer Title Page custom titles in design themes that use 
larger size fonts. The Wizard will now scale all inserted graphics 
to 100% first, then apply custom scaling. 

 Fixed an issue with importing custom Title Page and Back Page 
graphics that could cause ZOrder error messages in some 
design themes that only use a single background shape object. 

 Fixed an issue when importing custom Proposal graphics into 
design themes that do not use the Description graphic when a 
custom Description graphic also exists in the MyGraphics folder 
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which would cause the Description graphic to be inserted in 
place of the Proposal graphic. 

 The Modify and Repair options in the Windows installers have 
been removed. These are unsupported options that are 
displayed by the installer when trying to run the installer more 
than once and can cause database paths to be blanked out 
resulting in errors when running the Wizard. 

WHAT’S NEW IN V14.6? 

 Added 3 more business situations to the Quick Start import lists 
(600 total). 

 Added support for 10 new Proposal Pack design themes (370 
total) now available from the Edit Styles screen drop down as 
new add-on designs. Add-on design themes are purchased 
separately. 

 Added a new feature for both Novice and Expert users that will 
convert the graphic designed chapter headers from pictures to 
text while still retaining the graphic designed themes chapter 
header logo. This allows for easier customizing of the templates 
when chapter headers need to be retitled without requiring the 
Professional upgrade. The Proposal Packs and Proposal Kit 
Professional have also been updated to support this feature. 

 Partial QuoteWerks support has been added to the 64-bit 
edition of Word. The Wizard can now create QuoteWerks layout 
files in 64-bit Word. Full functionality with communication with 
the QuoteWerks API still requires using the standard 32-bit 
Word. 
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 Increased the widths of unit price and total price columns in 
QuoteWerks layout files to accommodate longer dollar amounts 
without having to manually adjust the column widths or font 
sizes. 

 Added orange arrows designating that settings should be saved 
in the Top 40 configuration screen when default and favorites 
boxes are changed. 

 Fixed an issue where the display name of an externally added 
contract when multiple contracts are added to a project would 
show the wrong name in the edit document screen. 

 Fixed an issue with the Top 40 customization screen where the 
default checkbox would turn off when a new template was 
added to the list. 

WHAT’S NEW IN V14.5? 

 Added support for 10 new Proposal Pack design themes (360 
total) now available from the Edit Styles screen drop down as 
new add-on designs. Add-on design themes are purchased 
separately. 

 Auto-populating Presets are now loaded when a project is 
created instead of when the Pick Documents button is clicked. 
This eliminates one extra step when creating projects using 
presets. 

 Multiple Choice databases that are setup with specific templates 
that must have data selected for them will also be autoloaded 
now when the project is created instead of when the Pick 
Documents button is clicked. This eliminates one extra step 
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when creating projects using the Multiple Choice database 
feature. 

 Added 2 more business situations to the Quick Start import lists 
(597 total). 

 Updated the Edit Screen popup tutorial to note buttons added 
in the last update for adding Estimate Pack and Project 
Management Pack documents from the Edit Screen. 

 Add a new example in the MyGraphics folder illustrating how to 
create complex custom watermark backgrounds to be imported 
into the Title Page, body pages and Back Page. The new folder 
is titled Example-WatermarksUsingDocs. 

 Using custom watermark documents such as Watermark-
Title.docx, Watermark-Body.docx and Watermark-
BackPage.docx now supports rotation of shape objects. 

 Fixed an issue where the Wizard was not importing custom 
Watermark-Title.png/.jpg and Watermark-BackPage.png/.jpg 
graphics into styles that did not already have a background 
picture in the Title Page and Back Page. 

 Fixed issue in Edit Document screen where Spreadsheet tab 
was not always turning on when Estimate Pack or Project 
Management Pack spreadsheets added to a project from the 
edit screen. 

 Fixed an issue where the custom Back Page logo graphic was 
not being imported when a custom Watermark-BackPage.docx 
file was also imported at the same time. 
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 Fixed an issue where the background from the body section 
could replicate into the last back page section when using a 
custom Watermark-BackPage.docx file to import a custom back 
page design. 

WHAT’S NEW IN V14.4? 

 Added 5 more business situations to the Quick Start import lists 
(595 total). 

 Added a new feature that allows you to swap out any 
photographs used in photo designed Proposal Packs by putting 
a replacement photo in the same dimensions and file name into 
the MyGraphics folder (Expert Edition only). This only works with 
the upgraded V18.1 versions of the Proposal Packs with 
redesigned Title Page and Back Page templates that split out 
every photograph into individual replaceable objects. Also 
added a matching help video. 

 Added the ability to remove the <<Domain>> tag from document 
footers by setting the Alternate Footer Text field in the 
Preferences screen to the Word BLANK. 

 The current project’s <<CurrentDate>> field is updated every 
time documents are added to a project to ensure that the tag is 
inserted with the current date vs the date the project was first 
created. Primarily used for when adding extra documents to 
project such as invoices, contracts, Estimate Pack and Project 
Management Pack templates. 

 The Wizard is now integrated with the Estimate Pack and Project 
Management Pack template collections which are part of the 
Proposal Kit Professional bundle. You can now add templates 
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from these libraries directly to your projects in the Wizard. 
Templates will also have the design theme customizations and 
data merge tags applied to them. 

 When applying a color scheme to a document the Wizard will 
now set the fill color of text objects (in addition to Shapes) that 
have COLOR[1-6] set as the Alternate Text. 

 When applying a color scheme to a document any paragraph 
borders that are visible with a black border will have their color 
set to the same color as table borders. 

 Updated the URL conversion formatting to skip applying URL 
formatting to Table of Contents paragraphs. 

 Updated instructions in the example CustomFooter.docx files 
that custom page numbers must be put inside text objects. 

 The demo Title Page templates included in the Wizard have 
been updated to remove legacy shape objects. 

 The demo Cost Summary templates have been updated to 
match the Cost Summary table changes in the retail Proposal 
Packs. 

 Added a new example into the MyGraphics folder “Example-
MultiPictureDesignReplacement” showing how to do a complete 
design change using custom photographs to replace those that 
come with photo designed Proposal Packs. 

 Updated the Preferences tools for applying Proposal Kit Word 
Styles and page settings to external documents to also add 
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custom bullet points to the Bullet font type and the default 1.25” 
left and right page margin sizes used by Proposal Kit templates. 

 When QuoteWerks remapping was turned off some buttons in 
the Project screen were not turning back on until the Wizard 
was restarted. 

 When QuoteWerks remapping is turned on and the QuoteWerks 
3rd-Party features is enabled (for use with a different workflow) 
the Wizard won’t ask to import a quote. 

 When QuoteWerks remapping is turned on the Wizard will move 
all header objects in the Title Page and Back Page to the 
background of the body of the page using the ZOrder and 
rebuilding the shape objects and reinserting the graphics one at 
a time as opposed the previous version that did a mass copy 
and paste operation. This prevents Word from causing the 
ZOrder to be out of order across the objects which can happen 
at times when moving all objects with copy and paste. 

 Added new manual chapter How do I Integrate with Estimate 
Pack? 

 Added new manual chapter How do I Integrate with Project 
Management Pack? 

WHAT’S NEW IN V14.3? 

 Added 5 more business situations to the Quick Start import lists 
(590 total). 

 This update is primarily focused on expanded QuoteWerks 
integration features with the goal of being able to create custom 
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QuoteWerks layout files ready to use as-is in QuoteWerks 
without any manual reformatting or editing that was previously 
required. The process has been streamlined to require the 
fewest number of steps from turning on QuoteWerks remapping 
features to getting your document into the QuoteWerks system 
ready to use. 

 A new button was added to the Preferences > QuoteWerks tab 
that with a single click will reconfigure all the Wizard options 
required to start creating ready-to-use QuoteWerks layout files. 
Previously several screens had to have specific options set 
separately. A single click of the same button will restore the 
Wizard to generating Proposal Kit format documents. 

 Rewrote the 5 Minute Quick Start QuoteWerks chapter and 
added a matching video. 

 If QuoteWerks remapping is turned on the Wizard will put you 
directly into the QuoteWerks tab of the Edit Current Project 
Document screen after a document is generated. 

 QuoteWerks remapping will also now replace the tables in all 
the cost related Proposal Pack chapters with a QuoteWerks 
compatible table complete with QuoteWerks tags that matches 
the design theme of the Proposal Pack in use. Chapters are 
those such as the Cost Summary, Estimate, Quote, Invoice, 
Work Order, and other variations of the quote pages. 

 The Wizard can communicate with your running instance of 
QuoteWerks and can build either a single QuoteWerks 
compatible cost table layout for all line items or multiple tables 
one per QuoteWerks Item Type each with its own subtotal. 
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 The Wizard can be configured to build QuoteWerks layouts with 
QuoteWerks either running or not even installed on the same 
computer. You can manually enter your QuoteWerks Item Types 
in the Wizard’s Preferences or have the Wizard load them from a 
running instance of QuoteWerks. 

 The Wizard’s default table layouts for use with QuoteWerks can 
be edited from the Preferences > QuoteWerks screen. 

 Improved ability for Wizard to connect to QuoteWerks without 
having to be restarted. All QuoteWerks disconnected graphics 
can be clicked to initiate a reconnect and QuoteWerks can be 
reconnected from the Preferences > QuoteWerks tab. 

 9 new QuoteWerks tags added to the remapping feature. 

 Spots for 20 additional remappable tags added to the 
remapping screen. 

 Open Documents button added to the QuoteWerks tab in the 
Edit Current Project Document screen so all editing and saving 
of the QuoteWerks layout files can be done from one screen. 

 Non-mapped Proposal Kit tags will now be left intact instead of 
being replaced with blanks when remapping to QuoteWerks is 
enabled. 

 QuoteWerks database settings have been moved from the 
Options.ini file to the new QuoteWerks.ini file. 

 Wizard will reformat documents to make them more 
QuoteWerks compatible. Such reformatting includes moving 
shape objects and pictures from the headers into the body of 
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the Title Page and Back Page, making the body watermark 
backgrounds less complex in some Proposal Pack design 
themes and changing the alignment of all shape and picture 
objects. QuoteWerks does its own document processing in 
ways that do not support Word features that Proposal Kit 
supports that can cause formatting problems. 

 Added a new Bullets tab to the Edit Style screen with a new 
feature to give more control over bullet points. A dropdown list 
had been added that allows you to cause the Wizard to replace 
any stock bullet points (graphic bullets or symbol bullets) with an 
alternate standard bullet point with a custom color. This feature 
helps when creating documents for use in other platforms that 
may not support graphic bullet points. 

 Added a 5.5x8.5 Statement size to the paper size settings. 

 The Document Project’s Delete All Files button will now remove 
extra documents added from the new buttons to add letters and 
contracts in the Edit Current Project Document screen. 

 Added a button to the Add Contract tab to remove externally 
added contracts which also unchecks the Contract and Terms 
template. 

 If the Contract and Templates template is removed from a 
project any externally added contract tied to that template will 
now be removed as well. 

 Added the ability to load Quick Start lists and change out the 
general purpose Cover Letter for the grant Cover Sheet. 

WHAT’S NEW IN V14.2? 
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 Added 5 more business situations to the Quick Start import lists 
(585 total). 

 Added the ability for the Wizard to automatically import custom 
page header graphics when using graphic design themed 
Proposal Packs. The Wizard can now import custom made 
graphic page headers and substitute them in the correct page 
and update the Table of Contents text to match. All that is 
required is creating the new chapter header graphic and saving 
it into the MyGraphics folder with a specific file name. 

 Added a new feature to the Font Styles configuration for making 
mass changes to the font types across all the custom Word 
Styles. This is a faster way to change all the various Word Styles 
that are associated with header styles or body text styles at 
once. For example, all the Title Page header, chapter header, 
body page sub header Word Style that are in Arial can be 
changed to another font type in one operation. 

 Improved the ability to turn email addresses and web site 
domains into clickable hyperlinks in all areas of the document 
including headers, footers, text blocks and shape objects. All 
mail merge tags for email addresses and web site domains are 
turned into clickable links at the time they are merged into the 
document and if the http prefix is missing it will be added to 
ensure Word can turn it into a clickable link. Word Styles will 
also be applied using the Proposal Kit URL predefined style and 
if that is not in use it will default to the built-in Hyperlink style. 

 Added custom color settings that can override the default 6-
color palette colors scheme for bullet point colors and page 
border colors. These colors can be set in the Edit Styles screen. 
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 Wizard will switch from training mode to Expert mode upon 
entering the Edit Current Document screen instead of after the 
first document within the edit screen is opened. 

 When importing content from the prewritten samples and 
spreadsheet linking is not in use then any unmapped 
spreadsheet linking tags such as <<R#C#>> will be replaced 
with the text “<< Insert Info >>”. 

 Changed the default popup messages when only a Contract 
Pack is installed to tailor messages better and not add 
confusing Proposal Pack template information. The initial 
training mode project will also only add a Contract and Terms 
chapter when only a Contract Pack is installed instead of a 
default multi-page proposal set of templates. 

 The Font Styles screen will default to the current Proposal 
Pack’s color settings when editing any of the default Proposal 
Kit Word styles if that Word Style has not already had its settings 
changed. This will show the colors you see applied in the order 
that they would be applied to the documents during document 
assembly. 

 Added an option to the Font Styles screen to reset all the 
custom font styles to default settings at once to speed up the 
process of reversing mass changes or resetting many custom 
changes across different Word Styles. 

 Stock Contract Pack templates can now be edited from the Pick 
Documents screen in the Novice Edition of the Wizard. 
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 Fixed an issue with the View Manual link not having a valid path 
to the Documentation.pdf right after having searched for and 
installing new a new template pack on startup. 

 Added a fix for Word 2007 to prevent a known bug in Word 
2007 from generating out of memory errors when adding 
Hyperlinks. 

WHAT’S NEW IN V14.1? 

 Added 10 more business situations to the Quick Start import lists 
(580 total). 

 Added an Add Invoice button to the Edit Current Document 
screen (Expert Edition only). This allows you to easily add an 
invoice to an existing project. The invoice will be created as a 
separate document from the master project document. The 
Invoice Calculator Excel spreadsheet will also be copied unless 
a cost related page already exists such as a Cost Summary, 
Estimate, etc.  In this case the Invoice will be matched to the 
existing cost page. If the spreadsheet linking is turned on the 
Invoice page will be linked to the cells in the existing cost 
spreadsheet, otherwise they will be linked to the Invoice 
Calculator spreadsheet. 

 Added an Add Letter or Checklist button to the Edit Current 
Document screen (Expert Edition only). This allows you to easily 
add a letter or development checklist document to an existing 
project such as a customer follow-up letter, etc. 

 Added an Add Legal Contract button to the Edit Current 
Document screen (Expert Edition only). This allows you to easily 
add a template from the Proposal Kit Professional’s Contract 
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Pack library if installed. This feature also allows adding multiple 
Contract Pack templates to a single project whereas the Pick 
Document screen only supports adding one per project. 

 The Invoice template settings have been changed to create the 
Invoice as a document separate from the main project 
document instead of being inserted into it to support the new 
Edit screen button for adding an Invoice to an existing project. 

 The Create Reusable Template button on the Edit screen has 
been expanded to also allow selecting any external Word 
documents in the project for use as reusable templates such as 
an invoice, letters, checklists or contracts. If the selected Word 
document also has a matching Excel spreadsheet, that 
spreadsheet will also be added as a reusable template. 

 Added a Refresh button on the Edit screen for use when the 
user opens the projects file folder in the operating system and 
makes changes to the documents such as manually deleting 
files. Use the Refresh button to reload the interface lists of files 
based on the new contents of the file folder. 

 The Create Revision button on the Edit screen has been 
expanded to also create backup files for any Word documents 
on the Edit screen.  Only the master project document will have 
a new backup file created with an incremented file name while 
all other Word documents will have a single copy saved to the 
project Backup folder. 

 An Expert Edition feature has been added to create additional 
Word Section breaks at the end of the assembled document. 
This allows for inserting additional content such as supplied 
forms and tables that requires different page margins and/or 
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different headers and footers from the rest of the document 
while still maintaining the overall structure of the Proposal Kit 
layout and the Back Page. Up to 100 additional pages with 
independent Sections can be added. 

 The Auto Open documents in the Edit screen has been changed 
to be turned off by default due to additional features that can 
cause many more documents to be available to be auto-
selected than in the past. This option can be turned on in the 
Preferences. 

 If the Auto Open documents in the Edit screen is turned off, 
then the Word documents will also not be auto-selected in the 
file lists anymore. 

 The master project document when backed up by the Wizard 
will now be backed up into the project’s “Backup” subfolder 
instead of the main project folder. 

 A ReadMe.pdf instruction manual has been added to the 
“Alternates” folder to help explain what the .docx files in that 
folder are used for and to direct users to read the appropriate 
manual chapters for additional information. 

 Two new screens have been added to the Edit screen tutorial to 
cover the new buttons added in this update. 

 If a file is deleted from the project using the Edit screen’s Delete 
button and that file is an external invoice, letter, checklist or 
contract then the projects selected list of files will have that 
template removed so it does not get accidentally rebuilt into the 
project unless the user explicitly adds it back. 
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 A Delete button was added to the Spreadsheets tab of the Edit 
screen for deleting any project spreadsheets. 

 In the Team Editing tab of the Edit screen when a document is 
recombined from the individual chapters and when projects are 
generated using user customized content the Wizard will check 
for added Section Breaks and warn that it may cause the 
template to not be formatted correctly. 

 When the Edit screen detects both Word and PDF files and user 
selects PDF files to be opened it won’t open the Excel files as 
well.  Excel files are only opened if the Word files are opened. 

 Added a Search Contracts button to the screen that allows the 
user to select a Contract Pack template in various tabs of the 
Pick Documents screen. 

 If a custom Table of Contents object has been added to the 
stock TableContents.docx file by the user, the Wizard will use it 
instead of inserting its own stock TOC object. The Wizard will 
update the user added TOC object with the appropriate TC 
Field and Proposal Kit Page Header tags to ensure all the page 
headers are added properly. 

 When the Add Templates screen’s Contract and Terms 
checkbox is checked when the Proposal Kit Professional or a 
Contract Pack is installed user will be prompted to select a 
specific contract template. 

 Added an Expert Edition configuration option to have the 
Wizard automatically remove the instructional text in red font 
type from the cost and invoice pages. 
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 Expanded the feature that replaces the <<R#C#>> tags in cost 
and invoice templates with plain text when the dynamic Excel 
spreadsheet linking is turned off to work with every alternate 
version of table layouts and Excel sheet. The layout of the 
Invoice will also be automatically matched to the layout of any 
cost page already added to the project. 

 Fixed an issue when <<R#C#>> tags are replaced with OLE links 
to the Excel spreadsheets that the paragraph style (left, right, 
center) was not being retained. Now OLE links will be set to the 
same style as the text it replaces. 

 Fixed an issue where the master project document was backed 
up when external files were added to the project that did not 
affect the master project document.  The master project 
document is only auto-backed up when the Wizard makes 
changes to it such as adding new pages. 

 Fixed an issue with the customizing of the file list database 
when editing the settings of existing stock templates. 

WHAT’S NEW IN V14? 

 All Proposal Kit template products and the Proposal Pack 
Wizard software have been upgraded to work only with .docx 
and .xlsx files. All Word and Excel documents included in all 
products have been converted to the current Word and Excel 
file formats. All use of and references to legacy file formats have 
been removed. This upgrade effectively removes legacy 
support for Word 2003 across all Proposal Kit products.  
 
This allows you to now customize all the stock templates with 
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features available in all versions of Word and import content 
from any Word document. 

 A reusable Client and Company CRM database has been 
added. This allows you to select from a list of records for your 
company and client screens to be populated from. Create lists 
of employees who will be sending out documents and lists of 
clients or just base information for locations such as cities you 
provide services in. 

 Added a new manual chapter How do I Use the Client and 
Company CRM Database? 

 The configuration features for setting up a networking or 
alternate location for databases and project files will now 
automatically copy your database files and update all the links in 
the associated files such as absolute links between copied 
Word documents and Excel spreadsheets. 

 Added a fast and streamlined process to create reusable 
templates right from the Edit Document screen. This process will 
also automatically put the reusable templates on a Custom Top 
40 list up and make that Custom Top 40 list the default you see 
in the Pick Documents screen. 

 The Wizard can detect when it thinks you might be creating a 
document for use as a reusable template (when the Mail Merge 
and Dynamic XLS Linking boxes are unchecked) and will ask at 
that point it is created if you want to add it to the database and 
will walk you through the process. 

 A new Category H (Section 12) has been added to the database 
of templates for holding all user-created custom fully assembled 
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templates. This makes it easier to locate your custom templates 
in the various Wizard screens for editing and adding to your 
future projects. 

 The ability to use already linked Word documents and Excel 
spreadsheets has been added to the reusable template feature. 
The Wizard will now update the links between files as they are 
copied from the database to your project folder. 

 Added 10 more business situations to the Quick Start import lists 
(570 total). 

 You can now set any of the many Top 40 lists, including the 
custom lists, as the default Top 40 that is shown first on the Pick 
Documents screen. 

 The Preferences tool for adding custom templates to the 
database will also allow you to automatically add the new 
templates to a Custom Top 40 list. The Custom Top 40 list will 
also be set as the default in the Pick Document screen making it 
easier to find and add your custom templates to future projects. 

 Changed the order in which Word and Excel files are opened 
together. Excel files for your project are opened first followed by 
the Word document. This prevents the spreadsheets from being 
opened in read-only mode by Word when they are directly 
linked with OLE links. This affects the Edit Style, Edit Project and 
Pick Documents screens. 

 The Clone Project feature is updated so it can also work with 
linked Word documents and Excel spreadsheets. The cloning 
process will update the links in the Word document as the files 
are copied to a new project folder. 
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 QuoteWerks features will default to saving layouts in .docx 
format. Other file formats can be used as well such as .doc and 
.rtf. 

 The QuoteWerks tab in the Preferences screen is now visible if 
QuoteWerks is not installed. This allows for creating 
QuoteWerks layout files on a remote computer. 

 Added a new manual chapter 5 Minute Quick Start 
QuoteWerks 

 All security signatures on the Wizard and the installer programs 
have been upgraded with SH2 SHA-256 certificates. 

 All external web site links are converted from http to https. 

 The Time Line template is now searchable using the term 
Timeline. 

 Added 5 new slots in the Third Party Preferences screen to 
accommodate more add-on packages and external integrations. 

 All reports generated by the Wizard are now in Word format 
instead of plain text files. 

 The Wizard will not load old versions of template packages that 
use legacy file formats into its list of available templates. With 
the upgrade to .docx/.xlsx file formats only template products 
with these new file formats will be recognized by the Wizard. 

 The ability to use relative links in a Word document to a cell in 
an Excel spreadsheet has been removed due to restrictions in 
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Word. All paths in a Word document must now be absolute 
paths. 

 The Import/Export tool now uses an .xml file format and opens it 
with Excel. 

 The new client and company CRM database has been added to 
the Import/Export tool. This feature can also export an older 
version Project database into the new client CRM database. 

 Fixed an issue with some design themes not adding the revision 
number to the Title Page when creating a revision document. 

 Fixed an issue with Word 2007 setting position of some 
graphics that would generate an error message. 

 The new client and company CRM database has been added to 
the database testing tool. 

 Sped up the process of canceling the generating of long 
documents. 

 Created a workaround for a Word 2007-2010 bug that can, in 
some cases, cause generated documents to lose the 
background Title Page and/or Back Page graphics. 

WHAT’S NEW IN V13.2? 

 A new field for visibility of Word font Styles has been added to 
the font configuration Preferences screen. This field helps 
control displaying built-in font Styles so that Styles tied to Table 
of Contents sub headers are easily visible to the user. 
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 The number of Word Styles available in the Wizard Preferences 
has been increased from 40 to 50. 

 The built-in Word styles Heading 1 to Heading 9 have been 
added to the Wizard’s database to support easier creation of 
sub headers in the Table of Contents with custom settings that 
can be controlled through the Wizard software. 

 Added a new manual chapter How do I Add TOC Sub 
Headers? 

 The Wizard now automatically sets up generated documents 
with support for Table of Contents sub headers to be added by 
the user. To add sub headers the Heading 1 to Heading 5 will be 
automatically available and visible in the document Styles 
window. By setting any text you want as a sub header in the 
Table of Contents you can set the text to Heading 1 to Heading 
9 then update the Table of Contents object and the sub headers 
will be added. 

 The Wizard is now integrated with the help videos. Help video 
links are integrated into the Wizard home screen and 
documentation. 

 Added 20 more business situations to the Quick Start import 
lists (560 total). 

 Removed the Tab #15 from the RFP Response situation list and 
added it into the correct Page Dividers 1 of 2 situation list. 

 The Wizard will display a warning if it encounters read-only files 
or folders. This would be a more common issue when setting up 
a network or cloud installation. Any Proposal Kit template 
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products must be installed with read/write access in over for the 
Wizard to find and add them into the database. 

WHAT’S NEW IN V13.1? 

 Support added for installing and running Proposal Pack Wizard 
on Windows in S Mode. 
 
Windows in S Mode adds a layer of extra security that requires 
the Wizard and our template products (Proposal Packs, Contract 
Packs, Title Page Packs and Professional bundle) to be installed 
using the .ZIP files.  Some minor updates have been made to all 
the template products .ZIP files to add setup files used by the 
Wizard that were previously only included in the .EXE installers. 
Because Windows in S Mode does not allow .EXE files 
downloaded from the internet or copied directly to the 
computer to be run all Proposal Kit products must be installed 
using the .ZIP files on Windows in S Mode PCs. 
 
The functionality of the Wizard’s installer .EXE program has 
been added to the Wizard itself and a .ZIP file installer for the 
Wizard has been added to allow downloading onto a Windows 
in S Mode PC.   
 
The Wizard can now set itself up and configure its database and 
registry without having the .EXE installer perform that task. 

 Added manual chapter How do I Install in Windows S Mode? 

 The addition of the Wizard setup ability for Windows in S Mode 
has also been expanded to allow the Wizard to repair any 
broken paths found in the Wizard registry key and the Wizard 
database files. This allows you to now be able to drag and drop 
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your entire Proposal Pack Wizard and Proposal Kit product 
install folders from one computer to another or to move the 
install folders to a new location on your PC or to a network 
drive. The Wizard will check for any changed or broken paths 
every time it runs and will attempt to repair them based on the 
new location. This allows for seamlessly moving your entire 
installation without having to reinstall and reconfigure 
everything when moving to a new computer or a network setup. 

 Added manual chapter How do I Move to a New Computer? 

 The registered to name is first pulled from what the user enters 
in the product installer screen. If blank, then from what the user 
enters during the Wizard setup. 

 Added 4 more business situations to the Quick Start import lists 
(540 total). 

 Added more custom spreadsheet linking samples. 

 The Wizard will automatically turn off the display of non-printing 
characters when the Wizard first runs and when it opens any of 
its documents. This will help prevent formatting issues that 
might occur during automated processing. 

 Removed some old Word 2003 references. 

 Removed message that could popup sometimes when trying to 
automatically set table vertical border colors on tables with 
mismatched rows and columns. 

 Fixed the Orange Grey color values in the custom color scheme. 
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 Improved the instructions on how to set Custom X/Y logo 
scaling factors in the Edit Style Graphics tab. 

 The ability to edit stock Title Page templates has been added to 
the Novice Edition of the Wizard. This was previously an Expert 
Edition feature. 

 Added more error checking when opening PDF and Word 
documents in case the user’s system is not configured properly 
with default applications. 

 Added information to automated error reporting to tell when 
users are using 32-bit or 64-bit Word. 

 Fixed a potential error that could occur with a list index out of 
range in the Preferences when the user custom configured one 
specific list and removed default items. 

WHAT’S NEW IN V13? 

 The major new feature in this version is the ability to dynamically 
link cells in Excel spreadsheets to your Word documents. In the 
past all the financial and schedule related pages (cost 
summaries, work orders, budgets, ROI, timelines, installation 
schedules, etc.) were static Word tables that had to be manually 
typed in. 
 
This is an Expert Edition feature. 
 
This feature gives you automated financial calculations and 
scheduling that used to require costly 3rd-party quoting and 
project management software. We leverage the display features 
of Word and the calculation features of Excel to do the hard 
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work for you. 
 
Now all of the templates with matching spreadsheets will have 
the important data dynamically linked directly to the Excel 
spreadsheets. When you edit your calculations in the 
spreadsheet and save your changes your Word document can 
be automatically updated. This allows you to make changes to 
your financial data without having to keep manually retyping 
changes into the Word document. This also reduces the 
changes of errors occurring by mistyping data or forgetting to 
make updates manually. 
 
For example, if you use the Cost Summary template to display a 
nicely formatted table in your Word document where you just 
want to show the major line items and totals you customize the 
Word template for the visual look and data you want the client 
to see. The Cost Summary page has a matching Cost Summary 
Calculator Excel spreadsheet linked to it where you type in your 
line items, costs, quantities, taxes and any number of other 
information to arrive at your final totals. As you make changes to 
the spreadsheet the Word document automatically updates 
whenever you open it. 
 
This system is also completely customizable. You can customize 
our stock spreadsheets, Word tables and even make your own 
spreadsheets and link them to any pages. You can even embed 
links in any parts of the document to any spreadsheet cells. For 
example, if you want your total funding request amount to be 
displayed in the Cover Letter you can do so. Another example 
would be if you use an Installation Schedule you can link the 
starting date and ending date to your Cover Letter or anywhere 
else. 
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Most of the hundreds of samples have been reworked to 
include updated Excel spreadsheets using the new Excel 
dynamic linking feature that allow for all of the samples to be 
easily imported into your project. 

 All of the original Excel spreadsheets in all of the Proposal Kit 
products have been expanded to accommodate many more 
fields and additional calculations to work with the new Excel 
dynamic linking features. 

 The Edit Style > Manage Templates and the Pick Documents > 
Add Templates and Search by Name screens have checkboxes 
to let you filter by only those templates that have associated 
Excel spreadsheets to make it easier to find and add calculators 
to your project. 

 The Wizard now allows multiple spreadsheets associated with a 
template. Up to 9 additional spreadsheets can be associated by 
adding a number 2 to 9 to the end of the spreadsheet file name. 
This is mainly to support preassembled multi-page templates 
that have 2 or more linked spreadsheets added to the database 
as custom selectable templates. 

 Added a new manual chapter: What Types of Cost Calculation 
Features are Available? 

 Added a new manual chapter: What Happens if Dynamic 
Spreadsheet Linking is Disabled? 

 Added a new manual chapter: How do I Add Dynamically 
Linked Spreadsheet Calculations? 
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 With the new Proposal Pack V17 and Proposal Kit Professional 
V20 all 2000+ pages of Acrobat PDF sample content is now 
also provided in editable Word formats. We have painstakingly 
hand edited thousands of pages of our samples to make them 
completely editable and loadable into your project. 
 
In the past all our samples were uneditable Acrobat PDFs. Now 
with just a click of a button you can import an entire sample as 
an editable Word document, and have it converted into the 
visual design theme you purchased. This means a sample that 
was originally created in a different design theme than the one 
you purchased will be imported into your purchased design 
theme seamlessly. 
 
Plus we also have replaced the names, addresses and other 
data with our mail merge tags so that yours and your client’s 
data will be merged into the sample content making it easier to 
reuse any of our prewritten samples. 
 
Most of the samples with financial and schedule calculations 
(cost summaries, work orders, budgets, ROI, timelines, 
installation schedules, etc.) have filled in Excel spreadsheets 
dynamically linked to the Word document. 
 
The end result is that instead of having a static uneditable PDF 
sample to just look at to get some writing ideas from and 
copying and pasting some of its text you can now with a click of 
a button have a the entire sample merged into your document 
with your data and linked Excel spreadsheets in your design 
theme ready to edit. 
 
All you have to do is select a sample in the Pick Documents 
screen then click the Import Content from Selected Sample 
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button, save your project and the sample content will be 
automatically imported replacing the stock fill-in-the-blank 
content. 

 Any Quick Start import lists that were based on a completed 
sample can also have the content from the sample imported into 
the project just like when importing the sample content from the 
View Samples page. 

 The Quick Start tab now lets you only show Quick Start layouts 
that have importable sample content. 

 The number of licensed computers/users per copy purchased 
has been increased from 3 to 5. You can now install the Wizard 
on up to 5 computers for use by up to 5 individuals within your 
company per license purchased. 

 The drop down lists of hundreds of samples are now sorted in 
alphabetical order. 

 The Document Project drop down lists can be optionally sorted 
in alphabetical order. There is now a preferences option to sort 
the drop down project lists alphabetically. 

 The Wizard will now detect when it stops processing a 
document and will ask if you want to automatically restart 
processing where you left off when the Wizard is restarted. 

 The Wizard now has a crash logging feature to help diagnose if 
it terminates unexpectedly while processing a document. 



88 

 More detail has been added to the document processing 
progress bars so you know what stage it is in while processing 
long and complex documents better. 

 Color scheme application to Word tables is now done by row 
when possible instead of by cell due to how slow Word is when 
programmatically modifying a table cell by cell. This dramatically 
speeds up the document processing when applying custom 
color schemes. If a table has cells of different colors in the same 
row it reverts to updating cell by cell. 

 Sped up the document processing by determining when 
applying custom color schemes to Word tables was not 
necessary and skipping that process when possible. Word can 
be very slow when applying colors to Word table cells and table 
borders. 

 The old “Process Complete” popup message box has been 
replaced with a full screen that includes a breakdown of how 
long it took to process the document including timings for all of 
the major activities. This can assist in determining how best to 
customize the system to speed up processing based on how 
the user is intending to use the system. 

 The installer programs now check to see if Excel is installed and 
tell the user that it is required for using the new Excel dynamic 
linking features. 

 Mail merging was not working with text that had mail merge 
tags inside of a AutoShape object (i.e. the pull quote text blocks 
in some templates). Now tags are replaced with data inside 
AutoShape objects. 
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 The error reporting feature now includes the count of number of 
documents that were processed to help diagnose processing 
errors. 

 When importing the list of chapters from a sample the Wizard 
will automatically always add the Back Page as many samples 
were created before the Back Page was added to the system. 

 Added a button on the document reordering screen to reset the 
default sort order and turn off the custom ordering of the pages. 
This is useful if you want to revert back to the stock ordering of 
pages. 

 When changing the background color in the styles Color screen 
the Use Shape Watermark is checked automatically to reduce 
the steps needed to add background page colors and to make 
the feature more intuitive to use. 

 Added a Preferences configuration screen to control how the 
new Excel dynamic linking features work. 

 Changed the ‘Add Templates Based on Selected Sample’ 
button to ‘Import Content from Selected Sample’ now that this 
operation also imports the actual text of the sample and Excel 
spreadsheets used by the sample into your project. 

 Replaced the digital security certificate with a new 3 year 
VeriSign security certificate. 

 Added 21 more business situations to the Quick Start import lists 
(536 total). 



90 

 Added 35 more demo sample proposals (200 total). If you install 
a Proposal Pack or Professional bundle template package you 
will also get the complete versions of all 35 new samples. 

 The Wizard interface screens have all been updated with new 
screenshots and typography to match the new Proposal Kit web 
site and product design. 

 Added the registered users name or company to the home 
screen. This can be changed in the Preferences. 

 Added keywords as searchable terms in the Search by Name 
tab of the Pick Documents screen and imported keywords for 
many templates. For example, a search on ROI will now find a 
match for the template Return on Investment as ROI is a 
searchable keyword. 

 Added table formatting fields in the Edit Styles > Tables screen 
to set the top, bottom, left, right and spacing between cells. The 
fields are all set to DEFAULT which will cause the Wizard to skip 
any special processing. If you set these fields to within the 
allowable ranges the Wizard will apply the custom margins to all 
tables in the document. 

 Added an option in the Edit Styles > Tables screen that allows 
for turning off all table styling for borders and colors. If 
unchecked the Wizard will hide all of the table borders and set 
all table cell colors to the default background color. This feature 
will also reverse the colors of the white table text as turning off 
table colors can cause white text to not be visible by setting the 
color of the Proposal Kit Table Text 1 and Proposal Kit Table 
Text 2 styles to the color of the Proposal Kit Sub Header style. 
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 The function that calculated unique identifiers (GUIDs) for the 
creation of custom import lists has been updated. The previous 
Windows API function now generates Permission Denied errors 
due to a recent Windows security update and Microsoft has 
changed the recommended method of generating GUIDs. 

 When cloning a project and copying the project documents the 
Word documents will be updated to point to the new cloned 
folder if any dynamic OLE field links are in the documents. 

 The Preset feature that used to be an Expert Edition feature is 
now also available in the Novice Edition. 

 Increased some limits in the Wizard to accommodate the 
additional samples, spreadsheets and upcoming design themes. 

 The list of spreadsheets in the Edit Styles > Edit Spreadsheets 
tab is now broken into categories of spreadsheets which are 
also now sorted alphabetically. Spreadsheets in the folder that 
are not in the Wizard’s databases will also now be added to the 
drop down list. 

 Fixed a decryption error message in the 64-bit Word version 
that would occur when saving the preferences. No actual 
problem was occurring. 

 A recent Microsoft update to Word was causing some crashes 
on some computers during mail merging data into text block 
objects in the Title Page. A fix has been made to work around 
this bug Microsoft recently introduced. 

 The Wizard now checks to see if it’s document is in Print View 
mode and if not it switches itself to Print View on startup. If the 
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user had modified the Wizard’s document to something like Full 
Read Mode it could cause Visual Basic error messages on 
startup on some versions of Word. 

 Microsoft recently made changes in updates to Office 365 
which cause hidden fields to be turned on by default which can 
cause the Wizard during assembly of documents to delete some 
graphic page headers. The Wizard now hides the hidden 
characters from view as it is processing files. 

 Fixed a bug in the 64-bit Office version that could cause Word 
to crash in various setup screens when browsing for a folder. 

 To improve the ability to open PDF documents from within the 
Wizard if a program is not detected as the default for viewing 
PDF files the Wizard will try to launch the PDF file via a browser. 

 The Wizard’s security certificate has been updated with a new 
Norton Symantec code signing certificate that doesn’t expire 
until 2020. 

WHAT’S NEW IN V12.8? 

 Added 10 new photo designed Proposal Packs to the list of 
available add-on packs. New Proposal Pack designs can be 
purchased from within the Wizard (350 total design themes). 

 Added 8 more business situations to the Quick Start import lists 
(515 total). 

WHAT’S NEW IN V12.7? 
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 Added 10 new photo designed Proposal Packs to the list of 
available add-on packs. New Proposal Pack designs can be 
purchased from within the Wizard. 

 Added 6 more business situations to the Quick Start import lists 
(507 total). 

 Added some additional error checks to prevent an out of 
bounds error message. 

 The Word 2003 version of the Wizard has been removed. Word 
2003 support has been discontinued. 

WHAT’S NEW IN V12.6? 

 Added 10 new photo designed Proposal Packs to the list of 
available add-on packs. New Proposal Pack designs can be 
purchased from within the Wizard. 

 Added 6 more business situations to the Quick Start import lists 
(501 total). 

 Added additional searchable tags to some situations to make 
them easier to locate. 

 The Multiple Choice pick list screen used when the user is 
selecting items from the multiple choice database has been 
restructured to display much larger if the Wizard detects the 
screen resolution is larger. This allows for more items to be 
displayed on the screen. Word 2016 was also hiding items due 
to a bug in how Word 2016 is displaying screen items. This 
update also makes the Multiple Choice screen display correctly 
in Word 2016. 



94 

WHAT’S NEW IN V12.5? 

 Added 10 new photo designed Proposal Packs to the list of 
available add-on packs. New Proposal Pack designs can be 
purchased from within the Wizard. 

 Added 5 more business situations to the Quick Start import lists 
(495 total).  

 Added additional checks in the Wizard’s installer programs for 
the Webroot security software that can cause install errors due 
to interference from Webroot with the InstallShield’s temporary 
files. 

 Removed the restriction in the Wizard on having periods in 
folder names. Periods can now be used in operating system 
paths in the Wizard database and project folders. 

 Any screens that populate drop down list boxes from a search 
will now automatically open the drop down list making it more 
obvious where to find the search results. 

 On the Add Templates screens where you select individual 
chapters. If the drop down item selected is already in your 
project then an orange arrow will display pointing you at the Edit 
Template button instead of the Add Template button making the 
interface more intuitive as to what button you should click next. 

 Added additional information to some error messages to clarify 
how to resolve the problem. 

 Added additional information to data decryption error messages 
to make it clearer that the problem was caused by a registry 
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error probably from the user deleting something in the Windows 
registry. 

 Added additional code to help ensure that all work is done in 
Print View mode to prevent occasional view mode errors. 

 Fixed a bug that may cause an error in specific Proposal Pack 
design themes such as Healthcare #3 when the Wizard is 
adding a full page colored background shape object when 
building the document. 

WHAT’S NEW IN V12.4? 

 In the Wizard’s Pick Documents screen where the user has the 
ability to open and edit the Proposal Pack stock templates the 
user can now have only the selected templates in their project 
display in the drop down lists instead of the thousands of 
available templates. Only showing the currently selected 
templates makes it much easier to find and open just the 
desired templates for editing. 

 Added checks for the 3rd party add-in “AcerCloud Word Addin” 
which will cause the Wizard to not be able to process 
documents. This is one of multiple Acer and other 3rd party add-
ins that changes Word’s default behavior and will cause other 
software such as our Wizard to not be able to function correctly. 
Once detected the Wizard will instruct you to disable the Acer 
add-ins. 

 Added 10 new photo designed Proposal Packs to the list of 
available add-on packs. New Proposal Pack designs can be 
purchased from within the Wizard. 
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 Added 4 more business situations to the Quick Start import lists 
(490 total).  

 Increased the maximum number of document projects from 250 
to 500. 

 Added the ability to use Word line objects as color changeable 
design elements just like Word shape objects for more complex 
Title Page and Back Page designs. 

 Added code to help identify and eliminate errors that may be 
due to view mode changes during document processing when 
the Wizard is interfered with while building a document. 

 Fixed an issue where multiple install, uninstall and reinstalls of 
the Wizard could cause errors to occur when old files from a 
previous install were not deleted before the next install. Wizard 
installer will now ensure old database files are removed during 
an uninstall. The Wizard will also terminate when a bad install is 
detected right away along with giving instructions on how to 
repair the bad install instead of generating many error 
messages. 

WHAT’S NEW IN V12.3? 

 Added 6 more business situations to the Quick Start import lists 
(486 total). 

 Added 15 new photo designed Proposal Packs to the list of 
available add-on packs. New Proposal Pack designs can be 
purchased from within the Wizard. 
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 Added the ability to create more complex custom Title Page and 
Back Page background designs that can be imported from 
external Word documents. This ability makes it easier to create 
custom Title Page and Back Page designs that use multiple 
elements such as images and shape objects. 

 Added examples of custom designed multi-element Title Page 
and Back Page designs into the MyGraphics folder. 

 Added more information to some error messages. 

WHAT’S NEW IN V12.2? 

 Added more support for full page size watermark backgrounds. 

 Added ability for Wizard to import .JPG images for the Title 
Page, Back Page and body background watermark images to 
better support photo-based design themes and custom creating 
your own photo-based design theme. 

 Added ability for Wizard to load more complex body page 
backgrounds from an external Word document. This allows for 
more complex body page backgrounds than just the importing 
of a single graphic. Some photo based Proposal Packs use this 
feature to incorporate both images and colors that can be 
customized using the Wizards color palette feature. 

 The Wizard can also now load a custom body background from 
the Watermark-Body.docx file in the MyGraphics folder. This 
allows for both adding your own more complex body watermark 
to any Proposal Pack and overriding any default one that may 
exist in a photo designed Proposal Pack. 
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 An example custom Watermark-Body.docx file has been added 
to the MyGraphics folder. 

 Added a photo based example to the MyGraphics examples to 
show how to create a photo based custom design theme. 

 Added a longer chapter on specific steps to follow when 
creating a customized design theme to the 
MyGraphics/Readme.PDF instructions. 

 Added 10 more business situations to the Quick Start import lists 
(480 total). 

 Changed some integer variables to long to help avoid overflow 
errors when dealing with large volumes of files. 

 Newer versions of Word were not allowing some combinations 
of border style and border width that used to work in older 
versions of Word. This would generate and out of bounds error 
when trying to use an invalid width. The default border widths 
have been changed to ensure invalid widths cannot be 
selected. 

 Added 10 new Proposal Pack designs to the Wizard database 
for the new photo designed pack add-ons. 

 Expanded size of error report screen to accommodate longer 
messages. 

 6th color added to the colors palette screen for customizable 
full page colors. Customizable full page colors are now part of 
the new photo based Proposal Packs and have been added to 
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the Proposal Pack for Any Business and Proposal Pack for 
Government Grants packs. 

 You can configure different background colors for the Title 
Page/Pack Page and body pages as well as configurable 
dividers for separating images. Most new photo based Proposal 
Packs use shape objects on top of the photo backgrounds to 
allow the Wizard to change the colors of the separator lines 
between photos. 

 In the Word Fonts Preferences screen changed background 
color in view fonts so inverted colors are visible and now any 
custom colors from the current style and project will be applied 
to the sample view to show the final output the Wizard will 
generate. 

 Added 4 new custom Word Styles for inverted text colors to 
support light text on dark backgrounds. 

 Wizard can combine shape objects with custom background 
images or photos for more customizable page colors mixed with 
images. New photo designed Proposal Packs make use of 
customizable shape objects over the background photos. This 
allows for easy customizing of the colors of the blank areas 
reserved for text without requiring a graphics editor. 

 Moved page size setting higher up in the document processing 
process to work with resizing new photo designed watermark 
full size images when the paper size is set to a size other than 
standard 8.5x11 Letter size. 

 Added extra error checking if a custom footer file was defined 
to be used but no file was found. 
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 Added extra error checking if both full page shape object and 
page borders turned on that page borders will be hidden. Word 
does not support both features together. 

 Added an example photo design theme to the demo version of 
the Wizard. 

 Expanded the manual chapter on using the 6-color palette with 
more tips. 

 
WHAT’S NEW IN V12.1? 

 Added 12 more business situations to the Quick Start import 
lists. 

 Added more help material to the installation. 

 Updated links to the Facebook page. 

 Retitled the “Photographers Contract Pack” product to 
“Photography/Media Contract Pack”. 

WHAT’S NEW IN V12? 

 Increased maximum limits of number of templates in the Wizard 
databases to accommodate the newly added Proposal Pack 
templates with room for hundreds of custom user additions. 

 Added 380 new entries in the database for all of the new 
Proposal Pack templates. 
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 Added 3 new entries in the database for all of the new Proposal 
Pack estimate spreadsheets. 

 Added 27 new business situations to the Quick Start import lists 
(over 450 total). 

 Added a document revision feature that archives your current 
master proposal document then updates a revision number in 
the Title Page of the document. All edits to the master proposal 
will then be made to the current revision and all past revisions 
will still exist in your project folder. 

 Added a feature to clone an entire existing installed Proposal 
Pack set of templates to a duplicate copy that is selectable in 
the Wizard as a new style. This is useful for when you want to 
make multiple custom design themes of your own or other 
customizations to the templates that would be too cumbersome 
to manage with just a single library of templates. 

 The Multiple Choice database feature now allows for changing 
the insert order of paragraph content in the Wizard’s 
Preferences. This is for use with lists that are setup for allowing 
the user to select multiple items for a single tag. 

 Added a new article to the articles database for How to Follow 
Up or Revise Your Business Proposal. 

 Added edit buttons to open and edit the stock templates from 
within the Add Templates screens in the Wizard’s Project 
screen. This will make it easier to edit the stock templates while 
in the Project vs. having to go out to the Wizard home screen 
and into the Document Styles edit screens. 

https://www.proposalkit.com/htm/how-to-follow-up-or-revise-your-business-proposal.htm
https://www.proposalkit.com/htm/how-to-follow-up-or-revise-your-business-proposal.htm
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 Added better error messages for a couple of obscure problems 
to better help catch invalid input values that can cause 
problems with Word. 

 The Wizard installers will give notices to Office 2003 and Office 
2007 users to make sure they have all of the required Microsoft 
Office Service Packs #1, #2 and #3 installed to prevent potential 
problems running the Wizard on old and unpatched Office 
installations. 

 The Search By Name tab in the Pick Document screen now puts 
all exact and partial matches first followed by a the lists of 
alternate and related templates making it easier to find the 
exact and partial matches when long lists of results are found. 

 Added a Yes/No prompt when the Quit button on the Wizard 
home screen or the X box in the corner of the Wizard home 
screen are clicked. Along with an extra notification if the Wizard 
is still processing a document. This is to prevent accidental 
closing of the Wizard. If the Reduce Messages box in the 
Preferences is turned on this new Yes/No prompt will not be 
shown. 

 Updated the custom graphic import feature to allow for a full 
page size body watermark graphic image. Previously body 
watermark graphics would only be contained within the area of 
the colored page border. The full page size body watermark 
image will also be scaled if the page size is set differently than 
the standard letter size. 

 Added a message when selecting an alternate Title Page Pack 
design for the front cover that if the user already had a Proposal 
Pack with a custom designed front Title Page it will warn them 
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the design might clash. The Title Page Packs are intended for 
use with the more customizable ‘Proposal Pack for Any 
Business’ and ‘Proposal Pack for Government Grants’ that let 
the user start with a pack of templates that doesn’t already 
include a graphic and logo design. 

 Added more information to an error message that can occur 
due to interference with the Wizard during processor or due to 
3rd-party Add-In’s that have changed Word’s default behavior. 

 Restricted the screen for adding new documents copied from 
existing .docx files that the file extension must remain as .docx.  

 Updated the Wizard tutorials to include the new features added 
to this version 

 Maximum number of templates the Novice Edition will assemble 
has been set to 10. 

 Renamed SoftwareDevelopment.docx legal contract to 
SoftwareDevelopmentContract.docx to prevent Wizard from 
confusing it with the Proposal Pack’s 
SoftwareDevelopment.docx template. Checks put in place to 
ensure no Contract Pack and Proposal Pack templates share the 
same file names. This is to prevent contract exhibits and 
schedules from being accidentally appended to a proposal 
template that shared the same name. 

WHAT’S NEW IN V11.6? 

 Updated installers with Office 365 Word 2016 support. 

 Updated Wizard with Office 365 Word 2016 support. 
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WHAT’S NEW IN V11.5? 

 Updated installers with Windows 10 support. 

 Added links to the 25 new Proposal Pack add-on purchasable 
design themes recently added to the ProposalKit.com web site. 

WHAT’S NEW IN V11.4? 

 Added detection features for 3rd-party Add-Ins that are known 
to cause the Wizard to fail such as ‘Acer ABDocs’. Some 3rd-
party Word Add-Ins such as mailing label and document 
management software integrated into Word can cause Word’s 
default find handling to be changed which results in our Wizard 
software generating errors. Checks have been added 
specifically for ‘Acer ABDocs’ and additional messages have 
been added to help identify other conflicting products. 

WHAT’S NEW IN V11.3? 

 Updated the code signing security certificate which was 
expiring with a new 3 year certificate. 

WHAT’S NEW IN V11.2? 

 Added 30 new business situations to the Quick Start import lists 
(430 total proposal situations to get started with). 

 Added 2 new how-to articles “How to Market Your Business 
with A Community Workshop” and “Automate or Die – What 
Your Business Needs to Survive”. 

 Manual updates for how to create multilevel Table of Contents. 

https://www.proposalkit.com/
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 Added the ability to create Table of Contents so that outline 
levels can be used together with TC Fields (when used with our 
graphic based page headers). 

 The Wizard can now detect new product installations while it is 
running and will prompt you to restart the Wizard to complete 
the installation and setup of newly installed Proposal Kit 
products. 

 Fixed a bug in the Novice mode where a different field was set 
for use with the users custom logo than what was mentioned on 
the documentation. 

 When importing Quick Start lists of templates for business 
situations if there are any invalid characters in the import list’s 
title they will be removed to prevent error messages when 
saving your project to remove those characters. 

 Double quote characters are now not allowed in any file names 
or file path names. This is to help prevent system error 
messages from occurring if creating an invalid file name or path. 

 There were some cases where the order of the Cover Letter or 
Title Page could get changed in a custom sort order out of 
sequence. This has been fixed to ensure the Cover Letter 
always comes first, the Title Page follows, then all body pages. 

WHAT’S NEW IN V11.1? 

 The Wizard now has built in support for creating and managing 
Acrobat PDF files. While you can always save your Word 
documents as PDF with Word and Acrobats built-in features. 
The Wizard now integrates the creating, opening and managing 
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of the PDF versions of your documents directly into the Wizard 
interface. You do have to have Word 2007 or greater to use the 
PDF features, this feature is not available in Word 2003. 

 The Acrobat PDF support has also been integrated into other 
parts of the Wizard such as saving PDF files when cloning or 
backing up projects, notifying the user when PDFs may need to 
be resaved when the Word documents are changed, and testing 
the Word templates for tags that may have been forgotten to be 
edited or removed before saving in PDF format. 

 Added new manual chapter: How do I Save in PDF Format? 

 A new Preferences tool has been added for batch processing 
old or external Word documents. This allows you to make mass 
updates to a folder of Word documents for things such as 
updating headers, footers, page borders, page settings, color 
schemes, clickable URLs, Word font Styles, and document meta 
data. This feature is used to update old documents and to help 
prepare custom templates to be integrated into the Wizard 
database. 

 Added new manual chapter: How do I Batch Update Old or 
External Documents? 

 The Wizard now automatically opens the documents once they 
are built instead of the user having to manually click the Open 
Documents button which saves an extra step. This auto-open 
feature can be disabled in the Expert Wizard to restore the 
manual opening of the documents every time the edit screen is 
entered. The Wizard now also, auto-opens the documents after 
recombining them in the team editing mode. 
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 Added 50 new Quick Start business situations (400 total) to the 
import lists of templates. 

 Added 2 new how-to articles to the article library. 

 Many of the existing Quick Start import lists of templates have 
been updated with more specialized chapters. 

 Added a delete button to the Edit Current Document screen to 
make it easier to remove files from the project folder. 

 Added a select button to the Edit Current Document screen for 
selecting all PDF’s. Also reworded the current select button for 
selecting only the Word documents. 

 If the Quick Start import list is a different proposal type (i.e. 
setup for a Grant or Business Plan) the Wizard will automatically 
now switch the proposal type of the project to match. 

 All documents opened by the Wizard are now put into Print 
View Mode. This can prevent errors if the user saved a 
document in a different view mode then later opened it in the 
Wizard and the Wizard tried to do an operation on it that is not 
allowed in that view mode. 

 Added some more error checking for out of range values in 
table border setting. 

 If the default project name is not changed by the user and a 
Quick Start list is selected the Wizard will now set the project 
name from the name of the imported list of templates. 
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 If a Quick Start import list of templates is loaded then user 
cancels out of the Pick Documents screen the Wizard will now 
reset the main project screen settings that had been changed 
during the import of the Quick Start list. 

 Cleaned up the creation of folder names to remove extra blank 
spaces when introduced by removing other invalid characters. 

 Added checks so the Wizard home screen buttons cannot be 
clicked and used while the Wizard is building a document which 
could cause unexpected errors when users do not read the 
instructions to let the Wizard complete its build process 
uninterrupted. 

 If adding the Blank Templates to a project that also uses the 
new Back Page the Wizard now makes sure the Blank 
Templates come before the Back Page. 

 Added more verbose descriptions to some error messages 
created by Word. 

 When auto-generating file names the Wizard will now remove 
the “#” sign from any file names. 

 Replaced calling the Chr$ and ChrW$ functions in the foreign 
language translation features with Chr and ChrW calls because 
some early versions of Word 2003/2007 and some foreign 
language packs installed by Microsoft are missing the $ 
versions of the functions resulting in error messages. 

WHAT’S NEW IN V11? 
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 The Wizard can now add new pages to an existing document 
that you have already started editing. In the past any new pages 
would have to be manually copied and pasted into an existing 
document the Wizard has already built. The Wizard will add new 
pages in the correct order as defined in your project and will 
also update the Table of Contents and page numbering. 

 Added 28 new Quick Start business situations for new types of 
proposals (350 total). 

 If a Title Page Pack cover is used and you have already defined 
a custom background graphic then the Title Page Pack’s color 
scheme will not be used so it doesn’t clash with your custom 
background’s colors. 

 All of the color picking dialog popups now set the initial starting 
color. 

 Added a style settings screen so the user can configure various 
styling settings for table borders such as turning table borders 
on or off, changing the color, line style and line width. 

 If the Back Page Generic template is used the logo and contact 
information text block is automatically centered. This can be 
overridden in the MyGraphics configuration file. 

 The Edit Styles > Colors screen now lets you select from a pre-
designed set of almost 100 color palettes to get started with. 

 Added a number of graphic tutorials to help new users how to 
use various parts of the Wizard. 
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 Added a new graphical based screen for selecting the Title 
Page design and color scheme. 

 Removed the button to delete installed Title Page Packs, now 
uninstalled Title Page Packs are automatically removed from the 
drop down list. 

 Progress bars are displayed now when loading the Pick 
Document screen. 

 Added the ability to turn on or off the Title Page Pack color 
scheme when using a custom Title Page Pack background. 

 The Edit Selected Title Page button in the Pick Documents 
screen will also open the generic Back Page template and will 
apply the selected color scheme. 

 Added Next/Previous buttons to the Pick Documents checkbox 
screen to more easily scroll between pages of checkboxes. 

 Wizard includes an option to replace the graphic page headers 
(in graphic versions of Proposal Packs) with text. This removes 
the stock logo and text in the graphic headers and replaces 
them with text only headers. 

 The Cover Letter, Cover Sheet, Title Page and Back Page now 
cannot be reordered or repositioned, this is to prevent problems 
moving a document meant to be in its own standalone "section" 
into the main body section and causing formatting problems 
with headers, footers, page numbers, page borders, watermark 
graphics, etc. 
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 More error troubleshooting information added to some 
messages. 

 30 new custom mail merge fields have been added (50 total 
custom fields). 

 Color settings for Word Styles are now stored in text R,G,B 
strings making it easier to manually update the database files to 
specific color values. 

 If the CustomFooter.docx file exists in MyGraphics folder the 
Wizard will now auto-set the "Use My Custom Footer" option in 
the Table of Contents configuration screen. This saves the user 
having to remember to set this value when using a custom 
external file for the document footers. 

 Values can now be set in both points or inches in the 
GraphicSetup.ini file for positioning of custom graphics. 

 The internal limits of the Wizard have been increased to allow 
for up to 1000 templates per section in the database files and 
2000 total templates to accommodate the newly added 400+ 
templates with room for hundreds of additional custom 
customer added templates. 

 The Wizard will now remove any existing TC Fields from 
templates to ensure no outdated page headers are added and 
no duplicate entries occur in the Table of Contents when using 
graphic page headers with the new templates that now include 
TC Fields already embedded in them. 

 The Wizard database files are updated to add over 400 new 
templates for the latest Proposal Pack upgrades. 
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 The Wizard now automatically puts you into the Edit Current 
Document screen after manually starting the document build 
process. 

 All of the new 400+ template page headers are translated into 
15 foreign languages. 

 Updates have been added to the Wizard’s contract database to 
support the new templates added to the latest Contract Packs. 

 The Quick Start import lists are now alphabetically sorted to 
make it easier to browse. 

 Reworded some interface text to simplify descriptions of buttons 
or menu options. 

 Updated the saving of custom Quick Start import files to remove 
double or triple dashes from when non-usable characters are 
stripped out of the file name. 

 Updated instructions on how to update a Preset (i.e. load it first, 
delete it, then add it again). 

 When the Novice training mode is changed to the Expert mode, 
the Custom Proposal Type is also automatically enabled to be 
customized. Saves the user having to manually enabled the 
Custom Proposal Type. 

 The Wizard will ask if you want to change the default Proposal 
Type when a non-default Proposal Type’s settings are changed. 
Saves the user having to manually change the default type or 
forgetting to change it. 
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 Improvements to Preferences screen when adding templates to 
remind user to save their changes before leaving the screen 
when changes detected. 

 The Import/Export feature now tests the Multiple Choice 
database during the import pre-scan to notify how to migrate 
them to the latest version. 

 The Multiple Choice system now has a test and report option 
that will check your custom settings and display a formatted 
report of your settings. 

 The Wizard will now automatically insert your custom letterhead 
logo graphic into the header of your contract page. 

 Added new Multiple Choice delimiter option page break + 
custom which allows for adding a subheader to the custom 
delimiter file so the subheader starts at the top of each page. 

 The Wizard now asks if you want to add a Table of Contents 
once you get to over 8 pages selected for your document 
instead of you having to remember to add it once your 
document gets long enough to justify having a Table of 
Contents. 

 Reorganized some screens to better fit on small laptops with 
increased font sizes and minimum screen sizes. Wizard screens 
will now have all the important buttons visible on screen at a 
minimum screen resolution height of 768 and with a medium 
font size setting of 125%. 

 Changed the <<Fixed Rate>> mail merge tag to <<FixedRate>>. 
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 The Wizard now detects and gives instructions for fixing various 
setup and installation mistakes users make from time to time 
such as forgetting to install the Expert version of the Wizard 
after making an order and still are running the demo, using 
demo or limited styles when they have full retail packages 
installed, etc. 

 Fixed up some translations in the Korean and Japanese 
translation lists. 

 Fixed a bug in using custom graphics in the MyGraphics folder. 
If custom positions were set to 0, it was setting the graphic to 
the actual position 0 instead of using the default position. 

WHAT’S NEW IN V10.5? 

 Added more business situations to the Import Lists (322 total). 
These lists are used to load your project with all the templates 
needed for various types of proposals, business plans, business 
documents and other situations. 

 This patch of the Wizard focuses on making the Wizard operate 
consistently with the custom logo replacement features across 
all combinations of logo designed Proposal Packs, non-logo 
designed Proposal Packs, Title Page Pack templates and when 
used in conjunction with the language translation features. 

 A new configuration file is added to the MyGraphics folder to 
allow users to exactly define the position and scaling of all 
custom graphics that can be imported into the various Proposal 
Pack templates. This helps keep all of the users custom created 
graphics and positioning data in one place. This file is the 
GraphicSetup.ini file. Using this settings file will override any 
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other settings defined for logo positioning and scaling via the 
Wizard interface screens. 

 Scaling features have been added to the Accent graphics used 
in the Title Page and body page footers. 

 Added a new feature to let the user select the zoom level of all 
documents opened by the Wizard as well as how many pages 
to show in rows and columns when opening documents from 
within the Wizard. 

 If the user had defined a custom logo or alternate Title Page 
logo, the Wizard will automatically add the Title Page and Back 
Page templates to your project to save the user having to add 
the pages manually to their project. 

 When using the custom body page header logo to define a 
custom company logo that sits in front of the chapter headers 
with a logo designed version of a Proposal Pack the Wizard will 
delete the body page chapter header graphics and replace 
them with the actual text of the chapter names. This prevents a 
“double logo” with the users custom logo being put in front of 
the Proposal Pack’s logo theme logo on each body page. The 
user does lose the graphic designed version of the chapter 
headers, but can mimic the same look and color by modifying 
the Proposal Kit Page Header font Style settings. 

 Improvements have been made to the creation of the 
automated Table of Contents to ensure the proper use of TC 
fields vs. font Styles are used when using the language 
translation features with the custom page header logo 
replacement features. 
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 Expanded the new custom defined graphics to also be loaded 
into templates that are not combined into the master document 
(such as external checklists and letters). 

 Added more checks on user-configurable Word settings to 
catch out of bound conditions before Word reports them with 
more cryptic error messages. 

 Increased the maximum number of templates from 1300 to 
2000 to accommodate users with large number of custom 
templates. 

 Added additional troubleshooting tips to error messages when 
3rd party application launching returns an unexpected error. 

 The Wizard will now detect if someone using the Novice edition 
is trying to setup custom replaceable graphics (which is an 
Expert edition feature) and will direct the user to purchase the 
Expert Wizard upgrade. 

 The Wizard will periodically offer upgrades to higher end 
products when running more limited editions of products. These 
upgrade offers can be disabled in the Expert edition of the 
Wizard. 

 Fixed a problem with the new Back Page Generic template that 
was having the page borders and background watermark 
graphics loaded into it when it was manually selected as a 
template instead of automatically swapped in when using an 
alternate Title Page Pack background design. 

 Fixed a problem with logo designed Proposal Packs not loading 
custom user-created bullet point graphics into all of the 
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templates using some of the new features added in the previous 
patch update. 

WHAT’S NEW IN V10.4? 

 Added 20 more business situations to the Import Lists (320 
total). These lists are used to load your project with all the 
templates needed for various types of proposals, business 
plans, business documents and other situations. 

 The Wizard can now do mail merging into tags that are 
contained within text boxes that are in the template headers 
and footers. Previously tags could only be put into text boxes 
within the body text of the document. 

 More configuration options have been added to configure the 
look and initial settings for the document’s page numbering 
(such as the starting page number, turning on/off the display of 
the page numbers on the first body page, and changing the 
styling and positioning of the page numbers). 

 A new “Back Page” has been added to all the Proposal Pack 
document packs. This new Back Page is a final ending page to 
your document that has a design that compliments the front 
“Title Page” giving a more polished looking ending to your 
documents. The Wizard now supports this new “Back Page” in a 
variety of ways. 

 Most of the 300+ importable lists of situations have been 
updated with the new “Back Page” template. 

 A new multi-page popup displays at the start of the Wizard that 
helps explain all the custom branding features. 
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 The Wizard now supports the customizing of the colors in the 
new pull quotes that have been added to the most recent 
updates of the Proposal Pack document packs. 

 Added a new manual chapter: How do I Add TOC Sub 
Headers? 

 Added a new manual chapter: How do I Use the 6-Color 
Palette to Match My Logo Colors? 

 Added support for a set of 5 color attributes assigned to each 
Proposal Pack style and Title Page Pack design. These 5 colors 
are used to set the colors of fonts, bullet points, page borders, 
table cells and pull quotes. Use of this new color scheme allows 
more visual configuration of the documents generated by the 
Wizard. The use of the new color scheme is completely 
configurable in the Document Styles screen. 

 The Novice edition of the Wizard now includes some of the 
Document Styles configuration screens such as for customizing 
the newly added color schemes as well as editing the stock 
document templates and spreadsheets directly from the Wizard 
interface. 

 Added more auto-importing graphics features using the 
MyGraphics folder. Now the Wizard will auto-import the 
MyLogo-TitlePage.png into the Letterhead, Fax Cover Sheet 
and Envelope templates. Or – if there is a Letterhead.png 
graphic in the MyGraphics folder it will load that graphic instead. 

 The auto-importing of all of the graphics from the MyGraphics 
folder feature now also work on the plain text versions of 
Proposal Packs (Proposal Pack for Any Business and Proposal 
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Pack for Government Grants). Previously most of the custom 
graphic replacement was only supported when using Proposal 
Packs that already included a graphic design theme. 

 The auto-importing of graphics from the MyGraphics folder 
feature now also work when a custom Title Page Pack alternate 
front Title Page design is selected. 

 Now the Wizard will auto-import the Description.png graphic 
from the MyGraphics folder into the Title Page. 

 The custom Title Page selection screen has been updated with 
popup messages that help guide you through using the screen 
as well as additional displays of thumbnails to help make 
selecting designs easier. 

 Custom headers and footers can now be automatically loaded 
by the Wizard by creating a CustomHeader.docx or a 
CustomHeader.docx file in the Wizard’s MyGraphics folder. 
Putting a custom header or footer file here will override any 
custom header/footer defined in the style settings 
configurations, and also is quicker to use this feature than 
customizing the individual styles settings in the Wizard 
database. 

 The Wizard will now automatically scale the various logo options 
for the front Title Page to fit each specific Proposal Pack logo 
theme. Previously you would have to manually resize logos that 
were larger than the allocated space on the Title Page. 

 Example custom header and footer files have been added to 
the MyGraphics folder. 
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 Added example custom graphics to the MyGraphics folder that 
can be used as a guide to create your own per the instructions. 

 A PDF example that shows how the example graphics included 
in the MyGraphics folder look when assembled into a completed 
document. The sample also illustrates how the 5-color scheme 
and font styles were configured for a completely custom look. 

 The Preferences tool for adding the custom pre-defined 
Proposal Kit Word Styles to a single external Word document 
has been extended to also allow batch adding the Word Styles 
to an entire folder of external Word documents. 

 The Novice edition of the Wizard has had its upper limit 
increased from 10 to 20 templates per document. For 
documents greater than 20 pages long the Expert Edition of the 
Wizard is needed. 

 A new feature has been added to the Preferences > Project 
Settings > Configure Template Lists screen to select all of the 
master templates based on the templates selected for your 
current project. This is a more efficient way of building up the 
Custom proposal type by first picking templates for a project. 

 The Wizard initializing progress bars are now hidden when the 
initial setup screen is shown to prevent people thinking the 
Wizard is hung up while it is actually just waiting for the user to 
finish closing the setup screen. 

 Added a troubleshooting tip to the manual on how to resolve an 
issue with page numbers turning on in the Cover Letter/Title 
Page when you have edited the stock templates and completely 
removed the stock footer information. 
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 The Wizard now tests for write access to its registry key and if 
unable to modify its key reports an error along with detailed 
troubleshooting tips on how to correctly install the Wizard with 
access to its registry key. 

 The Wizard can now be shut down from the initial first time 
running setup screen in case the user is unable to access the 
buttons on the bottom of the screen. The Wizard will display a 
message for users with screen resolutions or desktop font sizes 
set too small for the Wizard screens to be completely viewable 
how to resolve the issue and resize their desktop or fonts. 

 The Envelope template is now kept in the default paper size and 
not changed when the default page size is changed for the 
combined documents. 

 The maximum number of active projects per project database 
has been increased from 160 to 250 (Expert edition only). 

 The Cost Summary is now added to all of the Wizard demo 
styles. 

 The Cost Summary is now added to the first proposal’s list of 
pre-selected templates. 

 The X close window buttons on all screens are now active and 
will invoke the close or cancel functions for each screen. 

 The Wizard now automatically changes from Novice to Expert 
mode in the full Expert Edition when you open your first 
completed document for editing. This saves new users the time 
of entering the Preferences screen and manually turning on 
Expert mode. 
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 Added extra information to the build document message to not 
interfere with the Wizard or use Word until the documents are 
built to avoid errors that can occur if you interrupt the Wizard 
while it is processing. 

 Added more troubleshooting tips for old versions of Word 2003 
that may need to be updated to prevent an error occurring in 
the Wizard related to the translation features. Also disabled the 
language translation features by default in the Word 2003 
version of the Wizard to prevent possible errors on first startup. 
Word 2003 users can turn on the translation features in the 
Preferences to test if their version of Word 2003 will work or if it 
needs to be updated. 

 Fixed a bug in the Configure Proposal Files screen where the 
Wizard lost the Section Number of where the template being 
edited was to be placed when the list is sorted alphabetically. 

 Added extra error checking to various functions. 

WHAT’S NEW IN V10.3? 

 Added 50 more business situations to the Import Lists (300 
total). These lists are used to load your project with all the 
templates needed for various types of proposals, business 
plans, business documents and other situations. 

 Support has been added for the 20 new Title Page Pack 
volumes of front cover designs. There are now 40 total Title 
Page Packs with a combined collection of 24,000 choices of 
designs and color schemes (each Title Page Pack is sold 
separately). 
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 Added a new Word Style “Proposal Kit Pull Quote Text”. This 
Word Style is used for the bold emphasized text in pull quotes 
or short statements in a highlighted text box. 

 The complete list of Title Page graphic replacement options is 
now supported in the non-logo designed Proposal Packs. When 
using the drop down list of replaceable Title Page headers with 
a non-logo Proposal Pack the stock ‘Proposal’ text header will 
be replaced with the text version of the selected header. This 
helps support the newly added features of the samples and 
Import Lists being able to change the Title Page header text to 
match the imported sample or import list automatically in both 
non-logo and logo designed Proposal Packs. 

 Added new articles to the how-to and help article database. 

 Added new manual chapter: How to Import Custom Graphics 
Using the MyGraphics Folder? 

 Added tests to the Import Lists function to check for incorrect 
import files. Some users accidentally rename (or their email 
programs rename) the .ini files as .txt files. The Wizard now 
checks to make sure an Import List file is not accidentally saved 
with a .txt file extension. 

 All of the Wizard’s sample document databases have been 
updated with the custom Title Page graphic used in the sample 
(i.e. if the stock ‘Proposal’ graphic was changed to something 
else like ‘Project’, ‘Business Plan’, ‘Resume’, etc.). The Wizard 
will now automatically change your project’s default Title Page 
logo graphic to match when importing the list of templates for a 
given sample (if you are using a logo designed Proposal Pack 
and haven’t set a custom Title Page logo graphic already). 
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 All of the Wizard’s 300 Import List files have been updated with 
custom Title Page graphics used to match the situation (i.e. if the 
import list is for something else like ‘Project’, ‘Business Plan’, 
‘Resume’, etc.). The Wizard will now automatically change your 
project’s default Title Page logo graphic to match when 
importing the list of templates for a given Import List (if you are 
using a logo designed Proposal Pack and haven’t set a custom 
Title Page logo graphic already). 

 When importing a list of templates using an Import List and your 
project already has templates selected you are given the option 
to replace or append to the list of templates in your project. This 
gives you the option of adding templates from multiple specialty 
lists when creating a complex document that covers multiple 
unique situations. 

 If QuoteWerks was running the background but you had 
disabled the use of QuoteWerks in the Wizard’s Preferences, 
the Wizard would still try to load the contact data from 
QuoteWerks. Now the Wizard will ignore QuoteWerks if it is 
running but disabled from use in the Wizard’s Preferences. 

 Fixed a list index error if running the current release of the 
Wizard on an older Wizard’s database from before when 
currency conversion features were added. 

 Added some addition error checking and logging to various 
functions. 

 Expanded the descriptions of some error messages with more 
verbose troubleshooting information. 

WHAT’S NEW IN V10.2? 
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 Added 50 more business situations to the Import Lists (250 
total). These lists are used to load your project with all the 
templates needed for various situations. All of the Import Lists 
have also been categorized to make it easier to find a group of 
related situations. 

 Added support for 30 newly added Proposal Graphics Packs 
products. There are now over 250 Proposal Pack logo design 
packages available (each sold separately). 

 Added a new feature for supporting international currency 
symbols in the Expert Edition of the Wizard. The Wizard can now 
automatically replace any United States Dollar ($) symbols in the 
templates with either 3 character currency codes or the Unicode 
symbols for most international currencies. The currency 
translation feature is also integrated into the use of the Presets, 
Import Lists and data Import/Export features. 

 Added new manual chapter: How do I Translate Currency 
Symbols? 

 All of the Import List business situations have been expanded 
with additional information about which type of proposal 
situation they were used for (i.e. real estate, healthcare, 
contracting, and so on). The Import Lists screen has also been 
expanded with a new drop down list of business categories so 
you can also see all proposal lists by category in addition to 
searching by name. 

 Added an additional “Remove” button to the viewing selected 
templates screen to make it more efficient when removing 
selected templates. This is a 2nd way to remove templates in 
addition to the usual Remove templates tab. 
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 The ability to create your own “Favorites” list has been added to 
the Import Lists screen. Now you can add any of the business 
situation lists to your Favorites list to quickly locate them later. 

 Changed the name of the “Add Templates Based on Samples” 
tab to “View Samples” and changed the name of the “Import” 
tab to “Quick Start”. An extra popup message was added to 
help direct new users to the “Quick Start” tab their first time 
using the Pick Document screen instead of manually selecting 
chapters. 

 Added a “Start Here” arrow button to the Wizard home screen 
to help point new users at where to start creating their 
documents. 

 Added a “Start Here” in the Novice training mode to the 
Document Project screen to make it more obvious to new users 
where to start the process of creating a new document. 

 Added new options to configure the Search Samples and 
Search Import Lists screens to help narrow down the list of 
found matches. 

 Added a new Preferences repair tool to recreate the ‘Run 
Proposal Pack Wizard’ desktop shortcut created by the Wizard 
installer program. You can now rebuild the shortcut link if you 
have upgraded your version of Word or had deleted your 
shortcut link from the desktop. 

 Added a new manual chapter: Repair the ‘Run Proposal Pack 
Wizard’ Desktop Shortcut 
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 The Wizard now goes straight to the Add New Project screen 
when there are no projects to edit. Otherwise the normal screen 
to select projects to edit or add a new project is displayed. 

 The Wizard will now resize the Title Page background to fit the 
page if the Letter page size is changed (i.e. to Legal, A4, etc). 
This will eliminate white bars around the edges of the 
background design. 

 The Wizard will now automatically reposition the faded body 
page watermark background graphic if the Letter page size is 
changed (i.e. to Legal, A4, etc). This will help keep the 
watermark within the color borders and in the bottom right 
corner of the page. 

 Added new articles to the library of help articles. 

 Added notification messages if a limited Demo or Limited style 
is selected when the user also has a full retail style also installed 
to inform the user to switch to the retail style to access all of the 
installed content. 

 Added more feedback messages in some operations when 
operations were completed. 

 In Demo mode the Pick Documents screen now default to the 
“Quick Start” tab. In Novice and Expert Mode the Pick 
Documents default is still the “Add Templates” tab. 

 Added a new help screen for the View Samples tab of the Pick 
Documents screen that reiterates some important information 
about the samples. 
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 Added more orange pointer arrow images to help show user the 
next button or operation that can be performed. 

 Added additional error checks in case users are still running 
versions of Word 2000 or earlier that are not supported and will 
cause errors while running. 

WHAT’S NEW IN V10.1? 

 Over 150 new business situations added to the Import List files 
to help you more easily figure out what chapters to add to 
different types of proposals. 

 Added a “Search” button to the Import File list screen. Now that 
the number of import lists has grown we have added search 
screen to make finding specific import lists easier. Use of import 
list searching has also been expanded by adding keyword lists 
to the import files. 

 Added a “Search” button to the Edit Current Document’s screen 
for viewing samples. 

 Added a “Search” button to the Add a Contract screen. This 
makes it easier to locate specific contract templates in installed 
Contract Pack libraries. 

 Added a “Search” button to the Document Project screen. This 
makes it easier to locate a specific client project if you have 
added a lot of projects. 

 Added the ability to clone past projects including both project 
settings and data as well as all of the source project’s 
documents. This feature makes it easier to make new 
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documents for past clients and to reuse a past proposal for a 
new client. This is an Expert edition feature. 

 Adjusted the positioning and spacing of text fields in the 
interface to prevent text from being cut off or wrapping. In some 
cases on new tablet platforms (such as Microsoft Surface Pro) 
Microsoft Word alters the screen size of text fonts in the Wizard 
interface causing display issues. All of the Wizard screens have 
been updated to provide more screen space for interface text to 
avoid text elements being cut off in the interface. 

 When adding a new project the project name is automatically 
generated with a default title and incremental number. The 
Wizard’s Preferences allows you to turn this feature off and also 
configure the default project name. 

 Added a new manual chapter: How do I Use the Cloud or 
OneDrive? 

 Added easier access to the extensive library of online help and 
how-to articles with a new screen available on the Wizard home 
screen. You can directly search for and lookup specialty how-to 
articles from the Wizard and open the web page efficiently from 
the Wizard interface. 

 Added a new manual chapter: How do I Configure the Articles 
Database? 

 The new online how-to and help article screen can also be 
completely customized with your own URLs and article and 
resource links. This allows you to build your own tailored article 
repository and make it easily searchable and viewable from our 
Wizard interface. 
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 Added admin features to completely hide the help and article 
buttons from the Wizard interface. Existing admin features for 
disabling specific interface buttons on the Wizard home screen 
have been expanded to also hide the buttons. This allows 
administrators to tailor the Wizard home screen better to hide 
features they don’t want their end users accessing or seeing. 

 Added tests and messages for inaccessible folders for use 
when the Wizard is configured to access files on networked or 
cloud based drives. If your connection to the remote drive is 
broken the Wizard will detect and report access problems. 

 If the Wizard has been configured for remote network or cloud 
access to your project files and the remote access is not 
available the Wizard will ask if you want to temporarily use your 
local hard drive project folder so you can continue working 
without an Internet connection. 

 Added a “Select All” button to the Configure Template Lists 
screen and improved performance for when large amounts of 
templates are updated at once. 

 Added a “Select All” and “Unselect All” button to the Configure 
Top 40 Lists screen and improved performance for when large 
number of templates are updated at once. 

 Added orange pointer arrows to the Document Project screen 
to help show what buttons still need to be clicked to finish 
adding templates or filling in project data in order to complete a 
project before building the documents. Helps show new users 
what still needs to be completed and helps remind expert users 
to not forget important details. 
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 Added buttons to the Preferences > Configure Top 40 Lists 
screen to mass enabled and disable all of the pre-defined Top 
40 lists. This lets you quickly tailor the users Pick Document 
screen to only show checklists of custom lists you have defined. 
This is more efficient than manually disabling each predefined 
lists one at a time or having to manually edit the Situations.ini 
database file for mass updates to all lists at once. 

 Added 6 new fields to the Edit Style > Page Setup screen to set 
specific page margins on the body pages of your assembled 
documents. This can be useful when using the Wizard to import 
custom documents that have wider than default page margins. 

 Add 2 new logo positioning fields to the Edit Styles > Page 
Headers screen (From Page Left and From Page Top). These 
field allow absolute positioning of the body page custom logo 
from the top and left corner of the page. Use these fields to fine 
tune the positioning of custom logos. If either of these fields is 
set to non-zero they override the Relative Top and Relative Left 
fields. 

 Fixed a problem in the new feature that allows the Wizard to 
auto-import your custom graphics from the new MyGraphics 
folder. The file being looked for was a different name than 
shown in the documentation. 

 Fixed a display issue in the interface where the use of the demo 
style was showing the wrong count of available documents. 

 Added support for future versions of the Title Page Packs. 

 Minor interface message cleanup. 
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 Added progress bars for the various search screens to provide 
more feedback during longer processes. 

 Added more error checks to ensure invalid data entry is not 
allowed in some screens. 

 Added more error checks and messages to notify about 
problems accessing files that are not available or caused by 
interfering with the Wizard during processing. 

 Increased the number of configurable Top 40 lists from 80 to 
100. 

 Fixed a bug where the Default Top 40 list would still be 
displayed if it had been disabled in the preferences. 

 Set the maximum number of active document projects to 40 for 
the Novice Wizard and 160 for the Expert Wizard. If the proposal 
database becomes full there is also a new Preferences button to 
create a new empty database (Expert Wizard users also have 
the option to archive or delete individual projects to create more 
space in the active project database). 

 Added more error checks when deleting Title Page Packs from 
the interface to prevent an error message. 

 Added a new manual chapter: How does the Wizard Use the 
Windows Registry? 

WHAT’S NEW IN V10? 

 Added a major new feature for multiple choice content. This 
allows you to define custom pick lists of external content 
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(paragraphs of text, entire documents, image files, 
spreadsheets, PDF files, etc.) for inserting into your documents 
when they are assembled. You can define up to 100 custom 
tags inserted anywhere in your templates and up to 300 custom 
pick list items organized in any combination you need and 
grouped in up to 10 different categories. For example, you can 
define a pick list of product descriptions, sample photographs, 
client references, etc. When you create your project pick your 
desired content and the Wizard will automatically insert it into 
your documents. Create your customized client proposals even 
more efficiently than before. 

 Added support for 9 new custom Title Page graphics. In 
addition to the 17 existing choices of graphics for the front Title 
Page the following new ones have been added: “Policies”, 
“Procedures”, “RFP”, “Request for Proposal”, “Samples”, 
“Handbook”, “Bid”, “Memorandum” and “Solicitation”. 

 This allows you to use the Wizard and Proposal pack to create 
additional types of business documents with a consistent design 
theme. 

 Translation support has been added for 15 languages: Canadian 
English, British(UK) English, Australian English, Spanish, 
Portuguese, Dutch, Italian, French, German, Romanian, Russian, 
Chinese, Korean, Japanese and Arabic. 

 Added a new manual chapter: How do I Translate Into Foreign 
Languages? 

 More support for creating Request for Proposals (RFPs) has 
been added. One of the 12 pre-loaded database lists has been 
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updated to include the RFP writing topics. “Request for 
Proposal” is now one of the selectable proposal types. 

 Added a “quick project change” drop down button to the Wizard 
home screen to allow quickly changing the current project. This 
makes it easier to swap between different projects when editing 
multiple proposals at once. 

 The Wizard will now automatically build your documents and 
open the edit screen when you have finished saving your 
project. This saves a couple extra steps of having to click the 
build button then the edit button from the Wizard home screen 
after saving your project. You can also disable the auto-build 
feature to return it to the legacy way of operating. 

 The Wizard can now automatically load graphics into your 
document by copying your own custom graphics into the new 
MyGraphics folder. See the ReadMe.PDF file in the MyGraphics 
folder for details. This can be a more efficient way of quickly 
getting your custom graphics into your document without 
having to configure various Wizard screens. 

 Internal limits on the number of documents the Wizard database 
can manage have been increased to accommodate the large 
number of new proposal and contract templates. 

 Added a large number of additional import files with lists of 
template defined for many new types of proposal situations. 

 Added support for the 30 new samples included in the new 
Proposal Packs. 
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 Added support for more new categories of templates and 
expanded categories to accommodate the additional new 
templates added to the latest edition of the Proposal Packs. 

 Added a new custom import tag specifically for inserting a 
custom spreadsheet anywhere in your assembled proposal. In 
addition to the <<ImportFile>> and <<ImportContractFile>> tags, 
you can now use the <<ImportExcelFile>> tag. 

 Extended the import tags (<<ImportFile>>, 
<<ImportContractFile>>, and <<ImportExcelFile>>) so they can 
be used to also import other file types such as PDF files. 

 Added the ability to import the contents of the footer of an 
external document into your assembled proposal. See this new 
chapter for details: How do I Import a Custom Page Footer? 

 The Wizard can now be configured to disable the display of the 
“Default Top 40” entry of the list of drop down choices in the 
Pick Documents screen. This allows you to completely 
customize the Top 40 drop down list to only include your own 
custom lists. 

 When custom documents are added into the Wizard database 
via the Configure Proposal Documents tool the Wizard will now 
automatically add the default Proposal Kit Word Styles to the 
custom documents as they are copied by the Wizard into the 
Proposal Pack’s document folder. 

 A new tool has been added to the Preferences > Data & Display 
> Font Styles screen to allow you to automatically add all of the 
custom Proposal Pack Word Styles to any external Word 
document. This can help maintain a consistent format across all 
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of your documents and aid in importing custom documents into 
the Wizard with consistent formatting. 

 The Edit Current Document screen will now bring your already 
opened proposal to the foreground whenever you click the 
button to open your documents. This is helpful if your proposal 
is actually open but hidden behind other windows. 

 Added a new Preferences configuration screen and options to 
configure how the custom import tags work. You can now 
configure the starting folders to look for your external import 
files and how the imported files are inserted (linked, static or the 
Wizard will ask before each file is imported). 

 Added additional error checking to data entry fields to prevent 
invalid data in some cases. 

 Fixed a minor problem in the importing of data from past 
versions of the Wizard when custom sort orders were defined 
for projects and presets that would cause the sort order to not 
be reapplied to the imported data. 

 Added extra error checks to ensure that if too many custom 
contracts are added to the system it will not cause overflow 
error messages. 

 Added extra checks on all important Wizard screens and forms 
to ensure they will fit on the minimum size supported screen 
size dimensions. 

 Added extra error information when there is a problem 
launching PDF or Excel documents from within the Wizard 
screens. For example, if there is no file association setup or an 
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unsupported application is defined in the operating system for 
opening the documents the error message may help pinpoint 
the configuration problem. 

WHAT’S NEW IN V9.4? 

 The Wizard licensing has been increased from 1 to 2 computers 
and 1 to 2 users per license to 1 to 3 computer and 1 to 3 users. 

 The documentation shortcut link is no longer put on the 
Windows desktop. Open the documentation right from the front 
page of the Wizard interface instead, or from the Windows Start 
menu. 

 The ‘Search for Styles’ button is now available in the Novice 
Edition 

 All of the 310+ demo contract documents included in the Wizard 
(i.e. the previews of what is available in the Contract Packs) have 
been updated with more content and are now completely 
reformatted to make use of the Word ‘Styles’ features now 
supported in the Wizard and the Proposal Pack documents. 

 The Novice Edition is now limited to creating documents only up 
to 10 pages long. The Expert Edition must be upgraded to for 
creating longer documents. 

WHAT’S NEW IN V9.3? 

 Added a new manual chapter What’s the Novice Edition vs. 
Expert Edition? 
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 Added a new manual chapter How do I Add Subheads to the 
Table of Contents? 

 The Wizard has been split into a Novice Edition and Expert 
Edition. The Novice Edition is bundled with all Proposal Packs 
and Contract Packs. The Expert Edition is bundled with Proposal 
Kit Professional. This has enabled us to make the initial 
purchase for Proposal Pack users less confusing and with a 
lower price for those who do not need the Expert Edition 
features. Novice Edition users can upgrade to the Expert Edition 
if they need any of the advanced Expert Edition features. 

 The Wizard has additional screens that make it easier to find 
and purchase add-on document packs (Proposal Packs, 
Contract Packs and Title Page Packs). Past versions of the 
Wizard only showed you what add-on document packs were 
installed. The Wizard now also shows all other packs that can be 
purchased with links to add to your shopping cart right from the 
Wizard interface. 

 The Wizard now has the ability to insert your own custom logo 
into every single body page of your document. You can also 
specify different logos for your Title Page and all of your body 
pages. The body page logo feature also includes fields to fine 
tune the placement and scaling of your logo. Your logo will be 
inserted in front of the header text of every body page of the 
document (i.e. in front of the text “Executive Summary”, “Cost 
Summary”, “Company History”, and so on. 

 Added a new manual chapter How do I Add My Logo to the 
Headers of all Pages? 
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 The Wizard now has the ability to import the header of an 
external document into the body pages of your document. This 
This is now handled via the MyGraphics folder features. 

 Added a new manual chapter How do I Import a Custom Page 
Header? 

 Custom logos can now be scaled automatically by the Wizard. 
You can set a scaling factor in the Wizard’s Edit Style > Graphics 
screen. This will help not having to rescale your logo in a 
graphics program before inserting into your documents. You 
also don’t have to manually resize custom logos each time they 
are inserted now. 

 Fixed a bug in the Configure Proposal Documents screen where 
if the list of templates was sorted alphabetically an error 
message would be displayed when deleting a document from 
the database. 

 If the Wizard is unable to locate the actual Word document for 
any templates in its database it will now generate a warning 
message with a list of the file titles and file names that cannot 
be found. This is typically only an issue when someone is 
customizing the Wizard database files manually and forgets to 
copy documents to the right folder or mistypes the file name in 
the database. 

 The Open Folder Button on the Proposal Edit screen has been 
disabled in Novice mode to reduce confusion over having 
multiple methods for opening the master proposal. 

 Added a more obvious graphic in red text and with red arrow 
pointing to the drop down list of additional Top 40 categories to 
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make it easier for new users to locate all of the 1000+ available 
topics via the various Top 40 sub categories. 

 Support for the upcoming Word 2013 has been added to the 
Wizard. 

 When adding a template to a disabled Top 40 list, the enable 
box will be automatically turned back on to prevent problems 
forgetting to enable the Top 40 list. 

 Additional error handling messages have been added to aid 
debugging obscure configuration problems. 

 Minor interface improvements. 

 Added more import files for additional types of proposal 
situations. 

 Added additional error checks for unsupported Word versions 
such as Word 2002. 

 Improved the encoding of URLs when the Wizard calls web site 
scripts. 

 Improvements to the Graphics & Logos screen such as auto-
enabling entries as soon as a file is browsed to and selected to 
help ensure the user does not forget to enable custom logos. 
Additional tips are also displayed when adding custom logos on 
how to finish setting up and configuring the use of custom 
logos. Custom logos are also now checked to ensure they are 
graphic file extensions such as (.png or .jpg). 
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 Additional text has been added to a number of Wizard 
messages to make steps more clear and to offer additional tips. 

 The Import function of the Pick Documents screen will now 
display a warning message if importing templates that do not 
actually exist as documents - such as when using the (Limited) 
stripped down set of templates that ships as a demo in the 
Wizard. 

WHAT’S NEW IN V9.2? 

 The samples can now be searched. A new search feature has 
been added to more efficiently locate samples by searching the 
sample titles, descriptions and keywords. This features also 
allows you to find all samples that use specific Proposal Pack 
templates. For example, you can search for all samples that use 
the Executive Summary template or the Project Management 
template. Look for the new “Search Samples” button in the Pick 
Documents screen in the View Samples tab. 

 When you use the Wizard Preferences to set your own custom 
company logo for the Title Page the Wizard will automatically 
change the default graphic to be the custom graphic you setup 
in the Preferences. This saves you the time having to make 2 
setting changes in different screens for getting your custom 
logo setup. 

 The “Edit Current Document” screen now pre-selects your 
assembled documents saving you the time of having to select 
the documents each time the screen is entered. All you have to 
do is click the Edit button to open the project documents. 
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 In some cases Microsoft Word was applying defaults settings to 
custom Word Styles that were added to documents for settings 
such as the “No Proofing” flag when the Wizard was not 
specifically setting the flag. This sometimes meant Microsoft 
Word was defaulting to turning off the spell checker for text that 
had a specific custom Word Style applied to it. The Wizard now 
defaults to always ensuring the spell checking is turned on for 
all of the custom defined Word Styles. There is also a Wizard 
Preferences setting to turn off the spell checker for any specific 
Word Style. 

 When using a Proposal Graphics Pack that includes custom 
bullet point graphics, the Wizard will now automatically set the 
“Bullet” Word Style to use the custom bullet point graphic. 

 Previously the Wizard would not import custom graphics into 
templates that were designed to be plain text (i.e. the Cover 
Letter, Inquiry Letter, etc.). Now the Wizard will import custom 
bullet points graphics into these templates during the assembly 
process when operating on a Proposal Graphics Pack that 
includes custom bullet point graphics. 

 The Wizard no longer requires the user to click on the Logo tab 
of the First Run screen during the initial setup of the Wizard. 

 The Wizard will skip processing of shape objects that do not 
contain text (such as autoshape checkboxes) when scanning the 
objects in the document during the mail merge process. This 
can significantly speed up the mail merge processing if you 
have added a lot of custom shape objects to your document. 

 A number of error messages have been enhanced with 
additional information to help more precisely determine the 
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cause of those error conditions (i.e. such as point sizes out of 
range, or running versions of Microsoft Word with limited 
functionality). 

 When using the Wizard on laptops with small screen sizes, some 
buttons were being cut off at the bottom of the screens. The 
buttons have been moved a little higher on those screens to 
make them accessible on very small screen sizes. 

 A couple cloud styled graphics were added to the Wizard 
document to help point new users at where to find the macro 
security button and the Add-Ins tab for running the Wizard. 

 If no document project is selected from the Pick Project drop 
down, the edit and change buttons will be greyed out and not 
accessible until a valid project is selected from the list. 

 If a custom sort sequence for a set of template in a Document 
Project gets out of sequence and causes an error message 
about the sort sequence not being correct, the Wizard will now 
automatically repair the error. 

 All of the samples included as demos have been updated with 
new graphics. 

 In some cases when installing newly purchased additional 
Proposal Graphics Packs they were not being automatically 
selected as the current Document Style. Now whenever a new 
Proposal Graphics Pack is installed it will automatically be set to 
your current style so you don’t have to manually select it from 
the Document Styles list. 
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 The Alphabetical template listings are now enabled in the 
Novice mode in the Pick Documents screen. 

 The message displayed when new Proposal Graphics Pack 
installations are detected by the Wizard is now updated with 
more information to help direct the user to where to manage 
those new packages in the Wizard interface. 

 If the Pick Documents > View Samples cannot locate the 
specific Cover Letter for a sample it will default to whatever 
Cover Letter it finds first in cases when you didn’t change the 
default Proposal Type to match the one used to create the 
sample initially. 

 In some cases when using custom Word Styles that were 
“Character” styles and not “Paragraph” styles and the user set a 
flag that was not applicable to “Character” styles the settings 
would not be applied correctly. The Wizard now checks for 
settings that are not applicable to “Character” styles and won’t 
try to apply those settings. 

 Fixed an error message that occurred during the First Run setup 
screen when the “Other” catch-all drop down item was selected. 
This error message did not actually result from a problem, it was 
just an erroneous message. 

 Some documents had minor cosmetic formatting updates. 

WHAT’S NEW IN V9.1? 

 Improved processing time of documents that include shape 
objects. 
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 Added buttons to various screens to directly access document 
folders using the desktop as an option to selecting documents 
from the interface lists. 

 Added a new button to the Pick Document’s ‘Search by Name’ 
tab to clear out the form fields. This will make it more efficient 
when doing lots of searches as you don’t have to manually clear 
out the fields each time you start a new search. 

 Changed the default Word “Style” Proposal Pack Title Page 
alignment to be right aligned. Also changed all of the custom 
styles from “Paragraph” to “Character” styles to avoid problems 
with applying styles to existing documents and having to deal 
with formatting changes. 

 Added the ability to change settings of built-in Word Styles 
(such as Normal, Heading 1, Heading 2, Title, Subtitle, Bullet, 
Hyperlink, Header, Footer, and Page Number).  

 Added a new field to the Word Styles options to allow setting 
the First Line Indent of the Style’s paragraph settings. This 
option also allows for negative numbers. 

 The Wizard database includes default settings for these 10 
standard built-in Word styles that match settings for the custom 
Proposal Kit styles. Use of the Wizard to update the built-in 
Styles and use the custom Styles can help ensure all text in your 
documents can be easily changed and will be consistently used 
across your entire document. 

 Added a new custom style “Proposal Kit Faux Page Header”. 
This style is used to match the same styles as the “Proposal Kit 
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Page Header” but will cause the Wizard to exclude headers in 
this style from going into the automated Table of Contents. 

 Added a new custom style “Proposal Kit Important Body Text”. 
This style is the same as the body text however is in a dark red 
font. Used to highlight important body text. 

 Added a new custom style “Proposal Kit Sample Header”. This 
style was intended for internal use to highlight text in bold red in 
demo documents. However you can use this style for your own 
purposes. 

 Added a new custom style “Proposal Kit Sample Text”. This 
style was intended for internal use to highlight text in bold red in 
demo documents. However you can use this style for your own 
purposes. 

 The Wizard will now set the header text of any templates that 
are NOT included in the Table of Contents to the “Proposal Kit 
Faux Page Header” style.  

 Added the ability for any of the Style settings to be left 
unchanged. This is mainly used when specifying changes to 
built-in Word Styles. 

 Increased the number of supported custom Word Styles from 
20 to 40. 

 Proposal Packs that are loaded into the Wizard that use the new 
Word Styles will turn off the auto-reformat feature of the Wizard 
by default. 
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 Changed the auto-updating Table of Contents to assign a Word 
Style to the actual Table of Contents using the pre-defined 
“Proposal Kit Body Text” style. 

 Updated the custom bullet point graphic replacement feature to 
not replace numbered lists with custom bullets. 

 Updated the document reformat process to no longer reformat 
text set to the “Normal” style. 

 Any new Proposal Packs version 13.1 or higher will automatically 
have the document reformatting process turned off by default 
now that all of the documents use Word “Styles” to prevent 
formatting problems with documents are combined together. 

 If all of the custom Top 40 situation lists have been disabled and 
there is only 1 Top 40 screen left (the default screen) then the 
drop down list of all Top 40 lists will be hidden from view in the 
Pick Documents screen. 

 Added some more information to some error condition 
messages. 

 The Edit Style screen has been updated to allow switching 
between the lists of templates in category listings and 
alphabetical listings to make it easier to locate specific 
templates. 

 More arrow icons have been added to the interface screens to 
visually show when operations are available (i.e. such as turning 
on an arrow icon next to an edit button when a selection has 
been made). 
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 The Wizard now includes a new Import tab in the Pick 
Documents screen. The Import tab is a new feature that allows 
for auto-selecting a set of topics for a proposal from a list that 
someone else created. A number of common situations have 
also been added for the user to auto-select a set of templates 
from. This feature also allows administrators to create custom 
lists of templates for other users to import into their projects - 
saving the end user taking the time to find and select a set of 
templates. This is very similar to using Presets, Auto 
Recommend or View Samples, however this allows the list to be 
selected based on an external file that was created outside of 
the Wizard. 

 The Pick Documents screen of checkboxes was not being 
updated as templates were added using the other tabs. As you 
add templates to your project from any of the tabs and you then 
go to the tab of checkboxes, the boxes will now be checked for 
added templates. 

 Fixed a bug that may have prevented custom logos from being 
inserted into the plain text versions and alternate Title Page 
Pack title pages. 

 The ‘View Samples’ tab now warns if any templates in the 
import list are not available in the current proposal type (i.e. if 
you are importing a list of topics for a business plan but you do 
not have your project type set to a business plan for your 
current project. 

 Turned off the messages about mail merge tags that were not 
filled in after each proposal is created. The message can be 
turned back on in the Preferences. 
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 Turned on the ability to change the order of selected templates 
when in the Novice training mode and demo mode. 

 Fixed an error message that would occur when multiple 
templates were added from a “Search by Name” screen to a 
project that had a custom sort order defined for its templates. 

WHAT’S NEW IN V9? 

 Proposal Pack Wizard had been updated to work with over 230 
new Proposal Pack Templates, 5 new samples and over 40 new 
Contract Pack contracts included in the new 2012 products. 

 Added 4 new custom logo options and 4 additional custom logo 
options to the Preferences > Logos & Graphics screen to 
support the 4 new logos available in the 2012 Proposal Packs. 
Now you can include graphic headers into the title page for 
“Manual”, “Information”, “Documentation” and “Instructions”. 
This allows you to use the Wizard and Proposal pack to create 
additional types of business documents with a consistent design 
theme. 

 Proposal Pack Wizard now directly integrates with the 
QuoteWerks quoting software. Multiple workflows are 
supported allowing you to either import QuoteWerks data and 
documents into your proposal or copying your Proposal Pack 
master proposal into QuoteWerks as a Layout to be completed 
within QuoteWerks. The Wizard will automatically detect and 
configure itself to work with QuoteWerks. Other features include 
auto-launching and logging into QuoteWerks when the Wizard 
is started. When creating a new Proposal Pack Wizard project 
you can also import your contact information directly from 
QuoteWerks. 
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 The Wizard’s mail merge tag remapping feature has been 
expanded to support multiple lists of remappings. The Wizard is 
now pre-configured with tag remappings for the QuoteWerks 
quoting application. Three custom lists of remapping tags are 
also now supported. Tag remapping will automatically convert 
Proposal Pack tags to a different set of tags to allow easier use 
of integrating documents between applications. 

 A new file import feature has been added to the Wizard. You 
can now insert multiple <<ImportFile>> and 
<<ImportContractFile>> tags into your templates. During 
document assembly the Wizard will prompt you for files to be 
inserted into your assembled proposal. If you have third-party 
applications such as QuoteWerks installed it will default to 
looking in their document folders. This new feature allows you 
to create a single combined reusable master proposal that can 
have quotes, multiple contract options, or other information 
imported into it for each new proposal. 

 The Third-Party configuration screen now includes a Skip Mail 
Merge checkbox (which is turned on for QuoteWerks by 
default). This feature improves performance when importing 
complex 3rd-party created documents that don’t include mail 
merge tags. 

 The “Top 40” list of most common templates screen of 
checkboxes has been significantly expanded with over 65 “Top 
40” lists. Instead of a single “Top 40” list, then all 1000+ 
templates being accessed via other screens and entire suite of 
“Top 40” categories has been added. These new lists allow you 
to instantly see all of the topics for specialized business types 
(contracting, events, security, real estate, logistics, and so on), 
proposal types (service sales, product sales, projects, business 
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plans, and so on), and usage categories (introductions, 
summaries, company details, financials, appendices, and so on). 
The new categories make it much faster to locate topics out of 
the library. 

 During the initial setup the Wizard will add selected situations 
from the new suite of “Top 40” lists to your Favorites list making 
it easier to locate. This initial setup will also add samples related 
to your type of situation to the samples favorites list. 

 The Top 40 screen does not require an extra button to be 
clicked after selecting templates. Templates are now 
automatically added to/removed from your project as boxes are 
checked. 

 The new suite of “Top 40” lists is also customizable. You can 
put your important lists in a Favorites category. You can define 
multiple custom lists. You can change the topics in all of the 
lists. You can also remove lists from the display. 

 The Wizard can now create a true Word auto-updating Table of 
Contents. The Wizard will automatically insert a Word Table of 
Contents object into your document and update all of the page 
headers to support the Word Table of Contents object. Text 
page headers are set to a Word “Style” and graphic page 
headers have TC Fields inserted next to them during document 
assembly. 

 A new Preferences > Data & Display > Auto Table of Contents 
Display screen has been added to allow configuration of how 
the Word Table of Contents will be created. All of the standard 
Word settings for the Table of Contents are supported. 
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 When inserting page numbers into your document the new Auto 
Table of Contents options can be used to define the type of 
page number allowing for more options besides standard 
numbers. 

 When creating the Table of Contents the Wizard will now 
automatically exclude any topics/pages above and including the 
Table of Contents from the Table of Contents. 

 To support the Word Table of Contents and the updated 
reformatting process the Wizard now inserts a collection of 20 
pre-defined Word “Styles” into the documents during assembly. 
This collection of Word styles defines the font styles for various 
parts of the document. Up to 20 Word Styles are supported by 
the Wizard and a number are set aside for future use and 
custom use. 

 A new Preferences > Data & Display > Font Styles screen has 
been added to allow customizing of all of the Wizards custom 
Word “Styles”. 

 The Wizard’s document reformatting process has been updated 
to make use of the new Word “Styles”. While it does not change 
the existing styles in the document, it will use the font settings 
to update the text of the document. This is to ensure the 
reformatting process does not alter the document layout. You 
can cause the Wizard to skip reformatting text by setting 
paragraphs to an actual custom (non-built in) Word “Style”. 

 A new option has been added to the Preferences to have the 
Wizard do the reformatting of the document on a Word by Word 
basis instead of the default Sentence by Sentence basis. The by 
Word option is much slower however it is more precise. The by 
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Word option is recommended when you have a lot of sentences 
that mix multiple font types in the same sentence (i.e. a bold 
Arial header and a non-bold Times New Roman). 

 More progress bars have been added to various Wizard 
operations. 

 More visual feedback is provided in many of the Wizard screens 
such as arrows pointing to buttons once the screen fields are in 
a state where you are ready to perform an operation. 

 File and folder browse buttons now default to starting in a 
specific folder to reduce the amount of time locating files and 
folders on your hard drive. 

 The new “What You Can Expect” template is now included in 
the main Top 40 list for general business proposals. 

 The Top 40 tab in the Pick Documents screen is now defaulted 
to being displayed first in both Novice and Expert modes. 

 If a Contract Pack has been uninstalled the Wizard will 
automatically turn off messages about missing files. 

 All of the drop down lists in the Wizard screens have been 
adjusted to fill the available space on the screen giving more 
visibility all of the options. 

 The Wizard documentation can now be opened from the Wizard 
home screen. This is useful if you have deleted the desktop 
shortcut icons. 
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 The color picker dialog screen now retains any custom colors 
setup while using the Wizard. Custom colors are only retained 
while the Wizard is running. 

 To improve performance during assembly custom mail merge 
tag wrappers are not searched for now by default. If you are 
using custom mail merge tag wrappers you can enable them in 
the Preferences > Data & Display > Edit Mail Merge Fields 
screen. 

 The maximum number of documents the Wizard can manage 
has been increased to accommodate the hundreds of new 
templates in the new Proposal Packs. 

 When switching from Novice to Expert mode you do not have to 
exit and reenter the Preference screen anymore after switching 
modes. 

 Added new manual chapter: It’s not just for Proposals and 
Contracts! 

 Added new manual chapter: How do I Import the Contents of 
External Files? 

 Added new manual chapter: How do I use the MyProjectFiles 
folder? 

  

The Wizard allows you to copy your own custom files that are not 
part of the Proposal Kit system into each of your new projects 
using the MyProjectFiles folder. 
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This feature allows you to automatically copy your own content 
such as worksheets, checklists, letters, spreadsheets, forms, etc. 
into each of your new Proposal Pack Wizard project folders. 
 
The MyProjectFiles folder is in the root install folder where the 
Proposal Pack Wizard is installed. This folder by default is: 
 
C:\ProposalKit\ProposalPack\MyProjectFiles 
 
Whenever you build a new document in the Wizard a copy of all 
the files in the MyProjectFiles folder will be made into your 
document’s project folder. 
 
You should not name any of your custom files the same file names 
and extensions as any of Proposal Kit’s document file names. 
 
Use the Preferences > Project Settings > Configure MyProjectFiles 
Settings screen to manage adding files, removing files, and setting 
attributes for the custom files in the Wizard database. 
 
You can manually copy files into the MyProjectFiles folder however 
that will not setup any of the attributes such as human readable 
titles for use in the Wizard drop down menus. Use the Wizard’s 
Preferences tool for managing the attributes.  
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 How do I Change/Use Word Font Styles? 

 Added new manual chapter:  

 How do I Add a Line Item Quote? 

 
The Wizard’s built-in line item database system is used 
automatically and nothing extra needs to be setup initially. 
 
See the Line Item Database Manual for all of the details of using 
the Wizard’s line item database for quotes, schedules and 
business plan financials, etc. 
 
All you need to do is click the Line Item Quote button in the project 
screen. If you have selected templates for your project that are line 
item database enabled the Wizard will add those database 
components to your project. 
 
If you select a premade database or import a Sample Proposal that 
has a custom database that will be assigned to your project 
automatically. 
 
Then you can start adding line items to your project which will be 
automatically output into your documents when you save your 
project and build your project documents.  
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 How do I Integrate with QuoteWerks? 

WHAT’S NEW IN V8.11? 

 Added information to supplement some Microsoft Word system 
error messages that occur if a required Windows/Word DLL is 
missing or unregistered. 

 Uninstalled Title Page Packs would generate a missing file 
message. Updated the Wizard to disable Title Page Packs in its 
database that have been uninstalled to prevent error messages 
about missing files. 

WHAT’S NEW IN V8.1? 

 Added support for more category groupings of the Title Page 
Packs. The Wizard now groups the Title Page Packs by single 
color, dual color, triple color and textured color designs. 

 Added color swatches next to the selected alternate Title Page 
Pack title page document. 

 Added additional information to a couple Word generated error 
messages. 

 Updated the Wizard demo to check for updated versions of the 
demo. 

 Updated the Wizard error handling system to detect if a new 
Wizard version is available. 

WHAT’S NEW IN V8? 
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 The Windows bitmap (.BMP) files and folders have all been 
converted and renamed to PNG format files. The Wizard will still 
be backwards compatible with old styles of Proposal Packs that 
still use Windows bitmap (.BMP) graphic files. The Wizard now 
defaults to looking for all Proposal Pack graphics in PNG format. 

 Added the “Company History” template to the Wizard demo. 

 Added the “Company History” as an auto-selected template to 
your first proposal created in Novice training mode.  

 The demo version of the Wizard now uses the newly redesigned 
Title Page backgrounds and graphics. 

 All of the templates that come with the Wizard and Wizard demo 
have been updated to the new Proposal Pack template designs, 
colors and layouts. 

 A number of samples have had additional content added to 
them. The Wizard database has been updated with this new 
content for use with the “View Samples” feature. 

 The Sample Business Proposals in the Wizard demo have all 
been updated with the new Proposal Pack graphic designs. 

 Removed the “Replace Graphics” checkbox from the Document 
Styles screen. This is an obsolete feature not supported 
anymore. 

 The Wizard now loads the new Proposal Pack setup.ini fields for 
use with the new custom bullet point graphics, Title Pages with 
background watermark graphics and body background 
watermark graphics. 
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 Added a new manual chapter How do I Use Custom Graphic 
Bullet Points? 

 Fixed a drop down on the Document Styles settings screen that 
wasn’t being displayed to the correct value in the database. 

 The project status buttons in the Pick Project screen are now 
disabled when there are no projects in the list. 

 The project status buttons in the Pick Project screen are now 
disabled in Novice training mode. 

 The Pick Data screen is now refreshed to update the drop down 
lists of projects when the status of the current project is 
changed or the project is deleted and removed from the list. 

 All data coming from the registry and INI database files is now 
trimmed to remove any leading and trailing white space. 

 If an error condition occurs and the error report screen is 
displayed a clickable link to the troubleshooting web page is 
given. This makes it easier to locate more details and 
resolutions for errors that may occur. 

 Added more information to the diCryptoSys.dll error messages 
caused by user installation mistakes such as installing the 
Wizard from a user login with restricted access permissions. 

 Added the ability to set the page width and height in the 
Options.ini as points instead of inches. This helps get around 
problems using the Wizard when inches are not converted by 
international non-English versions of Windows/Word that may 
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use different characters such as commas instead of periods for 
floating point numbers. 

 Other uses of inches for page layout settings have been 
changed to points by default to avoid potential floating point 
conversion problems in international versions of Windows and 
Word. 

 Added better error messages for errors due to running 
trial/expired/limited versions of Microsoft Word. Microsoft will 
disable some features of Word if used with limited or expired 
installations of Word software, which can translated into error 
messages when the Wizard is run. 

 Fixed a list index error message that occurred if the user 
configured the database incorrectly and disabled all of the 
Wizard’s default proposal types. 

 Added some more verbose error message information to a 
number of Word generated errors for various situations. 

 Added support for the new Title Page designs with custom 
watermark backgrounds. The Wizard will now default to using 
the new Title Pages using the newly redesigned background 
graphics first. The Wizard is also backwards compatible with old 
Proposal Pack designs and will revert to using the old style Title 
Page design for older Proposal Pack versions. 

 Added new manual chapter How do I Use Custom Title Page 
Background Graphics? 

 Updated how users custom logos are inserted into the Title 
Pages (both old and new Title Page designs) so the logo can be 
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repositioned easily in the layout without having to manually 
change the picture layout settings.  

 There are new X and Y coordinate settings in the Document 
Styles settings screen for the user to custom position imported 
logos in the Title Page. 

 Added support for new background body watermark graphics 
embedded into background of body. Can turn on/off or change 
the background watermark. The body background watermark is 
a custom graphic faded into the background of all of the body 
pages of the main document. Custom body background 
watermark graphics are new design elements added to the 
most recent version of Proposal Pack. 

 Added new manual chapter How do I Use Custom Body 
Watermark Graphics? 

 Added support for new custom graphics used as bullet points. 
Can turn on/off or substitute in custom bullet graphics. Custom 
bullet point graphics are new design elements added to the 
most recent version of Proposal Pack. 

 Added a new Title Page tab to the Pick Documents screen that 
allows selecting a custom Title Page from the new line of Title 
Page Pack products and options to apply those settings to all 
new projects. The new Title Page settings also work with the 
Presets and database Export/Import features. 

 Added new manual chapter How do I Use Add-on Title Page 
Packs? 
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 Updated the Project screen to allow resetting of the customers 
logo for a project. Once a custom logo was selected for a 
specific project it previously could not be changed in the data 
entry screen. 

 Added a new tab to the First Run screen to allow faster 
customizing when first using the Wizard to add a custom logo. 

 The Cover Letter and Cover Sheet documents are now 
combined into the master proposal using section breaks to 
isolate them in their own section without page numbers and 
colored borders. Previous versions of the Wizard kept the Cover 
Letters and Cover Sheets in separate documents from the main 
proposal. 

 The main proposal document is now broken into multiple 
“sections” to separate the Cover Letter/Cover Sheet, Title Page 
and rest of the body of the proposal. This ensures that 
header/footer and page number information is properly 
maintained throughout each section of the proposal. For 
example, the Cover Letter/Cover Sheet is maintained as a plain 
text page with no page numbers, graphics or colored borders. 
The Title Page is maintained as a separate section without page 
numbers and uses a new custom background graphic. The body 
of the proposal is maintained as a separate section with page 
numbers, colored borders, footer accent graphics and faded 
body watermark graphics. 

 Added new manual chapter How do I Use Word Document 
Sections? 

 Changed the tab stop settings in the Table of Contents to 
ensure all of the entries line up correctly. 
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 Removed some legacy code that caused existing hyperlinks and 
other linked fields in documents to be removed that may have 
removed some links added by custom edits to the stock 
Proposal Pack documents. 

 Added the location of any installed Title Page Packs to the file 
location report. 

WHAT’S NEW IN V7.3? 

 When adding a new custom template and there are not already 
40 templates in the Top 40 list, the new template will 
automatically have the Top 40 check box turned on in the add 
new template screen. For example, when adding new custom 
templates using the Custom proposal types this makes it easier 
to ensure your new templates will show up in your Fast Access 
lists. 

 Added a more detailed error message when unable to create a 
folder. Typically, due to someone trying to create a subfolder in 
a path when a parent folder in the path also does not exist. 

 Fixed a bug in the Document Project screen that was not 
allowing users to set the project folder path to a custom folder 
using the browse button or manually changing the system 
generated project folder. It would always revert back to the 
system default of using the Wizard project parent folder and the 
project name as the projects subfolder when saving the project. 

 Added more details to the 5 Minute Quick Start chapter on how 
to run the Wizard as a Word Add-In. 
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 Cleaned up an error message when someone used an old 
version Wizard database with the new Wizard software and the 
old database was missing the new project tracking data. 

 Added a tip in the activation code screen on how to cut-and-
paste the activation code from the users email. 

 Added an extra one-time tip message when first entering the 
Pick Documents screen pointing out how to quickly select 
templates using the View Samples tab. 

 Added 20 more Proposal Pack skins to the Demo version of the 
Wizard. 

WHAT’S NEW IN V7.2? 

 Added the ability for administrators to disable more Wizard 
screens for use when creating customized versions for end 
users. The “Document Styles”, “Preferences” and “Check for 
Updates” buttons can now be individually disabled; preventing 
end users from entering any of the configuration screens. 

 Added a new chapter to the manual to describe the new 
configuration features that allow administrators to disable 
specific Wizard features: How do I Disable Access to Features 
as an Admin? 

 When in Novice training mode the Edit Tag Labels & Defaults 
button in the Contract and Custom Merge data screen is now 
disabled. This makes the behavior consistent with all other 
screens disabling advanced features in the Novice training 
mode. 
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 Added a Quit Wizard button to the error handler screen. This 
comes in handy if a system error such as not having admin 
permissions to edit a database cause a cascade of error 
windows you can quickly exit the Wizard. 

 Completed integration of the new error handling and reporting 
system into every function of every screen of the Wizard to 
assist in tracking and resolving system errors generated by 
Word or Windows that affect the operation of the Wizard. 

WHAT’S NEW IN V7.1? 

 Added more verbose instructions to the -2147467259 
PrivateProfileString error message which occurs when a user 
does not have access permissions to write to an INI database 
file or the Wizard registry keys. The old message was the 
standard cryptic Word system error. Instructions have been 
added to this error condition that are more meaningful and 
direct the user to the file that does not have access permissions. 

 Fixed a minor bug when customizing templates. When using the 
Preferences > Tools > Configure Proposal Files screen to edit an 
existing document and change its title an error message was 
occurring. 

 Optimized the process when making custom edits to existing 
templates using the Preferences > Tools > Configure Proposal 
Files screen. The processing time to check all of the cross 
references between the various database files has been 
significantly decreased. 
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 Added extra error messages to help diagnose possible file 
permission problems when editing custom templates that may 
be accidentally protected from editing. 

 Added the Windows system version and the Word version to the 
error reporting system to aid remote diagnosis of reported 
errors. 

 Added the new error handling system to more parts of the 
Wizard code. 

 Added a feedback screen to the demo version of the Wizard. 

 Fixed a minor glitch that cropped up when a user customizes 
one of the 12 project types and removes ALL of the templates 
from the list. The Wizard would display empty rows in some 
cases in edit screens until at least one file entry was added back 
to the list of templates for that project type. 

 Fixed a bug in the new Configure Templates screen that could 
cause the templates to be deleted when bouncing back and 
forth between the screen multiple times. 

 Fixed a bug in the new Configure Templates screen that would 
cause custom retitled templates that did not match stock 
Proposal Pack template names to not be written back to the list 
of files during the Save operation. 

 Also added a backup feature that backups the current 
FileList#.ini file before the Configure Templates screen Save 
operation rebuilds the file. 

WHAT’S NEW IN V7? 
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 Proposal Pack Wizard had been updated to work with over 200 
new Proposal Pack Templates and over 20 new Contract Pack 
contracts. 

 Since the Wizard now supports a collection of over 800 
templates, 120 samples and 270 contracts it can be sluggish on 
older and slower computers. While we have optimized the 
Wizard quite a bit this version you can setup a customized set of 
templates that will both be faster for you to work with and will 
make the Wizard run faster as well. Added a new manual 
chapter on how to improve the Wizard performance: How do I 
Improve the Performance of the Wizard? 

 The Wizard now uses an Activation Code you received with 
your order. 

 Updated Wizard to allow user to setup Word auto-generated 
Table of Contents. Added a new chapter to the manual on how 
to set up an auto generating Table of Contents How do I Add a 
Word Auto-Generate Table of Contents? 

 Rewrote the manual chapter on using the Pick Documents 
screen for adding and removing templates from projects: How 
do I Add a New Document Project? 

 In the Pick Documents screen the Auto Recommend tab is now 
hidden once you switch from Novice training mode to Expert 
mode. This tab is primarily only used as a training tool for 
beginners. 

 Progress bars have been added to a variety of operations such 
as creating project documents, database tests and data 
import/export functions. 
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 Documents opened by the Wizard for processing during the 
document creation process are opened minimized so the new 
progress bars will be visible. 

 The document creation process is now better protected against 
the user changing the active document during processing which 
could cause errors or Wizard crashes. 

 Import data from past versions of the Wizard with the new 
export/import tool. The new data export/import tool is a multi-
step process that assists migrating to the new version of the 
Wizard if you have customized your old Wizard databases. The 
tool runs a prescan of your old databases and generates a 
report of potential customizations it found and how to migrate 
them to the new products. A detailed import report is also 
generated outlining any issues it found with the imported data. 
Added a new chapter to the manual to assist with migrating: 
How do I Migrate from a Previous Version? 

 The export tool allows exporting your projects to an XML file for 
external use. Your project data can be manipulated and 
integrated into 3rd party systems. Added new manual chapter: 
Error! Reference source not found. 

 The import tool allows importing of project data from an XML 
file. This provides another tool for integrating with 3rd party 
systems. 

 Research Proposals have been added as a new type of 
proposal with a customized selection of templates. Select the 
Research Proposal type when creating a new project. 



169 

 The auto-recommendations have been revised for Micro, Small, 
Medium and Large sized proposals. Micro proposals will now 
show an average of 3 templates, Small proposals will show 
about 6 templates, Medium proposals will show about 10 
templates and Large proposals will show about 15 templates on 
average (depending on the type of proposal being created). The 
“Everything” option has been disabled by default to prevent 
accidentally selecting too many templates. If you have made 
use of the “Everything” option in the past, it can be enabled in 
the Preferences when in Expert mode. The Everything option is 
only meant for customized proposal types. The auto-
recommend tab also now requires that all 3 of the drop down 
boxes be selected before clicking the Recommend button. 

 The maximum number of documents the Wizard can manage 
has been increased to accommodate the hundreds of new 
templates in the new Proposal Packs. 

 The “Limited” collection of templates that ships with the 
Proposal Pack Wizard has added 7 new templates increasing 
the total number of templates to over 60: Rates, Payment 
Options, Vendors, Confidentiality, Instructions, Diagrams, 
Appendices 

 A number of existing templates that ship with the Proposal Pack 
Wizard have been updated with more content. 

 The Novice mode that the Proposal Pack Wizard starts in has 
been much more streamlined to make the creation of your first 
proposal easier. The Pick Documents screen will now auto-
configure itself to show you only the most relevant information 
first, and still gives you all the past features (including new ones) 
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to find what you are looking for in the entire collection of 
templates.  

 The Pick Documents screen has been redesigned to configure 
itself differently based on what product(s) are installed to help 
show only the most relevant information. For example, some 
tabs may be hidden when they are not relevant to the situation. 
You may notice the various tabs and templates change in the 
Pick Documents screen if you have multiple products installed 
and you switch between them (such as using Proposal Packs vs. 
Contract Packs, or Proposal Kit Professional, etc. 

 When the Proposal Pack Wizard is used with a full Proposal 
Pack for Any Business template collection, the default limited 
collection will be disabled to help prevent new users from 
accidentally selecting the wrong template collection. 

 All Help buttons have been changed to have red backgrounds 
to help make them stand out on the interface screens. 

 The “Top 40” templates feature has been completely revised. 
The last version of the Wizard included a basic “Top 40” feature 
that rebuilt the drop down lists of templates with the top 40 
most commonly used templates. The same Top 40 list was also 
used for all proposal types. The new “Top 40” system now uses 
a different list of top 40 templates for each of the 12 proposal 
types (i.e. general business proposals, grant proposals, business 
plan proposals, grants, government contracts, resume 
proposals, contracts, quotes, research proposals, booking 
publishing proposals and the 2 custom types). Also, the Top 40 
list can be overridden for a specific Proposal Pack style (at this 
time only Limited styles have custom Top 40 lists). Also, the 
entire list of Top 40 templates is now shown at once on the 
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screen using checkboxes (instead of listing them in drop down 
lists). This makes it much more efficient to check off a set of 
templates to add to your proposal, and it will be tailored more 
specifically based on the type of proposal being created. You 
can also quickly flip between the “Top 40” tab and the tab that 
gives you access to all 800+ templates. In addition, in Novice 
mode, beginners will see the Top 40 list first vs. in Expert mode 
when they see the tab with all 800+ templates first. 

 The Pick Documents tab which gives access to all 800+ 
templates via drop down lists has been streamlined to only use 
one set of Add/Description buttons for the entire tab, instead of 
one set of buttons for each drop down list. This makes the 
screen more intuitive and easier to use. The Pick Documents 
tab has also been revised to move the Remove Template(s) 
button to its own tab to contain all template removal to one 
button and one screen. 

 More help information is displayed regarding the Delete Old 
Files button in the Project screen and how to safely add and 
remove templates and change mail merge data when you have 
already created a proposal. The Delete Old Files button will be 
disabled when there are no files created. If you try to make 
changes to an proposal that has already been created 
additional help information will be displayed on the Project 
screen. 

 Added examples in the help screens for the company and client 
mail merge data screens about what types of information should 
be entered in those fields. 

 The Presets feature has been moved to its own tab in the Pick 
Documents screen and is not part of the Auto Recommend tab 
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anymore. The maximum number of presets has been increased 
from 5 to 40. The Presets feature also has been enhanced to 
add an auto-populate feature. You can now designate one of 
your presets to be used to auto-populate the templates for each 
new project saving you time each time you create a new 
project. NOTE: Each of the 12 proposal types that can be 
selected for your project (general business proposal, grants, 
contracts, resumes, business plans, etc.) has its own set of up to 
40 presets (effectively giving you up to 480 presets total). Use 
the Auto-populate in conjunction with customized proposal 
types to more efficiently create each new proposal. 

 The Presets feature has also been enhanced to allow saving of 
a custom contract and all of the contract configuration settings 
(such as if the contract is created separately or is included in the 
proposal). 

 The Presets feature has also been enhanced to save the custom 
ordering of the templates if you have changed the default order 
the templates are assembled in the final combined project 
document. 

 Selecting templates from alphabetically sorted lists has been 
added as another way to select templates in the Pick 
Documents screen. 

 In Novice mode the first time a new project is created the 
Wizard will pre-select the Cover Letter, Title Page and Cost 
Summary templates to help new users get started learning what 
templates to select. 

 The Wizard includes many more popup messages that help 
guide what you need to do. In many cases when you perform an 
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operation without performing required steps before hand, the 
Wizard will give you additional instructions on what to do first. 

 Added new Preferences options to allow administrators to 
configure the tabs shown in the Pick Document screen. Admins 
who are configuring the Wizard for other users can configure 
individual tabs to have them always displayed or never 
displayed. This allows more customized installations that only 
give end users access to the options you want. Added new 
chapter in the manual for this feature: How do I Turn On/Off the 
Various Pick Documents Tabs? 

 Added new Preferences options to configure what templates 
are displayed in the Top 40 template screen. Each of the 12 
major proposal types has its own unique list of Top 40 
templates (i.e. for general business proposals, business plans, 
grants, resumes, etc.). You can change the default Top 40 lists 
we supply to your own Top 40 list. This is a handy tool for 
administrators to configure the Wizard for their end users that is 
more specific to their needs. Added a new manual chapter on 
how to customize the Top 40 lists: How do I Setup my Own 
Top 40 List of Templates? 

 Added meta data fields to the Wizard. The Wizard will now set 
the Author, Comment, Company, Keywords, Subject and Title 
meta data tags in each new document you create. You can 
override the default meta data fields in the Wizard’s 
Preferences. Added a manual chapter on setting up the 
property meta data: How do I Change My Final Document’s 
Properties? 

 The Wizard now requires new users to create one proposal 
document in the Novice mode before the Expert mode can be 
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turned on. This helps ensure new users do not get lost in 
configuration screens and sections of the Wizard that are not 
necessary for creating a proposal. New users will be guided 
through an easier setup process for creating their first proposal 
so they will understand the basic elements of the system (i.e. 
adding a new project, selecting templates, entering mail merge 
data, creating the proposal document and editing it). The Novice 
mode has been simplified even more in this new release to 
restrict access to areas of the Wizard that are not required for 
learning the basics of the system. 

 While the Wizard was revised in the past to protect users from 
overwriting their work too many users are not paying attention 
to the instructions on how to safely add or remove templates or 
change the mail merge data in a project that has already had its 
documents created. This version of the Wizard includes more 
checks to detect when someone is attempting to incorrectly 
alter an existing project and will direct them as to how to do it 
safely. 

 Another new feature added to both help prevent unintended 
overwriting of edited documents and to give additional 
instructions on how to safely change projects is the Locked for 
Editing feature. Once you have created the documents for a 
project and have opened at least one of them for editing, you 
will not be able to go back and save changes to the project (i.e. 
adding/removing templates or changing mail merge data). If you 
have not made custom edits that could be overwritten, you can 
unlock the project, delete the old files and safely recreate the 
project with your changes. 
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 When deleting a document project from the Wizard, the Wizard 
will also prompt to delete any existing files for the project and 
will delete them as well. 

 The Edit Project screens have been streamlined to allow 
multiple spreadsheets and templates to be opened from a 
single list box of project files. The Team Editing feature is 
disabled by default, when Team Editing mode is enabled in the 
Preferences, a new tab will show in the Edit Project screen. A 
new safety feature has also been added to the Team Edit 
screen where the combined project document will be locked for 
editing if it has been opened and will prevent it from being 
overwritten if you try to recombine the documents while it is 
locked for editing. 

 Fixed a problem that could generate Run Time Errors 5152 and 
5187 which relate to customized lists of files that included 
duplicate file names and titles of document names that included 
invalid characters such as slashes in the file name. 

 Demo versions of all of the Contract Pack Professional/Proposal 
Kit Professional contract documents are included in the Wizard. 
Demo contracts are truncated down to part of the first page for 
illustration purposes so you can see what types of contract 
material are included in the Contract Pack products and you can 
test the functionality of the Contract Pack products without 
having to purchase them first. 

 Add a new Preferences screen for customizing the Top 40 
template lists more efficiently. This new configuration screen 
allows you to manage all of the Top 40 listings for all proposal 
types on one easy screen instead of having to manually update 
each proposal template one at a time. 



176 

 The Wizard now includes a feature that allows you to easily 
change the default order of the templates for each new project. 
The new ordering will be used when the Table of Contents is 
built and the templates are assembled together in the specified 
order. All screens that display the selected templates will show 
them in the custom ordering (i.e. the remove templates screen, 
the view selections screen, the presets features and the final 
project edit screens). There is also a Preferences setting that 
administrators can use to disable the custom ordering feature to 
help control how much ability end users in a larger environment 
have to edit predefined proposals. Note that the ability to 
change the order of the templates is only available in Expert 
mode. 

 Added 7 new styles to the demo version of the Wizard. The 
demo of the Wizard now includes 20 of the over 200 Proposal 
Pack skins. The Contract and Terms template has also been 
added to the demo version to allow users to see how the 
Wizard integrates the proposals and contracts. 

 The Document Styles screen now displays a graphic of the 
currently selected Proposal Pack skin to help users see which 
skin is the currently selected one. Added the ability to edit the 
original stock Contract Pack contract templates directly from the 
Add a Contract tab of the Pick Documents screen. This feature 
will also open all of the related exhibits/schedules that will be 
attached to the contract when it is assembled. 

 Disabled the close buttons in the upper left corner of all Wizard 
screens to ensure users use the appropriate close buttons on 
each screen and to avoid unintended problems with windows 
being closed while work is in progress. 
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 Added a simplified version of the Document Styles window for 
use in Novice mode. The operations of the Document Styles 
window have also been enhanced with more messages to help 
assist the user in how the styles or skins are managed. 

 The Wizard will now automatically disable the use of the limited 
Proposal Pack template collection that ships with the Wizard 
when a full retail Proposal Pack for Any Business template 
collection is installed. The Wizard will also automatically default 
to using the most appropriate Proposal Pack when multiple 
packs are installed. 

 Added the actual counts of all proposal and contract templates 
to the various tabs of the Pick Documents screen. 

 The Document Styles screen now dynamically determines what 
products are installed and displays the appropriate discount for 
add-on Proposal Packs along with a link to the web site form to 
order discounted Proposal Packs. 

 The Wizard home screen now includes visual cues as to the 
state of your current project. Next to each of the major buttons 
for managing your projects there will be a graphic that lets you 
know what operations are ready to proceed with, are completed 
or are not ready to continue with. 

 When reformatting the combined document’s text, the Wizard 
will not reformat large font (20 to 28 point Arial Black) text or 
text in the dark red or red font color. This will retain formatting of 
custom sections of Contract Pack documents. 
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 The Wizard can now automatically convert URL's and email 
addresses to clickable links when it creates your documents. 
This feature can also be disabled in the project preferences. 

 The document creation process now ensures that change 
tracking is turned off. This will prevent some reformatting 
messages in contract exhibits when the combining of templates 
causes some lists to be reformatted in the contract exhibits. 

 The document auto-reformatting process is not performed when 
only one template is selected for the project. This is meant to 
prevent unwanted font reformatting when a custom proposal 
already pre-assembled is being used as the project template. 

 The document formatting process is done twice, once during 
the Table of Contents creation and once after. This helps ensure 
the page numbers are all correct in the initial Table of Contents. 

 The Wizard works better with multiple different versions of 
Proposal Pack and Contract Pack template products installed. 
The Wizard will default to enabling the most current products it 
finds as the default starting products. 

 A version number field was added to the Third Party fields to 
help the Wizard determine which Contract Pack products are 
the most current and which one should be enabled if it detects 
multiple versions of products installed. 

 When a Proposal Pack style is deleted from the Wizard, it is also 
archived so the Proposal Pack will not be reloaded into the 
Wizard again. The files still exist so no custom work will be 
removed if you have edited the product files. 
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 Added a proposal and contract status tracking system to the 
Wizard. Now projects can be tracked through the entire process 
of being developed, submitted, approved and completed. The 
Wizard includes 8 stages that the project can be moved through 
and can be configured with up to 20 custom stages. All of your 
projects can also be exported to a single project tracking 
spreadsheet. 

 Added a new error reporting system that allows error reports to 
be automatically submitted to customer support via a web form. 

 Added a new preferences configuration screen to efficiently 
define custom lists and default orderings of templates for all 
new projects. 

WHAT’S NEW IN V6? 

 The Wizard has a new feature to show alternate and related 
templates when searching for templates to add to your 
proposal. When using the Project screen to select templates 
there are 2 new checkboxes in the Search tab. This can give 
you ideas for different templates to use or additional templates 
you hadn’t considered. For example, if you check the Alternate 
and Related boxes and search for “Executive Summary” you will 
also see the “Client Summary”, “Abstract”, “Introduction” and 
“Forward” templates. 

 The Wizard now integrates the Proposal Pack samples allowing 
you to more efficiently find, view and even select templates 
automatically based on specific samples. In past versions of the 
Wizard you had to access the samples from the separate 
desktop organizers for the Proposal Pack template collections. 
Now you can access them directly from within the Proposal 
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Pack Wizard interface. You can even add all of the templates 
used to create a specific sample to your project with the single 
click of a button. 

 Added a new manual chapter Stay Out of Trouble Copying 
Proposal Examples 

 Added a new manual chapter Boilerplate is Bad for Business – 
Templates without the Fluff 

 Added a new manual chapter Select Your Chapters with 
ChatGPT 

  

 The Wizard has a tab in the Pick Documents screen that works 
with ChatGPT to get your project’s chapters selected 
automatically. 

 
While we have hundreds of human curated lists of proposal 
layouts in the Quick Start and View Samples tab you can use 
ChatGPT or another AI to generate a list of chapters for special 
use cases to speed up your chapter selection. 
 
This screen is designed to be used with our custom GPT ‘Business 
Proposal Outline Creator for Proposal Kit’. You will need a 
subscription to OpenAI to use this GPT. 
 
We do not directly link to any specific AI using an API which also 
means we don’t charge credits or have any extra fees for using 
this AI assistance feature. 
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While we designed this feature to work with our custom GPT which 
is trained to use our list of thousands of chapter templates you 
may be able to use it with other AI models however results will 
vary. Even the custom OpenAI GPT has a mind of its own and will 
give chapter names that are not exact matches to our templates or 
will give its output in varying ways. 
 
The Wizard will process the AI response to pull out the chapter 
templates (based on all the ways we have seen it generate output 
so far) and will attempt to map as best possible mismatches to our 
templates. 
 
If multiple pages may be applicable, you will have the option of 
selecting which template to use and updating the mappings to 
always use your selection in the future. 
 
If you paste in output from another AI, it may be in formatting we 
haven’t accounted for or may generate more mismatches that 
have to be manually mapped. 
 
To reduce problems with formatting the best way to input a list of 
chapters is in a comma separated list with each word capitalized. 
 
You can generate a report when the list has been imported and 
email it to us if you would like help mapping templates and to help 
use update our mappings or account for new formatting we 
haven’t seen yet. 
 
A handful of chapters that are almost always selected for 
proposals will be automatically added in case the AI doesn’t 
suggest them such as a Cover Letter, Executive Summary, Cost 
Summary and the front Title Page and the ending Back Page. 
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Once the chapters are processed, they will all be automatically 
selected and you can further customize the list using the other 
tabs. 
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 It’s All About Trust – Winning Proposals by First Winning Trust 

 The Wizard now integrates the Proposal Pack calculator 
spreadsheets into your projects. Proposal Pack has always 
included a number of spreadsheets to help assist in your 
financial calculations. The Wizard now integrates those 
spreadsheets into your document projects. Each time you 
create a new document project that uses templates that also 
have associated spreadsheets (i.e. a Budget, Cost Summary, 
Return on Investment, Quote, etc.) the related spreadsheets will 
be copied to your project folder. The “Edit Proposal” screen 
now allows you to open these spreadsheets along with your 
proposal and the “Edit Styles” screen is updated to allow you to 
edit the base spreadsheets so your customized spreadsheets 
will be copied over for each new project. You can also disable 
the copying of spreadsheets in the Wizard Preferences. 

 Added a new manual chapter How do I Add Calculations from 
Spreadsheets Manually? 

 Proposal Pack Wizard now supports more than one Contract 
Pack template collection and a new tab in the Pick Documents 
screen allows easier selection of contracts and switching 
between different Contract Packs. 

 The Wizard’s error, warning and message system has been 
updated to consistently display messages in the same format 
and to code every popup message with a unique number to 
assist customer support. Also all popup messages are now 
forced to display in the foreground to ensure they will not be 
hidden behind other windows. 
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 Added a Repair Registry tool to the Wizard’s Preferences tools. 
This tool can restore a lost Windows registry set of keys, 
typically caused when someone tries to move their Proposal Kit 
software from one computer to another. This feature can ease 
migrations by not requiring a reinstall of the original Wizard 
software. 

 The Wizard document now closes when the Wizard interface is 
quit. 

 When a project is deleted all of the contact information fields in 
the Wizard database are now deleted as well to provide better 
data security. 

 The Search For Styles tool has been changed to not allow 
searching the entire drive. You must select a specific folder on a 
drive to search. 

 Drop down lists in the Wizard interface screens have been 
updated to not allow the user to type into the drop down fields. 

 Removed the demo Proposal Pack styles from the retail version 
of the Proposal Pack Wizard’s Pick Styles menu. Demos are still 
included, just not added to the Wizard menu. 

 Button colors changed to purple to stand out when on a grey 
tabbed page background. 

 Added a dark green background to all tabbed screens to help 
the tabs stand out better and be more obvious. 

 Added more messages to the 5 Minute Quick Start and the 
Wizard popups to keep beginners from terminating the Wizard 
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while it is still processing the documents. Assuming they even 
read the comments and instructions. 

 The Preferences screen cannot be exited now if there are data 
errors in any of the Preferences fields. User must fix the errors 
or cancel the screen. 

 Changed the install folders names from “V50” to “V60” 

 Changed the registry key name from “V5” to “V6” 

 Changed the Wizard file name from “V5” to “V6” 

WHAT’S NEW IN V5.1? 

 Updated the Wizard to work with the new Office 2010 in 64-bit 
mode. Some code changes were required to prevent a “compile 
error” message when running the Wizard on this platform. 

 The Wizard is now saved in the .docm file extension (Macro 
Enabled Word Document) for Office 2007 and Office 2010 
users. 

 The Wizard installer will determine if your system supports the 
.docm file extension (i.e. Office 2007-2010) and will link the 
Wizard shortcuts to the .docm file. Legacy versions will have the 
.docx file linked to the desktop shortcuts. 

 Updated the Wizard document with Office 2010 installation 
instructions. 

 Fixed an obscure problem that only affected a few international 
foreign language users. In a few cases where the Windows 
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system used a comma instead of a period for the decimal place 
the Windows system was incorrectly recalculating the page size 
which caused the Wizard to display an error message ‘5149’. In 
this case the Wizard now defaults to the users current page size 
setting and does not try to reset the page size. 

 Fixed a problem introduced in the 5.0 release where templates 
that are selected to be removed from a pre-existing project 
were still showing up in the selected template list. 

 The Proposal Pack Wizard has stopped being supported on 
Word/Office 2000 due to a feature of the Visual Basic for 
Applications (VBA) used throughout the Wizard that is not 
available in versions of Word prior to the 2003/XP version. 

 Fixed a problem in multi-user versions of the Wizard where the 
preferences setting was not editable when trying to change the 
current user id. 

 Reorganized a few interface screens for users with 800x600 
resolution monitors to better fit all of the buttons. 

WHAT’S NEW IN V5? 

 Added support for the over 200 new proposal templates 
included in the latest release of Proposal Packs. 

 Added support for all of the Contract Pack templates included in 
the latest release of Contract Packs. 

 Added a new search feature to the Wizard. The search feature 
allows you to search for a specific template or collection of 
templates quickly and efficiently instead of having to scroll 
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through long lists of templates. This feature makes adding 
templates out of the hundreds of available templates much 
easier. The search screen will also allow searching for Contract 
Pack templates if they are installed. 

 Reorganized the Pick Documents screen by breaking up the 
various ways of selecting templates into three different tabbed 
screens. It is now much easier to locate templates and add them 
to your projects. 

 Tested on Windows 7 and installer program upgraded to be 
Windows 7 compliant. 

 Added a new chapter to assist with network installations How 
do I Install and Configure for Use on a Network? 

 Changed the install folders names from “V42” to “V50” 

 Changed the registry key name from “V4” to “V5” 

 Changed the Wizard file name from “V4” to “V5” 

 Changed one of the Custom proposal types to be used for 
Business Documents. 

 Changed one of the Custom proposal types to be used for 
Government Contracts. 

 Renamed the “Save Selections” button to be “Create Preset” in 
the Pick Documents screen. 

 10 new templates have been added to the Proposal Pack 
“Limited” which is included with Proposal Pack Wizard. 
Templates added are: Getting Started, Solutions, Prototyping, 
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Networking, Launching, Choices, Affiliates, Price Comparison, 
Prospect Thank You Letter, Customer Thank You Letter. 

 Increased size of internal variables in the Wizard to 
accommodate the new material added in the new Proposal 
Packs. 

 Changed the “Miscellaneous” documents section header to 
“Letters and Checklists” in many of the 12 proposal types. 

 Added the ability to have custom cover letters, cover sheets, 
inquiry letters, title pages, table of contents, envelope and 
letterhead templates for each of the 12 proposal types. This 
feature provides an override for the default special files used 
across all 12 proposal types. The Business Plan and Government 
Contract proposal types make use of this feature to use custom 
cover letter and cover sheet templates for these proposal types. 

 Fixed a minor problem with the “#” sign when used in the title of 
the document. String comparisons were using the # sign as a 
pattern match incorrectly. This only affected people who may 
have added a custom template with a title that included a “#” 
symbol. 

 Fixed a minor problem with custom master proposals causing 
the Wizard to close itself when the proposal was created. This 
only affected people who may have setup a custom master 
proposal document and added it as a selectable template in the 
Wizard. 

 Fixed a minor problem with custom master proposals when a 
normal template title in plain text was used in the first page of 
the master proposal document. In some cases the page header 
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of the master proposal when a title page was not the first 
template could have its title changed to the title of the entire 
proposal. For example, if the “Executive Summary” template 
was used as the first page of a custom master proposal titled 
“My Master Proposal”, the “Executive Summary” header text 
would be changed to “My Master Proposal”. This only affected 
people who may have setup custom master proposals using the 
Proposal Pack for Any Business or Proposal Pack for 
Government Grants.  

 Added more checks to make sure files exists before they are 
copied during the initial installation. 

 Added more error checking for the existence of the Wizard 
database files before they are accessed to provide more 
detailed error messages in cases where users alter the Wizard 
installation to the point the paths to the database cannot be 
found (i.e. when users copy the Wizard to another computer 
without moving the registry, or trying to run the Wizard from a 
remote computer, etc.). 

 Added more error checking for the existence of the Wizard 
registry keys before they are accessed to provide more detailed 
error messages in cases where users alter the Wizard 
installation to the point the paths to the registry cannot be found 
(i.e. when users copy the Wizard to another computer without 
moving the registry, or trying to run the Wizard from a remote 
computer, etc.). 

 Added REPORT_OFF sections to the recommend database files 
to help control what templates are recommended for different 
types of proposals. Also added these options to the Preferences 
> Tools > Configure Proposal Files screen. This allows you to set 
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specific templates to not be auto selected when creating 
business documents like reports. 

 Added “Report” as an option for the type of document being 
created. 

 Fixed a minor problem when the default title page graphic to be 
applied to new projects was off by one in the index of available 
graphics. 

 Optimized the adding of new projects so they save to the 
database a little faster. 

 Fixed a problem with selecting a custom Preset when in Novice 
Mode that caused the Wizard to select all available templates. 

WHAT’S NEW IN V4.5? 

 Replaced the Thawte digital security certificate with a 3 year 
VeriSign security certificate.  

 The new Proposal Packs V10.1 and Proposal Kits V13.1 now store 
the paths they were installed in when the default install location 
is changed. The Wizard can now search all of the non-standard 
install locations and find all of the installed Proposal Kit, 
Contract Pack and Proposal Pack products when they are not 
installed in the default folder. 

 The Wizard now automatically searches for installed Proposal 
Packs, Proposal Kits and Contract Packs every time it is run so 
you do not have to manually search and install new products 
after the Wizard has been configured the first time.  
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 Added a new public macro function RunWizard_SafeMode 
which bypasses the automatic search for styles in case there 
are any problems accessing folders.  

 Added a new Preferences checkbox to turn off the auto-
searching of Proposal Pack styles. This checkbox basically 
returns the Wizard to the same method of operation in the 
previous version where it would only search for installed 
products once. Turning this feature off can speed up the 
process of running the Wizard. 

 Added error handling to prevent error messages stopping the 
Wizard when Proposal Packs installed on network drives are 
unavailable due to broken network connections. 

 Added a new chapter to the manual for helping select 
documents How to Select Templates: The Top 5 / Top 40 Rule 

WHAT’S NEW IN V4.4? 

 Replaced the Thawte digital security certificate with a 3 year 
VeriSign security certificate.  

 Added some troubleshooting instructions for some installations 
of Word 2007 that are unable to enable macros when the 
Wizard is first run. This only occurs on some users computers 
and only when launching the Wizard from a shortcut link the first 
time. The resolution is to run the Wizard directly from the install 
folder the first time if you have problems enabling the macros. 

 Fixed a problem with changing the paper width and height from 
the default 8.5 x 11 to international sizes. The Wizard was always 
defaulting to 8.5 x 11 even when selecting alternate page sizes. 
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Also added a default option to disable the resetting of the page 
height and width when the Wizard is assembling a proposal. 

WHAT’S NEW IN V4.3? 

 Updated the graphics with our new logo. This is a cosmetic 
change and not a functional change to the Wizard. 

 Slashes and colons are not allowed in the Project Name 
anymore. Since the Project Name is used in the file name for the 
Project folder this can cause problems with the Wizard not 
finding the path to the files. 

 Leading and trailing blank spaces are now removed from the 
Project Name. This could cause path not found errors since the 
Project Name is used in the folder name of the project. 

WHAT’S NEW IN V4.21? 

 Updated the Wizard to recognize the new IT/Software/Hardware 
Contract Pack product. 

 Updated the Wizard to recognize the new 
Advertising/Marketing Contract Pack product. 

 Updated the installation programs to not allow the Wizard to be 
installed into the root of a hard drive. 

WHAT’S NEW IN V4.2? 

 Added support for the 122 new proposal templates included in 
the latest release of Proposal Packs. 
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 Added support for the 30 new contract templates included in 
the latest release of the Contract Packs. 

 Improvements to this manual, including hyperlinking chapter 
references and table of contents to the content. 

 Add 6 new demo styles. 

 Added a “project” type to the drop down lists of proposal types 
being written in the Pick Documents screen (i.e. in addition to 
product and service types). 

 Added a Top 40 button in the Pick Documents screen to only 
show the most commonly used 40 templates. This helps 
beginners find templates more easily than being shown over 
400 templates to pick from. 

 Added a new mail merge tag: <<EffectiveDate>> for contract 
use. 

 Increased the maximum number of proposal templates the 
Wizard can operate on from 300 to 500. 

 Increased the maximum number of proposal templates in a 
section of the proposal from 100 to 150. 

 Renamed all references to the old product name Proposal Pack 
PlainText to Proposal Pack for Any Business. 

 Updated the Wizard digital certificate valid until 2010. 

 Updated the Wizard to recognize the new Contractors Contract 
Pack product. 
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 Added PROJECT_OFF, OTHER_OFF and 
PRODUCTSERVICE_OFF sections to the recommend database 
files to help control what templates are recommended for 
different types of proposals. Also added these options to the 
Preferences > Tools > Configure Proposal Files screen. 

 Added new manual chapter How do I Combine the Cover 
Letter Into a Master Proposal? 

 Added new manual chapter How do I Manage this Much 
Information? 

 Made many messages in the Preferences > Tools > Configure 
Proposal Files screens more meaningful when editing and 
removing documents. 

 Added underline graphics and mouse pointer changes to 
clickable web site links in the Wizard interface screens. 

 Fixed a bug where the current project settings were not being 
reset after exiting the Preferences screen in some cases. 

 Added more tests to the Test Database function. 

 
WHAT’S NEW IN V4.1? 

 Added a new mail merge dynamic data type 
“CURRENTDAYNUMSTR” to support Contract Pack contract 
templates. The <<CurrentDay>> mail merge tag string has been 
changed to use this data type by default. This data type will 
create the <<CurrentDay>> mail merge tag as the string “1st”, 
“2nd”, “3rd”, etc. This is used in contract strings such as “this 
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<<CurrentDay>> day of” which if it was on the 22nd of the 
month would become “this 22nd day of”. 

 The buttons on the Document Styles page for purchasing new 
Proposal Packs will take you to the specials page for a discount 
on new Proposal Packs. 

 An obsolete warning message about out of date Proposal Pack 
styles was changed.  

 The Contract and Terms page header was being removed when 
contracts were integrated into a proposal in some cases. This 
behavior is now consistent with the Document Project settings 
being used. 

 A potential problem with the Table of Contents page numbering 
was fixed. 

 A potential problem with the page footer not being included 
when the final FullProposal.docx file is created was fixed. 

 The Wizard runs automatically now when the desktop shortcut 
is run. 

WHAT’S NEW IN V4? 

 Colon and equal signs are not allowed in the template titles and 
file names. Extra error checking has been added to prevent this 
when adding new templates. 

 The “Compress Templates” tool is now obsolete and has been 
removed from the preferences. 
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 The “Test Database” tool was reporting errors that were not real 
errors in the database files. These erroneous error messages 
have been removed. 

 Fixed some cases of template names having mixed cases 
between database files (i.e. “Long Form” vs. “long form”) which 
are now all consistently named. 

 The “Reset to Default” button in the “Edit Style” screen now 
resets the path to the graphics files. 

 The Pick Documents screen display is cleaned up when the 
database has blank section headers. 

 The database folder used by this version of the Wizard has 
been changed to “Database_V4”.  

 The project folder used by this version of the Wizard has been 
changed to “ProposalProjects_V4” 

 A new feature has been added for integrating 3rd party 
documents such as contracts, quotes, invoices, etc. into your 
proposal. Now you can automate integration with your other 
business document creation software better. See the “3rd Party” 
tab in the “Preferences” screen. 

 Better integration with our Contract Pack contract documents 
has been added. Now you can use the Wizard to manage your 
contract documents separately or include them in your 
proposal. This feature also automatically inserts all of the 
referenced Exhibit/Schedule templates at the same time. The 
specific Contract Pack you have installed will be detected by the 
Wizard and can be selected as one of your proposal types when 
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you create a new project. This feature can be configured using 
the Preferences tool “Configure Contract Files”. 

 The Wizard allows you to enter alternate text to be used in 
place of the <<Domain>> tag in your proposal footer, such as 
your company name, etc. 

 When using the Proposal Pack for Any Business or Proposal 
Pack for Government Grants themes (i.e. the themes that use 
plain text headers in each template instead of an embedded 
graphic design), the Wizard will now change the header of each 
template during assembly of the proposal if you have retitled 
the page header in the database. This is useful for large 
government grants where a single template is used multiple 
times in the proposal with different chapter headers such as the 
“Worksheet” template. For example if you create a proposal 
using the Worksheet template and you add it multiple times 
titled “Form SF-424”, “Fixed Sites” and “Non-Fixed Sites” both 
the Table of Contents and the page headers for each of those 3 
pages will be changed to match your new page header text. 

 The Wizard can now replace the “Project” placeholder in the 
Title Page template with your own custom logo graphic in the 
Proposal Pack for Any Business and Proposal Pack for 
Government Grants styles which do not come with an 
embedded graphic design. 

 The Wizard can now detect and display an error if your 
Windows Registry settings for the Wizard do not exist. This 
typically happens when moving the Wizard incorrectly from one 
computer to another, or logging in as a new user other than the 
one the Wizard was originally installed for. 
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 A File Location Report tool has been added to the Wizard 
Preferences. This tool will create a report showing you all of the 
locations on your hard drive the various files used by Proposal 
Pack and the Wizard are located including your projects, 
installed Proposal Pack templates, installed Contract Pack 
templates, Wizard database files, etc. 

 The maximum number of projects the Wizard will support in a 
single database has been increased from 100 to 150. 

 When generating a proposal, the Wizard will now display a 
message about any of the mail merge tags which did not have 
data filled in for them in your Document Project. This message 
can be disabled in the Preferences. 

 Added 2 new company mail merge tags <<Address3>> and 
<<MobilePhone>> 

 Added 2 new customer mail merge tags <<CustAddress3>> and 
<<CustMobilePhone>> 

 Fixed tab orderings for consistent tab navigation in a number of 
screens. 

 Added the ability to remap Proposal Pack mail merge tags to 
alternate tags to help support integration with 3rd party 
applications which will be used to add further data to the 
proposal documents created by Proposal Pack and Proposal 
Pack Wizard. 

 The Graphics tab on the Edit Styles screen is now set as the 
default tab first seen when the screen opens. 
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 Added 20 new contract mail merge tags to support the 
integration of Contract Pack templates: <<ContractCompany>>, 
<<Approver>>, <<Month>>, <<Amount>>, 
<<Supervisor>>,<<Department>>, 
<<InsuranceCoverageAmount>>, <<Credits>>, <<SSN>>, 
<<HREmail>>, <<HRPhone>>, <<HRContactName>>, 
<<TimeZone>>, <<Date>>, <<Minutes>>, <<Hours>>, <<Days>>, 
<<Months>>, <<Years>>, <<Weeks>> 

 Added a Search For Installs button in the Preferences Tools tab. 
This performs the same function as the Search for Styles button 
in the Document Styles screen. This makes it easier to install 
new Proposal Packs and setup 3rd party applications after the 
Wizard has been installed. 

 Added a button on Document Styles screen to launch web 
browser to display the Proposal Pack product web page to 
make it easier to purchase additional Proposal Pack styles. 

 Added a Preferences option to reduce the number of 
informational message boxes displayed during the proposal 
generation process.  

 A new method of removing templates from the Document 
Project’s Pick Documents screen has been added. Now you can 
select from a list of templates to remove selected ones in a 
batch which makes the process much less time consuming. 

 Added new tests to the Test Database preferences tool. 

 Lots of additional refinements to the interface, messages and 
text for usability and readability. 
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WHAT’S NEW IN V3.5? 

 Updated to support the latest Proposal Kit 12.0, Contract Pack 
11.0 and Proposal Pack 9.0 product upgrades so documents in 
the latest products will be accessible in the Wizard menus. 

 Added support for the 9 new Title Page graphics added to the 
new Proposal Pack 9.0. The new Title Page graphics are 
available in the Project screen and can be configured in the 
Preferences screen. 

 Fixed problem with the Limited version of Proposal Pack for Any 
Business having the same name in the drop down list box of 
styles as the full version. 

 Fixed an error message which occurred when trying to edit the 
demo styles. 

 Turned off the ability to create extremely large proposals in 
Novice mode. 

 Enlarged the screen displaying selected templates for the 
proposal. When selecting a very large collection the list if 
selected templates would be truncated. This did not affect the 
operation of the Wizard, just the display of all of the templates 
selected. 

 The Add/Edit Project screen now disables the Title Page graphic 
drop down list box when using a Proposal Pack style that does 
not have a graphic theme (i.e. the Proposal Pack for Any 
Business and Proposal Pack for Government Grant styles). 

WHAT’S NEW IN V3.4? 
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 Due to security issues in Windows Vista all of our related 
products such as the Proposal Packs and Proposal Kits have 
been moved from the c:\Program Files\ProposalKit install folder 
to c:\ProposalKit. This change was made to prevent users 
having their proposal templates installed in read-only mode 
which happens when installed in the c:\Program Files folder in 
Windows Vista. This update to the Wizard now installs it in 
c:\ProposalKit by default and also searches for your Proposal 
Packs in both the new c:\ProposalKit location and the legacy 
c:\Program Files\ProposalKit folders. 

WHAT’S NEW IN V3.3? 

 When running the Wizard on a new installation of Windows Vista 
and Office 2007 the Normal.dot template’s default settings 
caused the Wizard’s combined master proposal formatting to 10 
points of space after each paragraph. This update resets the 
default paragraph line spacing to 0 points before and after each 
paragraph when the Wizard combines your individual proposal 
templates into a combined master proposal. 

WHAT’S NEW IN V3.2? 

 Fixed a problem running the Wizard with Word/Office 2007. 
Office 2007 removed a key function (Application.FileSearch) 
which was previously used by the Wizard to search for files. This 
missing function has been replaced. The new Proposal Pack 
Wizard 3.2 will now run on Windows Vista, Word/Office 2007 
and previous versions of Word. 

WHAT’S NEW IN V3.1? 
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 Updated to support the latest Proposal Kit 11.0, Contract Pack 
10.0 and Proposal Pack 8.0 product upgrades so documents in 
the latest products will be accessible in the Wizard menus. 

 The Quote.png alternate Title Page graphic is now an enabled 
option in the Wizard now that the Quote.png graphic is part of 
the new Proposal Pack 8.0 products. 

 6 new mail merge tags have been added for more contract 
support: <<DeliveryDate>>, <<WorkOrder>>, <<FixedRate>>, 
<<ContractFirstName>>, <<ContractLastName>>, 
<<ContractJobTitle>> 

WHAT’S NEW IN V3? 

 The biggest changes in the new Proposal Pack Wizard are the 
ability to configure the Wizard the way you want to work with 
your proposal documents. Just about every aspect of the wizard 
interface and the documents can now be customized. All of the 
hard coded wizard settings and screen text have now been 
moved into configurable database settings. Other changes have 
been made to streamline the Wizard interface to remove or 
change options confusing or harder to use for the first time 
proposal writer in a hurry. 

 Added screens for adding, editing and removing individual 
documents in the Wizard. Allows the user to change the order of 
templates, add custom templates and customize the attributes 
of all of the documents. 

 When the Wizard is run for the first time a short question and 
answer form is displayed for the user to answer some questions. 
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This causes the Wizard to be pre-configured for the user with 
some default data specific to each user. 

 The General Business Proposal and Business Plan Proposal 
auto recommend Small proposal now includes the Table of 
Contents template and removes the Total Cost of Ownership 
template. 

 The Wizard now has an Expert and Novice Mode. The Wizard 
defaults to Novice Mode when first installed. Novice Mode 
disables all of the advanced features which are not necessary 
for a first time user to be able to create a proposal. Novice 
Mode is meant to streamline the process of creating proposals 
for first time users by reducing confusion about what options 
they should be using or configuring. When Expert Mode is 
turned on, all of the Wizard features are unlocked. 

 There is a new tool to remove the default installed Demo styles 
and Demo projects to clean up the menus. The remove demo 
option is also run when you enable Expert mode. 

 The Pick Documents screen now allows saving of up to 5 
custom selections of documents for each of the 12 proposal 
types. Preset selections can be named and then selected for 
each future proposal. The Preferences tab for the Document 
Project defaults will also allow you to select your custom 
recommend preset selections as the default to be used for each 
new proposal. 

 If you have selected more than 40 documents for your proposal 
an extra warning popup message is shown to alert you that the 
process may take a longer time and you must wait for the 
process to complete. 



204 

 Added a new Preferences option to allow the default folder 
created for each new proposal to be based either on the default 
system generated proposal index, the user defined proposal 
number or the name of the proposal. If you change the proposal 
number or proposal name fields with that option selected while 
editing your proposal, the save to folder will be automatically 
updated. 

 Added “Reset to Default” buttons on all database configuration 
screens. These buttons will reset the currently viewed tab or 
screen to the original settings from when the Wizard was first 
installed. Only the data in the visible screen or tab will be reset. 

 A new administrator feature has been added. The “Do Not 
Alter” button on the document project settings tab allows you to 
disable the various project settings when a Document Project is 
created or edited. This option can be used to prevent your users 
from inadvertently changing the default settings for the 
proposals. 

 A new option has been added to the Title Page graphic list box 
in the Document Project screen: “Do Not Alter Title Page 
Graphic”. Choosing this option is the same as not picking any 
graphic to be changed. It is meant to be an information only 
option to show the user that no change to the Title Page graphic 
will be made when the proposal is created. 

 Added the proposal development checklists as selectable files 
in the Document Project and also as an easy to use checkbox 
option in the Pick Documents screen. If selected, the proposal 
development checklists will be copied to your new document 
project folder. 
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 The ability to add a custom logo has been expanded to allow 
complete configuration of the existing 4 pre-defined logos and 4 
custom logos.  

 Each of the 12 project types can have a default Title Page logo 
used to pre-populate each new document project. When 
changing the proposal type in the document project screen, the 
logo graphic will change as well if you have defined a default 
logo for the new proposal type. 

 The current proposal type is now displayed in the Pick 
Documents screen. 

 The Cost Summary template has been added to the Demo 
version of the Wizard along with more informational messages 
about what is included in the retail version. 

 A single edit screen with multiple tabs has been added for 
editing all of the mail merge screen labels, mail merge tags, 
default pre-populated data, custom merge tag wrappers and 
date formats. 

 When the mail merge edit screen is opened the appropriate tab 
is displayed related to the screen the user came from. 

 The Table of Contents label editing screen has been extended 
to allow editing of the major category headers, the proposal 
type labels and the ability to hide individual proposal types. You 
can now limit and configure the text of the number of options 
shown in the Document Project screen. 

 The Preferences screen has been broken up into multiple tabs 
to differentiate the various editable options. 
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 A new Preferences screen has been added for customizing the 
default data pre-populated into each new Document Project 
including the default Pick Documents auto recommendation 
options. 

 New proposal types have been added for “Short Form Contract” 
and “Quote”. These are designed for short proposals of only a 
few pages. The Pick Documents screen will only show a very 
small collection of recommended documents. New FileList#.ini 
files have been added to allow complete customization of what 
documents are available for these proposal types. 

 5 customizable proposal types have been added. This allows 
you to name and configure your own proposal types and 
collections of templates. For example, you can have a different 
proposal type for different product lines or services. You can 
also use them for having pre-created proposals to choose from 
where you just want to change the mail merge information 
without having to assemble a new proposal from scratch every 
time. 

 The documents recommended by the Pick Documents screen 
are now completely configurable via the new Recommend#.ini 
database files. You can now configure what documents you 
want to have recommended for each new proposal you create. 
Each proposal type (business, grant, book, resume, quote, 
business plan, contract, custom types) has its own set of 
recommendations that can be configured. 

 The Preferences screens have been expanded to allow 
customizing of the labels for all of the proposal types and 
proposal section names used in the Table of Contents created 
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for your proposal. Click the “Edit Table of Contents Labels” in 
the Preferences screen. 

 The names of the proposal type drop down lists in the Wizard 
can be customized by editing the FileList.ini database files. 

 A new option for the Pitch and Industry auto recommend lists 
was added for “Other”. This is intended for use as a user 
defined default option when the other options in the list are not 
applicable. 

 The text on the Wizard screens for the proposal sections can 
now be configured using the FileList.ini files. For example, 
general business proposals will show “Client Centered 
Documents” while book proposals will show “Author Centered 
Documents”. This text as well as the text for the 5 custom 
proposal types can be customized. 

 Added a database test function to the Preferences screen. This 
button will run a test of all of your INI database files to check for 
errors. A log of the test will also be created which can assist in 
diagnosing database customizing mistakes. 

 A new database file Options.ini file has been added to allow 
custom configuration of many of the Proposal Pack Wizard 
functions such as mail merge options, paper size options, 
extensions for graphics file names, date formats, translation of 
month and day names, default mail merge tags to pre-populate 
each new document project, complete customizing of ALL 
custom and pre-defined mail merge tags and tag labels, 
customizable mail merge tag wrapper, define which files are not 
to be combined into the master proposal, define which 
templates do not use page numbering, define which templates 
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to not add to the Table of Contents, redefine the name of the 
master proposal file and how to locate new Proposal Packs, 
redefine the special files such as the cover letter, cover sheet, 
inquiry letter, etc. 

 Using the new Options.ini file, configure which files are used for 
the special files Table of Contents, Cover Letter, Cover Sheet, 
Inquiry Letter, Envelope, Letterhead and Title Page. See the 
[SPECIAL_FILES] section of the Options.ini file. 

 Using the new Options.ini file, change the name of the master 
combined project document created for each new project which 
is FullProposal.docx by default. See the [SPECIAL_FILE_NAMES] 
section of the Options.ini file. 

 Using the new Options.ini file, change the name of the file 
searched for when installing new Proposal Packs in case there 
are conflicts with existing files on your system. By default this is 
BlankTemplate.docx. See the [SPECIAL_FILE_NAMES] section 
of the Options.ini file. 

 Using the new Options.ini file, define which documents are not 
to be added to the Table of Contents when creating a new 
proposal. By default documents such as the cover letter, inquiry 
letter and title page are not added. See the [ADD_TO_TOC] 
section of the Options.ini file. 

 Using the new Options.ini file, define which documents are not 
to have page numbering turned on when creating a new 
proposal. By default documents such as the cover letter, inquiry 
letter and title page do not use page numbers. See the 
[USE_PAGE_NUMBER] section of the Options.ini file. 
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 Using the new Options.ini file, define which templates are not to 
be added to the master combined project document 
(FullProposal.docx) file when creating a new project. By default 
documents such as the cover letter, cover sheet and inquiry 
letter are not added. See the [COMBINE_INTO_MASTER] 
section of the Options.ini file. 

 Using the new Options.ini file, define your own custom mail 
merge tag wrapper if you are using pre-existing content with a 
different style of tags. By default the Wizard uses double 
brackets << >> and a customizable single bracket [ ] to enclose 
mail merge tags with your documents. The [ ] style can be 
configured to any type of wrapper such as { } as an example. 
See the [TAGS_WRAPPER] section of the Options.ini file. 

 Using the new Options.ini file, redefine the default company 
mail merge tags and screen labels. For example, if you don’t 
want to use our default <<FirstName>> tag, you can change it to 
something like [First]. See the [COMPANY_TAGS] section of the 
Options.ini file. 

 Using the new Options.ini file, redefine the default customer 
mail merge tags and screen labels. For example, if you don’t 
want to use our default <<CustTitle>> tag, you can change it to 
something like [ClientJobTitle]. See the [CUSTOMER_TAGS] 
section of the Options.ini file. 

 Using the new Options.ini file, redefine the default custom mail 
merge tags and screen labels. For example, if you don’t want to 
use our default <<Custom1>> tag, you can change it to 
something like [WorkOrderNumber]. Also 10 new custom tags 
have been added for a total of 20 custom mail merge tags. See 
the [CUSTOM_TAGS] section of the Options.ini file. 



210 

 Using the new Options.ini file, redefine the default contract mail 
merge tags and screen labels. For example, if you don’t want to 
use our default <<HourlyRate>> tag, you can change it to 
something like [Rate]. 20 new mail merge tags have been 
added specifically for contract related mail merge data. See the 
[CONTRACT_TAGS] section of the Options.ini file. 

 The customizable custom mail merge tag data from Version 2.0 
used to be stored in the Windows registry, it has now been 
moved to the Options.ini database file in Version 3.0 

 Using the new Options.ini file, added customizable default data 
to pre-populate each new project with. This feature replaces the 
older Version 2.0 pre-populate feature which used the settings 
from your first project for each new project. See the 
[DEFAULT_CUSTOMER_TAGS], [DEFAULT_COMPANY_TAGS], 
[DEFAULT_CUSTOM_TAGS] and 
[DEFAULT_CONTRACT_TAGS] sections of the Options.ini file 

 Dynamic mail merge data tags have also been added: 
CURRENTDATE, SYSTEMDATE, INCREMENT, 
CURRENTDAYSTR, CURRENTDAYNUM, CURRENTMONTHSTR, 
CURRENTMONTHNUM, CURRENTYEARYY, 
CURRENTYEARYYYY 

 Using the new Options.ini file, you can define the default date 
format and the text of the month and day strings for foreign 
translations. The default current date format is M/D/Y however 
any common date format can be used including international 
date formats. See the [MONTHS], [MONTHS_SHORT], [DAYS], 
[DAYS_SHORT] and [DATE_FORMAT] sections of the 
Options.ini file. 
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 Using the new Options.ini file, you can define new file 
extensions for graphics files to be used when inserting custom 
logos. All of the common graphics types are already pre-
defined. See the [GRAPHICEXTENSION] section of the 
Options.ini file.  

 Using the new Options.ini file, you can define new page sizes 
for your proposal formatting. New landscape settings have also 
been added. See the [PAPERSIZE] section of the Options.ini file. 

 The “Change Source Document” feature has been removed 
from the Wizard. This feature replaced the text of one document 
with the text of another document. This feature was too 
confusing for many users to setup and is also an outdated 
feature now that so many new configuration options have been 
added to the Wizard. The “Reset to Defaults” option has also 
been removed from the auto recommend screen which was part 
of the removed feature. 

 The proposal type drop down list box on the Auto Recommend 
screen has been removed. This was a redundant option. The 
Auto Recommend screen will be configured based on the 
proposal type selected on the previous screen for the document 
project. 

 Document drop down lists and buttons which operate on 
specific documents are now disabled when no file(s) exist or are 
unavailable for editing or use.  

 The proposal editing screen now disables any buttons which do 
not have files available for editing. Also a new “Team Editing” 
option has been added to the Preferences screen which is 
turned off by default. This option when disabled (by default) 
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does not allow editing of the individual proposal documents, 
only the complete master proposal and any special documents 
not normally combined into the master proposal are available 
for editing. This makes the final editing less confusing for new 
users who do not read the documentation about which version 
of the proposal to edit. Usually editing of individual proposal 
documents is used for team proposal writing which is a smaller 
set of Proposal Pack Wizard users. To enable individual 
document editing enable the “Team Editing” option in the 
Preferences screen. 

WHAT’S NEW IN V2.72? 

 Updated graphics in the interface. 

 Work around for a potential Word error when replacing the Title 
Page project graphic on some Proposal Pack designs on some 
versions of Word. 

WHAT’S NEW IN V2.71? 

 Minor interface adjustments. 

 
WHAT’S NEW IN V2.7? 

 Updated to recognize the templates in the new Version 7 
Proposal Packs and Version 10 Proposal Kit products released 
for 2006. 

 Added an option to the Project screen to allow the user to 
select a variety of pre-built and custom graphics for the Title 
Page Logo. Choose from pre-built “Project”, “Proposal” and 
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“Business Plan” graphics or choose your own custom logo 
graphic. 

 Added the ability to add new documents to the Wizard. For 
example, you can create multiple product lists to choose from. 

 Added the ability to change the ordering of documents in the 
Wizard. 

 Added the ability to change the document descriptions in the 
Wizard. 

 Updated the proposal template Auto Recommend screen to 
recommend templates for all supported types of proposals 
(general business, grant funding, business plan funding, book 
proposals, and resumes). 

 Added what type of proposal the current project is setup as to 
the main Wizard screen. For example, if your current project has 
the “Grant Funding Proposal” type selected in the Auto 
Recommend screen, you will see on the home screen of the 
Wizard interface “Type of Current Proposal: Grant Funding”. 

 Added an RFP response checkbox to the Auto Recommend 
screen. When checked this option will cause RFP response 
related templates to be added to the list of selected documents 
when the Recommend button is clicked. 

 Added a preferences option to change the sub header labels in 
the Table of Contents.  

 Minor enhancements to the Wizard interface. 
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 Added a Reset to Default button to the Document Project Auto 
Recommend screen. This option clears all selected templates 
and removes all custom alternate document links for the 
currently selected document project. 

 Fixed bug where a border was being added to the Inquiry Letter 
template when used with a Proposal Pack style which includes a 
page border. No border is added to the Inquiry Letter document 
now. 

 Updated the macro security certificate which will now expire in 
Dec, 2007. 

 New document projects are saved in the current Word format 
instead of the RTF format. This also reduces the file size of your 
proposal documents when using the Wizard. All file extensions 
still end in “.docx”. 

 Added a “Compress Files” option to the Styles editing dialog 
box to compress large RTF format documents by resaving your 
original installed Proposal Pack documents in Word format 
instead of the default RTF format. 

 New method for setting tab stops in Table of Contents added. 

 Added visual graphics to the final proposal edit screen to 
differentiate better between editing individual templates or the 
combined project document. 

 Auto Recommend screen settings for which dialog boxes were 
originally selected are retained in the registry to make editing 
the selected document list easier. 
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 Fixed bug where the “Automatic” page border color would 
crash the Wizard when trying to edit the style settings. 

 Fixed bug where Wizard would put a page border around 
Proposal Pack styles which were initially designed without page 
borders. 

 Added a preferences option to search again for older Proposal 
Pack Wizard database settings if reinstalling the current Wizard. 

 Added an option to the Document Styles menu to not reformat 
every sentence of the combined project document. 

WHAT’S NEW IN V2.63? 

 Added ability for Wizard to recognize new Proposal Pack styles 
without requiring a new Wizard patch as new styles are 
released. Wizard now reads setup.ini file included with new 
Proposal Pack installations. 

WHAT’S NEW IN V2.62? 

 Changed how Boolean values are saved in INI database files to 
work with international versions of Microsoft Word. 

 Fixed bug that would cause an error message when trying to 
edit styles Contemporary #3 and #4. 

 
WHAT’S NEW IN V2.61? 

 Updated to recognize the latest collection of 12 new Proposal 
Pack graphic themes (Business #5, Business #6, Business #7, 
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Education #1, Contemporary #3, Contemporary #4, Medical #2, 
Classic #4, Global #1, Flag #1, Painter #1, Photography #1).  

WHAT’S NEW IN V2.6? 

 Updated to work with the new Proposal Kit 9.0 and Proposal 
Pack 6.0. 

 Updated Code Signing Certificate valid until 2006. 

 Added support for 2 new tags: <<ProposalTitle>> and 
<<CurrentDate>>. 

 Added support for 4 new Proposal Pack styles: In Motion #1, #2, 
#3 and #4. 

 Changed behavior of “Create Document” operation to not 
overwrite existing individual documents if the configure 
operation is run multiple times. This will now prevent edited 
documents from the previous configuration from being 
overwritten when regenerating a document project multiple 
times. A more verbose warning message is included when 
reconfiguring a project to help avoid overwriting your master 
document work when reconfiguring and recombining all your 
individual templates into a master proposal document. A backup 
copy of your project’s files is also made each time the “Create 
Document” operation is run.  

 Added 7 new Proposal Pack templates. Templates added: 
Inquiry Letter, Services Provided, Benefits, Features, 
Qualifications, Products, Follow-up Letter. 

 Added a Proposal Development Checklist. 
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 Added a Post-Proposal Analysis Checklist. 

 New version of the “Proposal Writing Primer” included in the 
documentation. 

 Replaced Microsoft Word specific mail merge tags in all 
Proposal Pack styles with editable plain text tags for better 
support on all word processors. 

 When installing the full retail Proposal Pack Wizard after 
installing the Demo version, the full retail version will rescan 
your hard drive for installed Proposal Pack Styles. 

 Added “How do I Create a Custom Set of Documents?” chapter.  

WHAT’S NEW IN V2.5? 

 Changed references to “State” to “State/Province” and “Zip 
Code” to “Zip/Postal Code” for international users. 

 Added the ability at both the Style level and Project level to 
override the default text in any proposal document to load the 
text from an alternate file. For example, if you have multiple 
contracts for various types of projects, use the Style override to 
suck in the text of your most commonly used contract into the 
“Contract” template. Then for specific projects using an 
alternate contract, use the Project override to override the 
custom Style setting. This feature was added to support better 
integration with our “Contract Pack” product, a collection of 
legal agreements. 

WHAT’S NEW IN V2.2? 
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 Added workaround for an error introduced by a some systems 
(most commonly Dell) where the Wizard could not find files 
which did exist. The problem is actually a driver problem on 
some systems causing the Visual Basic for Applications function 
FileSearch to not return results when it should. This problem 
only affects a very small number of systems and this patch 
includes a work around to resolve it. 

WHAT’S NEW IN V2.1? 

 Added workaround for an error introduced by a Microsoft Office 
patch which caused Visual Basic 4198 error messages to be 
displayed by the Wizard. 

WHAT’S NEW IN V2? 

 Updated to support 15 new templates added to the upgraded 
5.0 Proposal Packs. 

 Added ability to configure the titles and embedded tags of the 
10 custom mail merge tags.  

 Updated the format of the Table of Contents creation to match 
the new 5.0 Proposal Pack framework organization. 

 Added new templates to the Auto Recommend. 

 Added “Anatomy of a Proposal” section to the documentation. 

 Added an 11 page “Proposal Writing Primer” article to the 
documentation. Written specifically for Proposal Pack by the 
proposal development company, Design Café. 
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 Added popup descriptions of all of the template documents. 

 Added more error checking. 

 Added more help information. 

 Added version numbers to the Proposal Pack styles so you can 
manage multiple versions of Proposal Pack styles from the 
Wizard. 

 Added auto-incrementing of the Proposal Number each time a 
new document project is created. The starting number can be 
set in the Preferences screen. 

 Added Paper Size setting field to the Style screen. Each style 
can now have its own paper size (Letter, Legal, Executive, A4 or 
B5). 

 Added the Proposal Pack for Any Business (Limited) collection 
of templates to the Proposal Pack Wizard. The Wizard can now 
be used as a stand-alone proposal generator for small 
proposals without requiring any extra Proposal Packs. 

 The Auto Recommend and dynamic Table of Contents 
generation now do not include templates which do not exist in 
Demo, Limited or older Proposal Pack styles. 

 Reduced size of Windows download by 5mb. 

 Minor bug fixes.  

WHAT’S NEW IN V1.1/1.2? 
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 A couple cases were reported on systems unable to open files. 
File searches were changed to fix this problem. 

WHAT’S NEW IN V1? 

 This first release of the Proposal Pack Wizard helps automate 
the management and setup of your Proposal Pack documents. 
The Wizard automates the tedious tasks of picking documents, 
creating client folders, copying templates for each project and 
merging your company and client data into the templates.  

 Built in data manager for name address data for your company 
and client. Data manager also automatically recalls your 
personal information for each new client proposal to save 
retyping. 

 Proposal Pack style manager allows you to use one Wizard 
interface for all your Proposal Kit and Proposal Packs. If you 
have multiple Proposal Pack styles installed, you can easily pick 
styles to use for each proposal from one menu. 

 Auto Recommend screen helps you select a collection of 
proposal templates based on the size and type of the proposal. 

 Built-in mail merge replaces the manual Word mail merge 
feature and automatically merges your data manager data into 
each proposal. 

 Change page border styles using the style wizard. Add and 
remove page borders, change the border color, size and style. 

 Automated Table of Contents and page numbering. If you 
include a Table of Contents, you can have the Wizard 
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automatically create a Table of Contents matching just the 
documents picked for each proposal. 

 Combined master proposals. The Wizard can combine all your 
individually selected templates into a single master proposal 
document. 

 Automatically replace the proposal graphics with your custom 
versions. Using this feature requires that you create your own 
custom graphics using your own graphics program. The Wizard 
can then automate the process of deleting the stock graphics 
that come with the proposal templates and replace them with 
your custom graphics. 

 Multiple user licenses are also available. Single user versions 
can maintain your style and data manager information on a 
single computer. Multiple user versions can store the style 
database and data manager database separately on the user's 
local computer and/or a networked computer. For example, 
each user can have their own data manager database and 
access the Proposal Pack styles from a single network server. 
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WHAT’S THE NOVICE EDITION VS. EXPERT 
EDITION? 
 
The Proposal Pack Wizard is available in a Novice Edition that is 
included with each Proposal Pack and Contract Pack template 
product.  
 
The Novice Edition includes all the basic features that cover most 
document assembly needs. You can create projects, select from 
the entire library of templates, view samples and build your 
proposal and contract documents. 
 
The Novice Edition does not include the more advanced features.  
 
Advanced Expert Edition features include things such as: 
 

 The ability to create and customize line item databases 

 The ability to configure the Wizard interface 

 The ability to configure the Wizard databases 

 Ability to create your own graphic design theme 

 3rd party integrations such as QuoteWerks  

 Ability to edit the stock templates via the Wizard interface 

 Ability to add your own custom documents to the Wizard database 

 Project status tracking 

 Ability to define more than one custom company logo 

 Ability to remap and redefine mail merge tags 

 Ability to change the Word ‘Styles’ for changing font styles and colors 

 Ability to use dynamically linked Word and Excel files 

 Ability to use the company and client CRM database 

 International text and currency translation features 

 See the Wizard features list for a complete list 

https://www.proposalkit.com/htm/proposal-writing-software.htm#features
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WHAT IS “PROPOSAL PACK WIZARD”? 
 
Proposal Pack Wizard is an optional software interface for use with 
Proposal Pack and Contract Pack templates (sold separately). 
Proposal Pack Wizard is a built-in Word add-in which runs as a 
Word macro. The Wizard runs on Windows versions of Word 2010 
or greater. 
 
Since the Proposal Pack Wizard is an optional interface, older 
Word version users and Mac and Linux users can still use the 
Proposal Pack and/or Proposal Kit products without the Wizard. 
The Wizard helps automate tasks commonly performed manually 
using the proposal documents. 
 
If you purchased Proposal Pack Wizard separately, you must also 
have a Proposal Pack, Contract Pack or Proposal Kit already 
purchased and installed on your computer.  
 
The Proposal Pack Wizard can be used to setup a one page long 
to hundreds of pages long document framework in just minutes 
with the click of a few buttons. The Wizard will help automate tasks 
such as: 

 Managing all your Proposal Packs. With one Proposal Pack 
Wizard you can select any of your purchased Proposal Pack 
design styles from a single interface. The Wizard can also 
automatically search your system and setup any installed styles. 
For example, if you have multiple products such as Proposal Kit 
Pro, Proposal Pack Business #1 and Proposal Pack for Any 
Business, you can select between all these styles to use for any 
given client proposal from the Wizard. 
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 Writing Proposals and Contracts. You can create a proposal 
and a detailed contract when using the Wizard with our Contract 
Packs. For example, you can create a proposal document and a 
contract together or as separate documents for a client. 

 Writing Business Documents. You can create just about any 
kind of multi-page business document using Proposal Pack 
Wizard and a Proposal Pack template collection. We have 
added enough material to the template packages over the years 
that you can write information packets, instruction manuals, 
reports, studies, plans and more with it. 

 Picking a collection of templates to use in your document. 
Without the Wizard you must manually choose what documents 
to use out of the entire collection, create folders for your 
document and copy the documents. The Wizard includes a built-
in Auto Recommend tool which will assist in quickly picking a 
collection of documents. The Wizard will also create a new 
client folder and copy the selected documents to that folder for 
each project. 

 Merging client and company data into your document. Without 
the Wizard you can manually search and replace common tags 
with your contact information. With Proposal Pack Wizard, all 
you must do is enter your client and company data once and the 
Proposal Pack Wizard will automatically merge your data into 
every selected template. 

 Managing multiple client proposals. Without the Wizard you 
must manually create folders for each project and copy 
templates for each new proposal. With Proposal Pack Wizard, 
you can automatically create new client folders and copy all 
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your merged and combined documents into a separate folder 
for each client.  

 Combining all your templates into a single document. Some 
users like to combine all their templates into a single master 
document. There are pros and cons to both ways of managing 
the proposal writing process. Proposal Pack Wizard supports 
both methods. Without Proposal Pack Wizard you must manually 
append all your individual templates into your master proposal 
document. Word also has a habit of changing the formatting of 
text when combining documents which requires manual 
reformatting of paragraphs at times. With Proposal Pack Wizard 
you can have the Wizard combine all your selected documents 
into a single file and perform clean-up of the document 
formatting.  

 Page border style settings. The Proposal Pack Wizard can be 
used to automatically change the page borders on each 
document created. Without the Wizard you must manually set 
the page borders after the document is created on each 
individual template and the combined master document. With 
Proposal Pack Wizard all documents can have the borders 
automatically changed during the configuration process. 

 Integrating with third-party software. Proposal Pack Wizard 
directly integrates with quoting applications such as 
QuoteWerks. The Wizard also includes features that allow you 
to import documents created in other systems.  

 Dynamic linking with Excel spreadsheets. The Wizard can 
dynamically link cells in financial and scheduling spreadsheets 
to your document. This allows you to change pricing and 
schedules and have your documents auto-update. 
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REQUIREMENTS 
 
Word 2010 or greater using Windows operating system. Proposal 
Pack Wizard is entirely dependent on the Visual Basic for 
Applications (VBA) component of Microsoft Word/Office. You must 
have an up to date version of the VBA components for the 
Proposal Pack Wizard to operate properly and an edition of 
Microsoft Word/Office that supports macros. 
 
 
OPTIONAL 
   
Any Proposal Kit, Contract Pack or Proposal Pack product (sold 
separately). The Wizard comes with a limited collection of demo 
templates which is a limited version of what is included in the full 
retail Proposal Packs. Add-on Proposal Pack specialty styles will 
add a broader range of templates. 
 
Add-on Title Page Packs give you a wider variety of custom 
designed Title Pages to choose from in multiple designs and color 
choices. 
 
The Proposal Pack Wizard is an optional software interface for use 
with Proposal Kit and Proposal Pack products found at 
https://www.proposalkit.com  
  
 

https://www.proposalkit.com/
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5 MINUTE QUICK START 
 
Watch a video of these getting started instructions at: 
https://www.ProposalKit.com/htm/videos-wizard-quick-start.htm 
 
Additional setup tutorials are available online at: 
https://www.ProposalKit.com/htm/wizard-setup-tutorials.htm  
 
 
The Proposal Pack Wizard is a Microsoft Word Add-in. This means 
it is not a stand-alone program. The Wizard runs within Microsoft 
Word and only within our Proposal Pack Wizard’s word document.  
 
Enable the macros as soon as you first open the Wizard document 
which happens during the Wizard installation. Look in the Word 
toolbar for Add-Ins, click that toolbar, then click the RunWizard 
button. 3 button clicks are all it takes to get the Wizard running. 
 
 
STEP A: ENABLE THE MACROS 
 
Follow the instructions in the first page of the Wizard Word 
document for how to enable the macros. The Wizard program will 
not run if you do not enable the macros. 
 

A 

https://www.proposalkit.com/htm/videos-wizard-quick-start.htm
https://www.proposalkit.com/htm/wizard-setup-tutorials.htm
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If you are using Windows in S Mode 
 
If you are using Windows in S Mode, there is one extra setup step 
that may be required in addition to enabling the macros. 
 
You may have to also right-click this document in the install folder, 
click the General Properties tab then click the Unblock checkbox 
or Unblock button. 
 
This is a security measure required by Windows in S Mode. 



229 

For Microsoft Word 2010 and greater you must click the Enable 
Content button in the yellow bar next to the Macros are disabled 
warning message which looks like this: 
 
 

 
 
 
STEP B: RUN THE WIZARD 
 
Once the macros are enabled you can run the Wizard. Your 
Wizard’s Word toolbar will look like this screenshot. Locate these 
buttons on your Wizard document’s toolbar. 
 

 

B 
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STEP C: CREATE YOUR FIRST DOCUMENT: 
 

 First - Install your Proposal Kit Professional, Proposal Pack, Title 
Page Pack and/or Contract Pack product before running the 
Proposal Pack Wizard. The Wizard will search for these 
products, so they must be installed first. Proposal Packs, Title 
Page Packs, Contract Packs and Proposal Kit Professional are 
each downloaded and installed separately. We have hundreds 
of template packages which plug in to the Wizard. Install 
whichever product(s) you installed. 
 
The Wizard does come with a limited collection of plain 
templates; however, it is meant to be used with one or more of 
our other template products. Access to the complete range of 
templates requires a template product.  

 
If you purchased and installed Proposal Kit Professional, you 
will also see a blue icon on your desktop.  

 
If you purchased and installed a Proposal Pack template 
product you will also see a red icon on your desktop. 

 
If you purchased and installed a Contract Pack template 
product you will also see a purple box icon on your desktop.  

 
If you purchased and installed a Title Page Pack template 
product you will also see a magenta icon on your desktop. 

 
 
 

C 
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 Second - Run the Wizard by double clicking the  Run 
Proposal Pack Wizard icon on your Windows start menu or on 
your Windows desktop. The icon looks like our logo with a 
green background. 
 
Different editions of Microsoft Word have slightly different 
methods of enabling macros such as our Proposal Pack Wizard.  
 
Refer to the instructions in the Wizard document for the specific 
version of Word you are using. Enabling the Wizard macros is a 
security step that is managed by and required by your Microsoft 
Word software. This is a one-time only step you have to do 
before you will able to run the Wizard software. 
 
IF YOU DO NOT ENABLE THE MACROS ACCORDING TO THE 
INSTRUCTIONS, THE WIZARD SOFTWARE WILL NOT RUN, 
AND YOU WILL NOT SEE THE WIZARD INTERFACE SCREEN. 
 
IF YOU DISABLED THE MACROS BEFORE READING THE 
INSTRUCTIONS, RE-READ THE INSTRUCTIONS FOR YOUR 
VERSION OF WORD IN THE WIZARD DOCUMENT. THE 
INSTRUCTIONS WILL SHOW YOU HOW TO GET THE WIZARD 
SECURITY ENABLED. 
 
If you see a message about Trusting Content or Trusting 
Macros from this publisher, you must check the box. 
 
If you see a message about Enabling Content or Enabling 
Macros you must click the enable option. 
 
If you see an Options button during this process you must click 
to get to the enable options. 
 



232 

 
 
The first time the Wizard document is opened you will have to 
perform the macro security enabling steps. The Wizard will not 
automatically run and show you the interface screen this first 
time. Once you have enabled the macros, close the Wizard 
document. Then double click the Run Proposal Pack 
Wizard icon on your desktop.   
 
From then on, the Wizard software will automatically run each 
time you double click the icon, and you will see the Wizard 
interface. 
 

 Third - The first time the Wizard is run, after the macros are 
enabled, you will be prompted to enter some information about 
you and your company and how you intend to write your 
documents. The Wizard will start in Novice mode which disables 
the more advanced features of the Wizard. 
 
This will make it easier for first time users to quickly create a 
document without being confused by the more advanced 
features. Once you have created your first document in Novice 
Mode the Wizard will automatically enable Expert Mode (if you 
purchased the Expert version of the Wizard) and all the Wizard 
configuration features will be unlocked. 
 
Each time the Wizard is run it will search for any newly installed 
template packs. You only need to install the Wizard once 
regardless of how many template packs you purchased and 
installed.  
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Once you have 
completed the initial 
set up, the Proposal 
Pack Wizard interface 
opens, and you are 
now ready to start 
creating your first 
document. When the 
Wizard is run, you will 
see the main interface 
screen that looks like 
this: 

 
 
 
 
 
 

Click the button Document Styles, pick the style you want to 
use for this project. This will usually be the style you purchased 
or if you purchased the Proposal Kit Professional, you will have 
the choice of four or five assorted styles. Once you have 
selected the style click OK. A default style will already have 
been selected for you, so this step is not required to get started. 
You can also purchase additional add-on template packs at a 
discount from this screen. 
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 Fourth - Add a new project by clicking the button  Document 
Projects. We use the term “proposal” in many places when 
referring to the document being created – however you can 
create any type of business document including business plans, 
manuals, reports, studies, proposals, contracts, RFP responses, 
estimates, etc.  
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Then click the button Add New Project 
 
 

 
 
Gold arrows in the Wizard interface point at what you should be 
doing next. 
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Now you are on the main project screen. Enter a Project Name. 
This will be used for your reference and for the folder name that 
all this project’s documents will be saved in.  
 
Click the Pick Documents button to start selecting the chapters 
that will make up your document (i.e. a Cover Letter, Title Page, 
Table of Contents, and so on). This will take you to the Pick 
Documents screen. 
 
The Wizard will pre-populate your first project with a few 
common templates to help get you started. 
 
 

 

  



237 

The best way to get started is to use the Quick Start tab in the 
Pick Documents screen. There are hundreds of premade lists 
for all types of documents and all types of businesses.  
 
Click the Search Import Lists button and type in a single word 
that is related to what you are doing (i.e. investing, grant, 
education, training, electrical, lawncare, medical, security, 
wedding, catering, fashion, software, etc.) Pick any of those from 
the list then click the Import Topics from List button. 
 
Your project will now be loaded with a set of chapters. You can 
now customize that list as needed by adding new chapters and 
removing unneeded chapters based on your exact situation. 
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Use the Remove Templates tab to remove chapters that you do 
not want in your final document. Highlight one or more entries 
then click the Remove Template(s) button. This only removes 
them from your list of selected chapters for this project - no files 
are ever deleted.  
 
 

 
 
If you are not sure about needing a chapter leave it in your 
project. It is easier to remove an unneeded page than trying to 
add a new page once you have started editing your document. 
The Wizard can add a new template you may have forgotten 
into an assembled document you have started editing.  
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Use the Add Templates tab to add templates to your project. 
 
This screen gives you access to every chapter template 
available. The most commonly used ones are on the first screen 
of checkboxes you see (Cover Letter, Title Page, Table of 
Contents, etc.) 
 
To find lists of chapters grouped by different types of 
businesses and writing situations click the drop-down box and 
select from the list. You can check off chapters from multiple 
screens. 
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Use the Search by Name tab to add templates to your project. 
This tab is useful if you want to search the library of available 
chapters for a specific chapter instead of looking for it in the 
Add Templates tab. 
 
For example, say you want to find a budget template. Search for 
the word: budget 
 
Select whatever match is most appropriate and add it to your 
project. 
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Another way to quickly select a collection of templates is to use 
the View Samples tab and select a sample related to your 
situation. This option will add the templates and import the 
content used to create the selected sample to your project by 
clicking the Import Content from Selected Sample button. 
 
While we have a very large selection of samples, samples are 
only meant as general guides to show you how other people 
have assembled and filled in their documents. Millions of 
business documents like these are written every year so the 
samples are not intended to exactly fit your situation page for 
page. However, we have collected samples across a wide range 
of businesses and types of writing situations that will give you a 
good idea of how they are structured for similar situations. 
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Use the Add a Contract tab to add a legal contract template 
from either Proposal Kit Professional or one of the Contract 
Pack products to your project. You must have purchased a 
template product that includes contracts. 
 
If you are only using a Proposal Pack product you will find a 
handful of basic work orders and service contract templates in 
the Add Templates and Search by Name tabs. 
 
This tab gives you options to include the contract in your 
assembled document or have it created as a separate 
document. If the selected contract template also has exhibits or 
schedules related to it, those will be inserted into it. 
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Use the Title Page tab to select an alternate design and color 
scheme for your front title page.  
 
Select one of the 5 designs available in the selected Title Page 
Pack then select one of the 120 color schemes available. When 
done click the Use Selected Design and Color Scheme button. 
 
This option is generally used if you are using the “Proposal Pack 
for Any Business” or “Proposal Pack for Government Grants” 
styles. All our other Proposal Packs already come with a title 
page design tailored to match the rest of the pages. Your 
Proposal Pack comes with a starter package of title page 
designs and there are many more that can be purchased. 
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The View and Reorder Selected Templates button lets you 
change the order of the body pages. Special pages such as the 
Cover Letter and Title Page must remain at the front and the 
Back Page must remain at the end of the document. 
 
You can also remove chapters from your project using this 
screen. 
 
There are 2 panes in this screen. All the chapter templates that 
will be assembled into your document are shown in the left 
pane. All the templates selected that will be separate 
documents in your project are shown in the right pane (i.e. 
checklists, follow-up letters, external contracts, etc.) 
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The Presets tab is a shortcut for saving your currently selected 
list and ordering of chapters for future use. If your future 
documents are going to use the same set of chapters create a 
Preset. 
 
The next time you add a new Document Project and click the 
Pick Documents button, go to the Presets tab and select your 
saved Preset. Your list of saved chapters will be automatically 
loaded. 
 
This saves you the time of having to find and select all those 
chapters again. 
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When done selecting the chapter templates for your document 
click the OK, Use Selected Templates button which will take 
you back to the project screen. 
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Now that you are back on the project screen click the Company 
Data and Client Data buttons to enter the name/address data 
that will be merged into your document(s). Use the Line Item 
Quote button for adding quotes, schedules, etc. 
 
Save your project by clicking the OK, Save Project and Build 
Documents button to build your customized Word template.  
 
 

 
 
At this point the Wizard will automatically build the document if 
you choose to have it created right away.  
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If you choose not to build and open your document at this point 
you can do it later by editing the current project and saving the 
project again. This gives you the option to go back and edit your 
project settings before building your document(s). 
You will see a few dialog boxes displayed with status 
information during the document creation process.  
 
When you see a dialog box saying Process Complete, your 
template is now complete and ready to fill in the details. 
 
With slow computers and/or a very large document using many 
chapter templates this process can take a few minutes. If it 
appears your computer is not responding, or you see “(Not 
Responding)” in your Wizard’s Word document wait for the 
process to complete. Do not close the wizard while processing. 
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 Fifth - Click the OK, Open and Edit My Documents button in 
the Process Complete message and your templates will be 
opened in Microsoft Word and Microsoft Excel. 
 
All of your documents are stored in a folder on your hard drive 
which can be located in the        Edit Current Document button 
on the Wizard home screen. 
 
If you close your documents in Microsoft Word you can open 
them again by using the Wizard and clicking the Edit Current 
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Document button on the Wizard home screen. 
 
Each time you create a new project that project will be your 
current project. Your old projects will still exist, and you can get 
to them by making and old project your current project. 

 Sixth - Now that you have completed creating and opening your 
first document you are now ready to create more projects and 
to start customizing the Wizard and templates as needed. 
 
The Wizard can be configured for creating long and complex 
documents, for creating one-off custom documents or for 
creating custom tailored documents for many clients each 
tailored to the individual client. 
 
There are features for customizing the visual look of your 
documents including color schemes and branding with your 
own custom logos and graphics, custom font types, etc. 
 
Start reading the Wizard documentation and looking at the 
various configuration features in the Wizard’s Document Styles 
and Preferences screens next. 
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Creating your custom document only requires basic word 
processing skills such as opening Word documents, cutting and 
pasting text, typing, saving, printing, etc. 

The most overwhelming part for most people is figuring out where 
to start and how to select a set of documents from the large 
collection we provide. Think of your Proposal Pack as a large 
reference library that you are going to be taking portions out of 
and assembling together for your specific needs. 
 
The Wizard is designed to help you select templates from this 
reference library and assemble them into a single document. 
Proposal Pack template collections also include many completed 
samples to help guide you.  
 
Proposal writing runs the gamut from short one-page quotes to 
100 page multi-million dollar grants and everything in between. 
Most proposals are 5 to 15 pages long. Proposal Pack Wizard and 
Proposal Pack templates are used by companies (small and large) 
and individuals around the world to create these kinds of 
proposals, quotes, contracts, bids, grants, business plans, 
resumes, reports, studies and more. 
 
If you have problems running the Wizard software or have 
questions about how to get started, contact us for assistance at: 
https://www.proposalkit.com/htm/contact.htm 

https://www.proposalkit.com/htm/contact.htm
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5 MINUTE QUICK START QUOTEWERKS 
 
Watch a video of these getting started instructions at: 
https://www.ProposalKit.com/htm/videos-quotewerks.htm 
 
These are the minimal steps required to create a QuoteWerks 
layout file after having setup the Wizard and creating your first test 
document following the 5 Minute Quick Start instructions above.  

 First, click the Wizard’s Preferences > QuoteWerks tab and click 
the Generate Docs for QuoteWerks (Turn On) button. You can 
also edit the layout and tags used in the QuoteWerks table 
templates. 

https://www.proposalkit.com/htm/videos-quotewerks.htm
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 Second, click the Preferences > Data & Display > Remap Mail 
Merge Tags button. 
 
This step is only if you need to change any of the default tag 
remapping. By clicking the Generate Docs for QuoteWerks 
(Turn On) button in the step above the stock remapping tags 
will already be enabled for QuoteWerks. 
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‘QuoteWerks’ will already be selected from the drop down list and 
the Turn on mail merge remapping checkbox will be checked. 
This will cause the Wizard to replace our Proposal Kit tags with 
equivalent QuoteWerks tags. 
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 Third, create a new document project from the Wizard home 
screen. All buttons and options on this screen that are not used 
during the creation of QuoteWerks layouts will be greyed out. 
 
In the Pick Documents button add a page that will hold your 
quote such as the Cost Summary, Quote, Estimate, Invoice or 
Work Order. When adding one of these pages the Wizard will 
automatically insert a QuoteWerks compatible table layout. If 
QuoteWerks is also running it can build a custom table to match 
your QuoteWerks Item Types in your currently loaded quote. 
After you have selected all your chapters in the Pick Documents 
screen click the OK, Save Project and Build Documents button. 
The generated document will then be created as a QuoteWerks 
layout file. 
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 Fourth, the Wizard’s Edit Your Current Document Project screen 
has a QuoteWerks tab. This tab makes it easier to open and edit 
then save your generated document into your QuoteWerks 
layout folder. 
 
You can also do a ‘Save As’ with the Word document open and 
manually save it where you need and in the format you need for 
how you use QuoteWerks. 
 
Any documents you generate including proposals, invoices, 
letters and contracts can be converted into QuoteWerks layouts. 
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 Fifth, at this point you are ready to start using QuoteWerks with 
the new layout file. Using QuoteWerks click the Links tab then 
click the blue      button and select the new layout file. Finally, 
right click your mouse over the link and click the Save New 
Copy & Merge Word Document option. 
 
At this point QuoteWerks will merge your current quotes data 
into the layout file and you can make any final edits as needed. 
 
Consult your QuoteWerks documentation for help or contact 
QuoteWerks at this point for assistance with their software. 
Everything you do at this point is within QuoteWerks. 
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In this workflow you are using our Wizard and Proposal Kit 
template package to create a Word document that will be used 
independently within QuoteWerks. 

Due to differences in how QuoteWerks does their own custom 
processing on Word documents the Wizard will make some 
additional formatting changes to our standard layout. While we try 
to output files that work in QuoteWerks without any extra editing 
required there may be times when additional manual modifications 
need to be made to fix a formatting issue. If you see anything in 
the final layout that does not look correct contact us for assistance. 

QuoteWerks also has their own proprietary PDF generation which 
does not work with all the Word layout features our templates use. 
We do not recommend using our templates to output straight to 
PDF within QuoteWerks. Use the QuoteWerks Link tab and output 
to Word format in QuoteWerks first then use the Word Save as 
PDF or use Adobe Acrobat to create your final PDF file. 
 
It is also possible to work in the reverse direction using 
QuoteWerks to output just the quote and use our Wizard to 
assemble the rest of the proposal and pull in the quote output into 
the Wizard generated document. This workflow is not as 
commonly used. Consult the Wizard manual and QuoteWerks 
examples on how to setup alternate workflows. 

 

*** QuoteWerks is a 3rd party quoting application not sold by nor supported by Proposal Kit, Inc.  
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HOW DO I ACTIVATE THE WIZARD 
SOFTWARE? 
 
When you purchased the retail version of the Wizard you were 
given an activation code that was a series of numbers and letters 
in the format: 
 
####-####-####-####-#### 
 
This activation code was given to you in two places. If you got this 
far to download and install the Wizard, then you would have the 
Activation Code in the information that got you this far. 
 
First, it was included in the online ordering confirmation web page 
(hopefully you printed a backup copy for your records). 
 
Second, it was included in your Proposal Pack Wizard download 
email. And looks like this: 
 

Order #: ******* 
 
============================================================ 
The Proposal Pack Wizard is downloaded from here: 
 https://www.proposalkit.com/************************ 
You will need the following id and password to access the download page: 
 User Name: ************* 
 Login Password: ************* 
============================================================ 
 
Your Proposal Pack Wizard Activation Code is: 
  
####-####-####-####-#### 
 
Enter the Activation Code when you run the Wizard application 
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When you run the Wizard for the first time you will see a popup 
screen that asks you to enter some basic information, there is a 
tab on that screen for entering the Activation Code. 
 
If you do not enter the Activation Code, you can still run the Wizard 
in the Novice training mode.  
 
Once you complete your first training project in the Novice training 
mode you will need to have the Activation Code entered in the 
Preferences screen before you can switch the Wizard into Expert 
mode. 
 
If you have lost your Activation Code you can first try to have your 
download email resent to you using this form (most cases of 
missing emails are due to the user’s ISP, server or inbox junk 
filters, so first check your junk mail for our emails to you): 
 
https://www.proposalkit.com/downloadorder.htm 
 
If you are still unable to locate your Activation Code contact us for 
assistance. 
  

https://www.proposalkit.com/downloadorder.htm
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IT’S NOT JUST FOR PROPOSALS AND 
CONTRACTS! 
 
Yes, the name is Proposal Pack, so you are no doubt thinking 
"Okay, that may be great for proposals, but I also need to create 
other types of business documents. Is it good for anything other 
than writing proposals?" 
 
The answer to both these questions is a resounding "Yes!" 
 
The term “proposal” in much of the product and documentation is 
also synonymous with “business document”. You can also create 
reports, studies, plans, information packets, manuals, and more 
with Proposal Pack and the Wizard.  
 
If you are using a Proposal Pack that includes a graphic logo 
design, we include a collection of alternate graphics for your Title 
Page that lets you easily create other types of business documents 
with the same visual look. For example, instead of using the 
“Proposal” graphic logo in the Title Page we give you graphics for 
all these options: 
 
 

“Project”, “Proposal”, “Business Plan”, “Quote”, “Response”, “Submission”, “Contract”, 

“Estimate”, “Plan”, “Presentation”, “Report”, “Resume”, “Study”, “Documentation”, 

“Information”, “Instructions”, “Manual”, “Policies”, “Procedures”, “RFP”, “Request for 

Proposal”, “Samples”, “Handbook”, “Bid”, “Memorandum”, “Solicitation”, 

“Confidential”, “Bill of Materials”, “Analysis”, “Annual Report” and “Prospectus” 
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For example, this is what the “Proposal” and “Manual” graphics 
look like in the Proposal Pack Global #1 product: 
 
 
 
 
 
 
 
Scroll through the extensive list of the thousands of templates 
included in the Proposal Pack, and you'll see documents you can 
use in business plans, resumes, reports, grants, contracts, 
feasibility studies, government contracts, case studies, project 
quotes, RFPs, and bids - you name it; it's in there. 
 
Say, for example, that you're opening a small gym and you want to 
tell your local community about your facilities and the classes you 
plan to offer. You'll find templates in Proposal Pack for describing 
types of memberships, describing facilities, listing classes, and 
more. You can easily produce a simple single-page flier, a price 
list, or a whole packet of information. 
 
Or maybe you work in a scientific field where you need to conduct 
experiments, perform analyses, and write up conclusions, 
including statistics, charts and graphs. You may need to put 
together a report with appropriate citations and so forth. 
Templates for all those uses are included in Proposal Pack, too. 
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Perhaps you've been tasked with writing applications for grants or 
putting together a loan application, and you never really thought of 
those sorts of requests as proposals. But they are, in that you need 
to explain all the things your organization proposes to accomplish 
in exchange for receiving funding. Proposal Pack is not just for 
business needs or for selling products. Nonprofit organizations will 
find all the pages they need there, too. 
 
The longer and more complicated the document you need to 
create is, the more you will appreciate Proposal Pack's features. It 
allows you to easily assemble templates (thousands, if you need 
that many) and structure them into an organized, professional-
looking, easy to read package. 
 
All the templates include suggestions and examples of the types 
of information you might want to include. You get a jump start by 
using these templates because we've already done a lot of the 
thinking for you. You'll find yourself reading the suggestions and 
thinking, "Oh, yeah, I need to include this data and that piece of 
information—thanks for reminding me!" or "Oh, I was thinking I'd 
structure this page this way, but that suggestion makes more 
logical sense." Just by reading down the list of included templates, 
you'll probably find a few pages that you hadn't yet put on your list 
but that should be included in your proposal, application, or report. 
 
Keep in mind that most of the text on most template pages is 
designed be replaced, so you can customize each page in your 
document to be exactly what you need it to be. The whole product 
is endlessly flexible and customizable, because we want to make it 
easy for you to create not a carbon copy of our ideas, but a 
document that represents your organization and meets the needs 
of the project you're working on. 
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We give you a basic structure and tips to help you along the way. 
Odds are that by starting with Proposal Pack's templates, you will 
end up assembling a more thorough, thoughtful, and organized 
quote, report, or study than you would have if you started from 
scratch. And with our graphic designs, your finished package will 
look professional, too. 
 
It's true that we started Proposal Pack with the goal of making it 
easy for anyone, from a sole proprietor to a proposal writer inside 
a big company, to create proposals. Over the last decade we have 
expanded the products to cover a much broader range of business 
situations and nonprofit projects. Even community activists and 
hobbyists and a variety of clubs find the templates useful. Now, by 
including so many different templates for so many different 
purposes, we've made it easy for any individual or organization to 
put together almost any type of document package. 
 
There's also a collection of over a hundred samples. But they're 
not just samples of business proposals. The samples will assist 
with your proposal writing, grants, business plans, studies, and so 
forth by giving you ideas on how to get started, showing pages to 
include, and demonstrating ways to sell yourself or your 
organization or your ideas to your readers. Perusing the samples 
will spark your imagination, show you a variety of document 
structures, and remind you of the information you need to include 
in your writing projects. 
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So be sure to check out the sample list - you'll find that as well as 
giving you samples of all kinds, we provide samples of contracts, 
resumes, feasibility and case studies and many other documents 
created with Proposal Pack. You'll be surprised by the variety in 
style, tone, and types of documents included among the samples, 
and you'll find yourself imagining all sorts of new ways you can use 
the product. 
 
So, don't get stuck thinking that Proposal Pack is only for 
proposals, or only for use by marketing departments or sole 
proprietors selling products or services. No matter whether you 
are running a small business or managing a team inside a large 
corporation; no matter what sort of business documents you need 
to write; Proposal Pack will make all your writing tasks easier. 
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WHAT IS INCLUDED? 
 

 Proposal Pack Wizard includes add-in Word Wizard software 
and documentation. 

 Proposal Pack Wizard includes a limited collection of templates 
from the Proposal Pack for Any Business template product.  

 
WHAT IS NOT INCLUDED? 
 

 Additional Proposal Pack, Title Page Pack, Contract Pack and 
Proposal Kit templates are sold and installed separately. You 
must have at least one Proposal Pack or Proposal Kit to access 
the complete range of available templates. 

 
If you are new to proposal writing, we strongly urge you to read 
several books on this subject. These books go into much more 
detail on writing a client-centered proposal and proposal 
management. Recommended book resources can be found at: 
https://www.proposalkit.com/htm/append.htm  
 

https://www.proposalkit.com/htm/append.htm
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ANATOMY OF A PROPOSAL 
 
https://www.proposalkit.com/htm/videos-the-perfect-proposal-
kit.htm 
 
Your proposal may be anywhere from one page long to hundreds 
of pages long depending on many factors. The average proposal 
is 10 to 15 pages in length. The diagrams on the following pages 
show the anatomy of a proposal containing many of the various 
types of proposal templates included in the Proposal Packs. Your 
specific proposal will use a subset of the full collection of 
templates. Specific examples of proposals based on the same 
diagram are also included below. You will find the actual samples 
illustrated below, which are bundled with each Proposal Pack. 
 
The first diagram shows the anatomy of a complete proposal 
including templates from all the major categories (Introduction 
Pages, Client Pages, Project Pages, Your Company Pages and the 
Appendix Pages).  
 
If you are also using the add-on Proposal Pack Wizard, the 
Recommend Wizard uses this same structure for creating the 
proposal frameworks. You can also manually open and edit all 
these templates using your word processor.  
 
If you look at the included Table of Contents template, all the 
templates in the Proposal Pack are grouped in order to assist you 
in selecting which documents to use and what order to use them 
in. The Proposal Pack HTML organizer also lists all the templates in 
the same consistent order. Note that these examples and default 
orderings of the proposal pages are only examples and 

https://www.proposalkit.com/htm/videos-the-perfect-proposal-kit.htm
https://www.proposalkit.com/htm/videos-the-perfect-proposal-kit.htm
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suggestions. You may organize the proposal and use the 
templates in any order and combination you see fit.  
 
These diagrams show that regardless of the industry or type of 
proposal being created a similar framework is used, usually 
starting with the basics of a Cover Letter, Title Page, Executive 
Summary and as many supporting templates as needed in each 
case. Make sure to review all the included samples which illustrate 
a wide variety of uses for the Proposal Packs. Also review the 
Proposal Writing Primer section of this manual for further details 
on the organization of a proposal.  
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Comprehensive collection of templates organized by category: 
 
Introduction Pages 

 Cover Letter 

 Title Page 

 Table of Contents 

 Non-Disclosure 

Client Pages 

 Executive Summary 

 (more body page chapters here) 

 Opportunities 

Project Pages 

 Expected Results 

 (more body page chapters here) 

 Project Summary 

Your Company Pages 

 Mission Statement 

 (more body page chapters here) 

 Qualifications 

Appendix Pages 

 List of Illustrations 

 (more body page chapters here) 

 RFP Cross Reference 
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Micro (or Letter) Proposal Example: 
 
The following diagram shows the anatomy of a micro project 
proposal using only 4 templates. This diagram is based on the 
sample included titled “Micro PowerPoint Project Proposal”. See 
the complete PDF version of the actual proposal in the included 
samples.  
 
This sample was created for pitching a PowerPoint development 
project. Since this was a small dollar amount project, most of the 
proposal was contained in a one page Executive Summary. A one 
page Cost Summary was included to show the costs of the project. 
A one page short form contract was included to spell out the terms 
of the agreement. 
 
Introduction Pages 

 Title Page 

Client Pages 

 Executive Summary 

 Cost Summary 

Project Pages 

 Contract and Terms 
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Small Proposal Example: 
 
The following diagram shows the anatomy of a small service 
proposal using nine templates. This diagram is based on the 
sample included titled “Accounting and Payroll Services Proposal”. 
See the complete PDF version of the actual proposal in the 
included samples.  
 
This sample was created for an accounting firm proposing its 
accounting and payroll services to a potential client. Since this was 
a more expensive project covering ongoing client services more 
templates were added. A one page Cost Summary was included to 
show the costs of the project including setup, monthly and yearly 
fees along with a custom contract and terms statement.  
 
Introduction Pages 

 Cover Letter 

 Title Page 

 Table of Contents 

Client Pages 

 Executive Summary 

 Client Operations 

Project Pages 

 Cost Summary 

 Contract and Terms 

 Benefits 

 Project Management 
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Medium Proposal Example: 
 
The following diagram shows the anatomy of a medium project 
proposal using eighteen templates. This diagram is based on the 
sample included titled “CD-ROM Development Proposal”. See the 
complete PDF version of the actual proposal in the included 
samples.  
 
This sample was created for pitching a marketing CD-ROM 
development project. Since this was a more expensive project 
(over $10,000), many more templates were added. The additional 
templates were added to clearly show that the company making 
the proposal is a leader in their area of expertise and has the 
experience and portfolio that is a perfect fit for the client’s needs. 
 
Introduction Pages 

 Cover Letter 

 Title Page 

 Table of Contents 

Client Pages 

 Executive Summary 

Project Pages 

 Benefits 

 Features 

 Technical Approach 

 Production Schedule 

 Deliverables 

 Cost Summary 

 Project Management 

 Training Plan 
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 Case Studies 

 Company History 

 Testimonials 

 References 

 Portfolio 

 Team Resume 
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PROPOSAL WRITING PRIMER  
 
https://www.proposalkit.com/htm/videos-the-perfect-proposal-
kit.htm 
 
Writing a good proposal takes planning and preparation. Your 
proposal may be your only chance to sell yourself to a prospective 
client, so spend the time you need to present your history, your 
analysis of the needs to be met, and your solution in a polished, 
professional manner. 
 
Depending on the complexity of the project under consideration, 
proposals may be as short as three pages of basic, straightforward 
information, or as long as one hundred pages filled with detailed 
research studies, projected results, and cost summaries. Proposal 
Pack includes templates for all the standard parts of a proposal. 
 
Whether concise or complex, all proposals must include the 
following basic information: 
 

 A discussion of the problem you are proposing to solve or the 
need you are proposing to meet. 

 Your qualifications to undertake the project. 

 A detailed description of what you propose to do to solve the 
problem or meet the need, including your proposed timetable 
and costs. 

 

https://www.proposalkit.com/htm/videos-the-perfect-proposal-kit.htm
https://www.proposalkit.com/htm/videos-the-perfect-proposal-kit.htm
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Some proposals, such as those submitted in response to a specific 
Request for Proposals (RFP), may need to meet strict guidelines 
spelled out by your prospective client. 
 
In many cases, to receive an invitation to submit a proposal, you'll 
need to send an inquiry letter first. Inquiry letters should be printed 
on your company's letterhead and should contain: 
 

 A brief summary of the problem or need. 

 A summary of information about your organization and how it is 
qualified to solve the problem or meet the need. 

 A request for permission to submit a full proposal. 

  
With the inquiry letter, you may also need to include an executive 
summary, which summarizes the highlights of your proposal. Your 
following full proposal will spell out the details. 
 
Use Proposal Pack's Inquiry.docx template for your inquiry letter, 
and, if needed, the ExecutiveSummary.docx template for your 
executive summary. You can read more about the executive 
summary in the following pages. 
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Here is a common order of documents in a proposal: 
 

 Cover Letter (Introduction templates) 

 Executive Summary (Client-centered templates) 

 Cost Summary 

 Needs Assessment Section 

 Goals and Objectives Section (Project-centered templates) 

 Methodology Section 

 Evaluation Section 

 Financial Section 

 Project Summary Section 

 Your Company Qualifications Section (Company-centered templates) 

 Appendices (Appendix templates) 

 
The following is a more detailed step-by-step discussion of how to 
put your proposal together using the Proposal Pack templates. 
 
Proposal Pack includes a very large collection of templates to 
cover most of your needs. Your proposal could be one page long 
to hundreds of pages long depending on many factors. The 
average business proposal is 10 to 15 pages long. Use your best 
judgment to determine which templates are suitable for your 
specific proposal. 
 
Start with a Cover Letter, Executive Summary and Cost Summary 
then continue adding pages as they relate to your client, project 
and proposal. 
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 Cover Letter 
 
Introduce yourself and your purpose. Like any good business 
letter, cover letters are typically printed on company letterhead. 
 
Use the CoverLetter.docx template for your cover letter. 

 Executive Summary 
 
Present the highlights of your proposal and how it will benefit 
this prospective client, then concisely state your qualifications 
for accomplishing this project. The executive summary is 
frequently the most often read section of a proposal: take the 
time to hone it to professional perfection. 
 
Use the ExecutiveSummary.docx template for your executive 
summary. 

 Cost Summary  
 
Sum up the costs for your proposal. If you're considering a 
complex project, list only broad categories here; save the 
details for later in the financial section. 
 
Use the CostSummary.docx template for your cost summary. 

 Needs Assessment Section (Problem Statement) 
 
Explain the problem or need you propose to address and then 
detail how you performed your analysis and reached your 
proposed solution. You may want to include statements about 
business opportunities, comparisons with competitors or a 
general discussion of the industry, or discussions of marketing 
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or operations issues. 
 
Choose from the Opportunities.docx, Competitive.docx, 
Industry.docx, Background.docx, Operations.docx and 
Market.docx templates as needed for this section. 

 Goals and Objectives Section 
 
This section describes the results you plan to accomplish and 
provides explanations of how your success will be measured. 
For example, you may want to discuss how a process will be 
streamlined, how sales will increase, or how customers will be 
more satisfied. 
 
Use the Results.docx, Statement.docx, Benefits.docx, 
Features.docx, Samples.docx, Deliverables.docx, and 
Services.docx templates as needed to flesh out the goals and 
objectives section of your proposal. 

 Methodology Section 
 
Here is where you get down to all the details. Describe the 
process you will use to carry out your proposal, making sure to 
address all parts of your plan. Include discussions of personnel 
and equipment needed, the project schedule and milestones, 
the constraints and assumptions you're working with, and any 
other information your client needs to understand precisely 
what you propose to do. 
 
Use the Technical.docx, Schedule.docx, 
ProjectManagement.docx, MarketingPlan.docx, 
TestingPlan.docx, Integration.docx, InstallSchedule.docx, 
Training.docx, MaintenancePlan.docx, Legal.docx, Risk.docx, 
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Assumptions.docx, Storyboard.docx, Constraints.docx and 
Contingency.docx templates as needed for the methodology 
section. 

 Evaluation Section 
 
Explain how the success of your solution will be concretely 
measured, by whom, and when these tests will be performed. 
For a complex project, you may need to include milestones 
along the way. 
 
Use the Requirements.docx, Documentation.docx, 
Interface.docx and Accept.docx templates as needed to cover 
the evaluation sections of the proposal. 

 Financial Section 
 
In the previous Cost Summary, you listed the total cost of your 
proposal, and perhaps the major cost categories as well. In this 
section, present the details that demonstrate how you arrived at 
your total cost. Be sure to include all items the prospective 
client will pay for, as well as any discussion needed to show 
how you arrived at the budget figures listed.  
 
Use the CostBenefit.docx, SuppliedMaterial.docx, 
Equipment.docx, HardSoft.docx, Payment.docx, Contract.docx, 
WorkOrder.docx, WorkOrder2.docx templates as needed to 
cover the financial section of the proposal. 

 Project Summary Section 
 
Here's your final chance to sell your proposal again. Concisely 
describe the problem to be tackled, and then sum up the 
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highlights of your proposed solution, and how your proposal will 
meet the client's needs. 
 
Use the Summary.docx and Recommend.docx templates for 
your project summary.  

 Your Company Qualifications Section 
 
What makes you qualified to take on this project? Describe your 
history, other similar and successful projects, and other clients 
as needed to show that you are the perfect choice to get the job 
done.  
 
Proposal Pack includes many templates for your qualifications, 
including but not limited to: MissionStatement.docx, 
Qualifications.docx, QualityControl.docx, CaseStudy.docx, 
CompanyHistory.docx, Products.docx, Future.docx, 
ExecBio.docx, Testimonial.docx, References.docx, 
Portfolio.docx, Resume.docx. 

 Appendices 
 
Attach any details you need to complete your proposal. These 
might include legal papers for your company, lists of personnel, 
financial statements, testimonials, charts, blueprints—anything 
you require to provide all the information your client needs to 
decide. 
 
There are many templates to use for your appendices, including 
but not limited to: Illustrations.docx, Acronyms.docx, 
Benchmark.docx, RefMaterial.docx, Financial.docx, 
CrossRef.docx, Disclaimers.docx and Warranty.docx. 
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HOW TO SELECT TEMPLATES: THE TOP 5 / 
TOP 40 RULE 
 
There are thousands of proposal templates to choose from in a 
Proposal Pack (the Wizard by itself includes a small basic set of 
templates). Because any type of proposal for any industry, any 
business situation, and any size of proposal can be written with a 
Proposal Pack, we need a large collection of templates to cover 
everyone. 
 
The trick is then to figure out what small set of templates are best 
suited for your situation and how to efficiently find them. 
 
Technically, using Proposal Pack is very easy. It is nothing more 
than opening some documents and typing in your word processor 
after using the Wizard to assemble the selected templates 
together. The hard part is wrapping your head around the large 
amount of material and deciding what parts to use. 
 
A very short proposal may be 1-3 pages long for a short form quote 
or bid, an average size proposal may be 5-15 pages long, a 
government grant could be 30-80 pages long. 

 Start by looking at the large collection of samples. There are 
many samples which you can use to get ideas from. Samples 
will show you how other people selected templates, assembled 
them together in a specific order and filled them out. They will 
give you ideas on what templates you might want to select. 
Samples Proposals are the PDF documents included with the 
large collection of editable templates. Samples do not come 
with the Wizard, they are in the Proposal Pack template 
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collections. Find the samples by opening the Proposal Pack 
desktop organizer. 

 Then consider using these Top 5 most commonly used 
templates first: 

 Cover Letter 

 Title Page 

 Table of Contents 

 Executive Summary 

 Cost Summary  

 Then consider templates from the Top 40 most commonly used 
list: 

 Non-Disclosure Form (Short Version) 

 Introduction 

 Estimate 

 Needs Assessment 

 Opportunities 

 Market and Audience 

 Goals and Objectives 

 What You Can Expect 

 Statement of Work 

 Expected Results 

 Benefits 

 Features 

 Project Deliverables 

 Evaluation 

 Acceptance Criteria 

 Budget 

 Cost/Benefit Analysis 
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 Work Order (Without Deposit) 

 Work Order (With Deposit) 

 Hourly Services Contract 

 Invoice 

 Payment Schedule 

 Contract and Terms 

 Recommendations 

 Project Summary 

 Capabilities 

 Qualifications 

 Company History 

 Services Provided 

 Products 

 Comparison Chart 

 References 

 Company Operations 

 Financial Information 

 Reference Material 

 
When picking documents in the Pick Documents tabs, click the 
Top 40 button to narrow the large collection of templates down to 
just these Top 40. This will make finding these templates in the 
lists easier. 
 
This is only the default list of Top 40 templates for the General 
Business Proposal type. Each of the 12 Proposal Types has its own 
unique Top 40 set of templates (for example the Grant Proposal 
has a slightly different list, the Business Plan type has another 
slightly different list, etc.). You can also customize the Top 40 list to 
show your own personalized selection of templates. See this 
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chapter for details: How do I Setup my Own Top 40 List of 
Templates? 
 
 

 Finally, start looking through the rest of the entire collection of 
templates to find specialty templates that will fit your situation.  
 
If you know the name of the template(s) you are looking for you 
can also search for them by name using the Search by Name 
tab in the Wizard. 
 

You can search for specific templates by name using the search 
feature of the Proposal Pack PDF manual, by using the search 
feature of your web browser when you are viewing the complete 
list of templates in the Proposal Pack Desktop organizer, or by 
using your operating system Search feature to search for text 
across all the templates installed on your hard drive.  
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SELECT YOUR CHAPTERS WITH CHATGPT 
 
The Wizard has a tab in the Pick Documents screen that works 
with ChatGPT to get your project’s chapters selected 
automatically. 
 
While we have hundreds of human curated lists of proposal 
layouts in the Quick Start and View Samples tab you can use 
ChatGPT or another AI to generate a list of chapters for special 
use cases to speed up your chapter selection. 
 
This screen is designed to be used with our custom GPT ‘Business 
Proposal Outline Creator for Proposal Kit’. You will need a 
subscription to OpenAI to use this GPT. 
 
We do not directly link to any specific AI using an API which also 
means we don’t charge credits or have any extra fees for using 
this AI assistance feature. 
 
While we designed this feature to work with our custom GPT which 
is trained to use our list of thousands of chapter templates you 
may be able to use it with other AI models however results will 
vary. Even the custom OpenAI GPT has a mind of its own and will 
give chapter names that are not exact matches to our templates or 
will give its output in varying ways. 
 
The Wizard will process the AI response to pull out the chapter 
templates (based on all the ways we have seen it generate output 
so far) and will attempt to map as best possible mismatches to our 
templates. 
 

https://chatgpt.com/g/g-ythQ7pTv8-business-proposal-outline-creator-for-proposal-kit
https://chatgpt.com/g/g-ythQ7pTv8-business-proposal-outline-creator-for-proposal-kit
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If multiple pages may be applicable, you will have the option of 
selecting which template to use and updating the mappings to 
always use your selection in the future. 
 
If you paste in output from another AI, it may be in formatting we 
haven’t accounted for or may generate more mismatches that 
have to be manually mapped. 
 
To reduce problems with formatting the best way to input a list of 
chapters is in a comma separated list with each word capitalized. 
 
You can generate a report when the list has been imported and 
email it to us if you would like help mapping templates and to help 
use update our mappings or account for new formatting we 
haven’t seen yet. 
 
A handful of chapters that are almost always selected for 
proposals will be automatically added in case the AI doesn’t 
suggest them such as a Cover Letter, Executive Summary, Cost 
Summary and the front Title Page and the ending Back Page. 
 
Once the chapters are processed, they will all be automatically 
selected and you can further customize the list using the other 
tabs. 
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IT’S ALL ABOUT TRUST – WINNING 
PROPOSALS BY FIRST WINNING TRUST 
 
It’s a big impersonal world out there, especially on the Internet. 
The competition for attention is fierce. Anyone can slap together a 
price quote and a cover letter and ship them off via email, but 
that’s not a strategy that’s likely to succeed. 
 
So how do you create a proposal that will land your next customer 
or secure your business loan or grant money or get your project 
approved? We all want to do business with people we trust. Your 
proposal must convince readers that you are worthy of their trust. 
 
If possible, add a personal touch by requesting a face-to-face 
meeting to present your proposal. Shaking hands with the other 
party can go a long way toward finalizing a deal. But in-person 
meetings are not always possible, especially in the world of global 
business, so often your printed proposal needs to do all the work 
for you. 
 
How do you inspire trust? And particularly, how do you inspire trust 
in people who don’t know you at all? 
 
First, demonstrate that you have integrity and experience. To do 
this, provide honest, easily understood information about your 
background, your strengths, and your intentions. To do this with 
Proposal Kit, you could use the Company History, Credentials, 
Capabilities, and Awards and Achievements templates to describe 
yourself or your organization. Use concrete, straightforward 
language to describe how your proposal will benefit everyone 
(Opportunities and Benefits templates). 
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Clarity is important. Be sure to set forth clear expectations that 
both parties can understand, with results that can be measured. 
You may want to use the Goals and Objectives or Expected 
Results documents to provide a concise summary, and then use 
other pages to supply more explanation. Be as detailed as 
possible to ensure that you and the reader have a shared vision of 
what you are proposing. If you are responding to a request for 
proposal (RFP), show your thoroughness by carefully considering 
the information provided and by specifically addressing each 
requirement. If you are unclear about any requirement, get more 
information if possible so that you can include appropriate data 
instead of vague generalities.  
 
In every proposal, you should encourage feedback from the other 
party, and explain that you are willing to listen and modify plans as 
needed to make the project successful for everyone. 
 
Show your ability to complete the proposed project by explaining 
how and by whom the process will be accomplished. Proposal Kit 
products contain many templates you can use for this purpose, 
such as a Project Plan, Implementation Plan, Schedule of Events, 
and so forth. Describe the resources—such as equipment, financial 
backing, or experienced personnel—that you will employ for the 
project (Equipment, Facilities, Financial Information, and Personnel, 
just to name a few templates you might use).  
 
Be thorough. Demonstrate that you understand the complexity of 
the project under consideration. If blueprints, diagrams, or 
photographs would demonstrate your ideas better than words, be 
sure to add those (using templates such as Blueprints, Diagrams, 
Illustrations, Samples, etc.) 
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Establish your reputation by listing similar projects you have 
finished and recommendations from your satisfied business 
partners (Company History, Testimonials, Referrals, and 
References templates). If you have copies of complimentary 
newspaper or magazine articles about your company’s projects or 
history, you might want to include those as well. 
 
We are all more likely to trust others who hold themselves 
accountable for their actions. Legal contracts generally spell out 
the terms of accountability, and Proposal Kit contains many 
different types of contracts that you can adapt for your needs. You 
can also show your accountability by explaining how and when 
results will be analyzed. Some of the many templates available for 
this are Accountability, Testing Plan, Evaluation, Acceptance 
Criteria, and Reporting. Describe what you will do if wrongs need 
to be righted or the process needs to be changed. You might offer 
a guarantee of satisfaction or a warranty to fix any defects in a 
product—Proposal Kit includes Guarantee and Warranty templates 
for that purpose. 
 
If you are already allied with respected brands or organizations, 
highlight that (Brand Strategy or Strategic Alliances templates). 
Memberships in organizations with good reputations can go a long 
way to establish respectability—be sure to list any you belong to 
on the Accreditations template. 
 
If it’s appropriate, you may want to demonstrate your loyalty to 
good customers by providing a volume discount or other special 
offer. The Discounts template can be used for those descriptions. 
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Finally, we all tend to trust organizations and people who are good 
citizens. Do you donate to charity, lead a nonprofit organization, or 
lend a hand in your community? If so, point that out using the 
Donations or Contributions templates. Have you won any awards 
or experienced any publicity for your good deeds? Include any 
evidence that shows you are a contributor to a cause larger than 
your immediate organization.  
 
Presenting a proposal package that is full of errors will make even 
the best plans look unprofessional. Whenever possible, have 
others review your proposal and provide feedback, and get 
someone with a good eye to check your final version for grammar 
and spelling errors. Before you ship off the proposal, ensure that 
all pages are numbered appropriately, and all pieces are present 
and in order. Prospective partners will have more confidence in 
your ability to complete a project when you show that you are 
professional in your planning and presentation. 
 
Above all, be polite and show your respect in your Cover Letter by 
thanking prospective business partners in advance for their time 
and consideration and inviting their questions and feedback on 
your presentation. You may want to send a handwritten thank you 
note and follow up with a phone call. 
 
Use every aspect that your Proposal Kit product offers to help 
establish your credibility and dependability with your prospective 
business partners. 
 
Because it’s all about trust.  
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BOILERPLATE IS BAD FOR BUSINESS – 
TEMPLATES WITHOUT THE FLUFF 
 
It used to be that most business was conducted in person, or at 
least over the phone. Odds were that your prospective clients 
knew who you were, and your competition was local—you knew 
who they were, too. In that environment, it was possible to 
distinguish yourself from the competition by your personality. 
 
Now our world is global and connected mostly by impersonal 
means via email and the internet. Whether you’re vying for a job, 
trying to secure a loan or a business contract, or reaching out to 
new customers, odds are that your competitors will be many, and 
they can come from anywhere. 
 
Many of our competitors’ products feature proposal documents 
with a great deal of boilerplate text; their pages encourage you to 
‘fill in the blanks’ with your own information. This results in 
proposals that contain a lot of fluff but deliver little useful data. And 
worst of all, the proposal ends up looking and reading like 
hundreds—if not thousands—of others. This greatly increases the 
odds that the proposal will end up in the slush pile instead of on 
the decision maker’s desk. 
 
Proposal Pack takes a different approach from this ‘fill in the blank’ 
style. Instead of giving you paragraphs of essentially meaningless 
boilerplate text, we provide you with instructions, constructive 
suggestions, and examples of appropriate information to put into 
each proposal page, as well as a professional format you use to 
present your ideas. The words come from you, and so does the 
tone and style of your presentation. 
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You’ll never be perplexed about what to add to your proposal 
when you’re using Proposal Pack. We have an extensive library of 
template pages for you to choose from, and hundreds of 
suggestions on how to connect those pages and elaborate on 
important topics. Proposal Pack also includes hundreds of samples 
from a wide variety of organizations for all sorts of situations. By 
exploring these samples, you’ll see how our templates can be 
easily used and assembled into a unique package. 
 
You want your proposal to showcase your ideas, show your 
personality, and stand out from the crowd. Those are our goals, 
too. When you use Proposal Pack, your proposal will be easy to 
write. You’ll feel like an expert as you put your information on the 
pages. Your finished product will be well structured, easy to read, 
and best of all—it will be a proposal that represents you. 
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STAY OUT OF TROUBLE COPYING 
PROPOSAL EXAMPLES 
 
Why you should not copy someone else’s proposal example. A 
Best Practices article to help keep you out of trouble when you are 
writing your business proposal. 
 
From a Proposal Kit article by Pam Beason: 
 
I received a packet of information recently in the mail. The 
introductory letter started off like this: 
 
 

Dear Mr. Beason,  
 

We know you sometimes need temporary office help at WildWing Press. Did you 

know that you can hire a construction worker for just a day to handle the extra work? 

Our temporary service is here to give you help when you need it. We’ve enclosed a list 

of available services and prices, as well as information about some of our staff. After 

you’ve had a chance to read through our offerings, we’re sure that you’ll call 

Hard@Work Temps to learn how we can make your life easier. 
 
 
As a business owner, I file packets like this in my recycle bin. Why? 
Because I can tell that this is only a copy that is going out to 
thousands of other business owners. For one thing, I have multiple 
business licenses, so I got multiple copies. But even if I hadn’t, I 
could tell that the sender has substituted only a few words—my 
last name, the word “office,” and the name of my company—
because he forgot to change the font, so all the text would match. 
The sender clearly hasn’t bothered to check that I am a ‘Ms.’ not a 
‘Mr.’ And most telling of all, the sender forgot to take out the word 
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‘construction,’ and why would my publishing company need a 
construction worker? Does Hard@Work even employ construction 
workers, or is this a copy of another company’s proposal or 
proposal example that they found on the internet? 
 
I recognize that the person who created this proposal was not a 
writer but a copier. I have no doubt that Hard@Work Temps is 
sending the same package to thousands of other companies. As a 
matter of fact, I’m sure I’ll discover exactly that when I get together 
with local business owners at our next networking meeting. 
 
Did receiving this packet inspire me to use the services of 
Hard@Work Temps? No way. It makes me think that if the 
company is this lazy and careless in sending out proposals, they’ll 
probably be that lazy and careless in all their business dealings. 
 
I’m a professional writer and editor, and of course I re-use formats, 
proposal examples and basic information where it’s appropriate, 
but I start from scratch when I write, and I always proofread 
carefully to make sure that everything I’m sending out represents 
me and is intended for my specific client. Copying someone else’s 
proposal would be like copying someone else’s homework—it’s 
not ethical and it’s certainly not professional, and some telltale sign 
is bound to be left—mismatched writing styles, the wrong word, a 
name that doesn’t belong.  
 
Proposal Kit is designed around best practices, and one of those is 
that copying samples and proposal examples is not 
recommended. Any professional will tell you the same thing.  
 
Proposal Kit gives you all the tools you need to create good 
proposals and other business documents. The editable proposal 
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templates are full of suggestions and proposal examples for you to 
follow. The sample PDF proposal examples are not editable, but 
they provide you with great ideas of how to create your own 
proposal. Take those ideas and do what the sample writers did—
use Proposal Kit’s templates to generate your own unique 
proposal. 
 
Proposal Kit gives you a big head start, but you need to do the 
work of creating a document that represents you and is designed 
for your specific audience. A copied proposal or proposal example 
just won’t cut it when your proposal is not the only one on the 
client’s desk. If you are absolutely in love with a proposal example, 
you can copy and paste the text from the PDF file, but you run all 
the risks I mentioned above. 
 
The competition’s tough out there. Use Proposal Kit’s features to 
create your own personalized proposal. Then at the next 
networking meeting, instead of laughing about the latest crummy 
copy they all received, your clients and potential customers will be 
raving about your fantastic proposal.  
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FREQUENTLY ASKED QUESTIONS 
 
Q: How do I insert graphics?  
 
A: If you are inserting a new graphic into a Word document, click 
the “Insert > From File” menu option and pick your new graphic. 
We recommend using a 150 dpi transparent PNG format graphic. 
Try to avoid compressed JPG or GIF files as they might not print 
high quality. To position your logo, select the “Text Wrapping” 
option on the Picture toolbar when your logo is highlighted (after 
inserting it). Select the “in front of text” option. You can now drag 
your logo around the Word document. 
 
Transparent PNG graphics will also overlay background colors and 
graphics in cases where a more complex layout is being used. 
 
If you want to add your logo to the graphics, you must first edit the 
graphics in a program such as Adobe Photoshop or Adobe 
Illustrator. Save your edited graphics as a 150 dpi PNG file. Follow 
the instructions above to import your updated graphics back into 
the Word documents. The Proposal Pack Wizard can be used to 
automatically replace stock graphics already in the Proposal 
Packs. See the documentation section on creating your own 
custom graphics for details. 
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Q: Where are the files on my computer? 
 
A: When first installing the Proposal Pack Wizard, you were 
prompted to choose a location for installation and all associated 
files. This is where files are located. No desktop icon or application 
is launched during installation. All files are contained on your hard 
drive in the original folder you chose. The default install folder is 
“C:\Proposal Kit\Proposal Pack” 
 
Q: Where do I start? 
 
A: First review all the material to get an idea of what is included. 
Then review this documentation. See the 5 Minute Quick Start 
section in this manual on how to quickly create your proposal 
framework. 
 
Q: How do I edit the text in the page header graphics? 
 
A: The page header title text cannot be edited in Word. If you try to 
click the page headers, the entire box will be selected. Each page 
header is a graphic file imported into the template. You must use 
your graphics program to edit the page header titles. Once edited 
and saved, delete the existing page header graphic in the Word 
template and import the new one in the same location. The 
Proposal Pack Wizard can automatically delete the stock page title 
graphics and import your own custom versions. Also see the 
section in this manual titled Easily Create Your Own Graphic Style 
for instructions. 
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Q: Why are all the templates in separate files? 
 
A: Since there are a huge number of combinations of templates for 
any given proposal, the templates are best left in individual files. 
Using separate templates also allows you to have multiple people 
working on sections of the proposal. Future proposals can easily 
be put together using individual template files from existing 
proposals. The Proposal Pack Wizard can be used to automatically 
combine your selection of templates into a single master proposal 
and can create a custom Table of Contents.  
 
The Proposal Pack can also be used to create any kind of multi-
page business document such as information packets, instruction 
manuals, reports, studies, plans, resumes, business plans, RFPs, 
and so on. 
 
In order to create an unlimited number of complex documents the 
only way to do so is to keep every pre-written chapter in its own 
separate template. You can then select just the topics you need 
and assemble them into your own unique master template.  
 



299 

HOW DO I GET HELP CONFIGURING THE 
WIZARD? 
 
Most people use the Proposal Pack Wizard and Proposal Pack 
template products with the default settings of the Wizard. The 
most basic configuration changes (such as turning on/off 
messages, adding custom logos to be added to your Title Page, 
editing the default mail merge data, etc.) are straight forward. 
 
The Wizard interface help screens contain a lot of information to 
help with the most common situations. 
 
This manual will cover just about every major type of configuration 
scenario you might need. Look through the various chapters here 
first. 
 
While the Wizard does include many configuration options, and 
this may make it look very complicated, most people do not need 
to change the default settings. 
 
Proposal Pack Wizard is used by most people in its default 
configuration however there are many consultants and companies 
that have heavily customized the Wizard for specialized situations. 
Some examples are for teams of salespeople who only need 
access to portions of the material and they need some Wizard 
features disabled or hidden. Or maybe you need to setup multiple 
variations of price lists, products or services that a salesperson can 
pick from to build the proposal. 
 



300 

If you need help with complex custom configurations, hourly 
consulting services are available. You can contact us here for more 
information: 
 
https://www.proposalkit.com/htm/contact.htm 
 
Free product support for basic issues and software problems is 
available by email using our web site contact form. 
  
 

https://www.proposalkit.com/htm/contact.htm
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HOW DO I MANAGE THIS MUCH 
INFORMATION? 
 
With an extensive collection of templates available for your 
document some people get overwhelmed with the amount of 
material. 
 
Here are some tips for beginners to help deal with the task of 
writing a business proposal, business plan or other complex 
business document. 
 
With millions of proposals being written in many different business 
situations and industries it takes a core library of this many 
templates just to begin to cover everyone who uses Proposal Kit 
products. 
 
Nobody will use all the material; you may only pick 5, 10 or 20 
templates out of the available template library. The reason there 
are so many templates is that you need a large library to cover all 
the possible situations that may need to be written about. 
 

 Read the 5 Minute Quick Start chapter. 

 Look at the samples to get an idea of how others have written 
their proposals. The samples are only included in the retail 
Proposal Pack template collections. Look at your Proposal Pack 
Desktop Organizer for the links to the samples. Samples will 
give you ideas on what templates to pick and how to fill in the 
content. 
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 The Proposal Pack Wizard operates in Novice mode initially. 
Novice mode disables all of the more advanced features, so you 
don’t get off track with the basics of generating a proposal.  

 When you are picking documents in the Wizard you have 
access to the entire library of templates included in whatever 
template packs you have installed. To narrow down this list to 
only the most commonly used templates when using the Add 
Template tab click the Top 40 button. There are Top 40 lists 
covering many business situations to help you locate topics 
related to your situation. 

 If you are just writing a short quote, bid or contract use the 
“Contract” or “Short Form Quote” proposal types when you 
create a new document project. This will narrow down the 
volume of templates considerably. Read the chapter What are 
the 12 Proposal/Project Types? for more details. 

 Once you select your own set of templates in the Pick 
Documents screen, click the Presets tab and “Create New 
Preset from Selected Templates” button and save it as a named 
collection. Then whenever you return to this screen you can 
pick that entire set from the Load Templates from Preset button. 

 You can define your own custom selections of templates which 
will give you fast access to just the material you want to deal 
with daily. By default, you will have access to the entire 
collection of templates. Use the ‘Custom’ project type and 
configure it with a small subset of templates, then set the 
‘Custom’ project type as your default project type for all new 
proposals. Read the chapter How do I Setup My Own Short List 
of Templates? 
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HOW DO I MIGRATE FROM A PREVIOUS 
VERSION? 
 
Depending on how extensively you have configured your old 
Wizard, migrating your old data and configuration can be as easy 
as pushing a couple buttons or it could require a significant 
amount of manually copying documents and re-applying 
customizations. 
 
MIGRATING LEGACY FORMATS 
 
The Wizard and all Proposal Kit template packages now use 
current .DOCX and .XLSX format files. Older versions use legacy 
.DOC and .XLS format files. The files otherwise are still the same 
root names in the same folders. So, you can manually migrate 
custom versions of your old Proposal Kit files by saving them over 
the new files in the new format. 
 
For example, if you have a custom ExecSummary.doc template 
you want to keep using in the new format you can open that file 
and do a ‘Save As’ and save it over the top of our newer 
ExecSummary.docx template in the current Word Document 
format. 
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Old versions of the Wizard can be installed at the same time as 
new versions without interfering with each other. It may be safest 
to keep your old version installed then install the new version and 
make the same configuration changes to the new version such as 
custom Preferences settings. 
 
Next, determine if you have customized any of the stock 
templates.  You can copy any customized templates from the 
Documents/Word folder of one Proposal Pack version to another if 
you save them all in the new .docx file format. 
 
If you use the MyTemplates folder for your custom templates, then 
you do not need to do anything as this folder is shared across all 
versions of the Wizard. 
 
You should keep your old projects in the original folders and use 
the old Wizard to manage your old projects.  
 



305 

HOW DO I USE EXPERT/NOVICE MODE? 
 
By default, the Wizard first installs in Novice Mode. Novice Mode is 
intended for first time users to be able to quickly start creating 
proposals without being confused or distracted by the advanced 
features of the Wizard. 
 
In Novice Mode only the essential configuration options are 
enabled. The Wizard is still fully functional, you will just find that 
some of the configurable options have been disabled (the buttons, 
list boxes or checkboxes will appear grey and will not operate). 
 
To enable Expert Mode, use the Preferences screen and enable 
Expert Mode under the General Settings tab. Expert Mode will 
enable all of the configurable options which appeared grey in 
Novice Mode. 
 
If you are in a hurry to create a proposal leave the Wizard in 
Novice Mode, especially if you do not have the time or interest in 
reading documentation, which means you are probably not 
reading this anyway. 
 
When you are ready to start configuring the Wizard, adding your 
own custom templates, changing the ordering of documents, etc. 
you can enable Expert mode. 
 
Once you have built your first document in Novice Mode (and you 
are running the Expert Edition of the Wizard), the Wizard will 
automatically switch to Expert Mode. 
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HOW DO I USE THE WIZARD? 
 
To use the Proposal Pack Wizard, begin by setting up any installed 
Proposal Pack styles so the Wizard can access their documents. 
For each proposal to be created, first pick a style to use, create a 
document project, select a collection of documents to use and 
enter your company and client contact information. Finally click the 
OK, Save Project and Build Documents button then edit the 
created framework.  
 
The Proposal Pack Wizard automates the tedious task of managing 
the proposal framework setup. Once the framework is created, you 
can start editing the combined and merged proposal template to 
fill in your company, project and client specific information. 
 
The Proposal Pack Wizard will help guide you with pop-up 
information and help screens on each page with detailed 
information on how to use the various advanced features. Also see 
the specific chapters in this documentation on how to use specific 
features or accomplish specific tasks.  
 
Read the chapter 5 Minute Quick Start for a more detailed step by 
step on how to create your first proposal.  
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HOW DO I SETUP THE WIZARD? 
 
When you first install the Proposal Pack Wizard, it will be pre-
configured automatically by the installation process to operate as a 
single user system on a single computer. 
 
With the multiple user license, you can change the database paths 
to store the style database and/or the project database on a 
different computer. This allows you to have a single style database 
for all users and a single project database for all users. Each user 
will have to have their own copy of the Proposal Pack Wizard 
installed with a unique User Id number. Your serial number will 
determine how many users can be setup. Each individual user can 
have their style database local to their machine or on a network 
server. Each individual user can also have their project database 
local to their computer or on a network server. When first installed, 
the User Id always defaults to a unique system generated id and 
the style and project databases are local to the computer the 
Wizard was installed on. For network use read the chapter How do 
I Install and Configure for Use on a Network? 
 
To create your own documents, you will first have to set-up your 
Proposal Pack(s) and/or Proposal Kit in the Wizard. Proposal Pack 
and Proposal Kit templates must already be installed on your 
computer before you use the Wizard. See the section below on 
adding styles to the Wizard.  
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HOW DO I INSTALL IN WINDOWS S MODE? 
 
https://www.proposalkit.com/htm/videos-windows-10s.htm 
 
All our products will work on a Windows in S Mode PC as well as 
full versions of Windows. 
 
The only difference is how they are put onto a Windows in S Mode 
computer. 
 
The biggest issue with installing on Windows in S Mode is that you 
cannot run executable programs that did not come from the official 
Windows App Store. 
 
Because our products are template collections and Word add-in 
software that is built into a macro enabled Word document, they 
will all work once they are put onto a Windows in S Mode 
computer. 
 
How you do that is to download the .ZIP files from our download 
web page then uncompress them onto your computer as there are 
no restrictions in Windows in S Mode from downloading .ZIP files 
and copying documents to your computer. 
 
Once you download the .ZIP files for your Proposal Kit product(s) 
instead of the .EXE installers unzip them into a common folder 
such as C:\ProposalKit.  If you unzip everything into this default 
folder, it will make it easy for the Wizard to set itself up and locate 
all your template packages. 
 

https://www.proposalkit.com/htm/videos-windows-10s.htm
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You may have to also right click the Wizard’s Word document and 
in the General settings tab look for a checkbox or a button that 
says Unblock.  Click that to tell Windows in S Mode that you are 
explicitly allowing that file to run the embedded macros. 
 
The Wizard’s document is ProposalPackWizard_Win_V#.docm 
 
It will be in the ProposalKit\ProposalPack folder of the 
uncompressed .ZIP file. 
 
Make sure on Windows in S Mode to open this file, enable its 
macros then run the macro ProposalPack.Wizard.RunWizard from 
the Add-Ins tab. 
 
If you need to reset your registry keys for the Wizard in Windows in  
S Mode you can run the RunWizard-ResetRegistry macro from the 
Wizard document’s macros in the Word toolbar. 
 
There will be minor differences in how the Wizard operates 
between a full version of Windows and Windows in S Mode. 
 
One example is that the Windows App Store version of Microsoft 
Word cannot be launched from a desktop shortcut link. When run 
under Windows in S Mode the Wizard will create the ‘Run Proposal 
Pack Wizard’ desktop shortcut with only a link to open the Wizard’s 
document without launching the program automatically. 
 
When run under a full version of Windows the Wizard’s desktop 
shortcut link will open the document and launch the software 
automatically. 
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To run the Wizard program once the Wizard’s document has been 
opened using the ‘Run Proposal Pack Wizard’ desktop shortcut all 
you must do is click the Add-ins tab in the Word toolbar then click 
the RunWizard button. 
 
Because Windows in S Mode is a relatively new feature from 
Microsoft which is constantly being changed at the time of this 
writing there may be additional setup or usage issues not yet 
known. If you experience any issues using the Wizard or any 
Proposal Pack products in Windows in S Mode contact us for 
assistance. 
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HOW DO I MOVE TO A NEW COMPUTER? 
 
https://www.proposalkit.com/htm/videos-how-to-migrate-between-
computers.htm 
 
Proposal Pack Wizard stores many paths to folders and files in its 
Windows registry key and in many database files. 
 
For the Wizard to operate properly when moved to a new location 
such as a cloud drive or a new computer all the files and folders 
must still point to existing files and folders. 
 
If you drag and drop your entire Proposal Kit installation into the 
same drive letter and directory structure on the new computer will 
make this process much easier as those paths will not be broken. 
 
The Wizard tests all these paths in its registry and database files 
every time it runs. If any files or folders are missing the Wizard will 
start a repair process. 
 
The Wizard will first try to automatically repair the paths without 
intervention. It is best able to do this if you keep then entire 
Proposal Kit directory structure intact. 
 
If the Wizard’s registry key is missing it will also rebuild it to the 
factory settings. 
 
One example of how this works is if you installed the Proposal 
Pack Wizard and any template products to the default folder on 
your computer. In this case all files would be contained within the 
folder C:\ProposalKit 

https://www.proposalkit.com/htm/videos-how-to-migrate-between-computers.htm
https://www.proposalkit.com/htm/videos-how-to-migrate-between-computers.htm
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If you then drag and drop that folder to a new computer and put it 
in a folder on a different drive such as D:\MyProposals\ProposalKit 
All the paths in the database will still point to C:\ProposalKit which 
does not exist on the new computer. Plus, the registry key with 
default install paths and paths to where the database files are 
located will be missing on the new computer. 
 
When the Wizard is then run on the new computer it will see that 
there are many broken paths and that there is no registry anymore.  
At this point the Wizard will rebuild the registry then will attempt to 
repair all the database files replacing anything starting with 
C:\ProposalKit with D:\MyProposals\ProposalKit. 
 
If the Wizard is still unable to locate any missing files or folders 
which most commonly will happen if you have customized the 
Wizard to use external files such as links to your company logo or 
hooks into 3rd party systems folders and those files and folders 
were not copied to the new computer.  The Wizard will let you 
browse to those missing files and folders to reset them.  If the 
Wizard is still unable to locate missing files and folders it will start 
disabling custom features that depend on those missing files and 
folders, so the system will still be able to run and leave you to 
cleanup any missing or disabled content on your own later. 
 
This feature allows you to move the Proposal Kit to a new folder on 
the same computer it is installed on, to a new computer or to a 
networked drive with minimal setup problems so you do not have 
to do a fresh install from scratch and must take the time redoing 
any custom configurations. 
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To fix this you can either run the Windows S Mode version of the 
Wizard which does not include the 3rd party integration features. 
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HOW DO I RESET/RECOVER SETTINGS? 
 
The Wizard is installed with a backup of all the original 
configuration settings. 
 
If you need to reset the configuration settings to the original 
values, click the Reset to Defaults button on the affected screen. 
 
The Reset button will only reset the values for the screen being 
displayed; it will not affect any other screens not in view. 
 
The Wizard also stores some setup and configuration data in the 
Windows registry. If you are copying your Proposal Kit software 
from one computer to another you also should copy the Windows 
registry key for the Wizard. An alternative is to use the Preferences 
> Tools > Repair Registry function. The Repair Registry function will 
rebuild your Windows registry and reset it to the original default 
settings. The Wizard is also capable of rebuilding a missing 
registry. 
 
If your copy of the Proposal Pack Wizard had been corrupted to 
the point you cannot locate the files and folders, or they are in a 
corrupted state, you may have to reinstall the Proposal Pack 
Wizard from the original installer program. 
 
The Repair Registry tool is typically used when you have copied 
the entire install folder and all files as-is from one computer to 
another. Current versions of the Wizard can rebuild the registry 
key if it is missing. 
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To make a complete copy, you should also export the Proposal 
Pack Wizard registry key from the source computer and import it 
into the new computer. You may also have to edit paths in the 
imported registry if the source and destination folders are not 
identical. 
 
The Wizard registry key changes each version of the Wizard. 
Replace the ## with the version number of the Wizard: 
 
HKEY_CURRENT_USER\Software\ProposalPackWizV#  
 
The Wizard can rebuild its registry key and repair broken paths in 
the registry and in its database files. This can happen when 
copying an entire Proposal Kit installation from one computer to 
another computer. Especially if the directory structure or drive 
letters are different on the new computer. 
 
The Wizard tests all its paths in its database files and registry key 
and tests for the existence of its registry key every time it runs. If 
anything is missing it will start a repair process and try to repair any 
missing paths. If all the Proposal Kit product files are in the places 
the Wizard normally keeps them then the repair process should be 
able to seamlessly repair itself. 
 
If the testing and repairing tool needs to be bypassed for whatever 
reason you can set a string in the Wizard’s Options.ini file 
 
BypassPathTest = 1 
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You can also run a macro from the Word document’s macros 
called RunWizard-ResetRegistry which can be found in the Word 
toolbar tab for the document’s macros. 
 
This function was added to support the Wizard in Windows S Mode 
because you do not have access to the Windows registry directly 
using command line tools like regedit or 3rd party registry tools. 
This is due to security restrictions imposed by Microsoft in 
Windows S Mode. 
 
This function allows you to delete all the main keys in the Wizard’s 
registry that will force the Wizard to rebuild its entire registry from 
scratch the next time it is run.  This can come in handy if you have 
bad paths in the registry that cannot be easily edited. 
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HOW DO I INSTALL PROPOSAL PACK 
LOGO/GRAPHICS PACKS? 
 
You must first have a Proposal Pack style installed on your 
computer before using the Proposal Pack Wizard to create your 
own proposals if you want to have access to the full range of 
available templates.  
 
A Proposal Pack with custom logos is commonly referred to as a 
Proposal Graphics Pack, Proposal Pack Style or sometimes a 
“Skin”. All these terms are interchangeable and refer to our 
Proposal Pack product line. 
 
If you have purchased one or more Proposal Packs and/or 
Proposal Kits from https://www.proposalkit.com or a reseller, you 
must first follow the install instructions with those products to 
install them on your computer. 
 
Proposal Pack Wizard does come with a limited set of proposal 
templates from the Proposal Pack for Any Business style.  
 
The first time you run Proposal Pack Wizard it will ask to search 
your default c:\ProposalKit install folders the Proposal Packs are 
normally installed into. If any are found it will automatically set 
them up in the Wizard. If none are found, you can always manually 
search your hard drive (if they were installed after you ran the 
Wizard or if you installed them in a location other than the default 
locations). Use the “Document Styles” button on the main Wizard 
interface then choose the “Search for Styles” button to manually 
search for installed Proposal Pack styles. Any styles not already 
set-up in the Wizard will be added if found.  

https://www.proposalkit.com/
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If you have created your own custom style or have renamed the 
original Proposal Pack install folders to a new name that the 
Wizard cannot recognize, you can add them to the Wizard. Click 
the “Add Style” button and manually set-up the style in the Wizard 
by browsing for the folders your Proposal templates and graphics 
are located in. 
 
The Wizard, in most cases, will be able to automatically find and 
set-up any known styles.  
 
The Wizard will detect and setup any new Proposal Packs it finds 
each time the Wizard is run if you ran the installer program on the 
same computer as you are running the Wizard on. 
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HOW DO I ADD A NEW DOCUMENT 
PROJECT? 
 
https://www.proposalkit.com/htm/videos-how-to-select-
chapters.htm 
 
This is how you create your proposal, business plan or other 
business document. To create a project, click the “Document 
Projects” button on the main organizer screen. Then click the “Add 
New Project” button. Enter a title for your project, follow the 
numbered buttons to select a collection of templates and enter 
your contact information. The basic tasks of creating a project are 
selecting the templates to be used to create the final documents 
and entering your company and client contact information. 
 
The Pick Documents button will take you to the screen where you 
can add templates, remove templates and change the order of 
templates. There are several tabs in this screen that are used in 
different ways to help you find and select documents. 
 
Here is the list of all available tabs and what they are used for: 
 

 Remove Templates 
 
This tab is very straight forward. It contains all the currently 
selected templates. You can remove templates by selecting 
them from the list and removing them. 

 Add Templates – By Category 
 
There are three different Add Templates tabs, but only one is 

https://www.proposalkit.com/htm/videos-how-to-select-chapters.htm
https://www.proposalkit.com/htm/videos-how-to-select-chapters.htm
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displayed at a time. This tab shows you all available templates 
broken up into major categories. Templates are displayed in the 
lists in a general order of how they usually fit together.  
 
Select a template from one of the drop down lists and add it to 
your project by clicking the Add Selected Template button. 
 
You can customize the default order of these templates using 
the Preferences > Project Settings > Configure Template Lists 
screen. 

 Add Templates – By Top 40 
 
This tab shows you the Top 40 most commonly used templates 
all on one screen with checkboxes. This makes it more efficient 
to quickly select the most common templates. You can also 
customize the Top 40 lists to show your own custom tailored 
Top 40 set of templates. 

 Add Templates – By Alphabetical 
 
This tab shows you all available templates in alphabetical order. 
This can make it easier to locate a specific template out of a 
large collection than using the category listing. 
 
Select a template from one of the drop down lists and add it to 
your project by clicking the Add Selected Template button. 

 Search by Name 
 
This tab allows you to search for a specific template out of the 
library of available templates. This may be the most efficient way 
to locate a template when you might only know one word to 
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describe it. Such as searching for “summary” to locate the 
Product Cost Summary or searching for “history” to locate the 
“Company History” template.  
 
This tab can also be used to show you other templates that are 
related to this one or that are alternative versions that might be 
more suited to your specific situation.  
 
This tab may be turned off in some situations, such as if you are 
using a very small collection of templates that doesn’t make 
sense to need search options to find templates in that small of a 
list. 
 
Do not try and search for complex descriptions using sentences. 
The searching is very basic and only matches words or strings 
exactly that occur in the document titles and short descriptions. 
If you type something like “baby sitting cost analysis proposal” 
you won’t find any matches. First, this search is too specific. 
Templates are generally very high level and won’t be so specific 
they would have a word like “baby” or “sitting” in them. Also, 
putting in a word like “proposal” will not find any matches. 
Templates are short and general topics you would find in a 
Table of Contents (i.e. Executive Summary, Benefits, Features, 
Company History, Cost Summary, etc.) and a word like 
“proposal” is a description of a completed document (i.e. not a 
single template/topic). So, in this case simplify the search terms 
by splitting the 2 words into 2 search fields and search for 
“cost” AND “analysis” which would result in a match for the 
“Cost/Benefit Analysis” template. 

 View Samples 
 
This tab allows you to select one of the completed samples and 
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build a list of templates for your project using the same 
templates that were used to create that sample. 
 
This only adds the same templates to your project that were 
used to create the sample; it does not copy any of the actual 
text from the sample into your project. Unless you click the 
“Import Content from Selected Sample” button. 
 
This can make it more efficient to setup a proposal for a specific 
situation. For example, if you are selling accounting services you 
can select the “Accounting and Payroll Services Proposal” from 
the samples list then click the “Import Content from Selected 
Sample” button and all 9 templates used in that sample will 
automatically be added to your project. You can also build up 
your list by adding templates from multiple samples to your 
project.  
 
This tab may be turned off in some situations, such as using 
custom project types with small collections of templates. 

 Auto Recommend 
 
This tab is primarily used as a training tool. It is similar to the 
View Samples tab, but it is simpler and more generic. Beginners 
can use it to get a general idea of what kinds of templates could 
be used for a variety of types and sizes of projects.  
 
Once you switch from Novice training mode to Expert mode this 
tab is turned off by default. 

 Add a Contract 
 
This tab is used when you have a Contract Pack template 
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collection installed. Contract Packs and Proposal Packs are 
separate products.  
 
While Proposal Pack template products do include a handful of 
basic and generic contracts and work orders, the Contract Pack 
template products contain large collections of very specialized 
contract documents. Use this tab to add a detailed contract to 
your project. 
 
There are also options to have the contract inserted into your 
main proposal or to have the contract created as a separate 
document from the main proposal.  
 
If this tab has been disabled and you later purchase and install a 
Contract Pack template product, this tab will be turned back on 
automatically. 

 Presets 
 
This tab is used to create and load preset collections of 
templates you have created. You can select a collection of 
templates, organize them in any order you like, even add a 
Contract Pack contract and save them all as a preset. 
 
You can even set one of your presets to auto-populate every 
new project with. For example, if every one of your proposals is 
virtually the same you can save time even having to come to the 
Presets tab and load the files from the preset by setting that 
preset to auto-populate new project with. Then, every time you 
add a new project it will already have those templates pre-
selected.  
 
You can have 40 different Presets for each of the 12 project 
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types (i.e. General Business Proposals, Grant Proposals, 
Business Plan Proposals, RFPs, Custom, etc.). 

 Title Page 
 
This tab is used to manage the Title Page Pack products which 
are sold and installed separately. A Title Page Pack gives you 
access to a much larger collection of pre-designed Title Page 
cover documents with different designs and color schemes. 
 
You can install and manage multiple Title Page Packs on one 
screen. 
 
You can also configure how the Title Page will be integrated 
into your master proposal, such as having it retain the plain text 
“Proposal” and “Description” elements or replacing them with 
custom graphics (if you have any installed) from a Proposal 
Graphics Pack. 
 
You can also elect to have a specific custom Title Page design 
used for all of your future projects you create. This will save you 
time having to reselect the custom Title Page design each time 
you create a new document.  

 Quick Start 
 
This tab is used to quickly load your project with a set of 
templates already pre-selected for hundreds of business 
situations. 
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Once you have selected your documents and entered your data, 
click “OK, Use Selected Templates” > “OK, Save Project and Build 
Documents” to return to the main Wizard Interface with the new 
project selected as the current project. 

The Wizard will create your document(s) when the project is saved 
and will then direct you to the document editing screen. 
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HOW DO I USE THE CLIENT AND 
COMPANY CRM DATABASE? 
 
https://www.proposalkit.com/htm/videos-company-client-crm-
database.htm 
 
https://www.proposalkit.com/htm/videos-how-to-import-crm-
data.htm 
 
There are two databases for holding lists of company contacts, 
client contacts and configuration settings. To manage these 
databases, click the Preferences > Data & Display > Edit Company 
& Client Database button. This is an Expert Edition feature. 
 
The Wizard database files this information is stored in are: 

 CompanyContacts.ini 

 ClientContacts.ini 

 
By default, all new projects have the company data populated with 
the information entered in the initial setup screen. This information 
can also be updated in the Wizard’s Preferences. 
 
Every time you create a new Document Project if you have filled in 
the Company Data and/or Client Data screens the Wizard will 
automatically add a new record to these databases if that 
information for the project is filled in and is unique. A record is 
unique if it has a First Name, Last Name and Company Name that 
doesn’t exist in the database. 
 

https://www.proposalkit.com/htm/videos-company-client-crm-database.htm
https://www.proposalkit.com/htm/videos-company-client-crm-database.htm
https://www.proposalkit.com/htm/videos-how-to-import-crm-data.htm
https://www.proposalkit.com/htm/videos-how-to-import-crm-data.htm
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The Company contacts database lets you create a list of multiple 
records you can pick from. This can be useful if you have more 
than one person who will be creating documents.  
 
The Client contacts database is a list of unique records from all 
your past projects. You can also add new records, delete records 
and edit records. 
 
Because these databases are separate from the project database, 
any additions, deletions or edits will not affect the project 
database. 
 
Records created during the saving of your projects will have the 
Nickname field set to a blank string. Using the Preferences screen, 
you can set unique nicknames on the records. This can also be 
used in conjunction with the Nicknames Only checkbox. If 
checked, only records you have added a unique nickname to will 
be shown. This is a way to create a specific list of records you want 
to be able to choose from in your projects. 
 
You can create a specific list of company employees and set the 
Nickname to their first names to populate the Company Data from. 
 
If you have a small number of cities you do business in you can 
create records with the basic information for each city such as the 
city name, state, zip code, area code, etc. and set the Nickname 
for the city.  This will let you more easily preload the Client Data 
screen for each new project with some default data. 
 
There are a couple special strings you can use in the data fields. If 
you put the string ‘BLANK’ (without quotes) in a data field that will 
tell the Wizard during assembly of a new document to replace the 
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entire <<xxx>> tag with a blank string.  Otherwise if you leave a 
data field an empty string it will leave the tag in the document. 
 
Another special string is ‘DEFAULT’ (without quotes). Using this 
string in a data field in the contact database will cause that field to 
not be overwritten when you load a record from the database. This 
can be helpful if you want to use the default in the preferences to 
hold some common information, but you only want the client or 
company database to overwrite some specific values. 
 
Another way to speed up the population of data in your projects is 
to use the Populate From drop down. You can set a specific record 
to always populate new projects with. This will save you the time of 
selecting a record from the drop down manually when creating 
each new project. 
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HOW DO I INTEGRATE WITH CONTRACT 
PACK? 
 
https://www.proposalkit.com/htm/videos-how-to-create-proposal-
and-contract-together.htm 
 
If you want to have your contract documents included as part of 
your proposal you can integrate your Contract Pack documents 
with the Proposal Pack Wizard. 
 
There are multiple ways to use Proposal Pack with your Contract 
Pack documents. Pick the method(s) that best fit your workflow. 
 
METHOD #1 
 
Proposal Pack Wizard will detect if you have a Contract Pack 
installed and will set it up as a “3rd Party” set of templates. This 
happens when the Wizard is run for the first time and searches for 
any Proposal Pack template collections and when you manually 
search for installed Proposal Pack styles from the “Document 
Styles” screen. You can find these settings in the “3rd Party” tab in 
the “Preferences” screen. 
 
When selecting documents in the “Pick Documents” screen use 
the “Add a Contract” tab to add a Contract Pack document. The 
contents of that specific contract will replace the content of the 
Proposal Pack “Contract and Terms” template in your proposal. 
Also, any referenced Exhibits/Schedules will be inserted along with 
the contract. 
 

https://www.proposalkit.com/htm/videos-how-to-create-proposal-and-contract-together.htm
https://www.proposalkit.com/htm/videos-how-to-create-proposal-and-contract-together.htm
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Any mail merge tags in the contract will also be replaced with the 
data you entered in the Document Project screens. 
 
You can configure this feature including disabling it, changing the 
path to where the Exhibits/Schedules are located and changing 
which Exhibits/Schedules are associated with the contracts. Click 
the Preferences button, then the Tools tab, then the “Configure 
Contract Files” button to configure this feature. 
 
METHOD #2 
 
You can use the Wizard to manage contracts by themselves (i.e. 
without a complete proposal. This is basically the same as Method 
#1 above, just simplified. Create a new project and set the 
proposal type to be the contract pack you have purchased such as 
“Contract Pack Pro Contracts”, “Web Freelancer Contracts”, 
“Photographer Contracts”, “Contractors Contracts” or “Human 
Resources Contracts”. Then add a contract template from the Pick 
Documents screens “Add a Contract” tab. When the proposal is 
created it will only consist of the selected contract.  
 
If you use this method and do not want the Proposal Pack graphic 
design added to the contracts go into the “3rd Party” tab in the 
“Preferences” screen and uncheck the box for using the Proposal 
Pack headers. 
 
METHOD #3 
 
https://www.proposalkit.com/htm/videos-how-to-add-new-
documents-to-project.htm 
 

https://www.proposalkit.com/htm/videos-how-to-add-new-documents-to-project.htm
https://www.proposalkit.com/htm/videos-how-to-add-new-documents-to-project.htm
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Using the Expert Edition of the Wizard from the Edit Current 
Document screen you can click the Add Legal Contract button to 
add any installed Contract Pack template to your existing project. 
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HOW DO I INTEGRATE WITH ESTIMATE 
PACK? 
 
https://www.proposalkit.com/htm/videos-how-to-add-new-
documents-to-project.htm 
 
Estimate Pack is a library of extra documents and spreadsheets 
included with the Proposal Kit Professional bundle. 
 
The Wizard can add documents from this library into your projects 
and additional files from the Edit Current Document screen. 
 
This is an Expert Wizard feature. Both the Expert Edition of the 
Wizard and the Estimate Pack are included in the Proposal Kit 
Professional bundle. 
 
From the Edit Current Document screen click the button “Add 
Estimate Pack Spreadsheet”. 
 
Select any of the templates from the list and it will be copied to 
your project. 
 
If a Word template is selected it will also have the design theme of 
the currently selected Proposal Pack and any custom preferences 
applied to it including the color scheme, font types and bullet 
points. 
 
Templates added from the Estimate Pack will be copied to your 
project folder as individual documents. They will not be inserted 
into any documents already in your project folder.  

https://www.proposalkit.com/htm/videos-how-to-add-new-documents-to-project.htm
https://www.proposalkit.com/htm/videos-how-to-add-new-documents-to-project.htm
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HOW DO I INTEGRATE WITH PROJECT 
MANAGEMENT PACK? 
 
https://www.proposalkit.com/htm/videos-how-to-add-new-
documents-to-project.htm 
 
Project Management Pack is a library of extra documents and 
spreadsheets included with the Proposal Kit Professional bundle. 
 
The Wizard can add documents from this library into your projects 
and additional files from the Edit Current Document screen. 
 
This is an Expert Wizard feature. Both the Expert Edition of the 
Wizard and the Project Management Pack are included in the 
Proposal Kit Professional bundle. 
 
From the Edit Current Document screen click the button “Add 
Project Management Pack Document”. 
 
Select any of the templates from the list and it will be copied to 
your project. 
 
If a Word template is selected it will also have the design theme of 
the currently selected Proposal Pack and any custom preferences 
applied to it including the color scheme, font types and bullet 
points. 
 
Templates added from the Project Management Pack will be 
copied to your project folder as individual documents. They will 
not be inserted into any documents already in your project folder.  

https://www.proposalkit.com/htm/videos-how-to-add-new-documents-to-project.htm
https://www.proposalkit.com/htm/videos-how-to-add-new-documents-to-project.htm
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HOW DO I CREATE AN EDITABLE COPY OF 
ONE OF THE SAMPLES? 
 
https://www.proposalkit.com/htm/videos-create-editable-
sample.htm 
 
There are hundreds of completed samples included in each 
Proposal Pack and Proposal Kit Professional that include the 
Wizard software. 
 
These samples are the completed versions of other people’s work 
and are included in Adobe Acrobat PDF formatting to preserve the 
details including the graphic design theme. Because these are 
completed works created in design themes other than the design 
theme purchased and have been customized, they are not meant 
to be directly edited as-is. 
 
One of the features of the Wizard software is the ability to load in 
the text content of any of those hundreds of samples in placed of 
the boilerplate text content of the chapter templates. 
 
This allows you to create an editable version of any sample in the 
visual design theme you purchased. In addition, you can apply any 
other customizations the Wizard supports to create a customized 
version of the sample. 
 
In the View Samples tab of the Pick Documents screen when you 
are setting up your project you can click the button Import Content 
from Selected Sample. When you save the project and build the 
document the text content of the sample will be imported. 
  

https://www.proposalkit.com/htm/videos-create-editable-sample.htm
https://www.proposalkit.com/htm/videos-create-editable-sample.htm
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HOW DO I CREATE A PROPOSAL AND 
CONTRACT TOGETHER? 
 
https://www.proposalkit.com/htm/videos-how-to-create-proposal-
and-contract-together.htm 
 
If you have only a Proposal Pack set of templates installed, there 
are a handful of general contract and work order templates 
included. These are selected and added to your proposal just like 
any other proposal template. 
 
If you have also purchased a Contract Pack collection of detailed 
pre-written contracts such as those in Proposal Kit Professional or 
any of our Contract Packs, you can now manage these documents 
with Proposal Pack Wizard.  
 
This situation is for when you are creating both a business 
proposal and a contract at the same time, either combined or as 
separate documents. You will be able to include the contract in the 
proposal or you can keep your proposal and contract separate. 
There are multiple workflows you can use with Proposal Pack 
Wizard and Contract Packs such as: 
 

 Just creating a business proposal  

 Just creating a contract (see the next chapter) 

 Creating a proposal with the contract included in the proposal 

 Creating a proposal and the contract together but as separate documents. 

 Creating a proposal first then creating the contract later (see the next chapter) 

 
This chapter is for using Contract Pack templates with the Wizard 
(not the general Proposal Pack contract and work order templates). 

https://www.proposalkit.com/htm/videos-how-to-create-proposal-and-contract-together.htm
https://www.proposalkit.com/htm/videos-how-to-create-proposal-and-contract-together.htm
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First your Wizard must have detected and setup the Contract Pack 
in its database. If you installed Contract Pack after the Wizard has 
already been setup, use the Preferences > Tools > Search For 
Installs button. A message will be displayed if it has detected a 
Contract Pack. You can also click the Preferences > Third Party tab 
and check the Third Party settings to find which one the Contract 
Pack has been setup in. There must be an enabled third party 
setting for the contracts before they can be used by the Wizard. 
 
Now that all your products are installed and setup, go to the 
Wizard home screen and click the Document Projects button, then 
click the Add New Project button. Enter a project name and for the 
type of proposal to create select the General Business Proposal 
option. Click the Pick Documents button to start selecting 
templates. 
 
Now select the Add a Contract tab, select a contract from the drop 
down list and add it to your project. 
 
There are a few option checkboxes to configure how the contract 
will be created.  
 
If you do not want to have the Proposal Pack graphic header 
"Contract and Terms" inserted at the top of your contract 
document, uncheck the box "Use Proposal Pack graphic header". 
 
If you do not want to have the contract document processed and 
reformatted to match the proposal formatting, uncheck the box 
"Use Proposal Pack document processing". 
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If you want the contract included in the proposal, uncheck the box 
"Create the contract in a separate document". Some people 
include the contract in the proposal document, other people keep 
the documents separate. Select the workflow that best suits you.  
 
Continue selecting the rest of the documents that will go into your 
business proposal from the drop down lists (i.e. a Cover Letter, 
Title Page, Table of Contents, Executive Summary, etc.). 
 
When you have completed setting up the project click the “OK, 
Save Project and Build Documents” button on the project screen. 
When the process is complete click the “Edit Current Document” 
button on the Wizard home screen. 
 
Click the appropriate document in the list depending on if you 
created your contract separately or combined with the proposal. 
 
Once a project has been created and our main project documents 
are created you can add additional pages to your project using the 
Add Legal Contract button in the Edit Current Document screen. 
This allows you to add multiple templates from an installed 
Contract Pack or Proposal Kit Professional. 
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HOW DO I CREATE JUST A CONTRACT? 
 
If you have only a Proposal Pack set of templates installed, there 
are a handful of general contract and work order templates 
included. These are selected and added to your proposal just like 
any other proposal template. 
 
If you have also purchased a Contract Pack collection of detailed 
pre-written contracts such as those in Proposal Kit Professional or 
any of our Contract Packs, you can now manage these documents 
with Proposal Pack Wizard.  
 
This situation is for when you are just creating a single contract 
and not a complete business proposal. This also applies to when 
you have already created a proposal for a client and are creating 
the contract later. In both cases you need to create a new 
Document Project. 
 
This chapter is for using Contract Pack templates with the Wizard 
(not the general Proposal Pack contract and work order templates). 
 
First your Wizard must have detected and setup the Contract Pack 
in its database. If you installed Contract Pack after the Wizard has 
already been setup, use the Preferences > Tools > Search For 
Installs button. A message will be displayed if it has detected a 
Contract Pack. You can also click the Preferences > Third Party tab 
and check the Third Party settings to find which one the Contract 
Pack has been setup in. There must be an enabled third party 
setting for the contracts before they can be used by the Wizard. 
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Now that all your products are installed and setup, go to the 
Wizard home screen and click the Document Projects button, then 
click the Add New Project button. Enter a project name and select 
the Contract Pack option (6th item down on the list). Click the Pick 
Documents button to start selecting templates. 
 
Click the Add a Contract tab, select a contract from the drop down 
list and add it to your project. 
 
There are a few option checkboxes to configure how the contract 
will be created.  
 
If you do not want to have the Proposal Pack graphic header 
"Contract and Terms" inserted at the top of your contract 
document, uncheck the box "Use Proposal Pack graphic header". 
 
Check the box "Create the contract in a separate document". 
Some people include the contract in the proposal document, other 
people keep the documents separate. Select the workflow that 
best suits you. Since in this situation we are creating a contract all 
by itself leave the box checked. 
 
When you have completed setting up the project save the project 
with the “OK, Save Project and Build Documents” button. When 
the process is complete click the “Edit Current Document” button 
on the Wizard home screen then select the contract document in 
the list and open it for editing. 
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HOW DO I INTEGRATE WITH OUTLOOK? 
 
The Wizard’s Microsoft Outlook integration features require an 
updated version of Microsoft Word that includes the “Microsoft 
Outlook 16.0 Object Library”. 
 
If you have an outdated version of Word with an older Outlook 
library, it will not work. You will have to upgrade your Office 
software. 
 
There are multiple copies of the Wizard included. Only one of them 
includes the Outlook integration feature. Due to many different 
end user configurations that may or may not be compatible with 
the 3rd Party integration features the Wizard defaults to opening 
the Wizard without the integration features. 
 
To use the integration features you need to first ensure your 
system is compatible. Click the Preferences button then click the 
Integrations tab. There is a button to perform a compatibility 
check. This will check to see if the required object library is in your 
installation of Microsoft Word. 
 
If this check passes you can click the button to create a new 
desktop shortcut link that will open the version of the Wizard with 
the 3rd Party integration features. 
 
If your office software is outdated you will have to upgrade to a 
version of Microsoft Office with an updated Outlook object library. 
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HOW DO I IMPORT THE CONTENTS OF 
EXTERNAL FILES? 
 
https://www.proposalkit.com/htm/videos-how-to-use-data-merge-
tags.htm 
 
There are multiple ways to import files into Proposal Pack Wizard 
to support different needs. You can include your own documents 
in the Wizard interface and there are two ways to import the 
contents of external documents during the document assembly 
process. 
 
If you want to add your own custom documents so they are 
available as selectable options in the Wizard interface read this 
chapter: How do I Add New Documents to the Interface? 
 
Another method of importing external file is when you have setup 
the 3rd Party configuration settings to integrate with an external 
system such as a quoting application. In this situation the text 
contents of a specified Proposal Pack template are replaced with 
the contents of an external file when the specified template is part 
of your project. Read this chapter for details: How do I Integrate 
with 3rd Party Quotes/Invoices/Etc.? 
 
The third way to import the contents of an external file is to insert 
tags into your templates. This can be used to import an externally 
generated quote or to select from multiple contracts when you 
generate each new proposal. 
 

https://www.proposalkit.com/htm/videos-how-to-use-data-merge-tags.htm
https://www.proposalkit.com/htm/videos-how-to-use-data-merge-tags.htm
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There are three predefined tags you can include in your Proposal 
Pack templates: 
 
<<ImportFile>> 
<<ImportExcelFile>> 
<<ImportContractFile>> 
 
These tags are like mail merge tags in that they have a similar 
looking format however they cause the Wizard to display a browse 
dialog box when your document is being created. When you 
browse to a Word, RTF, or Text file (i.e. any file that Word can 
import text from) the contents of the document replace that tag in 
the exact location the tag was in your template.  
 
These tags will also allow you to import as OLE objects any file 
type. This allows you to import PDF files or any other file type that 
Word can import as an OLE object. 
 
For example, you might replace the stock contents of the Proposal 
Pack’s Estimate template (Estimate.docx) leaving just the header 
and footer information and put the tag <<ImportFile>> as the only 
text on the page. Then, when building your project documents, 
browse to and select a quote created in your accounting or 
quoting software. 
 

 You can include multiple import tags in a document. Each tag 
will cause a browse box to display allowing you select a 
document to import. If you cancel the browse box, no file will be 
imported. 
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 If you have multiple 3rd Party applications defined for file 
importing you will be prompted to import multiple times. If you 
cancel one browse box, the next 3rd Party application defined 
will be used to browse from. 

 The <<ImportContractFile>> tags are used before the mail 
merge process. This means you can include mail merge tags in 
the imported files. This is useful for importing from a collection 
of contracts where you still want to merge client data after the 
import. 

 The <<ImportFile>> and <<ImportExcelFile>> tags are used after 
the mail merge process. This is to ensure that complex imported 
documents do not adversely affect the performance of the 
Wizard’s mail merge process. 

 Use these tags when your master proposal is a single document 
that needs to import external files into it. This is used when the 
3rd Party document replacement will not work (as it requires all 
the templates to be separate and assembled for each new 
proposal). 

 This feature uses Word’s “Insert > Text from File” functionality. 
So only files that Word can import can be selected. 

 Do not include the import tags in a document’s header or footer.  

 Do not include the import tags in a Word shape object. 

 Do not include the import tags in the document being imported 
otherwise the Wizard will loop continuously importing the file 
into itself. 
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 You can disable the import file feature as well as configure how 
the import process works in the Wizard’s Preferences > Data 
and Display > Configure Import Tags screen. 
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HOW DO I INTEGRATE WITH 3RD PARTY 
QUOTES/INVOICES/ETC.? 
 
The Proposal Pack Wizard allows you to integrate documents 
created outside of the Proposal Packs/Wizard framework such as 
quotes, invoices, contracts, etc. 
 
There are multiple ways to use Proposal Pack with your 3rd party 
documents. Pick the method(s) that best fit your workflow. 
 
METHOD #1 
 
You can setup the Wizard to replace the contents of a specific 
template with the contents of a 3rd party document. You can find 
these settings in the “3rd Party” tab in the “Preferences” screen. 
 
Using this method, whenever you create a new proposal and 
select that template you will be prompted to select the specific 
document to include in the proposal when the proposal is created. 
Browse to the specific 3rd party document and select it. The 
contents of that document will replace the content of the Proposal 
Pack template in your proposal.  
 
For example, you can setup the 3rd Party preferences to have the 
“Estimate” template replaced with the output of your 3rd party 
quote generation application. Whenever you then create a new 
proposal and have selected the “Estimate” template, during the 
proposal generation you will be prompted to browse for and select 
a quote you have already created in your 3rd party quote 
application. Your proposal will then be created from the Proposal 
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Pack templates and the 3rd party quote will be automatically 
included. 
 
You can also use this feature to include 3rd party invoices, 
contracts or any other 3rd party document. Imported documents 
need to be in a format that Word can import text from such as 
.DOCX, .TXT, .RTF and so on. 
 
If you cancel the browse box during the assembly of the proposal, 
the default Proposal Pack template will be used. 
 
METHOD #2 
 
This method depends on the features of your 3rd party 
applications. You may be able to create your proposal framework 
using the Proposal Pack Wizard. Then use the completed proposal 
as a document in your 3rd party software.  
 
Your 3rd party software can then be used to fill in remaining 
information in the proposal such as detailed quotes and filling in 
merge tags with data pulled from other databases. 
 
The Wizard can automatically remap Proposal Pack mail merge 
tags to tags defined in other systems to make this process easier. 
See the chapter How do I Remap Mail Merge Tags for a 3rd Party 
System? 
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METHOD #3 
 
The Wizard can import the contents of files directly into your 
proposal as it is being generated using the <<ImportFile>> and 
<<ImportContractFile>> tags. This is like method #1 and sometimes 
is used in conjunction with method #1. 
 
METHOD #4 
 
You can use a more basic cut-n-paste method to insert the 
contents of a 3rd party document into your Proposal Pack Wizard 
created document. This is basic word processing and not a 
“feature” of the Proposal Pack Wizard. This may come in handy 
when piecing together a complex proposal where the parts are 
worked on by different people and/or software. 
 
METHOD #5 
 
If your proposal is being printed and does not have to all be 
included in a single document, you can print your 3rd party 
documents separately and then insert them into the printed 
material.  
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HOW DO I ADD A LINE ITEM QUOTE? 
 
The Wizard’s built-in line item database system is used 
automatically and nothing extra needs to be setup initially. 
 
See the Line Item Database Manual for all of the details of using 
the Wizard’s line item database for quotes, schedules and 
business plan financials, etc. 
 
All you need to do is click the Line Item Quote button in the project 
screen. If you have selected templates for your project that are line 
item database enabled the Wizard will add those database 
components to your project. 
 
If you select a premade database or import a Sample Proposal that 
has a custom database that will be assigned to your project 
automatically. 
 
Then you can start adding line items to your project which will be 
automatically output into your documents when you save your 
project and build your project documents.  
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HOW DO I INTEGRATE WITH 
QUOTEWERKS? 
 
https://www.proposalkit.com/htm/videos-quotewerks.htm 
 
TLDR – Here is the short version to get started. 
 
The Wizard has its own built-in line item database. If you use 
QuoteWerks or need a higher end quoting system you can use 
QuoteWerks along with Proposal Kit. 
 
Click the Wizard’s Preferences button and go to the QuoteWerks 
tab. Check the “Enable QuoteWerks” checkbox and set a folder for 
where you want to save the QuoteWerks layout files. You do not 
have to have QuoteWerks installed on the same computer. You 
can set the Save to Folder to any folder.  It can be on your local 
computer, a networked folder and if you do have QuoteWerks 
installed or accessible via a network drive you can set it to your 
actual QuoteWerks layout folder. 
 
If you do have QuoteWerks installed on the same computer, you 
will have additional functionality available. 
 
While in the Wizard’s Preferences click the Data & Display tab then 
click the Remap Mail Merge Tags button. On this screen check the 
Turn on mail merge remapping box and then select QuoteWerks 
from the drop down list next to the checkbox. 
 
These are the minimum setup steps in the Wizard Preferences. 
The next part is setting up the document projects.  
 

https://www.proposalkit.com/htm/videos-quotewerks.htm
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You can also click the Generate Docs for QuoteWerks button 
which will automatically set all the needed options across all 
Preferences screens needed to setup the Wizard to generate 
QuoteWerks layout files. 
 
When you create your document project you must make sure the 
Use Excel Dynamic Links box is unchecked. This is because you 
will be using QuoteWerks for your quote generation and not our 
linked Excel spreadsheets. When your document is generated, it 
will be ready to copy into your QuoteWerks layout folder and finish 
manually editing to add your QuoteWerks specific tags. 
 

The longer version 
 
The Proposal Pack Wizard integrates with the QuoteWerks quoting 
application. Multiple workflows are supported so you can import 
quotes created by QuoteWerks into your proposal, or you can 
work in QuoteWerks and use your Wizard created document as a 
Layout template in QuoteWerks. 
 
You can also create QuoteWerks layout files on a computer other 
than the one you have your QuoteWerks software installed on. 
 
If you look in your Preferences > 3rd Party screen you will see an 
entry for QuoteWerks listed (if it’s been installed and detected by 
the Wizard). 
 
You will also see a new screen: Preferences > QuoteWerks. This 
new tab defines additional QuoteWerks configurations settings 
that allow you to auto-run QuoteWerks and login with a specific 
user. 
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If QuoteWerks is installed on the same computer you can set the  
QuoteWerks Outbox folder for use when importing QuoteWerks 
created documents into your project during the Wizard’s assembly 
process. It will then save your Wizard created documents into the 
Layouts\Quotes folder for use when you are working within 
QuoteWerks. 
 
WORKFLOW #1: IMPORTING A QUOTEWERKS QUOTE 
INTO A PRE-DEFINED TEMPLATE. 
 
This workflow is used when you are using Proposal Pack Wizard to 
assemble multiple templates and the contents of one of those 
templates (i.e. the Estimate or Cost Summary template) is going to 
be replaced with the contents of a quote document that was 
created in QuoteWerks. 
 
When you create your project in Proposal Pack Wizard and you 
have QuoteWerks running at the same time with a current quote 
loaded, the Wizard will be able to import your logged-in user and 
current quote data (i.e. the name and address contact information) 
into your project. The Wizard will then be able to use this data 
during its mail merge process. 
 
The 3rd Party settings for QuoteWerks will be used which define 
what template will be imported into, what folder you will be initially 
shown for searching for the quote in, and if you want to retain the 
Proposal Pack graphic header, and so on. 
 
In this situation when the Wizard is assembling your proposal and 
you have added the defined template (in this example the 
Proposal Pack’s Estimate template) you will be prompted to 
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browse to a file. When you select the file (i.e. a quote document 
you saved in QuoteWerks in a Word .docx, .doc or .rtf format) the 
contents of that file will replace the stock contents of the Proposal 
Pack’s Estimate template.  
 
You can configure the 3rd Party settings to change the Estimate 
template to any other Proposal Pack template. 
 
One catch to this workflow is that it is used when you are 
assembling multiple documents together for each proposal. If you 
have pre-assembled a complete master proposal and are reusing 
it, then this workflow will not work. Use the next workflow when 
you need to import an external quote into a completely assembled 
master proposal template. 
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WORKFLOW #2: IMPORTING A QUOTEWERKS QUOTE 
INTO AN EXISTING MASTER PROPOSAL THAT ISN’T 
BEING REASSEMBLED. 
 
This workflow is used when you are using Proposal Pack Wizard 
with a master proposal template you have previously assembled 
and combined into a single document. Many people do not want to 
have to reassemble all the component pieces of their proposal for 
each new project, especially when the bulk of the proposals for 
each new client are the same. 
 
It is more efficient to create a master proposal from all the 
component Proposal Pack templates, make all your custom edits, 
but leave in the client name/address merge tags. Then import this 
combined master proposal back into the Wizard so it can be 
selected as a custom template. Read this chapter on how to do 
this: How do I Reuse a Previous Document Over Again? 
 
Because that pre-defined template in the 3rd Party settings is not 
used anymore as the master proposal isn’t being reassembled for 
future proposals, we need a different method for importing the 
quote. 
 
In this case you add the <<ImportFile>> tag to your combined 
master proposal. In our example, the Estimate will still be a topic 
page within the combined master proposal, so you would replace 
the content of that page of the proposal document with the 
<<ImportFile>> tag. 
 
When you create a new project in the Wizard and select this 
combined master proposal, the Wizard will detect the 
<<ImportFile>> tag and prompt you for a file to import. Since 
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QuoteWerks has been detected and configured in the 3rd Party 
preferences, it will start browsing for the QuoteWerks file in the 
folder defined in the 3rd Party fields (which should be the folder 
you typically save your QuoteWerks created documents in). 
 
The contents of the QuoteWerks created document will then be 
imported into your proposal. Read this chapter on using the 
<<ImportFile>> tag: How do I Import the Contents of External 
Files? 
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WORKFLOW #3: USING QUOTEWERKS TO GENERATE 
YOUR FINAL PROPOSAL USING YOUR PROPOSAL PACK 
CREATED MASTER PROPOSAL. 
 
This workflow is used when you are using Proposal Pack Wizard to 
create your master proposal document, but you want to switch 
over to the QuoteWerks application to do the final data mail 
merging and inserting of the Quote. 
 
The steps for this workflow are laid out in detail in the chapter 5 
Minute Quick Start QuoteWerks 
 
One difference in this workflow is that you will need to convert any 
Proposal Pack mail merge tags in your document to QuoteWerks 
mail merge tags since both systems use different tags. The 
Proposal Pack Wizard had an automatic tag remapping feature that 
will help with this process. 
 
To use this workflow, you need to enable the remapping feature 
and make sure the QuoteWerks set of remapping tags is selected 
in the Wizard’s Preferences > Data & Display > Remap Mail Merge 
Tags screen. 
 
Once enabled, when you generate/create your proposal 
documents in the Wizard, any mail merge tags in the remapping 
list will not be replaced with the actual client/company data in your 
Wizard database. Instead, those tags will be remapped to 
QuoteWerks tags. 
 
For example, the clients company name tag for Proposal Pack will 
be changed from <<CustCompany>> to 
<<&DH_SoldToCompany>>, and so on for all defined tags. 
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Once you have assembled your master proposal document and 
remapped the tags and completed your editing you will be ready 
to insert QuoteWerks specific tags into the document to be 
replaced by the quote generated by QuoteWerks. Since this is 
specific to the QuoteWerks application and is the same process 
you would use setting up any Layout document in QuoteWerks to 
include a quote refer to your QuoteWerks documentation or 
contact QuoteWerks support for assistance. 
 
The Wizard will replace the contents of our cost related pages with 
a QuoteWerks compatible table layout. You can control how this 
table is created in the Preferences > QuoteWerks tab in the 
Wizard. You can have the Wizard create a single table for all your 
QuoteWerks line items or you can have it create a separate table 
for each QuoteWerks Item Type each with its own subtotal. You 
can also edit the layout of the table before it is inserted if you want 
to add additional QuoteWerks tags or change the layout. 
 
The Proposal Pack Wizard had an additional screen to make it 
easier to move your documents over to QuoteWerks. After you 
have created your proposal documents and you are in the “Edit 
Current Document” screen you will see an extra tab titled 
“QuoteWerks”. Using this tab, you can select a document, and 
have it saved into your QuoteWerks Layout\Quote folder. To avoid 
duplication of file names you can select how you want your 
Proposal Kit generated files renamed when it saves them into 
QuoteWerks. 
 
At this point you would switch over to your QuoteWerks 
application. Your copied document will be automatically displayed 
as an available Layout file in QuoteWerks. Your use of the Wizard 
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and Proposal Pack for this document would end here and you 
would be operating entirely within your QuoteWerks environment. 
 
  



358 

KNOWN ISSUES WITH QUOTEWERKS (AT THE TIME OF 
THIS WRITING): 
 
These are issues found when QuoteWerks was used to perform 
the document assembly, merge and PDF conversion process and 
are not related directly to Proposal Pack Wizard. These issues do 
not occur when using Word’s PDF conversion or Adobe Acrobat 
PDF conversion. If any of these issues are important and cannot be 
resolved on the QuoteWerks side, you may have to use one of the 
workflows mentioned above. 
 
We recommend you only use the QuoteWerks Link tab and merge 
your QuoteWerks data into your layout file into a Word format 
document. Then use Word’s built in Save as PDF option or use 
Adobe Acrobat to create your PDF files. 
 
If you experience any of these issues, contact QuoteWerks for 
support with their software. 

 QuoteWerks uses a proprietary PDF conversion engine which 
does not properly convert all Word features. Some of those 
Word features are used by Proposal Pack. 

 QuoteWerks does not support transparency of .PNG graphics. 
Transparent logos against a colored background will display 
with a white background. 

 ZOrder of layered shape objects may change causing 
background colored shapes to move in front of text objects 
rendering them invisible. 

 Some embedded graphics may display artifacts when using the 
QuoteWerks Save as PDF/Preview. 
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 QuoteWerks Save as PDF/Preview does not support the custom 
bullet point graphics that Proposal Pack Wizard may include in 
your proposal. Your QuoteWerks saved PDF may show default 
circle bullet points instead of the custom graphics that Proposal 
Pack includes. 

 QuoteWerks Save as PDF/Preview does not support the auto-
updating Word Table of Contents.  

 QuoteWerks does not allow saving your document as a 
Word/RTF file when a Word Layout file is used. QuoteWerks 
saves straight to print or PDF. This means you do not have the 
ability to make final adjustments to your QuoteWerks created 
file before delivery. 

 When QuoteWerks creates a document that can be imported, it 
creates many individual Shape objects for every word and 
element of the quote. This can be unwieldy to manipulate 
manually. Make sure to define your quote layout so it does not 
have to be manually fine-tuned once it is output. Also, setup 
your output and Proposal Pack templates so when it is imported 
it does not have to be further manipulated to fix any formatting 
issues. 

 Another issue with the multiple Shape objects is that this can 
dramatically reduce the performance of the Proposal Pack 
Wizard’s mail merge processing. This is worked around by 
disabling the Wizard’s mail merge processing on the imported 
QuoteWerks documents by default. So, you should not include 
any mail merge tags in the final QuoteWerks output file that is to 
be imported into your Proposal Pack Wizard project. Also, when 
using the <<ImportFile>> tag, the Wizard performs this import 
operation AFTER it has done its own mail merge processing. 
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This will prevent the performance slow-down importing complex 
QuoteWerks documents that include many Shape objects. 

 Due to a bug in Microsoft Word the reformatting process 
required to convert Proposal Kit files to QuoteWerks compatible 
files may cause the ZOrder of a shape object to change in a 
small number of Proposal Pack design themes. This can be 
manually fixed by moving the shape object into the correct 
position and saving the document. 

 
 *** QuoteWerks is a 3rd party quoting application not sold by nor supported by Proposal Kit, Inc. 
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HOW DO I SETUP PRODUCTS INSTALLED 
AFTER THE WIZARD? 
 
The first time the Proposal Pack Wizard is run, it will search for the 
following externally installed products: 
 

 Proposal Packs (including those found in Proposal Kit Professional) 

 Contract Packs (including those found in Proposal Kit Professional) 

 Title Page Packs 

 3rd party applications which integrate with Proposal Pack Wizard 

 
If any of these products are installed after the Wizard has already 
been setup there are 2 ways to have the Wizard search for them. 
 
First, In the Document Styles screen, click the “Search for Styles” 
button. This option will ask you to select a root folder to search for 
installed Proposal Packs. By default, they will be installed in 
C:\ProposalKit on your hard drive.  
 
Second, In the Preferences screen, click the Tools tab, then click 
the “Search for Installs” button. This will perform the same search 
as above, except it will not ask for a location to search from, it will 
use the default installation folder for the Proposal Kit products. 
 
The Wizard will configure itself to integrate with and use any of the 
found products. 
 
The Proposal Pack Wizard will automatically detect newly installed 
Proposal Packs each time you run the Wizard.  
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HOW DO I REMAP MAIL MERGE TAGS FOR 
A 3RD PARTY SYSTEM? 
 
Proposal Pack Wizard can replace its built in mail merge tags with 
alternate tags. This feature is intended for use when you are using 
Proposal Pack and Wizard to create a proposal document which 
will be further edited by a 3rd party application.  
 
An example of this would be creating a base proposal document 
with your information that will normally be static such as company 
and industry information. Then loading the document into a 3rd 
party application which will be used to insert additional data into 
the proposal document such as automated pricing and quoting 
and data pulled from a 3rd party CRM system.  
 
To enable the tag remapping and to edit the tags to be mapped 
from and to, click the Preferences button on the main Wizard 
screen, then click the Data & Display tab, then click the Remap 
Mail Merge Tags button. 
 
If the 3rd party application has its own mail merge tags which are 
different than Proposal Pack's mail merge tags this feature will 
allow you to replace Proposal Pack mail merge tags with mail 
merge tags recognized by a 3rd party application. 
 
You must check the Enable box for Proposal Pack Wizard to do the 
remapping when it is generating your proposal. 
 
The Name of the application field is for your information only. It is 
not used by the Wizard, it is descriptive information. 
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The From fields are the Proposal Pack mail merge tags to be 
replaced. The To fields are the exact text you want to change the 
Proposal Pack mail merge tags to. The tag wrappers are not 
included in the From fields and they are included in the To fields. 
 
In order to remove a Proposal Pack mail merge tag (i.e. remove 
and not replace it with any data), set the To field to the word 
BLANK 
 
When Mail Merge remapping is enabled, no data from the 
Proposal Pack Wizard database will be merged to the Proposal 
Pack mail merge tags listed in the remapping screens. Instead the 
new mail merge tag will replace the original mail merge tag.  
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HOW DO I MAKE AN EDIT APPLY TO ALL 
FUTURE PROPOSALS? 
 
https://www.proposalkit.com/htm/videos-editing-stock-
templates.htm 
 
In order to have your edits apply to all future proposals you need 
to edit the source Proposal Pack style documents which are used 
to create each individual proposal. 
 
These are the documents which were installed on your hard drive 
when you installed Proposal Kit or a Proposal Pack. If you review 
the web page organizer that comes with Proposal Kit and each 
Proposal Pack, the links in the organizer point to the source 
templates on your hard drive. These are the exact same 
documents opened by the Manage Templates > Edit Stock 
Templates option in the Proposal Pack Wizard when editing the 
style templates. You can also open and edit the stock templates 
from within the Document Project’s Pick Documents screen. 
 
You can edit these documents without using the Wizard by finding 
and opening the Word documents in the Proposal Kit or Proposal 
Pack installation folder and editing them like any other Word 
document. 
 
You can also open the source documents for editing using the 
Proposal Pack Wizard. First select the style to edit from the 
“Document Styles” button on the main Wizard screen. Then click 
the “Edit Style” button after selecting the style. Click the tab that 
says “Manage Templates” and click the button on that tab that 
says “Edit Stock Templates”. You will then be able to pick 

https://www.proposalkit.com/htm/videos-editing-stock-templates.htm
https://www.proposalkit.com/htm/videos-editing-stock-templates.htm
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individual documents from the lists and open them. Once you 
make edits to these documents, every new proposal you create 
will have your edits included. 
 
This will not change any previously created proposals. 
 
The Proposal Pack templates are designed for use with this 
Wizard. It is possible to make alterations to the original source 
templates which will cause the Wizard to not operate as intended. 
Make a backup copy of your source templates before editing 
them. 
 
If the Wizard is not able to properly operate on your edited 
version, you may have to replace the original version and try a 
different variation on your edits. For example, if you change the 
font style on the body text the final formatting cleanup operation 
may not reformat that text; or if you change the name of the 
document file when saving it, the Wizard will not find your 
renamed file. 
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HOW DO I MAKE MY OWN TEMPLATE W/O 
CHANGING THE ORIGINAL? 
 
https://www.proposalkit.com/htm/videos-how-to-use-
mytemplates.htm 
 
This feature allows you to make your own custom version of any of 
our stock templates without having to edit our original template. 
This would be an alternative to editing our stock templates. 
 
This feature allows you to import your own content into any 
chapter template by copying your own version of the template into 
the MyTemplates folder. 
 
This eliminates the need to edit our stock templates if you want to 
keep your installed Proposal Kit templates untouched. This can 
also make migrating your system to a new version easier. 
 
This feature also allows you to keep a single copy of your chapter 
template content for use when switching between Proposal Pack 
design themes without having to edit the stock templates in each 
Proposal Pack style you use. 
 
The MyTemplates folder is in the root install folder where the 
Proposal Pack Wizard is installed. This folder by default is: 
 
C:\ProposalKit\ProposalPack\MyTemplates  
 
 
  

https://www.proposalkit.com/htm/videos-how-to-use-mytemplates.htm
https://www.proposalkit.com/htm/videos-how-to-use-mytemplates.htm
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Do not include any headers, footers, chapter page titles/logos or 
other design elements in the templates you put into the 
MyTemplates folder.  
 
Some templates are specific to the design theme or are auto 
generated and are not imported from the MyTemplates folder.  
These are Title Page, Back Page, Letterhead, Table of Contents, 
Envelope and Fax Cover Sheet. 
 
Templates in this folder must have file names that exactly match 
the template file names in the Proposal Pack. For example, if you 
use the About Us chapter you make a copy of the AboutUs.docx 
template from your Proposal Pack installation and remove the 
chapter header in bold text or the logo chapter header that is titled 
“About Us”. 
 
See the examples in the Examples subfolder for reference. 
 
Whenever you build a new document in the Wizard with any 
selected Proposal Pack design theme style, and you have the 
chapter selected that have a matching file in the MyTemplates 
folder then your copy in the MyTemplates folder will be inserted 
into the document replacing the stock template. 
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There are a few different ways for external content to be imported 
into the templates during assembly in the following order of 
precedence. 
 

1. 3rd party content from external sources such as QuoteWerks 
or a Contract Pack. This would typically be a specific cost 
page or legal contract page. 

2. Templates from the MyTemplates folder. 

3. Content from a selected sample being imported. 

 
 
Excel spreadsheets can also be copied into the MyTemplates 
folder to override the stock spreadsheets. You must have both the 
.xlsx and .docx files for the cost related template in the 
MyTemplates folder. For example, if you add the 
CostSummary.docx template to the MyTemplates folder you can 
also add a custom version of the CostSummaryCalculator.xlsx 
spreadsheet. 
 
The stock templates headers/footers, chapter header logo and 
chapter header text will still be used.  Only the body content of the 
page will be replaced. This allows you to use a single copy of a 
chapter template such as the About Us page with multiple 
Proposal Pack design themes. 
 
Another use of this feature is in network setups with a shared 
template library. The MyTemplates folder allows individual users to 
have their own customized versions of templates.  
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HOW TO GET TEMPLATES INTO THE MYTEMPLATES 
FOLDER? 
 
The best way to get templates into the MyTemplates folder is to 
use the Wizard screens to copy them from the main template 
library. 
 
The benefit of doing it this way is that they will be already setup 
structurally with the Proposal Kit Word Styles and the Wizard will 
make alterations to them to strip out any design elements when 
they are copied by the Wizard. 
 
There are two places in the Wizard for copying stock templates 
into the MyTemplates folder. 
 
First, click Button #1 – Document Styles > Edit Style > Manage 
Templates > Edit Stock Templates 
 
On this screen when you select any stock template click the Copy 
To MyTemplates Folder button to make a copy. The copy in the 
MyTemplates folder will have the header and footer information 
removed and optionally it can be further modified to remove colors 
and custom bullet points. If the template is used by the Multiple 
Choice database system, the associated Multiple Choice tag will 
also be added. This will put the copy in a state where it can be 
imported into any project using any Proposal Pack design theme 
and the design theme elements will be added back during 
assembly. This allows you to have a single copy of a custom 
template shared across multiple Proposal Pack design themes.  
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The second place to copy templates is in the project screen. Click 
Button #2 – Document Projects > Add New/Edit Selected Project > 
Pick Documents > Add Templates. Click the Show All Templates 
button. Use the Copy To MyTemplates Folder button which works 
as mentioned above. 
 
If you have selected chapters, you will be wanting to make copies 
of already in your project, the quick way to find them to make 
copies is click the Only show templates selected in my project 
checkbox. 
 
One difference when using this button on the Pick Document 
screen is it also gives you the ability to copy the sample proposals 
versions of the pages instead of the stock fill-in-the-blank 
template. 
 
If you have selected a sample from the View Samples tab and 
selected it to be imported into your project when you click the 
Copy To MyTemplates Folder button you will be given the option 
to copy the sample proposals version of the page. This is how you 
can make your own versions of the sample content for use in your 
future proposals. 
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HOW DO I USE THE MYPROJECTFILES 
FOLDER? 
 
The Wizard allows you to copy your own custom files that are not 
part of the Proposal Kit system into each of your new projects 
using the MyProjectFiles folder. 
 
This feature allows you to automatically copy your own content 
such as worksheets, checklists, letters, spreadsheets, forms, etc. 
into each of your new Proposal Pack Wizard project folders. 
 
The MyProjectFiles folder is in the root install folder where the 
Proposal Pack Wizard is installed. This folder by default is: 
 
C:\ProposalKit\ProposalPack\MyProjectFiles 
 
Whenever you build a new document in the Wizard a copy of all 
the files in the MyProjectFiles folder will be made into your 
document’s project folder. 
 
You should not name any of your custom files the same file names 
and extensions as any of Proposal Kit’s document file names. 
 
Use the Preferences > Project Settings > Configure MyProjectFiles 
Settings screen to manage adding files, removing files, and setting 
attributes for the custom files in the Wizard database. 
 
You can manually copy files into the MyProjectFiles folder however 
that will not setup any of the attributes such as human readable 
titles for use in the Wizard drop down menus. Use the Wizard’s 
Preferences tool for managing the attributes.  
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HOW DO I CHANGE/USE WORD FONT 
STYLES? 
 
https://www.proposalkit.com/htm/videos-change-fonts-
typography.htm 
 
There are two types of ways the text of your document is 
formatted with fonts, colors and sizes. These are both Word 
features. For more information read your Word manual on the 
subject of “Styles”. 
 
Direct formatting is mostly used in the Proposal Pack templates 
and Wizard reformatting process. Direct formatting is nothing more 
than what most people already do when editing a document. For 
example, you select a paragraph, and in your Word toolbar you 
select a font type or change the size or color. 
 
Word Styles are pre-defined font characteristics that defined a font 
type, size, color, bolding, underlining and other characteristics. 
You can then select a paragraph and apply a Word Style to it. One 
benefit is that you can instantly change all text in your document 
that is set to that “Style” by just changing the Style settings. The 
downside is that this can introduce unintended formatting changes 
if done incorrectly. 
 
The Wizard now supports the use of Word “Styles” in your 
documents as well as direct formatting.  
 
Word has two types of Styles. Built-in Styles are ones that are 
always part of Word such as the “Normal” or “Heading 1” styles. 
Custom styles are ones that are created externally. The 50 Styles 

https://www.proposalkit.com/htm/videos-change-fonts-typography.htm
https://www.proposalkit.com/htm/videos-change-fonts-typography.htm
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supported by the Wizard are custom styles that are inserted into 
your documents and made available in the Word Quick Styles 
menu. 
 
While most of the Wizard formatting will be done using the direct 
formatting method it does apply Word “Styles” in one case. When 
using a Table of Contents, the Wizard must apply a specific Word 
“Style” to the text headers on your chapter pages. The stock 
Proposal Pack templates with text headers (i.e. Proposal Pack for 
Any Business or Proposal Pack for Government Grants) have text 
headers set to Arial Black 28 point using direct formatting. 
 
The Wizard will change these headers by applying a Word Style to 
them. The Style name is “Proposal Kit Page Header” and can be 
found in your Word Toolbar’s Quick Styles menu. These custom 
styles will only be found in the documents assembled by the 
Wizard and saved to your project folder. 
 
The Wizard supports 50 custom pre-defined Word Styles that can 
be configured in the Wizard’s Preferences > Data & Display > Font 
Styles screen. By editing these pre-defined styles, you can change 
the font types, sizes, and colors used when the Wizard creates or 
reformats your documents. 
 
The following pre-defined Word Styles are as follows: 
 

 Proposal Kit Page Header  
 
This is used for the main heading text at the top of each 
Proposal Pack template (i.e. “Executive Summary”, “Company 
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History”, and so on). The Wizard sets the text headers to this 
style to support the auto-updating Table of Contents. 

 Proposal Kit Faux Page Header 
 
The same font settings as above but is for use in templates that 
will not be included in the Table of Contents. 

 Proposal Kit Body Text 
 
This is used for the body text of the document. By default, this is 
Times New Roman 11 point. This font style is used during the 
reformat process to reset the body text. 

 Proposal Kit Important Body Text 
 
Used for the main body text of paragraphs that are highlighted 
in red text for important notes. 

 Proposal Kit Sub Header 1 
 
This is used for larger sized bold headers within the body of a 
page. This style is not currently used by the Wizard. 

 Proposal Kit Sub Header 2 
 
This is used for smaller sized bold headers within the body of a 
page. This font style is used during the reformat process to 
reset the header text within the body of the document. 

 Proposal Kit Footers 
 
This is used for text contained in the footer of your documents. 
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Typically, it is a smaller size than the body text. This font style is 
used by the Wizard to reformat the page footers. 

 Proposal Kit Fine Print 
 
This is used for fine print paragraphs within the body of your 
document. This style is currently not used by the Wizard. 

 Proposal Kit Title Page 
 
This is reserved for use in the Title Page for address blocks and 
other elements of the title page. This style is currently not used 
by the Wizard. 

 Proposal Kit Table Text 1 
 
This is used for text in a table. The intent is to be used when you 
need text that is applied to a dark colored background. This 
style is used during the reformat process when white text is 
located. 

 Proposal Kit Table Text 2 
 
This is used for text in a table. The intent is to be used when you 
need text that is applied to a dark colored background. This 
style is currently not used by the Wizard. 

 Proposal Kit URL 
 
This is used by the Wizard when it is reformatting all the 
hyperlinks in your document. You can change the standard blue 
underlined text to be more creative. Note, if you put a URL in 
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your footer, the footer styling takes precedence. If this style is 
disabled, the Wizard will use the built-in Hyperlink style. 

 Proposal Kit Title Page Sub Header 
 
This is used in the Title Page to define the text of the 
“Description” element. Typically, you would set to the same font 
type as the “Proposal Kit Page Header”. This style is not 
currently used by the Wizard. 
 

 Proposal Kit Title Page Header 
 
This is used in the Title Page to define the text of the “Proposal” 
element. Typically, you would set to the same font type as the 
“Proposal Kit Page Header”. This style is not currently used by 
the Wizard. 

 Proposal Kit Pull Quote Text 
 
Used for text that is larger font type bold and emphasized 
typically for a short quote or statement that stands out. 

 Proposal Kit Custom Style 1 to 13 
 
These are for your use to define additional styles you want 
added to your documents. 

 
The Wizard also allows you to define the settings for built in Word 
“Styles”. The following styles have settings pre-defined for them. 
To turn off the resetting of these built-in Word “Styles” you can 
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disable them in the Wizard’s Preferences > Data & Display > Font 
Styles screen. 
 

   Normal 

   Heading 1 to Heading 9 

   TOC 1 and TOC 2 

   Title 

   Subtitle 

   Bullet 

   Hyperlink 

   Header 

   Footer 

   Page Number 

All these pre-defined Styles are added to your generated 
documents. You can use them as you see fit. Some Styles are 
reserved for future use by the Wizard, some are set aside as 
custom styles for your own use. You can disable any of these 
styles as well, which will prevent them from being added to your 
documents. However, that also means any disabled styles used by 
the Wizard will default to built-in styles, or may disable formatting 
features in the Wizard. 
 
The Wizard will also automatically add these custom Word Styles 
to any custom documents you add to the Wizard via the Configure 
Proposal Files tool. This tool allows you to add the Word Styles to 
a single external Word document or batch add them to an entire 
folder of Word documents. 
 
The Font Styles configuration preferences configuration screen 
also includes a tool to allow you to add all these custom Word 
Styles to any external Word document. This will allow you to apply 
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consistent formatting across other documents as well as making it 
easier to import custom documents into the Wizard all with 
consistent font styles. 
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HOW DO I CREATE MY DOCUMENT? 
 
https://www.proposalkit.com/htm/videos-pack-quick-start.htm 
 
Once you have selected a document style, added a document 
project, selected your desired templates and entered your 
company and client data, then you are ready to create your 
document framework. 
 
If you skip the creation process at that point you can start it later 
by editing the current project and saving it again. 
 
From the main Wizard screen click the Document Projects button, 
click Add New Project then click the Pick Documents button. Once 
you have chapters selected click the OK, Use Selected Templates 
button the click the OK, Save Project and Build Documents button. 
This will start the process of copying your selected templates from 
the source Proposal Pack style, merging your data and copying the 
documents to your new client folder. The creation process will also 
combine all the selected templates into a single document and 
create a custom Table of Contents (if selected). Once this process 
starts it may take a few minutes depending on the number of 
documents selected and features in use. 
 
At this point you can then click the “Edit Current Document” button 
to finish editing. The automated creation of the framework may 
require you to manually clean-up some of the templates. For 
example, there may be a Title Page graphic or footer graphic 
requiring repositioning, some text requiring the font size to be 
changed, or in some cases page numbering may be off on a page 

https://www.proposalkit.com/htm/videos-pack-quick-start.htm
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or two (caused by extra page breaks inserted during the combine 
process).  
 
If you turn on page numbering and the creation of a custom Table 
of Contents, you will still have to manually update the page 
numbers as pages change as this is a Word object. 
 
Your proposal framework is now ready to complete by filling in the 
details specific to your proposal. You can review the samples 
included in your Proposal Pack or Proposal Kit as illustrations of 
how other companies have created their final proposals using the 
Proposal Pack and Proposal Kit templates. See your Proposal Kit 
or Proposal Pack installation for the bundled samples. The 
samples are not included in the Wizard software. 
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HOW DO I ADD SUPPORTING 
DOCUMENTS TO MY PROJECT? 
 
https://www.proposalkit.com/htm/videos-how-to-add-new-
documents-to-project.htm 
 
https://www.proposalkit.com/htm/videos-add-linked-invoice.htm 
 
Many times, there are situations where you could use supporting 
documents to go along with main document (proposal, business 
plan, report, etc.). 
 
Using the Wizard’s Expert Edition, you can add additional 
documents to your project right from the Edit Current Document 
screen button on the Wizard home screen. 
 
You can add an invoice which will also be directly linked to the 
same spreadsheet as the Cost Summary if you are using the 
Dynamic Excel Spreadsheet linking feature. 
 
You can add any number of letters or checklists such as customer 
thank you and follow-up letters. 
 
You can add a legal contract, estimate spreadsheet or a project 
management document from the libraries of templates contained 
in the Proposal Kit Professional. 
 
All these supporting documents will be created as additional 
documents in your project folder. 
 

https://www.proposalkit.com/htm/videos-how-to-add-new-documents-to-project.htm
https://www.proposalkit.com/htm/videos-how-to-add-new-documents-to-project.htm
https://www.proposalkit.com/htm/videos-add-linked-invoice.htm
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HOW DO I ADD INVOICE LINKED TO 
EXISTING COST OR ESTIMATE? 
 
https://www.proposalkit.com/htm/videos-add-linked-invoice.htm 
 
The Expert Edition of the Wizard software allows you to add an 
invoice to an existing project such as a proposal or estimate 
document. 
 
In the Edit Current Document screen there is an Add Invoice 
button you can click that will add the invoice template to your 
project. The Wizard will apply its normal customizations that it 
would have applied to the original document such as color, font, 
logo changes. It will also apply the Company Data and Client Data 
merge fields. 
 
If you do not use the Dynamic Excel Spreadsheet Linking feature 
the invoice will be copied into your project folder as a separate 
document that you must manually edit in Word to fill in any line 
items and prices. 
 
If you are using Dynamic Excel Spreadsheet Linking the Wizard will 
see if you already have a Cost Summary, Estimate or any of the 
other standard cost related templates and spreadsheets in your 
project. If so, it will remap the Invoice templates <<R#C#>> tags to 
match those of the cost templates and link the new Invoice 
document directly to the existing cost or estimate calculator 
spreadsheet. 
 
If you have modified the structure of the stock spreadsheet the 
remapping may not link to the correct cells. In this case you may 

https://www.proposalkit.com/htm/videos-add-linked-invoice.htm
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need to manually update the <<R#C#>> tags in the Invoice 
template to match whatever cells you are now using.  
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HOW DO I USE MULTIPLE CHOICE FIELDS? 
 
https://www.proposalkit.com/htm/videos-how-to-use-multiple-
choice-database.htm 
 
The multiple choice features allow you to define lists of multiple 
choice content you can pick from at the time your document is 
assembled and have the chosen content inserted into specific 
locations in the assembled document. 
 
You can hide the multiple choice feature from being seen by the 
end user by unchecking the Enable box. You can also hide the 
preview/edit button from the end user if you do not want the end 
user to be able to change the multiple choice paragraphs from the 
project screen. Another customization feature is the ability to turn 
off the auto-selection of templates used with multiple choice tags. 
By default, whenever you create a new project the Wizard will 
auto-select any templates you have defined attached to multiple 
choice tags to help ensure you do not forget what templates you 
have setup. 
 
This feature is useful for having multiple choice lists of products, 
services, team members, photographs, spreadsheets, parts lists 
and so on. 
 
The multiple choice features allow you to not only define custom 
paragraphs of text to pick from, your multiple choice selections can 
be images, spreadsheets, PDF files and even complete multi-page 
documents. 
 

https://www.proposalkit.com/htm/videos-how-to-use-multiple-choice-database.htm
https://www.proposalkit.com/htm/videos-how-to-use-multiple-choice-database.htm
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The Project Type field is only for use if you are using custom lists 
of documents or have added custom templates of your own into 
the Wizard database and need to change the project type, so your 
custom templates are visible in the Edit Selected Tag screen.  
 
Previously this type of multiple choice option was performed by 
having to create multiple copies of entire templates and then pick 
one of multiple templates for your project. This multiple choice 
feature allows for much more flexibility in setting up multiple 
choice lists. 
 
The way the multiple choice feature works is that you can have up 
to 10 categories which are ways of categorizing your tags into 
major types of usage. For example, some tags can be for product 
information, some for services and so on. You can define what all 
the categories are used for. 
 
Each category has several tags. A tag is added to one or more 
templates to tell the Wizard that a multiple choice item will need to 
be inserted into a specific location in one or more templates as 
they are being assembled.  
 
You can define your tags to be single select or multiple select. A 
single select (default) tag only will allow you to select a single 
‘paragraph’ to be inserted into that tag. A multiple select tag allows 
you to pick more than one paragraph from the pick list and all the 
selections will be inserted one after the other in place of the single 
tag in the template. If using multiple select tags you can also pick 
what you want inserted between each paragraph item. A custom 
file in the ParagraphFiles folder called DefaultDelimiterFile.docx 
can be used to completely customize what you want inserted 
between multiple items (this is how you would add custom 



386 

separator lines, text, etc.). If you have selected the ‘Custom’ entry 
from the drop down list you then must edit the 
DefaultDelimiterFile.docx file to customize that file. 
 
The piece that defines the actual choices are called 'paragraphs'. 
A paragraph is any content that the users picks that is then 
inserted into the assembled document. A paragraph can be as 
simple as a paragraph of text or it can be as complex as an entire 
multi-page Word document, spreadsheet, graphic image, PDF file, 
etc. 
 
You create multiple paragraphs per tag depending on how many 
choices you need. 
 
If you want a specific item(s) to always be pre-selected when you 
create new projects, then check the ‘Default Selection’ checkbox 
in the paragraph edit screen. 
 
If your external content file is a graphic image you can also define 
the image wrapping, scaling factor and positioning. The scaling 
factor ‘1’ will leave the image alone as will setting it to ‘100%’. You 
can use fractions or percentages. For example, 1.5 is the same as 
150%. 
 
For example, if you want the end user to be able to select 1 of 5 
different products to be added to the products template you would 
setup 1 tag and add 5 paragraphs to it. Each paragraph you will 
setup for a different product.  
 
If you want the end user to be able to select one of 3 photographs 
to be inserted into a samples page, you would setup a 2nd tag 
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with 3 paragraphs. Each paragraph will be linked to a separate 
image file. 
 
Multiple choice categories are a way for you to organize different 
tags for different purposes. There are 15 categories. You can 
change the category names to anything that suits your purposes.  
 
Enabled categories will be displayed in the project screen that the 
end user uses when making their multiple choice selections. You 
can reduce the amount of information the end user sees in the 
project screen by disabling unused categories. 
 
For example, if you are only going to be adding multiple choice 
options to a products page, you can disable all the other 
categories. 
 
The names you give the categories are for your use only and will 
only be used in the Wizard interface screens. The categories do 
not have any effect on how your proposals are created. 
 
Multiple choice tags are used to tell the Wizard where your 
multiple choice picked content will be inserted into your document 
when the Wizard assembles it. 
 
First you pick a Category, then under that category pick one of the 
tags. Each category as several pre-defined tags ready to use. All 
you must do is pick the first tag listed under that category to get 
started. 
 
Once you pick a tag to use you need to tell the Wizard what page 
(or pages) that tag is being inserted into. It is important to both pick 
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the templates the tag will be used in and open and edit those 
templates to insert the tag where you want it. 
 
The tag Label is for your information only. The Label is only used in 
the Wizard drop down menus, so you can see what each tag 
means to you. Give the tag a label that has some meaning for how 
you will be using it. For example, "Catering Menu Options" or "Web 
Site Design Services", and so on. 
 
The tag field can be kept as the default value or you can modify it 
to make more sense in your contextual use. For example, the 
default tag may be "MultipleChoice-1". You might rename it to say 
"MultipleChoice-MenuOptions" or "MultipleChoice-
DesignServices". 
 
You can use the tag in up to 20 different templates. This may 
come in handy if you want to select from a list of choices and have 
that choice populated in multiple areas of the proposal. For 
example, you may select a person's name to be inserted in 
multiple places, or a list of product codes to be put into both the 
products page and a contract's deliverables section at the same 
time. 
 
The most important thing to setup correctly is that you must also 
open the templates that you selected and edit them to insert the 
actual tag in the delimiter brackets into the location(s) the Wizard is 
to insert your custom content into. For example, if you select the 
tag "MultipleChoice-1" to be assigned to the Products template and 
the Contract and Terms template you must select both of those 
templates from the Used In list. Then you must also click the Edit 
Selected Templates button to open those templates and insert the 
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text "<<MultipleChoice-1>>" (without the quotes) into the templates 
and save the edited templates. 
 
The process of selecting 1 or more templates and then adding the 
tag to the templates is what tells the Wizard that there is a multiple 
choice selection that will have to be asked of the user to be 
inserted into that template.  
 
The next step is to add paragraphs to this tag that hold the actual 
content choices that the end user can pick from that will be 
inserted into the document as it is being assembled. 
 
Multiple choice paragraphs define what actual content will be 
inserted into your assembled document. Each 'paragraph' is a 
piece of content, that content can be as simple as a paragraph of 
text or it can just as easily be an entire file such as a multi-page 
Word document, a spreadsheet, a graphic image, a PDF 
document, and so on. 
 
The Enabled flag allows you to disable a choice without having to 
completely delete it from the system. Disabling will hide the entry 
from the end user's lists when selecting project data. 
 
The Title is for your information only. Give each paragraph a title 
that lets you know what the choice is, so you can locate it in the 
interface later. 
 
The File is an external file that contains the content that will be 
inserted for this choice. The simplest use of this feature is to use 
the default Word .docx file if your choice will be text. In this case 
you do not need to browse to a different file. All you must do is 



390 

click the Open or Edit button and the Wizard will create a file to 
hold this paragraphs text content. 
 
The OLE field is only for use if you must define the actual custom 
OLE data type for Word. This may be needed only if you are 
browsing to other file types than text, spreadsheets, images, or 
PDF files. This field is set based on your systems configuration and 
3rd party software and use of this field assumes you are familiar 
with embedding custom OLE objects within Word documents. 
 
By default, files are statically inserted into your assembled 
document. You can choose to link files such as spreadsheets so 
when the external file is updated the updates will show up in your 
assembled document. It is your responsibility to make sure links 
between documents are properly maintained. 
 
You add one 'paragraph' for each choice you want attached to a 
tag. For example, if you defined a tag as being used for a multiple 
choice list of products and you want to be able to pick from 3 
different choices all you must do is add 3 'paragraphs'. Each 
paragraph will be assigned to an external file holding the content 
for a different product choice. 
 
The Wizard does not know what the content of your files are. The 
Wizard replaces the tag with the contents of the selected file when 
it inserts your file into the assembled document. 
 
With 150 available tags, each tag can be inserted into multiple 
places and templates within your document and with 2000 
possible paragraphs you can configure anything from a very 
simple 3 choice product list for use in 1 place or a very complex set 
of multiple choice options for a wide variety of situations. 
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For example, you could define one tag for a multiple choice list of 
products, another tag for a multiple choice list of photographs, 
another tag for a multiple choice list of linked financial 
spreadsheets and so on. 
 
You can also change the order in which paragraph content is 
inserted into a single tag in the Preferences settings. Once 
paragraph content has been inserted into a Word document the 
only way to change the order is to copy and paste the content 
within the Word document. 
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HOW DO I SPECIFY AN ALTERNATE 
SPECIAL FILE (COVER LETTER, ETC.)? 
 
There are several special files that are treated differently than the 
bulk of the Proposal Pack templates when they are selected for 
use in your document. 
 
These special files are as follows in the Options.ini database: 
 

[SPECIAL_FILES] 

TOCFile=Table of Contents 

CoverLetterFile=Cover Letter 

CoverSheetFile=Cover Sheet 

InquiryLetterFile=Inquiry Letter 

EnvelopeFile=Envelope 

LetterheadFile=Letterhead 

FaxCoverSheetFile=Fax Cover Sheet 

TitlePageFile=Title Page 

BackPageFile=Back Page 

 

 Cover Letter 
 
The Cover Letter is a special file because it does not include a 
special header such as the graphic header or header used in 
the table of contents, page numbering or page footer. 
 
If you want to specify an alternate file to be used for the Cover 
Letter you can use the Preferences > Tools > Configure 
Proposal Files and change the Special Files setting for the 
template you want to set as the new Special File.  
 



393 

There is a default setting in the Options.ini database file in the 
[SPECIAL_FILES] section in the CoverLetterFile entry which sets 
the Cover Letter template as the default. You can override this 
for each of the 12 Proposal Types by setting the 
[SPECIAL_FILES] > CoverLetterFile entry in the FileList.ini file, 
use the Configure Proposal Files screen mentioned above to set 
this entry. 
 
An example of the use of this is in the Business Plan proposal 
type. If you create a new document project and set the type to 
be a Business Plan, you will see that the Cover Letter (Business 
Plan) template is now the default Cover Letter template. 
 
The reason for setting a specific template to be the Cover Letter 
special file is so when it is created, you can easily edit it by 
clicking the “Edit Cover Letter” button in the edit screen after 
you have created the entire proposal.  
 
You still must select the template designed as a Cover Letter 
special file in the set of templates you have selected for the 
proposal in order for it to be created along with the rest of the 
proposal. 

 Cover Sheet 
 
The Cover Sheet is a special file because it does not include a 
special header such as the graphic header or header used in 
the table of contents, page numbering or page footer. This file is 
very similar to a Cover Letter but is modified to be used more 
for grants. 
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 Inquiry Letter 
 
The Inquiry Letter is a special file because it does not include a 
special header such as the graphic header or header used in 
the table of contents, page numbering or page footer. This file is 
very similar to a Cover Letter, but it is designed to be sent to a 
prospect prior to sending or writing a full proposal. 

 Title Page 
 
The Title Page is a special file because it does not include a 
special header such as the graphic header or header used in 
the table of contents, page numbering or page footer. The Title 
Page has a different format than the rest of the templates and is 
designed to be the first page in the proposal. This template is a 
special file because there are some components of it that are 
processed differently than other templates such as the ability to 
incorporate your own company logo or change the main title 
graphic to titles such as “Proposal”, “Project”, “Business Plan”, 
“Resume”, “Presentation”, etc.  
 
Most versions of Proposal Pack’s Title Page use a background 
watermark graphic to create a visual background for the Title 
Page. Because of this the Title Page requires special processing 
to put it in its own section of the document. 

 Table of Contents 
 
The Table of Contents is a special file because it is processed 
differently than other templates. Including the creating of a 
custom table of contents to match the rest of the templates 
selected for the proposal. 
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 Envelope 
 
The Envelope is a special file because it is a separate document 
used to print on an envelope in a different size than most other 
documents. 

 Fax Cover Sheet 
 
The Fax Cover Sheet is a special file because it is a separate 
document used to print a fax cover (typically printed on your 
own letterhead). 

 Letterhead 
 
The Letterhead is a special file because it is a separate 
document used to print a blank sheet of paper as a letterhead 
with a graphic theme that matches the graphic theme of the 
proposal. 

 Back Page 
 
The Back Page is a special file because it contains a custom 
background watermark graphic and must be put into its own 
section of the document with its headers and footers unlinked 
from the previous section. 
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HOW DO I COMBINE THE COVER LETTER 
INTO A MASTER PROPOSAL? 
 
The Wizard incorporates the Cover Letter into the master proposal 
using Word document “sections”. 
 
The Cover Letter template is a plain text document (i.e. no 
graphics or colored borders). Due to the way Microsoft Word 
works when you append documents together you need to take 
some extra steps to ensure the formatting of the entire document 
is maintained. 
 
To maintain the proper formatting of the plain text Cover Letter it 
must be placed into its own “Section”. Sections are a feature of 
Microsoft Word that allow a multi-page document to be broken 
into multiple independent sections, each section having its own 
unique properties for things such as page borders, page numbers, 
background watermarks, header and footer information. 
 
The Proposal Pack Wizard will create a new section when it adds 
the Cover Letter template to a project. 
 
The new section will also have its header and footer unlinked from 
the previous document section so that it will not inherit any 
information from the previous section. 
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HOW DO I ADD PAGES TO A DOCUMENT 
ALREADY CREATED? 
 
https://www.proposalkit.com/htm/videos-add-new-chapters.htm 
 
Once you have created your documents you can edit them. Once 
you have started editing your documents you can only use the 
Wizard to make limited changes to an already existing document.  
 
You can safely edit the project and add new chapter templates to 
the project. When you click the OK, Save Project and Build 
Documents button the Wizard will update the existing project 
document by inserting the new pages into your existing 
documents. 
 
For example, if you need to add a few more chapters that you 
forgot to add when you first built your document. You can edit your 
project by selecting the new pages and then saving and building 
your project again. 
 
When you build the project again the Wizard will make a backup 
copy of your assembled document (i.e. the FullProposal.docx file). 
Then it will create and insert the new pages. Once the new pages 
are added the Wizard will renumber the pages and rebuild the 
Table of Contents – if you are using the Table of Contents and 
page numbering. 
 
Any existing pages in your already created documents will not be 
modified. For example, the Wizard will not change any mail merge 
data fields and it will not delete any pages if you removed pages 
from your project. Any other changes you need to make other than 

https://www.proposalkit.com/htm/videos-add-new-chapters.htm
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adding new pages you will have to do manually just by editing the 
document using Word. 
 
It is possible that the Wizard may not be able to figure out how to 
update your existing document if you have made substantial 
changes to it that remove elements the Wizard uses to determine 
how to update the file. If the Wizard cannot figure where to insert 
new pages, it will default to adding them to the end of the 
document. Otherwise the Wizard will insert them into the ordering 
you have defined in the project. 
 
There is a setting in your project called ‘Locked for Editing’. This 
box is checked in your project when the Wizard had detected you 
have opened a created document. The Wizard assumes you have 
started editing the document and will place a lock on your project. 
All this really means is that the Wizard will warn you when you are 
updating a locked project and will double check with a Yes/No 
question if you attempt to delete the files for the project to prevent 
you from deleting all your work. 
 
If you have not actually started editing your documents, it is usually 
better to uncheck the ‘Locked for Editing’ box and then delete the 
project files when making changes to your project. This is meant 
for when you are experimenting with your project and how the 
document looks in an iterative process of building the files, making 
changes to the project, deleting the old files then building them all 
again from scratch until you are satisfied with them and you are 
ready to start editing. 
 
Once you have started editing your documents the Wizard is not 
intended to be used to make changes or manipulate your created 
documents. This ability to update your existing project to add new 
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pages is meant to allow you to add pages you may have forgotten 
to add initially. 
 
Whenever you update a project with existing documents a backup 
copy of your project’s files will be made and stored in a subfolder 
of your project directory called “backup”. If you accidentally 
overwrite your edited work, you can manually recover the previous 
copy by looking in the backup folder. A backup of your 
FullProposal.docx file will also be created in your project folder 
and can be opened from the Edit screen.  
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HOW DO I CLEANUP MY DOCUMENT 
FORMATTING? 
 
Once you create your documents, the automated process may 
have introduced some formatting that needs to be cleaned up 
manually. This only happens in some cases, typically with older 
Proposal Pack styles which differ slightly from our typical designs 
and with custom created styles (if you have made changes to our 
default templates). 
 
The process of assembling multiple templates together into a 
single master document can introduce formatting changes that 
need to be manually cleaned up. By default, the Wizard will 
reformat your final assembled document to reset the body text, 
page headers, subheaders, URLs and footer text to a predefined 
set of font types, sizes and colors. 
 
The reformatting process is also performed to ensure you have a 
consistent set of fonts, sizes and colors used throughout your 
document. Note that the Wizard formats the document on a per-
sentence basis. This is a faster process, however is not as precise. 
Situations such as including multiple font styles in a single 
sentence can cause one to be changed. You can configure the 
Wizard to reformat on a per-word basis which is more precise, 
however much slower. In the Wizard’s Preferences > Project 
Settings > Configure Project Screen tab, check the box labeled 
“Do document reformatting during assembly by words instead of 
sentences”. 
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HOW DO I CHANGE THE FONT STYLES? 
 
The reformatting process uses a set of pre-defined fonts, sizes, 
colors and other attributes for various parts of the document. The 
documents default to using Times New Roman, Arial and Arial 
Black for most of the text elements to ensure commonly accepted 
fonts are used and are available on all users’ systems. Read this 
chapter for how to change the fonts and settings: How do I use 
the MyProjectFiles folder? 
 
The Wizard allows you to copy your own custom files that are not 
part of the Proposal Kit system into each of your new projects 
using the MyProjectFiles folder. 
 
This feature allows you to automatically copy your own content 
such as worksheets, checklists, letters, spreadsheets, forms, etc. 
into each of your new Proposal Pack Wizard project folders. 
 
The MyProjectFiles folder is in the root install folder where the 
Proposal Pack Wizard is installed. This folder by default is: 
 
C:\ProposalKit\ProposalPack\MyProjectFiles 
 
Whenever you build a new document in the Wizard a copy of all 
the files in the MyProjectFiles folder will be made into your 
document’s project folder. 
 
You should not name any of your custom files the same file names 
and extensions as any of Proposal Kit’s document file names. 
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Use the Preferences > Project Settings > Configure MyProjectFiles 
Settings screen to manage adding files, removing files, and setting 
attributes for the custom files in the Wizard database. 
 
You can manually copy files into the MyProjectFiles folder however 
that will not setup any of the attributes such as human readable 
titles for use in the Wizard drop down menus. Use the Wizard’s 
Preferences tool for managing the attributes.  
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How do I Change/Use Word Font Styles? 
 
HOW DO I TURN OFF AUTOMATIC REFORMATTING? 
 
If you only have one file selected in your project for your master 
document, the reformatting process will not be performed. This 
also means if you create a combined master document for reuse 
and it is all contained in a single file (even if it is many pages long), 
the Wizard will not reformat the text. 
 
You can turn off the reformatting of the text in the Wizard home 
page > Document Styles > Edit Style > Fonts screen. And check the 
box labeled “Do not auto-reformat text after combining the 
proposal documents”. 
 
You can selectively turn off reformatting within the documents by 
editing the stock Proposal Pack templates and applying custom 
Word “Styles” to the text. The Wizard will skip reformatting any 
sentences that have a custom Word “Style” applied to them. 
 
Here are some common formatting issues you may see and how to 
clean them up quickly. Note that all document cleanup is done 
with your own Word processor and are Word related issues. 
Consult your Word manual and help for all Word related issues and 
questions. 
 

 If the Title Page document is split across 2 different pages 
and/or the formatting of the primary logo graphic is in the wrong 
position do the following: 
 
Click the main logo graphic to highlight it, then click the Word 
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toolbar option “Format” > “Picture”, then click the “Layout” tab. 
Next, click the “Behind Text” option. This will reposition the 
graphic and fix the Title Page layout. 

 If the accent graphic in the footer is not centered due to turning 
on Page Numbering do the following: 
 
You can re-center the footer graphic by clicking the Word 
toolbar option “View” > “Header and Footer”, then select the 
footer (or just double click on the footer). Then manually 
reposition the footer as desired. See this chapter - How do I 
Import a Custom Page Footer? if needed to precisely define 
the positioning of everything in the footer. 
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HOW DO I CREATE A REVISION OF MY 
DOCUMENT? 
 
The Wizard can help you manage revisions to your document by 
creating revision documents. Instead of always updating the same 
Word document for which can lead to mistakes such as 
accidentally erasing work when everything is contained in a single 
file you can now easily create archives to preserve your work. 
 
The revision feature works by making a backup copy of your 
master combined document to a new file. Then the “Proposal 
Number” field in the Title Page (if used) will be updated with an 
incremental revision number to help you keep track of each 
revision. 
 
All your old revision copies are stored in your project folder’s 
Backup subfolder so you can open any previous revision if you 
need to find text or compare changes over time. 
 
The Wizard’s Options.ini database has a field labeled 
‘RevisionText=Rev’ that is used to update your Proposal Number 
text in the Title Page. To change the text that is inserted into your 
Proposal Number text from ‘Rev’ change this filed in the Options.ini 
database file. 
 
The revision feature defaults to using incremental numbers for the 
revision numbers. You can change the Wizard to use letters A-Z 
instead by changing the Options.ini database field 
‘RevisionType=0’ to ‘RevisionType=1’. 
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For example. If you are working on your 5th project document the 
Proposal Number text in the Title Page should say ‘Proposal 
Number: 5’. 
 
Once you create a revision it will be changed to ‘Proposal Number: 
5 Rev 2’. The next revision you make will change to ‘Proposal 
Number: Rev 3’ and so on. 
 
The archived copies will be saved with file names that reflect the 
revision number such as FullProposal-Rev-1.docx, FullProposal-
Rev-2.docx and so on. 
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HOW DO I PASTE FROM OTHER 
DOCUMENTS? 
 
Once you have created your project documents you can edit them. 
Since the final combined document and individual files copied to 
your client folder are Word documents, anything you can do with 
Word, you can do with your document framework. 
 
Consult your Word manual and help for all Word related issues and 
questions.  
 
You can easily copy material from past proposals and other 
documents by opening the documents and copying and pasting 
from one to another. 
 
You can paste text from the Acrobat PDF samples into your 
editable documents if you didn’t use the Wizard to create an 
editable Word version of a sample. Open a PDF document, use 
your mouse to select a block of text, then copy and paste the text 
from the PDF into your Word document. You then have an editable 
version of the sample. Editable Word format versions of the PDF 
samples are also included in each Proposal Pack. 
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HOW DO I ADD MY LOGO TO THE TITLE 
PAGE? 
 
https://www.proposalkit.com/htm/videos-add-logo.htm 
 
To insert your own custom logo graphic into the Title Page using 
the Wizard, first create your logo graphic and save it as a high 
quality graphic file. Then click the Logos & Graphics tab on the 
Preferences screen and click the Browse button next to one of the 
custom logo graphic files. Select your graphic and make sure the 
Display checkbox is checked, finally click OK and exit the 
Preferences screen. There are several “Custom #” entries set 
aside for you to define custom logo files. 
 
When you create a new document project, select your custom 
entry from the drop down list box for the graphic to include. You 
can also select from a variety of pre-built logos to change the text 
from “Proposal” to either “Project” or “Business Plan” and many 
other phrases. These pre-built logos are not available in the 
Proposal Pack for Any Business or Proposal Pack for Government 
Grants which do not include graphic designs. 
 
If you are using any Proposal Pack the Wizard can be used to 
insert your own logo graphic in the Title Page. The Wizard will find 
the placeholder text “Proposal” or pre-defined graphic and replace 
it with your logo. You can also configure the Wizard using the 
Document Styles > Settings screen to search for a different 
placeholder if you are editing the stock Proposal Pack Title Page 
template in a way that changes how the Wizard finds the 
placeholder text. 

https://www.proposalkit.com/htm/videos-add-logo.htm
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Once you have created your documents you can edit them. Since 
the final combined document and individual files copied to your 
client folder are Word documents, anything you can do with Word, 
you can do with your document framework once it is created. 
 
Consult your Word manual and help for all Word related issues and 
questions.  
 
You can also add your own logo manually anywhere in your 
proposal by selecting the Word toolbar option “Insert” > “From 
File” then select your logo graphic. Your logo will be inserted at 
the position of your cursor. You may have to change the picture 
formatting layout to be “Behind Text” in order to move the picture 
around in your document. Consult your Word manual for details as 
this is a function of your Word processor, not of the Proposal Pack 
Wizard or templates. 
 
To add your logo to all the body pages of your document read this 
chapter: How do I Add My Logo to the Headers of all Pages? 
 
We recommend that you import high quality graphics in PNG 
format, so they print well. If you import web site files such as GIF or 
JPG formats, they may not print high quality (even if they appear 
fine on your computer screen). Consult a graphic designer for 
details if you need help creating custom graphics.  
 
Newer versions of Microsoft Word automatically convert any 
graphics you insert into a Word document to PNG format. So, you 
might as well use the same format for consistency. 
 
If you want to change the stock Proposal Pack graphics to add 
your own logo, you will have to use a graphics program to create a 
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custom set of graphics. See your Proposal Pack 
documentation.pdf file or the section in this manual Easily Create 
Your Own Graphic Style for details on how to create your own 
custom graphics. 
 
You can also specify a custom X/Y coordinate in points from the 
top and left side of the page where you want your logo inserted. 
Use the Document Styles setting screen and pick the “Graphics” 
tab. The fields labeled “Custom Logo X” and “Custom Logo Y” are 
used to position your custom inserted Title Page logo. 
 
If your logo is not sized exactly you can specify a scaling factor. Be 
careful scaling up a logo as the quality may diminish. If your scaled 
logo does not print high quality, consider using a graphics editor to 
create a new logo file that is already sized properly for high quality 
printing. 
 
You can also copy your logo into the MyGraphics folder with the 
file name of MyLogo-TitlePage.png or .jpg to get the Wizard to 
insert the graphic. See the ReadMe.PDF file in the MyGraphics 
folder for details. See this chapter for more details: How to Import 
Custom Graphics Using the MyGraphics Folder?  
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HOW DO I ADD MY LOGO TO THE 
HEADERS OF ALL PAGES? 
 
The Wizard can insert your custom logo into the top of every body 
page of your assembled document. 
 
The logo will be inserted in front of the large page header titles on 
every body page of the assembled document (i.e. in front of the 
text that says, “Executive Summary”, “Cost Summary”, “Company 
History”, and so on. 
 
Remember when using point values in the positioning field that 1” = 
72 points. So, to set the logo 1” from the left and .5” from the top 
use 72 points and 36 points. 
 
You can use this feature with any of the logo designed Proposal 
Graphics Packs however inserting your logo right in front of our 
logos may or may not look visually attractive. Experiment with the 
options to best design the final look of your documents. 
 
You can copy your logo into the MyGraphics folder with the file 
name of MyLogo-PageHeader.png or .jpg to get the Wizard to 
insert the graphic.  
 
See the ReadMe.PDF file in the MyGraphics folder for details. See 
this chapter for more details: How to Import Custom Graphics 
Using the MyGraphics Folder? 
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HOW DO I IMPORT A CUSTOM PAGE 
HEADER? 
 
The Wizard can import the header from an external Word 
document into your assembled document.  
 
This gives you the ability to define a custom header and design it 
in a Word document as an actual document header (i.e. using 
Microsoft Word’s header features). 
 
When the Wizard assembles your documents the contents of the 
header in the external file will be imported into the header of your 
body pages causing it to be replicated through all body pages of 
your proposal (except for the Cover Letter and Title Page pages). 
 
You can create a CustomHeader.docx file in the Wizard’s 
MyGraphics folder. The Wizard will automatically detect and load 
the custom header from this file. 
 
Put your text elements in your custom header in text boxes. 
Including putting your mail merge tags into text boxes that can be 
exactly positioned in your custom header. Also set any pictures to 
specific positions so all elements show up in your assembled 
document in the correct places. 
 
Examples of custom footer and header files are in the MyGraphics 
folder. See the examples for how various custom headers can be 
created.  
 
If you include shape objects that include mail merge tags in the 
header and/or footer you will also have to enable the “Merge tags 
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into document headers and footers” setting in the Preferences > 
Project Settings > Document Creation screen. This option is 
normally disabled due to Word taking much longer to process mail 
merging into the headers and footers in some cases and normally 
we do not use tags in the headers and footers. If you can avoid 
using tags in custom headers and footers will be more efficient. 
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HOW DO I IMPORT A CUSTOM PAGE 
FOOTER? 
 
The Wizard can import the footer from an external Word document 
into your assembled document.  
 
This gives you the ability to define a custom footer and design it in 
a Word document as an actual document footer (i.e. using 
Microsoft Word’s footer features). 
 
When the Wizard assembles your documents the contents of the 
footer in the external file will be imported into the footer of your 
body pages causing it to be replicated through all body pages of 
your proposal (except for the Cover Letter and Title Page pages). 
 
You can create a CustomFooter.docx file in the Wizard’s 
MyGraphics folder. The Wizard will automatically detect and load 
the custom footer from this file. 
 
Examples of custom footer and header files are in the MyGraphics 
folder. See the examples for how various custom footers can be 
created.  
 
Using a custom footer is also a good way to define a custom styled 
page number. To do this, edit your custom footer and insert a 
Word template for the custom styled page numbering you desire 
(using the Word toolbar Insert > Page Number. Then in the 
Wizard’s Preferences > Data & Display > Auto Table of Contents 
Display screen pick the “Use My Custom Footer File” from the 
drop down list. This gives you the most precise formatting ability 
for items in the footer than using default options. Make sure to put 
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custom page numbers into your footer (and NOT the header). See 
this chapter for more details: How do I Add TOC Sub Headers? 
 
Put your text elements in your custom footer in text boxes. 
Including putting your mail merge tags into text boxes that can be 
exactly positioned in your custom footer. Also set any pictures to 
specific positions so all elements show up in your assembled 
document in the correct places. 
 
Do not add any extra “frames” to your custom page header as the 
default page number will be added as the 1st frame to the footer 
and will be operated on during the processing of the document. 
Adding additional Word “Frame” objects can interfere with the 
Wizard processing.  Frames are an older component of Word; you 
can also add your page numbers into a text shape. 
 
If you include shape objects that include mail merge tags in the 
header and/or footer you will also have to enable the “Merge tags 
into document headers and footers” setting in the Preferences > 
Project Settings > Document Creation screen. This option is 
normally disabled due to Word taking much longer to process mail 
merging into the headers and footers in some cases and normally 
we do not use tags in the headers and footers. If you can avoid 
using tags in custom headers and footers will be more efficient. 
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HOW DO I USE CUSTOM GRAPHIC 
BULLET POINTS? 
 
Proposal Packs include custom graphics for use as alternate bullet 
points. By default, the Proposal Pack templates use standard Word 
diamond bullet points. 
 
The Wizard can be used to replace the default diamond bullet 
points (or standard bullet points you have created) with custom 
graphics that are designed to match the rest of the graphics in the 
Proposal Pack design theme. 
 
The use of the custom bullet point graphics turned on by default if 
the graphics exist for the Proposal Pack that is in use. Not all 
Proposal Packs are designed with custom bullet point graphics. 
 
You can turn this feature on/off by using the Document Styles 
screen and in the Graphics tab check or uncheck the “Use Custom 
Graphics for Bullet Points” box. 
 
You can also change the graphic used for the bullet points by 
editing the Bullet.png file in your Proposal Pack’s PNG_Graphics 
folder. Replace our stock Bullet.png graphic file with a new graphic 
and the Wizard will automatically use your new graphic. 
 
It is recommended that you size your custom bullet point graphic 
as a 150 dpi graphic sized about .1 to .13 inches by .1 to .13 inches 
in size. This will be about 15x15 to 20x20 pixels. 
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You can also copy your bullet point graphic into the MyGraphics 
folder with the file name of Bullet.png or .jpg to get the Wizard to 
insert the graphic. See the ReadMe.PDF file in the MyGraphics 
folder for details. See this chapter for more details: How to Import 
Custom Graphics Using the MyGraphics Folder? 
 
The Wizard will only replace bulleted lists, it will not replace 
numbered lists with the custom graphic. If you have a bullet list 
that is not being updated with the custom bullet point graphics, it is 
probably stored as a numbered list in your document (but visually 
uses bullet points). Or you may have originally created the list as a 
numbered list but then replaced the numbers with bullet points 
(Word still has it labeled as a numbered list internally). If this 
happens you can select the list, clear the formatting and then 
rebuild it as an actual bullet point list.  
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HOW DO I USE CUSTOM BODY 
WATERMARK GRAPHICS? 
 
Most Proposal Packs include body background watermark 
graphics. Body watermark graphics are images that are faded into 
the background of the body pages of your document. 
 
The body background watermark graphics are designed based on 
the Title Page and page header graphics to give your entire 
document a consistent visual design and layout across every page 
of your proposal. 
 
By default, the body background watermark graphic is not 
included in the stock Proposal Pack documents. It is only inserted 
into your documents during the Wizards document assembly 
process. 
 
The use of the custom body background watermark graphic is 
turned on by default if the graphics exist for the Proposal Pack that 
is in use. Note that not all Proposal Packs are designed with 
custom background watermark graphics. 
 
You can turn this feature on/off by using the Document Styles 
screen and in the Graphics tab check or uncheck the “Use Custom 
Background Page Watermark Graphic” box. You can also set the 
positioning in points from the top and left of the page by changing 
the “Body Watermark Positioning X” and “Body Watermark 
Positioning Y” fields. 
 
You can also change the graphic used for the body background 
watermark by editing the Watermark-Body.png file in your 
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Proposal Pack’s PNG_Graphics folder. Simply replace our stock 
Watermark-Body.png graphic file with a new graphic and the 
Wizard will automatically use your new graphic. 
 
It is recommended that you size your custom body background 
watermark graphic as a 150 dpi graphic sized about 5 inches in 
size. The width and height will be dependent on the design. 
 
Since background watermark graphics are part of your Word 
documents headers, once you insert a background watermark into 
the first page of a document section, it will be replicated into every 
following page of your document. 
 
You can also copy your background graphic into the MyGraphics 
folder with the file name of Watermark-Body.png or .jpg to get the 
Wizard to insert the graphic. See the ReadMe.PDF file in the 
MyGraphics folder for details. See this chapter for more details: 
How to Import Custom Graphics Using the MyGraphics Folder? 
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HOW DO I USE CUSTOM TITLE PAGE 
BACKGROUND GRAPHICS? 
 
The Title Pages with background designs are in the 
TitlePage2.docx template. The cross-platform compatible Title 
Page designs are in the TitlePage.docx template. 
 
The Title Page designs will give your document a cleaner and 
more professional look. They are designed using graphics and text 
in easily repositionable objects which allows you to custom tailor 
your Title Page. 
 
The use of the custom Title Page background is turned on by 
default if the graphics exist for the Proposal Pack that is in use. 
Note that not all Proposal Packs are designed with the new custom 
Title Page backgrounds. 
 
You can turn this feature on/off by using the Document Styles 
screen and in the Graphics tab check or uncheck the “Use Custom 
Title Page with Background” box. If this box is checked, that 
means your Proposal Pack includes a new Title Pack background 
graphic design, otherwise it will use the original classic cross-
platform compatible version. If you turn off this feature in a 
Proposal Pack that includes a new custom Title Page background, 
the Wizard will revert to using the old classic Title Page design (i.e. 
a plain white background). 
 
You can also create your own customized Title Page background 
graphic. Either create your own background graphic from scratch 
or start with one of ours and edit it in a graphics editor.  
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It is recommended that you size your custom Title Page 
background graphic as a 150 dpi graphic sized 8.5 x 11 inches in 
size. Once your graphic background is created you can edit the 
TitlePage2.docx template, click the document’s header section, 
highlight the existing background graphic and delete it. Then 
insert your new one using the Word toolbar Insert > From File. 
 
Since background Title Page graphics are part of your Word 
documents headers, once you insert a background watermark into 
the first page of a document section, it will be replicated into every 
following page of your document. This is why the Title Page 
document is inserted into its own section within your main 
document. 
  
You can also copy your title page background graphic into the 
MyGraphics folder with the file name of Watermark-Title.png or 
.jpg to get the Wizard to insert the graphic. See the ReadMe.PDF 
file in the MyGraphics folder for details. See this chapter for more 
details: How to Import Custom Graphics Using the MyGraphics 
Folder? 
 



422 

HOW TO IMPORT CUSTOM GRAPHICS 
USING THE MYGRAPHICS FOLDER? 
 
https://www.proposalkit.com/htm/videos-replace-photos.htm 
 
TIP #1 
 
Custom sets of example branding graphics based on our Proposal 
Kit logo and a photo based design are included in the MyGraphics 
folder. 
 
Use these as guides and replace them with your own using the 
same file names and dimensions to create your own custom set of 
graphics more efficiently. We have also included some example 
custom header and footer files. 
 
Example PDFs are also included that show what the results of 
these graphics customizations look like when a document is 
assembled. All you must do is copy the files from any of the 
example folders up into the MyGraphics folder then edit those 
graphics to replace our logos and photos with your own. 
 
A second set of example images using photographs is included in 
the Example-UsingPhotos folder. The same process is used to 
customize your documents with your own photos as is to create a 
logo based design. To create a photo based design of your own 
copy these example images up into the MyGraphics folder and 
edit them replacing our photos and logos with your own. 
 

https://www.proposalkit.com/htm/videos-replace-photos.htm
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TIP #2 
 
Two other quick customizations to help brand your documents is 
to use the Document Styles > Edit Style > Colors screen and 
customize the 5-color scheme to match your company colors. 
 
Then use the Preferences > Data & Display > Font Styles screen to 
customize the font types and font colors to match the colors and 
font types your company typically uses. 
 
How to Brand Documents Using Your Graphics 
 
The Proposal Pack Wizard – Expert Edition allows you to brand 
your assembled documents quickly and more efficiently with your 
own custom graphics (logos and photos) by adding your graphics 
files directly to the MyGraphics folder.  
 
If you installed the Proposal Pack Wizard into the default install 
folder you will find the folder here: 
 
C:\ProposalKit\ProposalPack\MyGraphics 

 
This feature only works if you are running the Expert Edition of the 
Wizard. This feature does not replace every graphic in logo 
versions of the Proposal Packs. Images not replaced are graphic 
versions of individual page header chapters found in logo versions 
of Proposal Packs. In this case logo versions of page headers can 
be replaced with a combination of your logo next to text versions 
of the page chapter headers. This gives you the ability to then 
change the font type and font color of the page headers. 
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The use of the MyGraphics folder bypasses all the configuration 
options in the Wizard for branding your documents. By adding the 
following specific graphic files to this folder, the Wizard will 
automatically detect them and insert them into your document as it 
is being assembled making it much more efficient to custom brand 
your documents. 
 
A fast way to get started is to run a quick test by copying the 
graphics from one of the example folders up one level into the 
main MyGraphics folder. Then run the Wizard and create a new 
project, pick some templates (Cover Letter, Title Page, Executive 
Summary, Cost Summary, Back Page) and build a document. 
 
You will see our example graphics imported into the document. 
Then open each of those graphics in a graphics editor and paste in 
your own logo or photos and save the image in the exact same file 
name and format. Then rebuild the test project to see your 
changes applied. Continue tweaking the graphics and the 
positioning using the GraphicSetup.ini settings until you have it just 
the way you want it using your own customized design. 
 
When creating a logo based design, the .PNG file format is more 
commonly used for the graphics to maintain the highest quality 
image. When creating a photo based design, the full page size 
graphics for the Title Page, body page watermark and Back Page 
are usually in .JPG format to reduce the file size. 
 
The Wizard will first look for the full size images in .JPG format and 
if it finds any will load them first. If no .JPG images are found it will 
then look for images in .PNG format and if it finds any will load 
them. 
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The following graphics files must be put in the MyGraphics folder 
with these exact file names and in the PNG or JPG file format: 
 

 Bullet.png (or .jpg) 
 
The Bullet graphic is used as the bullet point symbol in any 
bullet point lists. 
 
This graphic should be 15x15 up to 20x20 pixels in size and 
should have a document image size between .1 and .13 inches 
at 150 DPI. If you set the dimensions differently your bullet point 
may not be sized correctly in the document. 

 Watermark-Body.png (or .jpg) 
 
The Watermark-Body graphic is a faded watermark image that is 
inserted into the body pages of your assembled document. It 
can also be a full color full size page image which is good for 
background images you want to cover the full length or width of 
the page such as using a full color sidebar image. 
 
This graphic is usually around 750x750 pixels in size and sized 
to about 5”x5” at 150 DPI. Set the fading of the image yourself in 
your graphics program so that any text that overlaps the 
watermark will still be readable. 8% to 12% opacity is a good 
range to start with. 
 
Some design themes use an 11” high sidebar image as the 
background watermark. 
 
You can manually reposition the background watermark by 
clicking into the document header, selecting the watermark 
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graphic and dragging it to a new position.  
 
If you want to fine tune where the Wizard will position the 
graphic use the Document Styles > Edit Style > Graphics screen 
and set the Background Watermark Positioning X and Y fields. 
 
Or, you can set the exact positioning and scaling of your custom 
graphic by setting the Left, Top and Scale in the [Body Page 
Watermark] section of the GraphicSetup.ini file located in the 
MyGraphics folder. 
 
If you need a more complex body page background design than 
can be achieved with a single graphic use the Watermark-
Body.docx file instead. See the example in the Example-
CustomHeaderFooter3 folder for details. 

 Watermark-Title.png (or .jpg) 
 
The Watermark-Title graphic is a full page background graphic 
for the Title Page. Just like the background watermark for the 
body pages, this graphic is inserted into the header of the Title 
Page as a background watermark. The difference between the 
faded watermark and the Title Page background is that they are 
different size graphics and one is faded and one is not. 
 
This graphic should be 1275x1650 pixels in size and sized to 
8.5”x11” at 150 DPI. 
 
Some design themes use a smaller size photograph as this 
image that may or may not have an underlying colored shape 
object as a frame. 
 
For international page sizes you can size it appropriate to the 
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page size you are using (Legal, A4, etc.) If you are using a page 
size different than the default 8.5”x11” Letter size also make sure 
to set the page size in the Wizard settings. This is found in the 
Document Styles > Edit Style > Page Setup screen. 

 Watermark-BackPage.png (or .jpg) 
 
The Watermark-BackPage graphic is a full page background 
graphic for the Back Page. Just like the background watermark 
for the body pages, this graphic is inserted into the header of 
the Back Page as a background watermark. The difference 
between the faded watermark and the Back Page background 
is that they are different size graphics and one is faded and one 
is not. 
 
The Back Page is typically a design that is simpler than the front 
Title Page design and compliments it. 
 
This graphic should be 1275x1650 pixels in size and sized to 
8.5”x11” at 150 DPI. 
 
Some design themes use a smaller size photograph as this 
image that may or may not have an underlying colored shape 
object as a frame. 
 
For international page sizes you can size it appropriate to the 
page size you are using (Legal, A4, etc.) If you are using a page 
size different than the default 8.5”x11” Letter size also make sure 
to set the page size in the Wizard settings. This is found in the 
Document Styles > Edit Style > Page Setup screen. 
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 MyLogo-TitlePage.png (or .jpg) 
 
While the Wizard does allow you to set a custom link in the 
Preferences to your own logo file and select that logo in your 
project, you can also get your logo into your document without 
having to customize the Wizard preferences by dropping your 
logo into this folder and naming it MyLogo-TitlePage.png or .jpg. 
 
Note that you do have to add the Title Page template to your 
project in order for the Wizard to insert your logo into it. 
 
This graphic should be sized appropriately for how large you 
want it to display on the Title Page. A good starting size may be 
1” to 2” in height and 1” to 4” in width at 150 DPI. 
 
You can manually reposition logo by clicking the graphic and 
dragging it to a new position. 
 
If you want to fine tune where the Wizard will position the 
graphic use the Document Styles > Edit Style > Graphics screen 
and set the Custom Logo X and Y fields. 
 
Or, you can set the exact positioning and scaling of your custom 
graphic by setting the Left, Top and Scale in the [Title Page 
Logo] section of the GraphicSetup.ini file located in the 
MyGraphics folder. 
 
This graphic is also auto-imported into the Envelope, Fax Cover 
Sheet, Letterhead, Back Page and legal contract pack’s 
Contract and Terms templates (see below). 
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 MyLogo-PageHeader.png (or .jpg) 
 
This logo is a 2nd version of your logo that can be used in the 
header of every page of your document (i.e. all the body pages 
after the Title Page). This may be a smaller version of your logo 
or a non-text version of your logo and it will be inserted before 
the titles of each of the pages. 
 
Note that this is mainly used only with the plain text versions of 
Proposal Pack (i.e. Proposal Pack for Any Business and Proposal 
Pack for Government Grants). If you use this with a logo design 
version of Proposal Pack then your logo will be inserted in place 
of the stock Proposal Pack page chapter header graphics and 
text versions of the chapter headers will be added. 
 
You can get your logo into your document without having to 
customize the Wizard preferences by dropping your logo into 
this folder and naming it MyLogo-PageHeader.png or .jpg. 
 
This graphic should be sized appropriately for how large you 
want it to display on the body pages at the head of each page. 
A good starting size may be .5” to 1” in height and .5” to 1” in 
width at 150 DPI. 
 
You can manually reposition logo by clicking the graphic and 
dragging it to a new position.  
 
You can set the exact positioning, scaling and text wrapping of 
your custom graphic by setting the Left, Top, Scale and Wrap 
values in the [Page Header Logo] section of the 
GraphicSetup.ini file located in the MyGraphics folder. 
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 Letterhead.png (or .jpg) 
 
This graphic is used in 5 possible places by the Wizard. If you 
have selected the Letterhead, Fax Cover Sheet, Envelope, Back 
Page and/or a Contract Pack’s Contract and Terms templates 
the Wizard will insert this graphic into these templates. 
 
If you have not created a Letterhead.png graphic but you have 
created a MyLogo-TitlePage graphic, then the MyLogo-
TitlePage graphic will be inserted instead. 
 
This graphic should be sized appropriately for how large you 
want it to display at the top of these pages. The default size of 
this graphic is 1”x1” at 150 DPI.  
 
If you size the graphic differently you may have to manually 
reposition elements on the page.  
 
Or, you can set the exact positioning and scaling of your custom 
graphic by setting the Left, Top and Scale in the [Back Page 
Logo] section of the GraphicSetup.ini file located in the 
MyGraphics folder. 
 
If you need a very precise custom layout or positioning, it is 
always better to manually update the templates and not use the 
Wizard’s auto-importing features. 
 
This feature requires a placeholder graphic in the templates that 
will be replaced with your custom graphic. This placeholder may 
not exist in older editions of non-logo versions of templates and 
will need to be manually added. 
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 Description.png (or .jpg) 
 
This graphic is optionally used in the front Title Page above the 
text paragraph description of what the document is about. You 
must have the Title Page selected for the Wizard to import this 
graphic into it. 
 
This graphic should be sized appropriately for how large you 
want it to display. A good starting size for this graphic is .5”x2.5” 
at 150 DPI. If you size the graphic differently you may have to 
manually reposition elements on the page. 
 
You can set the exact positioning and scaling of your custom 
graphic by setting the Left, Top and Scale in the [Title Page 
Description] section of the GraphicSetup.ini file located in the 
MyGraphics folder. 

 Accent.png (or .jpg) 
 
This graphic is used in the page footers of each body page and 
at the bottom of the front Title Page. The accent graphic is 
meant to just give a little bit of color and design to the end of 
each page. 
 
This graphic should be sized appropriately for how large you 
want it to display. A good starting size for this graphic is 
.25”x.25” at 150 DPI. 
 
If you size the graphic differently you may have to manually 
reposition elements on the page. 
 
Or, you can set the exact positioning and scaling of your custom 
graphic by setting the Left, Top and Scale in the [Title Page 
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Accent] and [Footer Accent] sections of the GraphicSetup.ini file 
located in the MyGraphics folder. The [Title Page Accent] 
section is used to position the accent graphic on the Title Page 
which can be a different position than when the accent graphic 
is used in the footers of the body pages which use the [Footer 
Accent] settings. 

 TPImage1-4.png (or .jpg) 
 
These images are usually only used in photo designed Proposal 
Packs where there are additional images used along with the 
Watermark-Title.jpg/.png image in the TitlePage2.docx template. 
 
These images should be 150 DPI. 
 
If a design theme uses any of these graphics you can make your 
own copy in the same dimensions and the same file name and 
put your new copy in the MyGraphics folder. 
 
The Wizard will replace the stock photograph with your new 
image. It is important to match the dimensions and DPI to 
ensure the image fits in the exact same location properly. 
 
If a Proposal Pack design theme uses these images you will find 
the stock ones in the Proposal Pack’s Graphics\PNG_Graphics 
folder. 

 BPImage1-4.png (or .jpg) 
 
These images are usually only used in photo designed Proposal 
Packs where there are additional images used along with the 
Watermark-BackPage.jpg/.png image in the BackPage.docx 
template. 
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These images should be 150 DPI. 
 
If a design theme uses any of these graphics you can make your 
own copy in the same dimensions and the same file name and 
put your new copy in the MyGraphics folder. 
 
The Wizard will replace the stock photograph with your new 
image. It is important to match the dimensions and DPI to 
ensure the image fits in the exact same location properly. 
 
If a Proposal Pack design theme uses these images you will find 
the stock ones in the Proposal Pack’s Graphics\PNG_Graphics 
folder. 
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HOW TO PUT A CUSTOM GRAPHIC INTO 
THE PAGE FOOTERS 
 
The Proposal Pack logo design packages include small accent 
logo graphics in the page footers. The plain version “Proposal 
Pack for Any Business” does not include any logos or graphics in 
the page footers. 
 
Page footer graphics make use of Word’s footers which causes 
whatever is in the first page of the section to be replicated down 
into the footer of all following pages. Because of how Word works 
that means you need a way to replace the stock page footers with 
a custom footer (without having to manually change all our stock 
templates because there is no way to know what the first template 
any given proposal will use first). 
 
The way to easily accomplish this is to create a blank word 
document and edit its footer to create your custom footer (such as 
including your company logo and any other items such as your 
company name, contact details, a web site address, custom 
formatted page numbering, etc.) 
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You can create a file in the MyGraphics folder called 
CustomFooter.docx and CustomHeader.docx and the Wizard will 
detect and automatically load the header/footer from those files. 
 
There are some example custom header and footer files in the 
MyGraphics folder you can use. Just make your edits and rename 
the examples and remove the “Example-#-“ part of the name. 
 
Now, whenever you create a new document the Wizard will 
replace the contents of any stock templates footers with the 
footers from this new file, saving you the time of having to 
manually edit the footers on all the stock templates individually. 
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HOW TO IMPORT A COMPLEX TITLE PAGE 
OR BACK PAGE DESIGN 
 
If you need to create a more complex front cover Title Page or 
Back Page design than using a single graphic use this feature 
instead. 
 
Create a file called “Watermark-Title.docx” or “Watermark-
BackPage.docx” in the Wizard’s MyGraphics folder. 
 
There are example files in the “Example-CustomHeaderFooter4” 
folder you can use as a guide that will show you how a complex 
design using multiple shape objects and pictures can be created. 
 
Add all your custom design elements into the header of the 
document. Do not put any elements in the footer or in the main 
body of the document. The Wizard will only copy what it finds in 
the header. 
 
If you see any of your custom elements not being copied but you 
see them in the Watermark-Title.docx or Watermark-
BackPage.docx file move those elements into the header. 
 
Once you have created your custom design run the Wizard and 
create a new project, select the Title Page and/or Back Page 
templates along with any other templates, then build your 
document by saving the project. 
 
You will see the stock background of the Title Page and/or Back 
Page replaced with your custom design. 
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HOW TO EDIT PAGE HEADERS THAT ARE 
GRAPHICS? 
 
https://www.proposalkit.com/htm/videos-convert-graphic-headers-
to-text.htm 
 
If you are using the brandable packs “Proposal Pack for Any 
Business” or “Proposal Pack for Government Grants” the page 
headers are all in editable text and this issue does not apply. 
 
If you are using any of the other Proposal Packs with a graphic 
design them then the page header titles are all in graphics. The 
reason page headers are in graphics is due to costs and licensing 
issues. In order to create the visual look, we use custom font types 
for the page header graphics however we do not own the licenses 
for those fonts that would allow us to distribute them as editable 
font types. 
 
To solve this, we create the page headers as graphics and embed 
the graphics in the Word document templates. Since we supply 
over 2200 chapters most people do not need to edit them to 
create custom chapters. 
 
If you do want to be able to edit the chapter headers in the graphic 
design themed Proposal Packs the Wizard includes a feature that 
will replace the graphic chapter headers with editable text.  
 
Click the button #1 Document Styles > Edit Style > Graphics tab. On 
this screen you can check the box “Replace Page Header 
Graphics with Text”.  

https://www.proposalkit.com/htm/videos-convert-graphic-headers-to-text.htm
https://www.proposalkit.com/htm/videos-convert-graphic-headers-to-text.htm
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When you create new projects, the documents will be built with 
text versions however you will lose the custom font types we used 
in the design. 
 
You can purchase your own license for the same font type we 
used (or any font type of your choice) and install it on your 
Windows computer. Fonts can be purchased from many online 
sources. 
 
Once you have a font type installed you can set that font type in 
the Wizard’s Preferences > Data & Display > Font Styles screen. 
 
Set the Proposal Kit Page Header and Proposal Kit Faux Page 
Header custom styles to whatever font type you want that is 
installed on your computer. 
 
Once you have made these customizations the Wizard will 
generate your project documents using editable Word text that will 
also look like the original graphic design theme version. 
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HOW TO CREATE CUSTOM PAGE HEADER 
GRAPHICS 
 
While the brandable Proposal Pack for Any Business uses text for 
all the chapter headers and is easily editable, the graphic 
designed Proposal Packs use graphics in order to create a more 
customized design without requiring the user to purchase 
additional font types. 
 
While Proposal Pack includes thousands of chapters sometimes 
there is a need for a custom titled graphic. 
 
A new graphic header had to be created. Then it must be inserted 
into the document and if the Table of Contents chapter is being 
used the hidden TC Field for the text of the chapter header must 
also be updated. 
 
To create a new graphic Proposal Pack includes the original 
artwork files in Adobe Photoshop and Adobe Illustrator formats. 
You may also need to purchase the font type and install the font 
on your computer first. Fonts can be purchased from many online 
font vendors and some fonts may be free to download. Proposal 
Kit does not provide font files and we do not own the licenses to 
provide any font files.  
 
Open the PageTitle.psd or PageTitle.eps file found in the Proposal 
Pack, edit the text then save your new graphic in the PNG file 
format. If you are unable to create your own custom graphic, you 
can order custom graphic creation services from Proposal Kit. 
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https://www.ProposalKit.com/htm/service.htm 
Once the custom graphic is created it must be saved in the 
MyGraphics subfolder of the Proposal Pack Wizard installation. The 
same folder you found this Readme.pdf in. 
 
This folder should be: 
 
C:\ProposalKit\ProposalPack\MyGraphics 
 
The Wizard needs to know the template that this graphic will be 
inserted into and it needs to know what the new chapter header 
text will be. The Wizard cannot detect what is inside the image. So, 
this is done by how the file is named. 
 
The format of the file name must be: [Original Title][New 
Title].png or .jpg 
 
The Wizard will look for any files with file names in this format and 
will assume they are new chapter headers. 
 
For example, you want to replace the Executive Summary graphic 
header with a new one titled Proposal Summary. If we use the 
Proposal Pack Architecture #3 design theme as an example here 
are what the graphics will look like: 
 

 
 
New file named: [Executive Summary][Proposal Summary].png 
 

 
 

https://www.proposalkit.com/htm/service.htm
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Another example is changing the title of the About Us page to 
Who is Proposal Kit? This is useful when you want to include your 
name in a chapter header for example. This illustration is to show 
how to deal with chapter headers that use characters that are not 
allowed in a file name. 
 
The issue here is that the question mark is one of several 
characters that cannot be used in the text of the chapter header, 
but we may still need to include. The file naming solves this by 
using substitutions to stand in for the unusable characters. 
 

 
 
New file named [About Us][Who is Proposal Kit{QM}].png 
 

 
 
The following substitutions can be used in the file name: 
 
{BS}  = \ 
{FS}  = / 
{CO}  = : 
{AS} = * 
{QM} = ? 
{QU} = “ 
{LT}  = < 
{GT}  = > 
{VB} = | 
{LB} = [ 
{RB}  = ] 
{PD}  = # 
{DO} = . 
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Look in the MyGraphics subfolder “Example-
PageHeaderReplacements” for copies of these custom graphics. 
 
This will show you how to name the files correctly so the Wizard 
can find them and apply them to the correct page and update the 
Table of Contents to match the text in the graphic. 
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HOW DO I USE THE 6-COLOR PALETTE TO 
MATCH MY LOGO COLORS? 
 
https://www.proposalkit.com/htm/videos-add-logo.htm 
 
The Proposal Pack templates are designed around a 6-color 
palette. These 6 colors are applied to various parts of the 
documents (page borders, header fonts, tables, pull quotes, full 
page backgrounds and bullet points). 
 
The Proposal Pack for Any Business pack is set to a default 
conservative black/grey/white palette. 
 
The Proposal Pack for Government Grants pack is set to a default 
red/white/blue/grey/black palette. 
 
All the other Proposal Packs with colorful logo designs have color 
palettes that match the logo graphics. This makes your entire 
document consistent in design and color across the entire 
document. 
 
The 6-color palettes are designed for you to be able to customize 
them to your own company colors so when the Wizard assembles 
your documents all those page design elements will automatically 
be created using your custom colors. 
 
To change the colors, click on the Wizard home screen Document 
Styles > Edit Style > Colors. 
 

https://www.proposalkit.com/htm/videos-add-logo.htm


444 

Since there are multiple color palettes that can be applied by the 
Wizard the following is the order of precedence for which palette 
is used: 
 

 If you have customized the Preferences > Data & Display > Word 
Styles colors, these will take priority first. 

 If you have selected a custom Title Page Pack title page with a 
specific color scheme, that 6-color palette will be used. 

 Otherwise, the 6-color palette defined in the Document Styles > 
Edit Style > Colors screen will be used. 

 Finally, there are custom colors that can be set in the Fonts, 
Borders and Tables tab that will override the default 6-color 
palette. You can individually set the overall page border color, 
the color of non-graphic bullet points and table border colors. 

 
The Color #6 is reserved for use in select Proposal Packs such as 
the Proposal Pack for Any Business, Proposal Pack for 
Government Grants and the photo-based Proposal Pack design 
themes. Other Proposal Packs that use logo designs are typically 
designed for white page backgrounds. 
 
Most documents look best with light colored backgrounds and 
dark text. The Wizard can be configured to create dark body 
pages with light text by changing the color palette and editing the 
Word font Styles. You will have to experiment with light and dark 
colors to find a combination that all works together. 
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If using colored backgrounds with logos and graphics, it is best to 
use transparent logos in PNG format so that background page 
colors will seamlessly show through your logo. Otherwise you 
should stick to adding logos and graphics that are designed to be 
square so that they still look good against a colored background.  
 
If you are unable to mix your logos and graphics against a colored 
background, consider using a white background and set Color #6 
in the palette to white and turn off the use of the watermark 
shapes. 
 
Photo based design themes and design themes with solid 
background colors and lots of dark colors are typically best used 
for PDF and electronic documents and for high-quality printing on 
full-bleed printers on stock designed for photos. 
 
Also see these chapters for additional document branding 
features: 
 
How to Import Custom Graphics Using the MyGraphics Folder? 
 
How do I use the MyProjectFiles folder? 
 
The Wizard allows you to copy your own custom files that are not 
part of the Proposal Kit system into each of your new projects 
using the MyProjectFiles folder. 
 
This feature allows you to automatically copy your own content 
such as worksheets, checklists, letters, spreadsheets, forms, etc. 
into each of your new Proposal Pack Wizard project folders. 
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The MyProjectFiles folder is in the root install folder where the 
Proposal Pack Wizard is installed. This folder by default is: 
 
C:\ProposalKit\ProposalPack\MyProjectFiles 
 
Whenever you build a new document in the Wizard a copy of all 
the files in the MyProjectFiles folder will be made into your 
document’s project folder. 
 
You should not name any of your custom files the same file names 
and extensions as any of Proposal Kit’s document file names. 
 
Use the Preferences > Project Settings > Configure MyProjectFiles 
Settings screen to manage adding files, removing files, and setting 
attributes for the custom files in the Wizard database. 
 
You can manually copy files into the MyProjectFiles folder however 
that will not setup any of the attributes such as human readable 
titles for use in the Wizard drop down menus. Use the Wizard’s 
Preferences tool for managing the attributes.  
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How do I Change/Use Word Font Styles? 
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HOW DO I USE ADD-ON TITLE PAGE 
PACKS? 
 
https://www.proposalkit.com/htm/videos-how-to-use-title-page-
packs.htm 
 
Title Page Packs are a line of products that give you more choices 
for the design of your Title Page. Each Title Page Pack contains 5 
design choices and each of those design choices comes in either 
120 color schemes. 
 
That means each Title Page Pack has 600 Title Page templates to 
pick from. 
 
Your Proposal Pack collection of templates comes with one Title 
Page volume and Proposal Kit Professional comes with four Title 
Page volumes. 
 
When you purchase and install one or more Title Page Packs you 
access them from the Wizard’s Pick Documents Screen in the 
“Title Page” tab. 
 
This tab will allow you to select a specific installed Title Page Pack 
volume, and a design from that volume and a color scheme for that 
design. 
 
You will see a thumbnail graphic of the selected Title Page 
displayed as you select the color scheme. 
 

https://www.proposalkit.com/htm/videos-how-to-use-title-page-packs.htm
https://www.proposalkit.com/htm/videos-how-to-use-title-page-packs.htm
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To make the Wizard use one of these alternate Title Page choices 
instead of the stock default Title Page click the purple button 
labeled “Use Selected Title Page”. 
 
If you want to restore the default template, click the purple button 
labeled “Use Original Title Page”. 
 
If you want to make custom edits to one of your selected alternate 
Title Pages, click the purple button labeled “Edit Selected Title 
Page”. If you save your changes, those changes will be applied to 
all future uses of that specific Title Page template. 
 
You can check the box labeled “Also use this selected Title Page 
for all future project” and after you click the “Use Selected Title 
Page” button all future projects you create will use that alternate 
selected Title Page. 
 
If you create a Preset, any custom selected Title Page Pack 
document will be added to that Preset.  
  
Proposal Graphics Packs are already designed with custom Title 
Page graphics with logos. The Title Pages with most Proposal 
Graphics Packs are already designed with a Title Page 
background graphic that matches the logos.  
 
If you are using the Title Page Pack with a Proposal Graphics Pack, 
you have two options for how you want the “Proposal” and 
“Description” sections of the Title Page to look. This does not 
apply to the plain text versions Proposal Pack for Any Business or 
Proposal Pack for Government Grants. 
 



450 

 You can leave the default “Proposal” and “Description” sections 
of the alternate Title Page in black text by unchecking the box 
labeled “Insert Proposal Pack graphics into this Title Page”. 

 You can import the Proposal Graphics Pack’s “Proposal” and 
“Description” logo graphics into your alternate Title Page by 
checking the box labeled “Insert Proposal Pack graphics into 
this Title Page”. 

 
Not all combinations of Title Page Pack design/color schemes will 
work together visually. Select a visually appealing combination of 
colors and logos. It may take some experimenting with various 
combinations to find a good match. Depending on the designs and 
size of logos you might need to reposition and/or resize some 
elements on the Title Page. 
 
When you select a custom Title Page and you are using the Back 
Page, the Wizard will switch to using the “Back Page Generic” 
template so that the Wizard can apply the same color scheme to 
the Back Page that is used in the custom Title Page. 
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HOW DO I USE WORD DOCUMENT 
SECTIONS? 
 
This chapter describes a feature of Microsoft Word that our 
Proposal Pack Wizard makes use of. Sections are a feature of 
Microsoft Word and you can learn more about them by reading 
your Microsoft Word documentation. 
 
A “Section” is part of a Word document. Every Word document has 
at least one (1) section. For example, a 10 page word document 
usually has all its pages in one section. You can see where a 
document’s section breaks are by using the Draft View mode. 
 
By default, if you create a Word document and type any number of 
pages, your document will have one section and all pages of that 
document will be in that section. 
 
The problem this introduces is when you need to incorporate 
pages of your document with different layout and design features 
such as page numbers, colored page borders, background 
watermark graphics, headers and footers. 
 
A typical Proposal Pack Wizard created document will have 1 to 4 
sections.  
 
The Cover Letter / Cover Sheet / Inquiry Letter will be in the first 
section. This first section is setup to turn off page numbers, 
colored borders and background graphics. 
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The Title Page will be in the next section (section number 1 or 2 
depending if there is a Cover Letter section above it). The Title 
Page is put into its own section because it has page numbering 
turned off and may have a custom background graphic design. 
This requires the Title Page to be in its own section, so the custom 
background graphic design does not replicate into the rest of the 
pages below it. 
 
The body of the proposal (i.e. all pages from the Table of Contents, 
Executive Summary, Products, Services, Project Details, and so on) 
will be in the next section (section number 1, 2 or 3 depending if 
there are a Cover Letter and/or Title Page above it). The body of 
the document is where page numbers are turned on, accent 
graphics are included in the footer and a body watermark graphic 
is included in the header. This requires that all pages of the body 
of the document be in one section, separate from the other 
sections. 
 
The Back Page will be in the last section (usually section 4 if there 
is also a Cover Letter, Title Page and other body pages selected). 
The Back Page is like the Title Page with its own unique 
background watermark graphic that compliments the Title Page. 
 
This document structure will create a consistently formatted 
document using Proposal Kit and the Wizard software. However, 
there are times when a more complex document structure may be 
needed.  Some examples would be if you have additional external 
documents you want to insert into the generated document, or you 
were given forms or tables from a 3rd party they want inserted into 
the document.  
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This external content may have page layouts that require different 
page margins, page borders, headers, footers, etc.  In this case 
you need to have a new Word Section created that is unlinked 
from the sections above and below it.  This can be a tedious and 
more complex task for new Word users.   
 
The Wizard can add up to 100 additional independent Sections to 
the end of the generated document.  Up to 50 can be added 
before the final Back Page and up to 50 can be added after the 
final Back Page. Look in the Preferences > Project Settings > 
Configure Document Creation screen for the settings.  Set these 
before you generate your document and if this is only required for 
the creation of one document you can set them back to 0 before 
creating your next project. 
 
Because the Wizard generates documents with a very specific 
structure of Word Sections it is important to not insert Section 
Breaks into any documents that you are using to build into the 
master project document that is assembled from various templates 
and content files.  The Wizard will detect if you have inserted a 
Section Break into any pages being assembled together and warn 
that it may cause formatting problems. If the assembled document 
does not look properly formatted and you have added Section 
Breaks remove them and rebuild the project. 
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HOW DO I ADD CUSTOM TITLED 
PAGES/CHAPTERS? 
 
To add a custom titled section or page that is not in the original list 
of Proposal Pack templates, you might first need to create a title 
header graphic if you are using a Proposal Pack with an 
embedded graphic theme. 
 
If you are using a Proposal Pack that does not use a graphic theme 
(such as Proposal Pack for Any Business or Proposal Pack for 
Government Grants), the Wizard will automatically change the 
page header text for you if you alter the page header text in the 
database. Changing the titles of the templates is done using the 
Configure Proposal Files tool in the Preferences. 
 
If you have significantly altered the original Proposal Pack 
templates such that the text headers positions or font sizes are 
different you may need to adjust some settings in the Document 
Style edit screen. The Sentences Till Header is the maximum 
number of sentences down that the header text is found on a 
page. Typically, the header is the first sentence. The Minimum 
Header Text Font Size is the smallest font size that a page header 
will be, typically this is 24 points. You can also completely disable 
this feature by unchecking the Replace altered text headers 
checkbox. 
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If you are using a Proposal Pack style which includes graphics, you 
can create custom page title header graphics using the 
PSD/EPS/PNG artwork files supplied with your Proposal Pack or 
Proposal Kit. See your Proposal Pack Documentation.pdf file or the 
section in this manual Easily Create Your Own Graphic Style for 
details on how to create your own custom graphics. 
 
Create your new header graphic and save it to the graphics folder. 
From the Wizard Interface go to Preferences > Tools > Configure 
Proposal Files. Select the Type of Proposal you are creating this 
new template for then select Create & Add a New Document. Pick 
any existing document as a starting point. When you click OK, an 
Edit New Documents screen pops up. From the list select the new 
document in the style you want to edit. Once the new document 
opens, replace the header graphic with the new graphic you 
created using Word’s Insert > Picture > From File and then make 
any text edits needed for this template. 
 
You will now be able to select your new template from the drop 
down list boxes when picking your documents for each new 
proposal. 
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HOW DO THE EDIT SCREEN DOCUMENT 
PROCESSING TOOLS WORK? 
 
https://www.proposalkit.com/htm/videos-how-to-use-batch-
processing-tools.htm 
 
The Wizard has a set of tools you can use to apply changes to any 
Word documents and those tools are available in both the 
Preferences and the Edit screens. These tools are an Expert 
Edition feature. 
 
While the tools are the same, they are typically used on different 
types of documents. If you have Word documents that were not 
created by the Wizard, you can apply these document processing 
tools from the Preferences > Tools > Batch Process Documents 
screen. 
 
If you want to apply some of these tools to a document already 
created by the Wizard in one of your projects, you can apply them 
from the Home screen > Edit Current Document > Document 
Processing screen. 
 
There are a wide variety tools available you can apply to your 
documents. 
 
Many of these operations are performed on the documents as they 
are created by the Wizard initially. However, due to editing of a 
Word document its possible some things may need to be checked 
or updated such as making URLs clickable or checking for left over 
data or instructional text. 
 

https://www.proposalkit.com/htm/videos-how-to-use-batch-processing-tools.htm
https://www.proposalkit.com/htm/videos-how-to-use-batch-processing-tools.htm
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TESTING TOOLS 
 

Test for left over << >> tags 
 
This tool will scan the document for any leftover instructional 
or data merge tags that should be removed. 

 

TEXT TOOLS 
 

Remove Proposal Pack Important Body Text 
 
This tool will remove any text in the document that has the 
Word Style “Proposal Pack Important Body Text” applied to it. 
This is a Word Style set to red text that is typically used for 
important instructional text. 
 
This feature also allows you to create an Editors Version of 
your documents with instructional or Q&A text that is meant 
to be finished off by your editor. Once the documents are 
finished this tool can be used to batch remove any leftover 
instructional text for the final production version. 
 

Add Proposal Kit defined Word Styles 
 
This tool will add all the predefined Proposal Kit Word Styles 
to the document. Any document created by the Wizard will 
have these styles already included. This tool is intended for 
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use with your external documents to get them ready for use 
within the Wizard. 
 

Change font styles 
 
This tool will allow you to change all the major header and 
body Word Styles in the document in a single operation 
rather than individually modifying all the Styles manually. For 
example, use this to change all the chapter header, title page 
header and sub header fonts from Arial to another font. 
Another way to use it is to set all the body text font types 
used in the document from Times New Roman to something 
like Proxima Nova for example. To make these changes 
before documents are created use the Preferences screen to 
change the font types. 
 

Convert all URLs to clickable links 
 
This tool will scan all the text in the document and if it finds 
any text that appear to be a URL or email address it will make 
it a clickable link. 
 

Remove all clickable hyperlinks 
 
This tool is used to remove all hyperlinks from the document 
such as email addresses and URLs. Internal document links 
such as the Table of Contents and references within the 
document will be retained. 
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Change URL and email links 
 
This tool will change all the URLs and email links in the 
document to a specific link or email while retaining the 
original text version. This is useful for creating fictional 
documents with fake addresses for the display, but you want 
them to link to a valid address such as your own web site. 
 

Set all footer text to specific Style 
 
This tool will change all text in the footers of the document to 
a Word Style you select. For example, if the generated 
document has normal font sizes and underlined hyperlinks 
but you just want a more subdued and smaller font type use 
this tool and pick the Proposal Kit Footers Style. 
 

Merge Data with Tags 
 
This tool will reapply all the data merging into any tags left in 
the document. Tags that will be merged into include the 
Company Data and Client Data screen information and Excel 
spreadsheet linking tags. 
 
This gives you the ability to create a document and skip 
doing the merging when the document is first created then 
apply it later. 
 
Another use is to add additional tags into the document that 
are more difficult to merge than the standard text tags such 
as adding additional Excel spreadsheet cell links. Using this 
ability you can customize a spreadsheet and then add 
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additional <<XLS:[FileName]:R#C#>> tags into a document 
and then use this tool to easily link the existing document into 
an existing or a new spreadsheet. 

 

IMAGE TOOLS 
 

Convert graphic headers to text 
 
This tool will convert all the graphic chapter headers to 
editable text while retaining the design theme logo. You can 
do this conversion during document creation by checking an 
option in the Edit Style screen. This tool is to prevent having 
to rebuild a document after it has been created to convert the 
chapter headers. You will lose the font styling used in the 
graphic version of the chapter headers and the editable text 
version will be set to Arial. You can then modify the header 
Word Styles to change the font type of the text headers to 
any font you have installed on your computer. You can also 
use the Change font styles tool at the same time to do both 
operations at once. To retain the exact font type used in the 
original graphic headers you will have to have that font 
installed on your computer which may require you to 
purchase the font type from a 3rd party font provider. 
 

Reposition chapter header logos 
 
This tool is used to adjust the position of every chapter 
header logo after you have used the tool “Convert graphic 
headers to text” to convert graphic chapter headers to text. 
Tool “Convert graphic headers to text” can result in the 
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chapter header logos being too low or high in relation to the 
text. If you only have a few chapter headers they can easily 
be repositioned manually however a large number is easier 
to change all at once using this tool. 
 

Replace title page watermark using .docx file 
 
This tool will swap the title page watermark in the selected 
document with the header/footer watermark in the 
Watermark-Title.docx file. This allows you to import a complex 
design for the title page watermark using multiple images and 
shape objects. 
 

Replace body watermark using .docx file 
 
This tool will swap the body page watermark in the selected 
document with the header/footer watermark in the 
Watermark-Body.docx file. This allows you to import a 
complex design for the body watermark using multiple 
images and shape objects. 
 

Replace back page watermark using .docx file 
 
This tool will swap the back page watermark in the selected 
document with the header/footer watermark in the 
Watermark-BackPage.docx file. This allows you to import a 
complex design for the back page watermark using multiple 
images and shape objects. 
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Change bullet points 
 
This tool will allow you to change the custom bullet point 
graphics in generated documents. It is best to use symbols or 
graphics when changing bullet points in documents created 
using Proposal Pack for Any Business or Proposal Pack for 
Government Grants. It is best to use graphic bullet points in 
all other Proposal Packs. It may not work if trying to change 
symbol bullet points to graphics in some design themes. 
Bullet point graphics should be 15x15 up to 20x20 pixels in 
size. 
 

Change footer accent graphic 
 
This tool will change the graphic in the footer of the body 
pages to a new accent graphic you can browse to and select. 
 

Change letterhead graphic 
 
This tool will change the letterhead graphic in the Letterhead, 
Fax Cover Sheet, Contract and Terms and Back Page 
templates. 

 
Change description graphic 
 
This tool will change the description graphic in the front Title 
Page. The description graphic is only used in older line art 
style design themes and is an optional graphic that can also 
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be removed manually. There is no description graphic used in 
the photo design themes. 
 

Change title page graphic 
 
This tool will change the title page graphic in the front Title 
Page. The title page graphic in the Proposal Packs is the 
graphic with the word Proposal, Business Plan, etc. next to 
the logo. This is also the placeholder logo that gets replaced 
when you use your own custom logo. 
 

Change title page watermark graphic 
 
This tool will change the title page watermark graphic in the 
header of the title page of the document. This is only used for 
design themes that have graphic in the header used as the 
watermark. Some design themes use shape objects that do 
not use a graphic. For more complex watermark designs use 
the “Replace title page watermark from .docx file” tool 
instead. 
 

Change body watermark graphic 
 
This tool will change the body watermark graphic in the 
header of the main body pages of the document. This is only 
used for design themes that have graphic in the header used 
as the faded watermark. Some design themes use shape 
objects that do not use a graphic. For more complex 
watermark designs use the “Replace body watermark from 
.docx file” tool instead. 
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Change back page watermark graphic 
 
This tool will change the back page watermark graphic in the 
header of the back page of the document. This is only used 
for design themes that have graphic in the header used as 
the watermark. Some design themes use shape objects that 
do not use a graphic. For more complex watermark designs 
use the “Replace back page watermark from .docx file” tool 
instead. 
 

Change chapter header logo graphics 
 
This tool will change the chapter header logo graphics. This is 
the graphic in front of the chapter headers on each body 
page. This is only used for design themes that use graphics 
for the page headers.  
 
If the chapter headers have not yet been converted to text 
that operation will be done first. If you have converted the 
chapter headers to text already, which replaces the full 
graphic with embedded text to editable text with just the 
logo, then this tool will just change the logos. 
 
Since replacement of the graphics usually uses a logo of a 
different size you may also need to reposition all the chapter 
header logos. Use the tool "Reposition chapter header logos" 
to reposition the new logos. 
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Apply custom header from .docx file 
 
This tool will replace the contents of the header in the body 
pages of the document with a custom header if you have 
created one. There are examples in the MyGraphics folder. 
 

Apply custom footer from .docx file 
 
This tool will replace the contents of the footer in the body 
pages of the document with a custom footer if you have 
created one. There are examples in the MyGraphics folder. 
 

STRUCTURAL TOOLS 
 

Update Table of Contents 
 
This tool will do a full update of any Word TOC (Table of 
Contents) objects in the selected documents. You can also 
manually update TOC objects by right clicking them with your 
mouse and choosing the update options. If you are unsure 
how to update a Word TOC object in your Proposal Kit 
generated documents, you can use this tool. 

 

Update metadata 
 
This tool will update the meta data fields of the document 
with the data defined in the Wizard’s Preferences. 
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Change table settings 
 
This tool will apply changes to all the tables in the document. 
Changes you can make include spacing between cells, table 
border colors, table cell colors. This tool is intended to allow 
you to easily make all your tables consistent in their visual 
appearance. 
 

Change entire color scheme 
 
This tool allows you to prescan the document to determine all 
the colors used in the various parts of the document such as 
font headers, page borders, table cells, table borders and 
shape objects. You can then set new colors as replacements. 
The Wizard will then replace all uses of the original colors 
with the new colors. This allows you to create a consistent 
and new color scheme for a document that is not tied to the 
stock Proposal Pack design theme. 

Apply current style color scheme 
 
This tool will apply the color scheme defined in the Document 
Styles screen. This is usually done to make a color change to 
a document already created by the Wizard such as to change 
the colors of table cells or header text across the entire 
document. 

Change document page settings  
 
This tool will change the page settings of the document such 
as paper size and page margins. 
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Change page borders 
 
This tool will change the page border of the body section of 
the document. 

Remove page borders 
 
This tool will remove the colored border around the body 
pages of the document (if there is one). The page borders are 
only used in some of the older line art design themes by 
default. 
 

Add new document sections 
 
This tool is used to add section breaks to the start and/or the 
end of the document. The new sections have the headers 
and footers unlinked from the other sections. This allows you 
to insert content that may otherwise alter the page borders, 
margins, and other formatting without disrupting the 
formatting of the rest of the document. This is useful when 
having to include forms supplied by the agency or company 
you are submitting an RFP response to. 
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MIGRATION TOOLS 
 

Save legacy .doc files as .docx 
 

This tool is used to save all the old Word 2003 legacy format 
.doc files in the current .docx format. The files will still look and 
work the same way as before. Use this tool if you are 
migrating from an older version of Proposal Kit and you need 
to move documents into the new system. Copy your old files 
to a temporary folder and batch update all the files at once. 
Then copy them to the appropriate folders in the new version 
of the Wizard and Proposal Kit as needed. 
 
This tool can only be used by itself. Any other tools you have 
selected will be unselected when this tool is selected. 

 
TROUBLESHOOTING TOOLS 
 

Move full size shapes to back of zorder 
 
This tool is meant to help clean up a possible glitch when 
Word sometimes gets the zorder (i.e., the layering) of the 
objects wrong. The layering of objects should be identical 
between the source and destination documents when the 
Wizard generates documents and pulls in the background 
watermarks from a WatermarkBody.docx file however 
sometimes Word may put a full size shape object in front of 
the rest of the objects resulting in them appearing to be 



469 

missing. You can either manually change the zorder by 
moving the topmost shape to the back or use this tool. 
 

Delete full size body watermark shapes 
 
This tool will delete any full page size (8.5x11) shape objects 
in the body pages of the document. Normally these shape 
objects do not cause any problems except when Word may 
get the zorder wrong. See the tool “Move full size shapes to 
back of zorder” for another option for cleaning up these 
layers when needed. Many Proposal Pack design themes 
include a full size shape object in white in the header/footer 
section of the body pages as a way for users to easily change 
the page color shading using the Wizard’s color palette tools. 
This tool can remove those full size shape objects if they are 
causing any issues with the display of other objects in the 
body page headers/footers. 
 

Rebuild chapter templates (Word bug workaround) 
 
This tool rebuilds Proposal Pack chapter templates as a 
workaround for a Word bug introduced in the August 3, 2022 
build of Microsoft Office that results in a 5097 error when 
assembling a document in the Wizard. 
 
This tool will rebuild the templates that are to be assembled 
in a way that Word will be able to insert them without failing. 
 
This tool is only for use on the Proposal Pack chapter 
templates which are the working templates contained within 
the proposal project folder.  Once rebuilt you can reassemble 
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the project.  This tool will also turn off the Word Insert Bug 
workaround so the templates will be assembled using the 
normal Wizard operations. 
 
To rebuild your entire template library use the repair tool in 
the Wizard Preferences > Tools > Repair Tools > Rebuild 
Template Library button. 
 
The version of this tool in the project screen will automatically 
select all convertable chapter templates for that project. 
When run from the Preferences you can browse and select 
the chapter templates manually.   
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HOW DO I FINISH MY PROPOSAL? 
 
Once you have created your proposal documents and cleaned up 
any formatting issues, you are ready to finish your proposal. 
 
At this point you will have to fill in the details which only you can 
provide for the proposal specific to your company, the 
product/service/project being proposed and your client.  
 
Also review the samples included with your Proposal Kit or 
Proposal Pack for a large collection of actual proposals created 
using our templates. The samples will show you how other 
companies and individuals have taken the Proposal Pack 
templates and filled them in for their own custom proposal. The 
templates are used for just about any kind of business proposal in 
any industry.  
 
If you need to include charts, graphs, complex costing, etc. you 
can find a variety of 3rd party programs to create such content 
which can then be included in your proposal documents. 
 
You should save your final digital distribution versions in Acrobat 
PDF format to ensure your end reader can view it as you intended 
and to prevent misuse and unauthorized editing (as best possible). 
Read this chapter for more details: How do I Save in PDF Format? 
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HOW DO I SAVE IN PDF FORMAT? 
 
The Wizard has PDF creation and management features built into 
the interface. 
 
The actual saving of documents in PDF format is part of your Word 
software and you must have this feature available in your version 
of Word to save documents from the Wizard in PDF format. 
 
Microsoft started supporting this feature in all versions of Word 
starting with Word 2010.  
 
You can always save any document using Word by clicking the 
“Save As” option and saving as a PDF format file (or using Adobe 
Acrobat Pro and using the Word toolbar buttons provided by Word 
and Acrobat. These features are part of Word already. 
 
The Wizard improves the PDF saving features by giving you a 
button in the edit screen to save any of your Wizard created 
documents in PDF format automatically. The Wizard will then 
display both your Word and PDF files for your project in the 
interface and will allow you to easily see and open either the Word 
or PDF versions. 
 
When the Wizard opens the edit screen and sees there are both 
Word and PDF files it will ask you which ones you want to open. It 
is presumed that once you have created a PDF version of a Word 
document that the PDF version is the one you will be delivering. 
 
The Wizard will also scan your Word files before saving PDF 
versions to see if you may have forgotten to fill in any of the data 
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merge tags or if you may have forgotten to remove any of the 
instructional text in the original templates. 
 
If you update your Word documents by adding new pages or 
regenerating your combined document the Wizard will also check 
if there are PDF versions and will notify you to update the PDF 
versions after finishing your edits to the updated Word versions. 
 
You should always send your document as a PDF whenever OLE 
objects were linked into the document such as when using the 
dynamic OLE spreadsheet links. The PDF format will ensure your 
final document is self-contained and rendered in a way that 
ensures the reader will see it as intended and not be able to edit 
or view your calculations. 
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WHAT TYPES OF COST CALCULATION 
FEATURES ARE AVAILABLE? 
 
Not every document needs to have extensive cost calculations or 
a line item database to generate quotes. Proposal Kit is designed 
to scale from a simple text only document to one combined with 
higher end cost quoting solutions provided by 3rd parties and 
some options in between. 
 
Word is a text editing and presentation program, so it is not 
designed to be able to do any calculations by itself. If you need to 
do calculations, they need to be done externally such as by a 3rd 
party system or an Excel spreadsheet. That data then needs to be 
put into a presentable format. The presentation format is generally 
the final Word document that is then rendered as a PDF document 
or printed. 
 
With the Novice Edition of the Wizard documents are created as 
stand-alone text based Word documents. There are also external 
Excel spreadsheets included you can use to do sales or business 
plan financial calculations which then must be manually typed into 
the Word documents. This is the most basic setup and how most 
people use the Proposal Pack. 
 
The Expert Edition of the Wizard includes features that allow you 
to dynamically link those Excel spreadsheets into the Word 
templates so that as you update calculations in the spreadsheets 
the updated cells will be auto-updated in the Word document. This 
allows for a more dynamic document. More complex proposals 
with a lot of costs, business plans and so on that are developed 
over a longer period and may have their calculations changed 
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during that time can benefit from using dynamically linked Excel 
spreadsheets. See this chapter for details: How do I Add 
Dynamically Linked Spreadsheet Calculations? 
 
The use of an Excel spreadsheet allows you to do complex 
calculations and many additional pieces of data that you generally 
do not want to include in the final presentation document. The 
dynamically linked Excel spreadsheets allow this by letting you do 
any level of calculations you need that can be done by Excel but 
then only link specific cells that you want in the final presentation 
to the Word document. 
 
Dynamically linked spreadsheets are not meant to be a solution for 
every document. There are limitations to using OLE links. Too 
many links can cause performance or stability problems with Word, 
so it might not be suitable for using hundreds of links for example 
which can occur if trying to build a quote with many line items or a 
complex business plan with many financial calculators. 
 
Linking Excel spreadsheets to your Word document can give you 
additional features you might not get even when using a 3rd party 
quoting system. A 3rd party quoting system could generate a quote 
embedded into your document but may not have the dynamic 
linking features that would allow for having changes made to the 
calculations auto-update in the Word document as you are 
developing a detailed or complex proposal or business plan. 
 
This feature has a higher learning curve but still uses all the 
standard features of Word and Excel and also allows for creating 
very customized solutions including custom calculations and 
custom spreadsheets without having to purchase any additional 3rd 
party software. 
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The next level up is for companies that have very complex cost 
calculations that require a large line item database such as 
companies selling large quantities of products or product resellers 
who need to import catalogs of items from suppliers to generate 
sales quotes from. Proposal Pack Wizard integrates with the 3rd 
party quoting software QuoteWerks as a higher end solution that 
combines the Proposal Packs, Proposal Pack Wizard and 
QuoteWerks. See this chapter for more details:  
How do I Add a Line Item Quote? 
 
The Wizard’s built-in line item database system is used 
automatically and nothing extra needs to be setup initially. 
 
See the Line Item Database Manual for all of the details of using 
the Wizard’s line item database for quotes, schedules and 
business plan financials, etc. 
 
All you need to do is click the Line Item Quote button in the project 
screen. If you have selected templates for your project that are line 
item database enabled the Wizard will add those database 
components to your project. 
 
If you select a premade database or import a Sample Proposal that 
has a custom database that will be assigned to your project 
automatically. 
 
Then you can start adding line items to your project which will be 
automatically output into your documents when you save your 
project and build your project documents.  
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How do I Integrate with QuoteWerks? 
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WHAT HAPPENS IF DYNAMIC 
SPREADSHEET LINKING IS DISABLED? 
 
In the Novice Edition of the Wizard the dynamic spreadsheet 
linking feature is automatically disabled. In the Expert Edition of 
the Wizard the features can be disabled across the board in the 
Preferences and it can be disabled on a project basis using the 
checkbox in the project screen. 
 
In all cases of the feature being disabled the spreadsheets will not 
have dynamic OLE links added between them and the generated 
document created for the project. 
 
This is how the Proposal Pack always worked in the past before 
this feature was added. The spreadsheets will still be copied to the 
project folders. The Wizard will not covert any of the <<R#C#>> 
tags into OLE links. 
 
The Wizard will however replace all the known <<R#C#>> tags in 
the stock Word templates with more readable text related to what 
kind of information normally goes in those locations. This will put 
the generated documents in a state matching what the Proposal 
Pack generated documents looked like before the dynamic 
spreadsheet linking updates were made to the product. 
 
For example, if a template used a tag such as <<R2C2>> linked to 
a cell in a spreadsheet that contained the current year, the Wizard 
will now just replace it with the <<CurrentYear>> tag which will 
then be converted to the actual year. Another example would be if 
a range tag was used for line item descriptions like <<R10-30C1>> it 
would be replaced with 3 lines of << Insert Cost Description >>. 
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Another example would be a range tag for cost totals like <<R10-
30C8>> would be replaced with 3 lines of << $ >>. 
 
The Expert Edition also allows you to configure how many 
replacement lines you want to use instead of the default of 3. 
 
The generated project Word document would then be edited as a 
normal Word document and all this information would be manually 
retyped with your actual information. This is how all versions of 
Proposal Pack worked in the past before the dynamic spreadsheet 
linking features were added and is how most documents are 
created. 
 
The text that is used to replace the tags in the Word templates is 
contained in the Wizard’s XLSFiles.ini database file. You can edit 
these text replacements. 
 
The dynamic spreadsheet linking feature is not meant for use in all 
documents and situations. It is only for use by those who’s 
calculation needs can be met by using Excel spreadsheets who 
want dynamically updated Word documents and who have the 
skills to use these advanced Word and Excel features. 
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HOW DO I ADD DYNAMICALLY LINKED 
SPREADSHEET CALCULATIONS? 
 
Dynamically linking the Excel spreadsheets into your Word 
documents via the Wizard is a Wizard Expert Edition feature. 
 
Microsoft Office has a feature called OLE (Object Linking and 
Embedding) which allows you to insert dynamic links between a 
Word document and another object so that updates to the external 
object automatically update inside the Word document. 
 
Proposal Pack Wizard uses this feature of Word and Excel to 
create dynamic OLE links between individual cells in Excel 
spreadsheets and the Word documents generated by the Wizard. 
 
The Wizard and our Proposal Pack templates are designed to 
support this out of the box plus allows you to completely 
customize our spreadsheets and templates or even add your own 
into the Proposal Kit system. 
 
The main places this feature is used is for financial calculations in 
sales proposals and business plans, etc. and for time schedules. 
 
We have premade a large collection of financial and schedule 
calculator spreadsheets complete with line item, price, quantity, 
tax, discount and other common fields ready for you to fill in the 
details. Our Proposal Pack templates are also already designed 
with tags in our financial and schedule templates, so our Wizard 
can figure out what spreadsheet cells to link to which parts of the 
Word documents. 
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You can customize these tags and cells as well. Many examples 
are also included in the sample document with product sales, 
service sales, business plans, grants and other situations with 
spreadsheets and linked Word documents you can use as guides. 
 
Without having to make any customizations this feature is 
automatically enabled in the Expert Edition of the Wizard. You 
should use the stock setup first and create a test document to see 
how the links work and how updating a Word document from an 
Excel spreadsheet works before starting to make your own 
customizations. First create a project in the Wizard and add a 
template such as the Cost Summary and then build your 
document. Once opened both a Word document and Excel 
spreadsheet will open. Word will always ask you if you want to 
update the Word document that has embedded links. Say Yes and 
continue opening the document. How it works best is if you make 
updates to your Excel spreadsheet such as typing in your line item 
descriptions, prices, taxes, quantities, etc. or if using a scheduling 
spreadsheet your schedule items, dates and durations. Then save 
the spreadsheet. Then open your Word document and update the 
values. If you have the Word document open while making 
changes to the spreadsheets it will not auto-update on the fly. 
 
Once you understand how spreadsheets are linked to the Word 
document you can start making customizations if you need more 
complex calculations or different cells displaying in the Word 
document. 
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Since dynamically linked cells is a built in feature of your Microsoft 
Office software you can manually create your own links as well 
once our Wizard has generated a document. Learn how to do this 
by reading more about these features in your Office help or online 
resources. 
 
The following instructions are only for how to customize how our 
Wizard builds links between our premade spreadsheets and 
templates or using your own customized templates and 
spreadsheets within our system. It is not a complete reference on 
how OLE linking works in Microsoft Office. 
 
WHERE ARE THE SPREADSHEETS? 
 
The stock spreadsheets that will be copied into your project folder 
during the creation of each project document and linked to your 
project document are in the “Spreadsheets” subfolder of your 
Proposal Pack. There is a large collection of premade 
spreadsheets. There is nothing special about our premade 
spreadsheets other than they are standard Excel spreadsheets we 
have added lines and calculations to ahead of time. 
 
Each time you create a project in the Wizard and build a document 
any associated spreadsheets will be copied from the stock folder 
of spreadsheets into your project folder. 
 
For example, you create a project using the Cost Summary 
template. The Wizard knows that the Cost Summary template also 
has an associated Cost Summary Calculator spreadsheet. These 
files are CostSummary.docx and CostSummaryCalculator.xlsx. Our 
Wizard database has entries that tie all these together, so it knows 
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that when you add the Cost Summary template it needs to also 
copy the associated spreadsheet into your project folder. 
 
Once you have created a project and built a document the 
generated Word document named FullProposal.docx and the 
spreadsheet CostSummaryCalculator.xlsx will both be in your 
project folder. When these are linked, if you make changes to the 
CostSummaryCalculator.xlsx file then open our FullProposal.docx 
document, the document will be updated with the changes made 
to the spreadsheet. 
 
This allows you to make changes to your calculations, line items, 
schedules or any other linked data during the development of your 
overall proposal without having to manually make changes to 
totals, etc. in the Word document. 
 
CAN MORE THAN ONE SPREADSHEET BE ASSOCIATED? 
 
Yes. The Wizard allows for up to 9 extra spreadsheets to be 
associated with a template. By default, each template that has an 
associated spreadsheet only has one associated spreadsheet. 
 
If you create a copy of any associated spreadsheet with an 
incremental number without any gaps in the numbering from 2 to 9 
it will automatically be copied and opened along with the default 
spreadsheet. 
 
The Cost Summary template in the CostSummary.docx file has one 
associated spreadsheet CostSummaryCalculator.xlsx. All Proposal 
Pack templates with associated spreadsheets follow this rule. 
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For example, the default Cost Summary spreadsheet is 
CostSummaryCalculator.xlsx.  If you create a 
CostSummaryCalculator2.xlsx and CostSummaryCalculator3.xlsx 
file all 3 will be opened and copied whenever the default one is 
opened or copied by the Wizard 
 
There is usually no reason to have more than one spreadsheet per 
template for normal use. When the Wizard generates your project 
document and you have selected multiple templates that have 
spreadsheets all of them will be combined and linked together. For 
example, if you have a Cost Summary and a Return on Investment 
chapter in your project each has its own spreadsheet and both will 
be linked to in the final generated document.  There is no need in 
normal use to have multiple Cost Summary or Return on 
Investment spreadsheets for one project. 
 
Where multiple spreadsheets for a single template comes into use 
is when you have created a custom template assembled from 
multiple Proposal Pack chapters like the example above. The final 
generated proposal FullProposal.docx will be linked to both the 
CostSummaryCalculator.xlsx and ReturnOnInvestment.xlsx 
spreadsheets in your project document. 
 
To create a custom reusable template that will also be linked to 
spreadsheets should first disable the Dynamic XLS linking feature 
and you should also disable the replacing of dynamic XLS tags 
with replaceable text. Before generating your custom template 
click the Wizard’s Preferences > Tools > Excel Calculators button. 
Then on the screen uncheck the Enable Excel Dynamic Links to 
Word Documents box and uncheck the If Excel Dynamic Link is 
turned off replace XLS tags with meaningful text from XLSFiles.ini 
file. Then you can build a template in the Wizard, customize the 
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tags and rename the files to get them ready to import as a custom 
reusable template. 
 
The Wizard is also capable of using linked Word documents with 
Excel spreadsheets as reusable templates. This, however, adds 
more complexity and potentially slower processing to the process. 
Due to absolute links in the Word documents, every single linked 
cell must have its path updated. Updating existing OLE paths can 
be a very time consuming task and should only be done when you 
have a limited number of pre-linked cells. Whenever a linked 
template is copied to a project folder the matching spreadsheets 
are also copied then every cell must have its absolute path 
changed to the new folder. The Wizard manages all of this for you. 
 
For people who want to optimize the project document generation 
process who are going to create many documents using the same 
layout you can import the FullProposal.docx back into the Wizard 
database as a selected template.  To do this however you have to 
rename all the files, so they do not interfere with any others and to 
put it into the Wizard database all of the associated spreadsheets 
need to be renamed to match the rules the Wizard uses for how it 
knows to associate templates and spreadsheets and link them 
together.  And this process will cause you to have multiple 
associated spreadsheets for a single template. 
 
In this example you would rename the generated project 
documents FullProposal.docx to a unique name such as 
OurCustomProposalLayout.docx then rename the project 
spreadsheet CostSummaryCalculator.xlsx file to 
OurCustomProposalLayoutCalculator.xlsx and the project 
spreadsheet ReturnOnInvestmentCalculator.xlsx file to 
OurCustomProposalLayoutCalculator2.xlsx 
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Then you will have to update the <<R#C#>> tags in the 
OurCustomProposalLayout.docx file so the Wizard will know which 
spreadsheet each tag is associated with.  In this example any tags 
in the Return On Investment chapter would have to be changed to 
<<XLS:OurCustomProposalLayoutCalculator2:R#C#>> 
 
Once these customizations are made then you can follow the 
instructions to add your custom multi-spreadsheet associated 
template into the Wizard database as a selectable template. You 
will also have to copy your 2 new spreadsheets into the Proposal 
Pack’s “Documents\Spreadsheets” subfolder. 
 
Read this chapter for details on adding custom templates into the 
Wizard: How do I Reuse a Previous Document Over Again? 
 
WHERE ARE THE TEMPLATES WITH OLE LINKS? 
 
There are no OLE links to start with in the Proposal Pack stock 
templates. The Proposal Pack templates include text tags such as 
<<R#C#>> which define where the Wizard will insert an actual OLE 
link to a spreadsheet during the project document assembly 
process. 
 
Because we use tags in the templates to define where links to 
specific cells in a spreadsheet will be created this gives you the 
ability to put your own tags in the templates. This way you can 
cause different cells or additional cells to be linked wherever you 
need them. For example, you might want to link quantity cells or 
different totals or custom calculations. 
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Once the Wizard has built your project document in your project 
folder it will have OLE links to the spreadsheets that were also 
copied into your project folder. 
 
HOW CUSTOMIZABLE ARE THE SPREADSHEETS AND 
TEMPLATES? 
 
We have premade a large collection of Excel spreadsheets. You 
can completely customize these spreadsheets as you like. You can 
also create your own spreadsheets from scratch and use them 
within our system. 
 
We have pre-added tags to our financial and calculator related 
Proposal Pack chapter templates that match the cells in our pre-
made matching Excel spreadsheets. 
 
The system works by having a Word template with a tag that our 
Wizard will understand such as <<R2C2>> which our Wizard knows 
is going to be turned into an OLE link to Row #2 and Column B of 
the associated spreadsheet. So, if you want to add your own link 
to a completely different cell you just have to know what cell that 
will be. For example, you made a custom tax calculation and put 
that in an empty cell in our spreadsheet which is say row 20 in 
column c, you just need to put the tag <<R20C3>> in the Word 
template. See below for a complete description of how to make 
OLE tags. 
 
We also give you the ability to easily create brand new 
spreadsheets of your own and our Wizard will link them into 
templates that never had OLE links setup for them. All you must do 
is add a new spreadsheet into our Spreadsheets subfolder of the 
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Proposal Pack that matches the name of one of our Word 
templates.  
 
Let’s say you want to create a custom spreadsheet for the 
Accessories template which is our Accessories.docx template. This 
stock template does not have any associated spreadsheet. All you 
must do is make your own AccessoriesCalculator.xlsx spreadsheet 
and copy it into our Proposal Pack’s Spreadsheets subfolder and 
the Wizard will find it and copy it into your project folder if you 
added the Accessories template to your project. 
 
Then you will need to add <<R#C#>> tags into the stock 
Accessories.docx template to match whatever cells you want to 
populate in the Word document from your custom spreadsheet. 
Say you made a spreadsheet with a list of accessories and in 
Column A rows 10 to 30 you have your list of accessory names and 
in Column D rows 10 to 30 you have your list of accessory prices. 
 
You could then create a table in the Accessories.docx template 
and in one cell add a tag <<R10-30C1>> and in the next table cell 
add a tag <<R10-30C4>> (i.e. column D is the 4th column). 
 
During the Wizard’s project document assembly process, it would 
then build in your customized Accessories.docx template into the 
generated FullProposal.docx document and copy your custom 
AccessoriesCalculator.xlsx spreadsheet into your project folder. All 
you do now is make changes to your custom spreadsheet, save 
your updates then open the project’s FullProposal.docx file and 
your accessories spreadsheet calculations will be displayed in 
your table in the Accessories page of the document. 
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This gives you the ability to completely customize the system by 
altering our stock templates and spreadsheets and create your 
own custom spreadsheets and letting our Wizard do the detailed 
work of linking everything together. 
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HOW DO I CUSTOMIZE THE SPREADSHEETS? 
 
This is the easiest part of making a custom system tied into the 
Wizard. You can customize the spreadsheets or make your own as 
normal Excel spreadsheets. There is nothing special about how 
the spreadsheets are customized. You just must know which cells 
are going to be linked to your Word document, so you can add the 
matching tags to the Word template and have the cell formatting 
set to how you want it displayed. For example, if you are using 
financial cells use a currency symbol and either no cents or 2 digits 
for cents. (i.e. $100 or $100.00) as that is the exact value that will 
be updated into your document. If you are displaying a percentage 
set the cell to display 100% or 10.4% for example. 
 
If you are making your own custom spreadsheet to go with one of 
our templates that did not originally have a spreadsheet you just 
need to name the file in a way the Wizard can find it. Take the file 
name of the Word template you are intending to link the 
spreadsheet with and add the word “Calculator” to the end and 
save it with a “.xlsx” file extension. For example. If you are going to 
put OLE links into the Accessories chapter, which is in the 
Accessories.docx template you just create your own custom 
AccessoriesCalculator.xlsx spreadsheet and put it in the Proposal 
Pack Spreadsheets subfolder where the rest of our stock 
spreadsheets are. 
 
If you are editing one of our stock chapters that already has an 
associated spreadsheet such as the Cost Summary chapter which 
is in the CostSummary.docx template and already has its own 
CostSummaryCalculator.xlsx spreadsheet you just edit our stock 
spreadsheet as needed. 
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HOW DO I USE AN EXISTING SPREADSHEET? 
 
https://www.proposalkit.com/htm/videos-reuse-existing-excel-
spreadsheets.htm 
 
If you have our own custom spreadsheet you want to use there are 
a couple options. 
 
First, you could just save your custom spreadsheet over one of our 
spreadsheets then adjust the <<R#C#>> tags in the related Word 
template to match the cells in your custom spreadsheet that you 
want to link into the final generated Word document. 
 
Second, another option would be to open one of our existing 
spreadsheets and add a new Worksheet to it. Then copy your 
custom spreadsheet entirely into that new worksheet. Because 
you can link cells between worksheets in an Excel spreadsheet 
you can then link the final totals and cells you want to use to the 
cells in our premade worksheets. This way you can populate our 
premade cost summary for example with data from your custom 
worksheet and you then do not have to update the Word 
templates to change the tags. 
 
This is a good option to use when you have a very customized or 
detailed spreadsheet for a specialty situation you want to use 
without having to customize it.  Typically, you do not need to make 
changes to a custom spreadsheet to get it to work with the 
Proposal Pack Wizard’s dynamic XLS linking feature.  You just 
need to have it in the file name the Wizard knows about and have 
tags in the associated Word template that match the cells you want 
to show up in your Word document. 

https://www.proposalkit.com/htm/videos-reuse-existing-excel-spreadsheets.htm
https://www.proposalkit.com/htm/videos-reuse-existing-excel-spreadsheets.htm
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HOW ARE TAGS USED TO CREATE OLE SPREADSHEET 
LINKS? 
 
Tags are inserted into the stock Proposal Pack templates to define 
the exact cell or range of cells that will be linked to in a specific 
sheet within an Excel spreadsheet.  
 
The result is that the standard Microsoft Office OLE linking feature 
will be used to link spreadsheet cells into specific locations within 
a Word document so that the Word OLE features can be used to 
update the Word document as changes are made to the linked 
spreadsheets. 
 
To do this we insert text tags into the Proposal Pack Word 
templates that the Wizard will then turn into OLE links during the 
project document generation. 
 
The dynamic Excel link tags are in a similar format to other Wizard 
tags such as those for the company and client data where we put 
our tags in << >> brackets. 
 
The complete syntax for our dynamic link tags is: 
<<[XLS:XLSFile:]R[S]#[-#]C#[S#]>> 
 
Examples of this are 
 

 <<R#C#>> 
 <<R#-#C#>> 
 <<R#C#S#>> 
 <<R#-#C#S#>> 
 <<RS#-#C#>> 
 <<RS#-#C#,#,#>> 



493 

 <<XLS:CostSummaryCalculator:R#C#>> 
 
 
Rows start at 1 and correspond to the numerical row numbering of 
Excel. Row 1 is R1 and Row 10 is R10. 
 
Columns start at 1 and correspond to the alphabetical column 
numbering of Excel. Column A is C1 and Column D is C4. 
 
The tags also compress multiple rows of links into a single tag for 
shorthand. All the rows in the range must be in consecutive order 
in the spreadsheet. <<R10-30C1>> is the same as having 20 tags in 
a row in the template <<R10C1>>…<<R20C1>>…<<R30C1>>. The 
Wizard will expand the tags with ranges into a list of links. In this 
example the one tag will be expanded and linked to 20 different 
cells. 
 
Excel spreadsheets can have multiple sheets and the tags allow 
for calculations to be linked to any sheet. By default, the first sheet 
“Sheet1” is always linked to if the S# part of the tag is missing. 
<<R2C2S1>> is the same as <<R2C2>>. <<R2C2S3>> means that 
Row 2 Column B of sheet #3 will be linked to. 
 
The order of the sheets is not used to determine the first sheet. 
The first sheet is the one named “Sheet1”.  The sheets can be 
reordered within the spreadsheet. Usually the sheet being used is 
moved to the front to make it easier to locate. If you are using 
Sheet3 for your calculations in one of the costing spreadsheets 
make sure to use S3 in the tags in the Word document. It doesn’t 
matter if Sheet3 is the topmost sheet viewable in the spreadsheet. 
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All the tags like this with only rows, columns and sheets are 
assumed to be linked between that one template and its 
associated spreadsheet. For example, <<R2C2>> in the 
CostSummary.docx template will always be linked to Row 2 
Column B of the CostSummaryCalculator.xlsx spreadsheet 
because the Wizard knows to associate which templates with 
which spreadsheets during the project document generation 
process. 
 
There are times when you might want to put a dynamic OLE 
spreadsheet link into a different location within the final assembled 
document so that is when the XLS:XLSFile: part of the tag is used. 
 
This allows you to define which specific spreadsheet to link to 
when you are using a tag outside of the template the spreadsheet 
is associated with. One example is if you are doing a business plan 
funding or grant funding request proposal and you want to put the 
total amount being requested for funding in the Cover Letter or 
Title page of the document so it can be auto-updated if the 
number changes whenever the Funding Request page changes to 
avoid making mistakes and forgetting to update a value in another 
part of the overall document. 
 
XLSFile is the name of the Excel spreadsheet file without the file 
extension. So if you were linking to the 
CostSummaryCalculator.xlsx file you would use 
XLS:CostSummaryCalculator: 
 
For this example, say you are using the Funding Request chapter 
in your document which is in the FundingRequest.docx template 
and has an associated spreadsheet 
FundingRequestCalculator.xlsx. All the normal linking rules 
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mentioned above apply when linking cells from the spreadsheet 
into the Funding Request chapter. 
 
But now we also want to link the total funding request amount into 
the Cover Letter and Title Page. What you would do is edit the 
stock CoverLetter.docx and/or TitlePage2.docx templates and 
insert the tag <<XLS:FundingRequestCalculator:R74C2>> into the 
text. 
 
For example you might insert a sentence such as: 
 
“<<Company>> is requesting funding of <<XLS:FundingRequestCalculator:R74C2>>.” 

 
Now when you generate your project which is using the Cover 
Letter, Title Page and Funding Request among other chapters the 
funding request calculation cell of the spreadsheet will by 
dynamically linked to that location of your Cover Letter as well as 
any cells that are linked into the Funding Request chapter. 
 
The Wizard’s tag to OLE linking system allows you to use the full 
functionality of Word and Excel’s linking features in a way that lets 
the Wizard do the more complicated tasks of inserting links and 
ensuring formatting is correct and letting you concentrate on the 
actual details of what you need to write. 
 
HOW DO I EXPAND TAGS INTO NEW TABLE ROWS? 
 
Ranges of tags are expanded by default into the same table cell 
that the tag was in. This means the tag <<R10-20C3>> will be 
expanded into 10 rows with line breaks after each row all inside 
the same table cell. 
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This works well if you have ranges of linked spreadsheet cells 
where the length of each piece of data does not wrap to a new 
line. When this happens, and you also have multiple ranges in a 
single row of your Word table the resulting data can be out of 
alignment across the cells of the table in that row. 
 
For example, you have a single table row with 3 columns, the first 
column is the item description and the next column is the quantity 
and the last column is the amount. If your line item descriptions 
cause the data to wrap they won’t all line up with the quantity and 
amount columns and you will have to manually reformat or edit the 
data for everything to line up and look correct. 
 
In cases like this it can be helpful to expand each item in the tag 
range into its own new row. This way all rows will stay lined up in 
the table even if the data in one cell of one row wraps to a new 
line. 
 
There are two ways to make the Wizard expand your range tags 
into new rows instead of within the same cell as the tag. 
 
The quick and easy way is to check a box in the Preferences. In 
the Wizard’s Preferences > Tools > Excel Calculators screen check 
the box labeled Expand all ranges into new rows. 
 
Now when you build your project documents all <<R#C#>> range 
tags will be expanded into new rows.  For example, the tag <<R10-
20C1>> will have 9 new rows added to the table and the cells of 
the new rows will be populated with the expanded tag. 
 
That option works well if you know you want every range tag in 
every table of the entire document to be expanded into new rows. 
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If you only want specific rows expanded and not others, then you 
have to edit the stock Word template and use <<RS#C#>> tags. If 
you use “RS” instead of “R” in the tag the Wizard will know to 
expand those into new rows. You need to have every range tag in 
a row using the “RS” version of the tags to get them to all expand 
correctly.  For example, if you have a row with 3 columns for a line 
item, quantity and amount using tags <<R10-20C1>>, <<R10-20C3>> 
and <<R10-20C8>> then you need to change all three tags in that 
row of the stock template table to <<RS10-20C1>>, <<RS10-20C3>> 
and <<RS10-20C8>> 
 
There are a few rules to keep in mind to ensure ranges are 
expanded correctly. Use the same numerical range in all range 
tags on the same row. For example, do not use <<RS10-20C1>> for 
the description then <<RS10-30C3>> for the quantity tag in the next 
table cell over. 
 
Expansion of tags into new rows only works when those tags are 
already within a cell of a Word table. 
 
You cannot use tables where an individual cell in a row has been 
split into multiple rows within the original row. The Wizard must be 
able to programmatically step through a Word table row by row 
and cell by cell and Word will generate errors if it encounters a cell 
that has been split into new rows within a row. 
 
If you are using the XLS:filename: feature of the tags to identify a 
specific spreadsheet to link to then all tags on the same row must 
also use the XLS:filename: in the tag. For example, you cannot use 
<<RS10-20C1>> for the description column then 
<<XLS:filename:RS10-20C3>> for the quantity column. 
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HOW DO I EXPAND A TAG ACROSS MULTIPLE ROWS 
BUT STILL HAVE MULTIPLE COLUMNS WITHIN THE 
SAME CELL? 
 
Using an RS tag, you can put multiple linked spreadsheet cells 
within the same Word table cell when expanding the tag into 
multiple rows. 
 
There are two delimiters defined in the Wizard Preferences > Tools 
> Excel Calculators screen for the text to insert between each tag 
when its expanded. You can define special characters in the 
delimiter by using “Chr(#)” in the text of the delimiter.  
Chr(13)Chr(10) for example translates into a paragraph break and 
Chr(32) translates into a blank space. The default for the 1st 
delimiter is “Chr(13)Chr(10)Chr(13)Chr(10)” and the default for the 2nd 
delimiter is “Chr(32)-Chr(32)”. Because the Wizard will strip leading 
and trailing spaces from data fields in its database using the Chr 
code for a space gets around this. 
 
This is done using the tag format of <<RS#-#C#,#,#>>. 
 
For example, <<RS5-7C1,3,5>> will cause the Wizard to expand the 
tag into three different table rows but will put all 3 linked columns 
one, three and five into the same table cell as follows: 
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So, if your tags are defined like this in your template: 
 
<<RS5-7C1,3,5>> <<RS5-7C9>> 

 
The Wizard will expand them like this before it merges the data 
into them using the default delimiters: 
 
<<R5C1>> 
 
<<R5C3>> - <<R5C5>> 

<<R5C9>> 

<<R6C1>> 
 
<<R6C3>> - <<R6C5>> 

<<R6C9>> 

<<R7C1>> 
 
<<R7C3>> - <<R7C5>> 

<<R7C9>> 
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HOW DO I REMOVE ROWS FROM THE STOCK 
SPREADSHEETS? 
 
The stock spreadsheets are designed with enough rows already 
set aside and tag ranges set to accommodate most needs. You do 
not need to remove anything from the spreadsheets. Just ignore 
an extra line item rows. The stock tag ranges will match the 
number of rows set aside in the stock spreadsheets. For example, 
the first range of line items for the Cost Summary will 
accommodate up to 20 line items which is enough to cover most 
proposals. 
 
This will cause additional blank rows to be linked into your Word 
template which you might want to remove the extra rows. This is 
done by either editing the tag in the Word template to only use the 
range of rows you need. This would only be done if you are going 
to be creating many proposals and you know you will only need a 
smaller number of rows every time linked from the spreadsheets. 
 
A quick way to reduce the number of linked rows without having to 
edit the range in the tag is to use the Maximum Rows drop down in 
the Project screen. By default, it is set to “Use All Available”. This 
means if you have 20 lines in the spreadsheet for rows and a tag 
that spans that range such as <<R10-30C1>> then 20 rows will be 
linked regardless of how many you are going to use. You can on a 
per-project basis set that drop down to a number between 1 and 
20 and the Wizard will stop expanding the range at that number. 
So, if you only needed 5 rows instead of 20 to be linked for a 
project set the drop down for the Maximum Rows to be linked to 5. 
 
Using the drop down Maximum Rows limiter option will also auto-
compress the table to fit only the final number of rows. The idea is 
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to use the Wizard to do most of the document formatting to reduce 
the amount of manually updates that need to be done to clean up 
the final generated document. 
 
If you wind up with more rows than needed you can also delete 
any extra OLE links from your assembled project document. No 
changes must be made to the spreadsheet. 
 
HOW DO I ADD MORE ROWS TO THE STOCK 
SPREADSHEETS? 
 
If you are using the stock premade spreadsheets and templates 
and need to add more rows you need to edit both the spreadsheet 
and the tags in the associated spreadsheet. 
 
Before you start editing the stock spreadsheets first see if that 
spreadsheet has alternate sheets that may cover the changes you 
need. 
 
For example, if you are using the Cost Summary chapter and need 
to have more than 20 line items we have added alternate sheets 
with up to 40 line items. Look at sheets 6 to 10. If this solves the 
problem, then rename Sheet 6 to Sheet 1 then open and edit the 
CostSummary.docx template to adjust the tags as needed. So, you 
don’t have to also figure out what to change the tags to we have 
also created some alternate tables to match the alternate sheets in 
these spreadsheets in many cases. 
 
To find the alternate table you can copy and paste into your 
CostSummary.docx template find the Alternates subfolder in your 
Documents subfolder of your installed Proposal Pack and open the 
Sheet6.docx file. This will have a table in it with tags that will match 
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the Sheet #6 of the Cost Summary (or any other cost calculator 
with multiple alternate sheets). Copy and paste this table in place 
of the one in your CostSummary.docx template. 
 
Or, you can edit the tags in the CostSummary.docx template to 
match the cell ranges and locations of the alternate sheet in the 
spreadsheet. 
 
Finally, you can also edit the first sheet of the spreadsheet to insert 
new rows. If you make any changes to the spreadsheets like this 
that also change the locations of other linked cells in the 
spreadsheet you will have to change check and change any other 
tags in the template that may have changed locations in the 
spreadsheet. You will also need to make sure all the spreadsheet 
calculations are still correct as making structural changes to 
spreadsheets can cause some cell formulas to not be using the 
correct rows. 
 
We have created premade spreadsheets and templates that will 
cover most needs as-is. After that check to see if we have made 
any alternate versions that will cover your situation. After that you 
can expand the existing template as needed. 
 
In the end, all you need to do is have a spreadsheet with correct 
cell calculation formulas and then put in matching tags in the 
Proposal Pack templates associated with those spreadsheets. 
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WHAT CONFIGURATION OPTIONS ARE THERE FOR THIS 
FEATURE? 
 
See the Wizard’s Preferences > Tools > Excel Calculators screen 
for all of this feature’s configuration options. 
 
You can completely disable this feature and used static unlinked 
Word documents by unchecking the Enable Excel Dynamic Links 
box. The Wizard will then run in the same manner it always did in 
past versions before dynamic linking features were added. 
 
To make it easier and more intuitive for people to get spreadsheet 
updates applied to their document by default the Wizard will turn 
on the Word features to Auto-Update Links when Word documents 
are both printed and opened. The Wizard is only turning on these 
options that are part of your Word program. Our Wizard does not 
control how OLE links work or how they are updated once the 
documents are built. 
 
To help optimize performance or warn about potential 
performance issues by using too many OLE links the Wizard will 
display warnings if tables have over a certain number of cells or if 
more than a certain number of OLE links are added to a document. 
You can change these numbers here. 
 
The stock templates and spreadsheets usually have 20 to 40 rows 
set aside for line items as that covers most needs and if you start 
trying to use more than this, the number of needed OLE links will 
turn into a performance problem with Word. A quick way to 
improve performance and reduce the amount of custom editing 
without having to edit the stock spreadsheets to reduce the tag 
ranges is to use the Maximum rows drop down when you know 
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you will not ever need more than a certain number of linked items 
in a row. For example, if you are writing product or service sales 
proposals and you won’t ever be using more than 7 line items in 
your quotes then set the Maximum row drop down to 7. This will 
cause the Wizard to only expand ranges of cells to 7 items instead 
of the entire range in the tag. If a tag was set to a range of 20 cells 
like <<R10-30C1>> but you used a Maximum rows value of 7. Then 
only R10 to R16 will be linked from the spreadsheet. 
 
By default, the Wizard will open both the generated project 
document and any associated spreadsheets when you open your 
project for editing. You can disable the default opening of 
associated spreadsheets by unchecking the Open Excel Files box. 
You can still open them from the Edit Current Project > Your 
Calculator Spreadsheets tab. 
 
By default, the Wizard will create the dynamic OLE links using 
absolute paths to the spreadsheets that are in the project folder. 
Absolute links are a requirement of Microsoft Word. This means if 
you do copy a linked document to a different folder then the paths 
must be updated. The Wizard will do this for you in many cases 
such as setting up reusable templates, creating projects and 
cloning projects. 
 
By default, when the Wizard expands tags that are ranges of linked 
cells it single spaces between the links. If you want to double 
space between each expanded line check the Double space 
checkbox. 
 
There are also some fields for customizing how the Wizard will 
replace tags with text when the Excel Dynamic Links feature is 
disabled. <<R#C#>> tags will be replaced with more readable text, 
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so the user will know what kind of information should go in those 
locations. For example, if <<R72C8>> is a dollar amount for a total 
it will be replaced with << $ >> so the user knows to type in a dollar 
amount in that location. Ranges are also replaced by 3 lines by 
default and that number can be changed here. <<R10-30C1>> may 
be replaced with 3 lines saying << Insert Cost Description >>. If you 
want a different number of rows such as 1 or 5 then change that 
number in the field here. The double spacing option also applies 
to these instructional lines. 
 
The default Proposal Pack costing spreadsheets (i.e. the Cost 
Summary, Estimate, Quote, etc.) all have multiple worksheets for 
different situations. Also, any given sheet can have many different 
table layouts depending on what data you want displayed in the 
final generated Word documents. This screen has an option that 
allows you to easily customize the system to pick a specific sheet 
in a multi-sheet costing spreadsheet and pair it with a matching 
table layout that may differ from the stock Word template layout. 
These are called Alternate templates. By selecting an alternate 
worksheet and alternate table layout here the Wizard will swap in 
that alternate table and set the alternate worksheet as the topmost 
visible sheet whenever you generate project documents. This 
feature is meant to be a quick and easy way to pick one of several 
premade variations. You can also customize the spreadsheets and 
tables yourself. 
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HOW DO I USE THE ALTERNATE COST TABLES AND 
SHEETS? 
 
When your project documents are finally generated, and you are 
using a linked Excel spreadsheet the cells of one of those sheets 
are dynamically linked to the Word document.  When you are 
using one of the cost related spreadsheet such as the Cost 
Summary, Estimate, Quote or similar spreadsheets those 
spreadsheets have many different calculators to choose from. For 
example, the default worksheet has 4 categories with sections for 
ongoing monthly and yearly line items. There is another sheet with 
10 sections defined and another sheet with just one section that 
has up to 40 line items. 
 
These variations on the calculator spreadsheets means everyone 
should find a cost calculator that will work for their situation.  
 
In addition to having several calculators to choose from within a 
single cost spreadsheet there are alternate table layouts to choose 
from as well. 
 
The default table layout links each line item’s description, quantity 
and total amount to the rows in the Word table. Some people may 
want to only link the line item description and final totals while 
others may want to link the line item description, unit price, 
quantity and final totals. 
 
While you can customize the Word table layouts to suit your 
needs, we have premade several common variations. 
 
The Wizard allows you to choose an alternate worksheet and an 
alternate Word table layout from the Preferences > Tools > Excel 
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Calculators screen. 
 
Click the Alternate worksheet drop down and pick from any one of 
the alternate worksheets and Word table layouts. 
 
If you set it to the Default setting the Wizard will use Sheet1 of the 
cost spreadsheets and the Word table layout in the stock Word 
templates. 
 
If you set it to an alternate worksheet then that worksheet number 
will be moved to the top worksheet of the spreadsheet and when 
your project is assembled the Wizard will swap in the alternate 
Word table layout into the cost page of the generated document.  
For example, if you select Sheet #6 (1 long section of line items) 
from the drop down the following will happen. 
 
If you selected the Estimate chapter for your project the Estimate 
Calculator spreadsheet copied into your project folder will have 
Sheet6 moved to the front of the spreadsheet. Then the Estimate 
chapter of your document will have its stock table removed and 
the alternate template (Sheet6.docx) will be inserted in its place. 
The Wizard will then replace the <<R#C#S6>> tags with links to 
Sheet6 of the spreadsheet. This all ensures the correct cells are 
linked into your generated document and is faster and easier than 
having to manually edit our stock tables, tags and spreadsheets 
when we have a combination premade that will work for your 
situation. 
 
The Wizard will first look in the Alternates subfolder within your 
Wizard’s project document folder for the alternate Word tables it 
will swap in. When you click the Edit Alternate Template button 
after selecting from the drop down list the Wizard look in its folder 
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first. Then if it is not found there it will check the Alternates 
subfolder in your Proposal Pack Documents subfolder. This allows 
us to provide new alternate tables in future Wizard patches more 
easily than within Proposal Pack template product updates. 
 
When you click the Edit Alternate Template button the Wizard will 
also give you the option to open one of the cost related Excel 
spreadsheets. This is helpful if you want to compare an alternate 
Word table layout side by side with its matching spreadsheet 
worksheet. 
 
The Wizard also will open the Alternate Word template if you have 
set this feature when you use the Edit Template button in either 
the Document Styles > Edit Style > Edit Template or the Document 
Project > Pick Document > Add Template screens. This helps 
ensure you will be editing the Word template that will be built into 
your project documents. If you set the Alternate template to the 
Default setting. Then all the screens in the Wizard that open cost 
templates will revert to opening the stock Proposal Pack chapter 
templates. 
 
When customizing our spreadsheets, it is important to keep the 
spreadsheet’s worksheets named the same as they are starting 
out. For example, do not rename Sheet1 to a different name. The 
links made by the Wizard specifically reference the linked sheet by 
their default names (i.e. “Sheet1”, “Sheet2”, etc.).  Our stock multi-
worksheet cost spreadsheets also put a unique identifier in the 
“CA1” row that the Wizard looks for to ensure it is working with one 
of our premade worksheets when using the alternate Worksheet 
feature. This CA1 cell is set to 100 times the sheet #.  So, for 
worksheet 5 which is named Sheet5, then cell CA1 is set to 500. If 
you start customizing your own cost worksheet and make changes 
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that violate any of the rules the Wizard is looking for then you will 
have to make sure to use Sheet1 and the Word table in the stock 
Proposal Pack chapter template and do not use the S# code in the 
<<R#C#>> tags. 
 
The short version is that the Wizard takes care of only showing you 
the actual Word document and worksheet you have configured 
and that it will build into your documents when you use this 
Alternate drop down list. All you must do is make your custom text 
edits and let the Wizard figure out how to assemble and link 
everything. 
 
If you are using Sheet #5 make sure you are editing Sheet5 of the 
cost spreadsheet you choose to use and that the tags in Word 
table for that cost template use <<R#C#S5>> tags. 
 
If you are using the defaults then everything defaults to Sheet #1 
and you will edit the default top worksheet titled Sheet1 and the 
default tags in the Word table will be <<R#C#>> tags (without the 
S#). 
 
HOW DO I USE INTERNATIONAL FINANCIAL 
CALCULATIONS? 
 
Using international data is easy. Change the cell formatting in the 
spreadsheet to use whatever financial or date format you want, 
and the Word document will be auto-updated with the new format. 
This is all done just within the Excel spreadsheet. 
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HOW DO I SEE THE ACTUAL DYNAMIC OLE LINKS? 
 
Normally you only see the linked data. If you have links to blank 
cells you will not see anything in your Word document that would 
indicate there is a linked cell there. Also, if you have many cells 
with identical data you might not be able to easily tell them apart. 
Being able to see the actual format of the how the link is made can 
help diagnose problems. 
 
All you must do is click the Alt-F9 on your keyboard which is the 
Word command to toggle fields, so you can see what the actual 
Word field linking looks like: 
 
{ LINK Excel.Sheet.8 “C:\\ProposalKit\\ProposalPack\\ProposalProjects_V#\\My New 

Project\\CostSummaryCalculator.xlsx” Sheet1!R4C1 \a \t \* charformat } 

 
This is what the <<R4C1>> text tag will be converted to by the 
Wizard when used in the Cost Summary template. By knowing how 
to toggle the field codes you can also edit the links in the 
generated document or even insert your own to further customize 
a generated document that is already linked to one or more 
spreadsheets. The OLE links are editable text as well when you 
toggle the field codes in the Word document to make them visible. 
 
You can also insert your own OLE links yourself at any time by 
using the field code features in Word. Read your Word 
documentation or online help on how to use this feature. 
 
  



511 

CAN I USE CUSTOM STYLING AND FORMATTING ON 
LINKED CELLS? 
 
The Wizard will try and apply the formatting used on the text field it 
is replacing with a link to the link once the link is inserted. This is 
best done with Word styles. 
 
Because the text tag (i.e. <<R#C#>>) is deleted and replaced with a 
dynamic link sometimes custom formatting applied to the text tags 
will not be applied to the linked data. 
 
If any custom formatting disappears from the link create a Word 
style with your styling settings and apply that Word style to the text 
tag. 
 
HOW DO I CUSTOM FORMAT DATA IN THE CELLS FOR 
PRESENTATION? 
 
To custom format what a cell will look like when it shows up in 
your Word document apply the formatting to the cell in the Excel 
spreadsheet. This is for how the data is expressed not the font 
styling. For font styling types of formatting use Word styles and 
apply that to the link in the Word document. 
 
For data formats such as the currency character, the number of 
decimal places, rounding of amounts, etc. should be done in the 
spreadsheet. 
 
One example would be if you are showing a percentage and you 
want two decimal places with a % sign. Set the cell formatting to 
show the data in that format. 
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Another example would be if you want a dollar value rounded up 
to the nearest $1,000 dollars. Maybe for a funding request you 
want to keep the funding value being requested rounded up, but 
your calculations are showing something like $100,356.16. Apply a 
rounding function to the spreadsheet cell to round up the 
displayed value to the nearest $1,000 so it displays in the 
spreadsheet as $100,000 with no cents and then link that cell into 
your Word document. 
 
If you want to keep your original calculation in the spreadsheet all 
you must do is use an empty cell somewhere in the spreadsheet 
that copies the value in the original cell, then apply your custom 
formatting to the new cell. Then link that new cell to the Word 
document. For example, your final calculation is in Row 72 Column 
B as $100,356.16 and Row 72 Column D is empty in the 
spreadsheet. Set the calculation for Row 72 Column D to be 72B. 
Then apply a rounding function to Row 72 Column D so that is 
displays as $100,000. In your Word template instead of linking the 
Word document to <<R72C2>> you will use the tag for the new 
calculation which is <<R72C4>>. 
 
HOW CAN I MAKE MULTIPLE COPIES OF A 
SPREADSHEET? 
 
One of the situations where people make multiple copies of a 
stock template is when they have multiple sets of products or 
services they offer and for any given client they want to pick one 
of multiple premade sets of products or services to add to the 
proposal.  
 
The Wizard supports this by allowing you to make one or more 
copies of any existing chapter template. The Wizard will also make 
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a copy of any associated spreadsheet as well. If you have 3 sets of 
products for example you can create 2 additional copies of our 
Cost Summary template which will also create 2 additional copies 
of the CostSummaryCalculator.xlsx spreadsheet. 
 
See this chapter for more details: How do I Add New Documents 
to the Interface? 
 
If you only need one copy of the chapter template but you want to 
swap between multiple cost calculators and all those cost 
calculators have the same structure (i.e. the same cells in the same 
locations). You could also use the one stock chapter template and 
stock calculator spreadsheet but make multiple sheets within that 
spreadsheet. Excel allows you to create multiple sheets. You can 
copy and paste entire sheet such as the default Sheet 1 to another 
sheet. Then when you generate your document rename which 
ever sheet you want to be your items for that project to Sheet 1 
and then open and update the links in the document. Most of our 
cost calculators already have 10 sheets for different types of 
calculations. You can overwrite any of our additional Sheets #2 to 
#10 or make additional sheets starting at Sheet #11. 
 
If you keep the structure of the cells the same and are only 
changing line item descriptions and amounts or cell calculations, 
then you do not need to change the tags in the associated Word 
document. If you are using spreadsheets with different cells in 
different locations than what is linked to in the Word templates, 
then you should use the feature where you create multiple copies 
of a template each with its own associated spreadsheet and 
update the document tags appropriately. 
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ARE THERE SAMPLES OF CUSTOM OR COMPLETED 
SPREADSHEETS? 
 
There are hundreds of sample proposals included with each 
Proposal Pack and many of them include associated spreadsheets 
and financial and scheduler related chapters linked to the 
spreadsheets you can look at. 
 
Most of them use the stock templates and <<R#C#>> tags and 
associated spreadsheets. Most of the customization in the samples 
is done in the calculations of the spreadsheets. 
 
Some samples also include examples of using multiple sheets 
within the linked spreadsheet. Look at the “Janitorial Services 
Sample Proposal” for an example of a spreadsheet that uses 
multiple sheets with calculations spanning the sheets to calculate 
square footage costs within the main spreadsheet. This is a good 
example of how the stock spreadsheets can be heavily 
customized for specialized situations and still work within our 
system. 
 
Look at the “Commercial Office Real Estate Lease Proposal” 
sample for an example of a spreadsheet that uses 3 different ROI 
calculators on different sheets that are all linked into one chapter 
of the generated Word document.  
 
These samples will give you ideas on how you can create 
completely custom spreadsheet calculators and calculations to 
solve your business needs and still link them into our Word 
templates for the final presentation in the generated documents by 
adding matching <<R#C#>> tags into the chapter templates. 
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If you are going to create a custom template that also has linked 
spreadsheets there are sample files you can look at based on this 
example.  Look in your Wizard install project folder in the 
CustomizationExamples subfolder.  Unless you changed your 
Wizard’s default install location it will be in the folder: 
 
c:\ProposalKit\ProposalPack\ProposalProjects_V#\CustomizationExamples\ReusableTemplat

eWithSpreadsheets 
 
HOW DO I LINK TWO DOCUMENTS TO THE SAME 
SPREADSHEET? 
 
This is a good example for a situation where you might want to 
create a proposal and an invoice or contract all at the same time 
and linked to the same financial information or calculations. 
 
You might send the proposal document first to a client then send 
the invoice or contract later, but you want to create them all at the 
same time and using the same data. 
 
This requires some customizing of the templates and Wizard 
database first, so you can create two separate project documents 
at the same time both linked to a single spreadsheet. 
 
In this example we’ll use the Invoice template to be created 
separately from the main project document using a Cover Letter, 
Title Page, Cost Summary and About Us. By default, the Invoice 
would be assembled into the main project document and would 
also have its own separate spreadsheet InvoiceCalculator.xlsx 
where we want to use the CostSummaryCalculator.xlsx cells linked 
into both the Invoice and generated project document.  
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We first go to the Wizard’s Preferences > Tools > Configure 
Proposal Files screen and select the Invoice template from the 
“Pick a Document or Section” drop down. Click the Sort List 
Alphabetically button to make it easier to locate the template in 
the list. 
 
Once you have selected the Invoice then click the Edit the 
Selected Document button. On the next screen uncheck the 
Combine into Master Document box and uncheck the Enable 
Matching Spreadsheet box. 
 
This will cause the Invoice to be generated separately from your 
proposal document in your project folder and the Wizard will not 
copy the InvoiceCalculator.xlsx spreadsheet into your project 
folder. You can also change the drop down for which file or section 
the Invoice will be placed after to either Section 10, Section 11, or 
Section 12. Any templates in these sections will automatically be 
generated as documents separate from the main project 
document. 
 
Save your Preferences changes. Now all that is left is to manually 
update the stock Proposal Pack’s Invoice.docx template to change 
the <<R#C#>> tags so that the Wizard knows to link them to the 
CostSummaryCalculator.xlsx spreadsheet. 
 
Find and open the stock Invoice.docx template. You can do this by 
clicking Button #1 – Document Styles > Edit Style > Manage 
Templates > Edit Stock Templates. Then select Invoice from the 
drop downs. Click the Show Lists in Alphabetical Order button to 
make it easier to locate. Click the Edit Selected Template once you 
have found and picked it from the drop down list. 
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All you need to do is add the text XLS:CostSummaryCalculator: to 
the start of all of the <<R#C#>> tags. A quick way to do this is a 
mass search and replace across the Invoice.docx template 
changing “<<R” to “<<XLS:CostSummaryCalculator:R” 
 
Because some of the cell calculations are in different locations of 
the Invoice vs the Cost Summary calculator spreadsheets some 
tags will also have to have their cell locations changed such as the 
cells the sub totals, taxes and grand totals are located in. You can 
customize the tags and templates as you see fit for whatever cells 
you want to show in the final documents. 
 

 Change <<R27C2>> to <<XLS:CostSummaryCalculator:R66C2>> 

 Change <<R28C2>> to <<XLS:CostSummaryCalculator:R67C2>> 

 Change <<R36C2>> to <<XLS:CostSummaryCalculator:R75C2>> 

 Change <<R5-24C1>> to <<XLS:CostSummaryCalculator:R5-24C1>> 

 Change <<R2C2>> to <<XLS:CostSummaryCalculator:R2C2>> 

 And so on for each tag. 

 
Save your edits to the stock Invoice.docx template and now you 
are ready to create a project with a separate Invoice tied to your 
project documents Cost Summary spreadsheet. 
 
Go back to the Wizard home screen and click Button #2 – 
Document Projects > Add New Project > Pick Documents > Add 
Templates tab. Now select the Invoice, Cover Letter, Title Page, 
Cost Summary, Company History and Back Page. 
 
Now click the OK, Use Selected Templates button and then click 
the OK, Save Project and Build Documents button. 
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Once the Wizard has generated your project documents you will 
have an Invoice.docx, FullProposal.docx and 
CostSummaryCalculator.xlsx files created and linked together. 
 
As you make changes to the CostSummaryCalculator.xlsx 
spreadsheet then you open the Invoice.docx and 
FullProposal.docx files they will both be updated with the changes 
made to the spreadsheet. 
 
This situation can also be used for creating contracts with lists of 
specifications or equipment lists based on the line items in a 
proposals cost summary. You can customize the templates and 
spreadsheets to suit your needs. 
 
If you are going to create a custom template that also has linked 
spreadsheets there are sample files you can look at based on this 
example.  Look in your Wizard install project folder in the 
CustomizationExamples subfolder.  Unless you changed your 
Wizard’s default install location it will be in the folder: 
 
c:\ProposalKit\ProposalPack\ProposalProjects_V#\CustomizationExamples\ReusableTemplat

eWithSpreadsheets 
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CAN I COPY DYNAMICALLY LINKED DOCUMENTS TO 
ANOTHER PC? 
 
Yes, however for Word to find the linked spreadsheets all the 
Word documents and linked spreadsheets must be copied 
together and into the same folder. 
 
Word for Windows will automatically find and fix the links and will 
relink the spreadsheet to the Word document if they have been 
moved together to another computer. 
 
You do not need to use the Proposal Pack Wizard software with 
the generated documents and spreadsheets after they are 
created. The Wizard can help you open and manage your project 
documents however it is not tied to your Word and Excel files. 
 
This means you can generate a Word document in our Wizard with 
a linked Excel spreadsheet then move that document and 
spreadsheet by themselves to a different computer and use them 
as normal Word and Excel documents. 
 
Microsoft Word requires all the internal OLE links to external files 
to use absolute paths. This means you will have to fix any of those 
paths in the Word document after copying your files. 
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CAN I COPY DYNAMICALLY LINKED DOCUMENTS TO A 
MAC? 
 
Yes, just like all our generated Word documents and spreadsheets 
they are standard format, cross-platform and backwards 
compatible formats that will work in any version of Word on both 
Windows and Mac. 
 
However, this is one feature we have seen that does not translate 
over to the Mac as well as most others. 
 
Because this feature by default uses embedded file links and 
directory structures do not work the same on Mac and Windows 
your embedded spreadsheet links are most likely going to cause 
errors or warnings that the documents could not be located. 
 
You will also have to manually change each OLE link in the Word 
document once you have opened it on the Mac to set the path to a 
new absolute path on the Mac. Mac versions of Word will be 
operating differently plus the formatting of linked cells may not 
display as intended as it does on Windows. 
 
It is your responsibility to fix any path and formatting issues. 
Contact Microsoft for help using dynamically linked spreadsheets 
on the Mac platform. 
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HOW DO I IMPROVE THE LINKING PERFORMANCE? 
 
This depends on what is causing any performance issues. First this 
could be an issue with how Word applies colors to individual cells. 
 
Most of the dynamic OLE spreadsheet links are linked into cells in 
Word tables. Also, the Wizard will apply a color scheme to all 
tables in the document including those that have dynamic OLE 
links, which are usually also the tables with the most cells. 
 
Word is very slow when it applies colors to individual cells. This 
might not be noticeable when you are manually changing cell 
colors by hand using Words interface screens, but it is extremely 
slow when word is stepping through a table cell by cell and 
applying colors individually to each cell. This is not directly related 
to the OLE links but is more something that can cause 
performance issue due to how OLE linked cells are placed in 
tables that use custom color palettes. 
 
Most of our stock templates are designed with tables that have 
color palettes that use the same color across entire rows. This will 
solve the performance issues with applying color schemes. The 
problem gets introduced if you have a table that has even a single 
cell that is a different background color than another cell in the 
same row anywhere in the table. What happens is that the Wizard 
then must change from applying the color scheme row by row 
(which is efficient) to cell by cell (which is very inefficient). 
 
You can also manually apply your color scheme to your tables in 
the Word templates and then turn off the Wizard’s feature for 
applying color schemes to Word tables during document 
assembly. 
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If you have checked your tables that OLE links are placed in so 
that all rows have a single color, then look at how many cells you 
are linking. 
 
Because OLE links are dynamic links between two documents and 
Word must manage the interconnections between the documents 
it can be inefficient to link many cells. 
 
One feature of Word is that you can have your spreadsheet and 
document open at the same time. As you update the spreadsheet 
you can mouse over dynamic links in the Word document and right 
click the Update Link option. This may work fine for small numbers 
of links but with many links this operation can be extremely slow. It 
is more efficient to close your Word document while you are 
updating your spreadsheet, save your spreadsheet changes then 
open the linked Word document. When opening Word will ask if 
you want to update the links. Say Yes to this and the document will 
be updated as it is being opened which is much faster than using 
the Update Link option. 
 
Normally this is not a big problem if your only linked template is a 
Cost Summary with a few line items, amounts and totals. 
 
If you are creating a very large proposal or business plan with 
many linked spreadsheets and hundreds of OLE links the time to 
generate the document can take longer. If this is a one-off 
document such as a business plan, then the time to generate a 
document will not be an ongoing problem. 
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If you are creating many documents each with hundreds of 
dynamic OLE links you might want to consider seeing where you 
can use static text data vs dynamic OLE links. 
 
A dynamically linked Word document with hundreds of OLE links 
can also take longer to just open in Word and update. These 
performance issues are all Word and Excel overhead which might 
only be resolved by using higher end computers with more 
memory and faster processors or even 64-bit versions of Word. If 
you have too many OLE links in a Word document, you can also 
case Word to crash. 
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HOW DO I ADD CALCULATIONS FROM 
SPREADSHEETS MANUALLY? 
 
Proposal Packs contain a collection of financial templates for your 
proposals such as budgets, cost summaries, quotes, return on 
investments, etc. 
 
In the Novice mode these templates are intended for use as static 
documents that are manually updated using your word processor. 
Because the final documents are typically converted to PDF files 
and sent via email as final quotes you do not want them tied 
directly to your spreadsheets. 
 
For each financially related template, Proposal Pack also includes 
a matching calculator spreadsheet. 
 
Use these spreadsheets to calculate your final costs and 
calculations, then manually enter the numbers into the word 
templates. 
 
The Proposal Pack Wizard makes this easier by managing your 
calculator spreadsheets for each project. Each time you create a 
document project that includes templates that have associated 
spreadsheets, the spreadsheets will be copied to your new 
project. You can open the spreadsheets from the “Edit Current 
Document” screen after our project has been assembled by the 
Wizard. 
 
If you want to customize the spreadsheets such as adding your 
own custom line items and costs use the “Edit Styles” button on 
the main Wizard interface, edit the style and click the “Edit 
Spreadsheets” tab. Once you edit the base spreadsheets, each 
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time you create a new proposal, your customized version will be 
copied for that project. 
 
If you are using the Expert Edition of the Wizard, you can 
dynamically link the cells in the Excel spreadsheets to your Word 
documents for a more dynamic solution. Read the What Types of 
Cost Calculation Features are Available? 
 
If you require a higher end quoting system with a database 
management system considering using the QuoteWerks quoting 
and pricing system which integrates with Proposal Pack Wizard. 
QuoteWerks manages large databases of line items and will build 
formatted tables, summaries and totals that can be added to your 
Proposal Pack templates. 
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HOW DO I USE PRESET LISTS OF 
TEMPLATES? 
 
https://www.proposalkit.com/htm/videos-create-preset.htm 
 
Many people who write proposals with our Proposal Pack and 
Proposal Pack Wizard have a specific set of templates that they 
like to use each time they start a new project. They do not want to 
go through the process in the Wizard to select the same set of 
templates each time. They would rather have the selected set 
predetermined, by them, and ready to go for each new proposal. 
One way to do this is with the Presets in the Pick Documents 
screen. 
 
Using preset lists is useful when you also want the ability to alter 
your default list of chapters and assemble every new document. 
The Wizard includes other features to add completely assembled 
documents and finished documents as reusable templates that do 
not have to be fully assembled from the individual chapter 
templates each time a new project is created. 
 
USING PRESETS 

 Click the “Document Projects” button on the main Wizard 
screen. Click the “Add New Project” button then the “Pick 
Documents” button. 

 You are now in the Pick Documents screen. Use the various 
tabs to select templates such as the “Add a Template” tab. 
Select the templates you always want to use for your future 
proposals.  

https://www.proposalkit.com/htm/videos-create-preset.htm
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 Use the “View Selected Templates” button to change the order 
of the templates (changing the order of templates is an Expert 
Mode option; it is not available in Novice training mode). 

 If you also have a Contract Pack template product installed, you 
can even add a specific contract template to your list, and it will 
be saved with in the Preset. 

 If you also have a Title Page Pack installed, you can have a 
custom Title Page added to your Preset. 

 Once you have your selections completed, click the Presets tab. 

 Enter a descriptive name for your new Preset selection and click 
the “Create New Preset from Selected Templates” button.  

 From now on, for all new projects, every time you select your 
saved selection from the Presets tab this custom selection of 
documents will be automatically added to your project.  

 You can have up to 40 custom presets to pick from for each of 
the 12 project types. That is total of 480 possible presets. 

 If all your future proposals will be using the same Preset, you 
can optimize your future project setup even more by setting that 
preset to auto-populate every future project with automatically. 
To use this feature, select the desired Preset from the list and 
click the “Auto-Populate New Projects from Preset” button. 
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HOW DO I CREATE A CUSTOM SET OF 
DOCUMENTS? 
 
Many people who write proposals with our Proposal Pack and 
Proposal Pack Wizard have a specific set of templates that they 
like to use each time they start a new project. They do not want to 
go through the process in the Wizard to select the same set of 
templates each time. They would rather have the selected set 
predetermined, by them, and ready to go for each new proposal. 
There are some common ways to do this. You need to have at 
least one of the Proposal Pack styles or Proposal Kits and the 
Proposal Pack Wizard installed on your computer first. The steps 
that follow assume the products were installed into the default 
folders set by the installers.  
 
 
METHOD #1 (USING PRESETS) 

 Click the “Document Projects” button on the main Wizard 
screen. Click the “Add New Project” button then the “Pick 
Documents” button. 

 You are now in the Pick Documents screen. Use the various 
tabs to select templates such as the Add a Template tab. Select 
the templates you always want to use for your future proposals. 
Once you have your selections click the Presets tab. 

 Enter a custom name for your new saved selection and click the 
Create New Preset from Selected Templates button. From now 
on for all new projects, every time you select your saved 
selection from the Presets tab your custom selection of 
documents will be automatically added to your project. You can 
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have up to 40 custom presets to pick from for each of the 12 
proposal types. 
 
See this chapter for more details: How do I Use Preset Lists of 
Templates? 

 
METHOD #2 (CREATING A PRE-ASSEMBLED REUSABLE 
PROPOSAL) 
 
Instead of assembling a proposal from separate templates each 
time, you can reuse a past proposal as your starting point and 
merge client data into it. Refer to the chapter How do I Reuse a 
Previous Document Over Again? for details. 
  
 
METHOD #3 (CREATING A COMPLETE CUSTOMIZED 
PROPOSAL PACK)  
 
For Expert Computer Administrators Only 
 
You should not manually edit the INI files unless you know what 
you are doing. Use the Wizard edit screens if at all possible, 
instead. Information is only provided for your benefit. Customer 
service will not be able to assist repairing manually edited 
database files. 
 
This configuration option is meant for use by administrators or 
consultants who are setting up customized solutions. It is not 
meant for use by the average user. 
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 First, you need to create a new folder with the templates you 
would like to use copied to the folder. The easiest way to do 
this is go to My Computer and browse down to the Word folder 
of your existing Proposal Pack style you would like to use the 
templates from. If you are using the Pack that came with 
Proposal Kit Professional, the path will be similar to the 
following: 
 
C:\ProposalKit\Pro_v#\ProposalPack\Classic_1_v#\Documents\Word 
 
If you are using a Proposal Pack that you purchased separately, 
the path will be: 
 
C:\ProposalKit\ProposalPack\[STYLE]\Documents\Word 
 

Once you have located the folder titled “Word” in the Proposal 
Pack style you want to use, make a copy of it and paste it right 
next to the original. Do this by right clicking on the folder, Copy, 
then move the cursor over and Paste. This new folder will be 
automatically named “Copy of Word”. You will now have two 
folders, one named “Word” and the other named “Copy of 
Word”. Open the folder “Copy of Word” and delete all the 
templates you do not want to include in your new set. The only 
files left should be the exact set of templates you want included 
in each of your proposals. By creating a new folder containing 
your custom set of templates, you will not affect the original 
Proposal Pack and its full set of templates. 

 Open your Proposal Pack Wizard. Go to Step 2 of the Main 
Interface, “Document Styles”. Click Add Style and OK at the pop 
up message. Browse back to the “Copy of Word” folder you just 
created with your custom selected group of templates, highlight 
“Copy of Word” and click OK. Name your new style where it 
says Style Name. Click the Manage Templates tab and the Edit 
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Stock Templates button and check that all the templates you 
want are in the various drop down menus. Click OK all the way 
back out to the Main Interface. 

 You have now set up your new Style with only the templates 
you have selected. When creating a new Proposal and you want 
to use the custom selected set of templates, go to Step 2, 
“Document Styles”, of the Main Wizard Interface and select that 
new Style from the drop down menu. Click OK. Go to Step 3, 
“Document Project”. Click “Add Project”. Give the project a 
name and go to Pick Documents. At the top of the screen, in 
Step 1, Pick Size, select Everything. Click Recommend. You 
should now see all your selected templates. If you want to 
remove a template for this particular proposal, you can find it in 
the drop down menus and click the Remove button. Now 
proceed as normal with setting up and editing your proposal. 
 
The Everything option has to be manually enabled in the 
Preferences > Project Settings > Configure Document Selection 
Screen. If you are running Expert mode, you will also have to 
manually set the Auto Recommendation tab in the Pick 
Documents screen to “Always Display”. This is done on the 
same screen using the Configure Tabs on Pick Document 
Screen settings: See this chapter for details: How do I Turn 
On/Off the Various Pick Documents Tabs? 

 If after you set up your selected set of templates you decide you 
want to add templates to it, go back to the original Word folder, 
find the templates, copy and paste them into the “Copy of 
Word” folder. You will now find these added templates in the 
Everything list of the Auto Recommend screen and the drop 
down menus for this style. 
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HOW DO I SETUP MY OWN TOP 40 LIST 
OF TEMPLATES? 
 
https://www.proposalkit.com/htm/videos-how-to-create-custom-
top-40-lists.htm 
 
There are 2 different types of “Top 40” lists in the Wizard (however 
they appear to be the same when using the Wizard interface). Each 
of the 12 Proposal Types includes its own single default Top 40 list 
of most used topics. This is the first Top 40 list you will see when 
you enter the Wizard’s Pick Document screen. As you change 
between the 12 Proposal Types that list will change. For example, 
the Top 40 list for product sales proposals is slightly different than 
for service sales proposals, resumes or business plans. 
 
The entire library of proposal topics is also categorized into many 
different situational Top 40 lists. For example, there are Top 40 
lists for real estate topics, security topics, event planning topics, 
logistics topics and so on. There are also Top 40 lists for proposal 
types (product sales, service sales, resumes, business plans, and 
so on). And finally, there are Top 40 lists for topic usage such as 
introduction topics, summary topics, financial topics, company 
information topics, and so on. 
 
Note that these extra Top 40 lists will not be visible in some 
situations, such as when you are using a custom proposal type that 
does not include a large collection of templates. 
 
All these Top 40 lists can be customized in the Wizard’s 
Preferences > Project Settings > Configure Top 40 Lists screen. 
 

https://www.proposalkit.com/htm/videos-how-to-create-custom-top-40-lists.htm
https://www.proposalkit.com/htm/videos-how-to-create-custom-top-40-lists.htm
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You can customize the lists by adding/remove templates, creating 
your own custom Top 40 lists, putting important lists up top in the 
Favorites category, as well as disabling lists you do not want 
displayed in the Wizard interface. 
 
There are 12 different Proposal Types in the Wizard (General 
Business Proposals, Grant Proposals, Business Plans, Resumes, 
RFPs, etc.). Each of these 12 Proposal Types has its own Top 40 list 
of templates. 
 
The point of the Top 40 lists is that with an extensive library of 
templates available in the full retail Proposal Packs it can be hard 
to locate the most used templates. The Top 40 lists locate the 
most used templates in a single screen. 
 
For example, the Cover Letter, Title Page, Executive Summary, 
Table of Contents templates are very common and some of the 
most used templates. These are included in the Top 40 list. 
 
Templates such as Exit Strategy, Location Analysis, and 
Accessories are examples of more specialized templates that are 
not commonly used. These are examples of templates that won’t 
be shown in the Top 40 lists. 
 
Another issue with showing Top 40 lists of templates is that one 
person’s Top 40 list won’t be the same as the next person’s Top 
40 list. A hundred different Proposal Pack users will all have their 
own idea of what the most important templates to their situations 
will be. 
 
The Wizard solves this by creating default commonly used Top 40 
lists with the ability for each user to easily configure their own 
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custom Top 40 list they want to always see displayed when they 
are selecting templates for their projects. 
 
Go to the Preferences > Project Settings > Configure Top 40 Lists 
screen. On this screen select one of the 12 Proposal/Project Types 
you will be configuring. The term Proposal Type and Project Type 
are used interchangeably, they meant the same thing. 
 
While you can have more than 40 templates in the list while you 
are in the process of moving templates in and out of your custom 
Top 40 list, when you finally save the list you cannot have more 
than 40 templates in the list. 
 
Add templates to the list by selecting them from the lists on the 
right and clicking the arrow button that points to the left. To 
remove a template from the Top 40 selections, highlight it in the 
list on the left and click the arrow button pointing to the right. 
 
When you are done selecting your customized Top 40 list of 
templates, click the Save button. Once saved, every time you are 
in the projects Pick Documents screen in the Add Templates tab 
for the Top 40 templates you will see your customized selections. 
 
You can set any Top 40 list to be the default shown in your Pick 
Document screen. 
 
The Top 40 lists do not define the order that the templates will be 
assembled in, read this chapter for how to change the default 
order of your selected templates: How do I Change the Order of 
Documents?  
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HOW DO I SETUP MY OWN SHORT LIST 
OF TEMPLATES? 
 
When you first run the Wizard with a full retail Proposal Pack using 
the default project types (i.e. General Business Proposals, Grant 
Proposals, etc.) you will have access to the complete library of 
templates. 
 
If you are going to be writing proposals frequently you might want 
to have the Wizard startup with a smaller list of templates that are 
tailored specifically to your type of business situation. This will 
make the use of the Wizard faster and more efficient than always 
using the default settings. 
 
Say there are 50 templates you want to frequently have access to 
for creating your proposals instead of the entire collection. Select 
the “Custom” proposal type in the Preferences > Project Settings > 
Configure Project Screen settings.  
 
You can change the title of “Custom” to be anything you like. 
Change this setting in the Preferences > Edit Table of Contents 
Labels > Custom tab. Then in the lower right corner change the 
Project Type Label from “Custom” to “Joel’s List” (for example). 
Now whenever you add a new project you will see “Joel’s List” in 
the drop down list of project types and you can set “Joel’s List” as 
the default list that will be used for all new projects. 
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Once you have selected one of the custom project types go to the 
Preferences > Project Settings > Configure Template Lists screen. 
This screen will let you efficiently change the default template 
order and add/remove individual templates from the different 
project types. This is also where you can use the custom project 
types to setup your own personalized lists of templates. 
 
For example, if you are only going to deal with 50 potential 
templates in your normal course of writing proposals for situations 
that apply to you, you do not need to have all of them in your 
default list to pick from every time you create a project. Instead, 
configure one of the custom project types and add just the 50 
templates that you want quick access to, then add the most 
common ones to your own custom Top 40 list for that custom 
project type. Then, whenever you start the Wizard, it will only be 
loading a small set of templates into its lists and will run much 
faster. This will be more noticeable on older or slower computers. 
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HOW DO I CHANGE THE ORDER OF 
DOCUMENTS? 
 
The Proposal Pack Wizard will append your selected documents 
using a default predefined ordering. Each of the 12 major type of 
proposal (i.e. General Business Proposal, Grant, Business Plan, 
Book, Resume, Business Document, Government Contract, RFP, 
Custom, etc.) has its own predefined ordering.  
 
These orders are initially setup based on Best Practices and 
general proposal writing standards. For example, introduction 
templates come first, templates that talk about your client and 
project are next, templates that talk about you come next, then 
appendix templates come last. Within each of these general 
categories, templates are ordered how they are usually used and 
how they are used in relation to other templates they are near. 
Note that with the complete library of templates and countless 
possible contexts in how they can be used that these are only 
general starting points for how to order your own templates. 
 
With the Wizard you have multiple options available for changing 
the order of templates for your projects. You can change the 
default orderings that all new projects will use, you can change the 
order of templates for specific projects (overriding the default 
ordering), and you can create presets with custom orderings that 
can be reused for new projects.  
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Once you have completely assembled your final proposal 
document and have started editing it, you cannot use the Wizard 
anymore to manage the templates or pages of the project, you will 
have to use Word to cut and paste your pages to new locations 
within your document. 
 
METHOD #1 
 
The first way to change the order of your templates without 
affecting the default settings of the Wizard is to change them on a 
per-project basis.  
 
You must be in Expert mode to be able to change the templates 
on a per-project basis. If you are in the Novice training mode, this 
ability is not available. 
 
As you add templates using the Pick Documents screen you can 
click the View Selected Templates button at the bottom of the 
screen at any time. This view screen is also displayed 
automatically for you when you make changes to your list of 
selected templates. 
 
You will see a screen split into two lists. The list on the right 
contains the templates selected for the project that are not going 
to be combined into your final proposal. These are templates such 
as letters, checklists, logs and externally created contracts. Since 
the templates in the right list are individual documents there is no 
point to allowing them to be reordered so they cannot have their 
order in the list changed. 
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The list on the left contains the templates that will be combined 
into the final combined project document. This list is also shown in 
the order that they will be assembled. The category headers you 
see are for information purposes only and you will not see them in 
the combined project document (except if you add a Table of 
Contents, then you will see them in that page). 
 
The templates will be shown in the default order that they are 
defined in your Wizard databases. There are 12 different Proposal 
Types and each of those proposal types has its own default order 
the templates are ordered in (see below for how to change this 
default ordering). 
 
You can select templates in the list (make sure they are 
highlighted in solid blue) then click the Move Up and Move Down 
buttons to change the order.  
 
When you create your project documents they will be assembled 
together in this new order. 
 
PROS: This method is quick and easy and can be migrated to 
future Wizard releases without having to redo customizations to 
the Wizard database. 
 
CONS: You must reorder the templates every time you create a 
new proposal. If you typically use the same templates over and 
over, create a Preset with this custom ordering. 
 



540 

METHOD #2 
 
Create a Preset you can use to reload a specific set of templates in 
a custom ordering each time you create a new project. 
 
Start with Method #1 above and select a collection of templates 
and change the ordering as needed. 
 
Then in the Pick Documents screen click the Presets tab. Give your 
Preset a unique description and click the Create New Preset from 
Selected Template button.  
 
Each time you create a new project, come to the Presets tab and 
select that Preset from the list and click the Load Templates from 
Preset button. Your project will now be automatically populated 
with the selected templates in the custom order you predefined 
earlier. 
 
You can create up to 40 presets for each of the 12 Project Types (a 
total of 480 possible presets). If it appears your presets have 
disappeared, make sure you did not change to a different Proposal 
Type for that project. For example, if your first Presets were 
created when you were in a “General Business Proposal” project. 
Then later you create a project and set its Project Type to “Grant 
Proposal”, “Business Plan Proposal”, “RFP”, “Custom”, etc. then 
you will not see that preset in the list anymore. To get that old 
preset back you would have to click back to the project screen, 
change the proposal type back to “General Business Proposal”, 
click back into Pick Documents > Presets and load the templates 
from the Preset. Then you can go back, change the Proposal Type 
back to your new proposal type and save the Preset again for this 
project type. 
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PROS: This method is quick and easy and can be migrated to 
future Wizard releases without having to redo customizations to 
the Wizard database. 
 
CONS: You must select the Preset every time you create a new 
project (this is very minimal effort however). And if you are creating 
projects with the same set of templates every time you can set the 
Preset to auto-populate each new project, so you do not even 
have to manually load the Preset). Also, if you switch between 
Project Types (i.e. “General Business Proposals” and “Grant 
Proposals” and you want to use the Preset in each you will have to 
resave the Preset in each Project Type). 
 
METHOD #3 
 
You can also change the default order of how templates are 
assembled for all new projects. Use the Preferences > Project 
Settings > Configure Template Lists screen. This screen will let you 
efficiently change the default template order and add/remove 
individual templates from the different project types.  
 
This is also where you can use the custom project type to setup 
your own personalized lists of templates. We only recommend that 
you use this method to change the default orderings on the 
custom Proposal Type that has been set aside for users to 
customize. This is the “Custom” Proposal Type. Read the chapter 
How do I Setup My Own Short List of Templates? 
 
PROS: This method is quick and easy and allows for a highly 
customized solution. 
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CONS: This method is not easily migrated to future Wizard 
releases. Because the Wizard databases change so much 
between releases (i.e. we add many new entries, sometimes 
remove entries and change the default orderings between 
releases) and users can also customize their own databases by 
adding/removing/editing entries it makes it impossible to 
automatically integrate all these changes. It is up to you to 
manually redo any custom orderings and changes you make to the 
Wizard’s default 12 Project Types. It is safe and recommended to 
make your customizations to the Project Type we have set aside 
for users titled “Custom”. 
 
METHOD #4 
 
Another method of reordering the templates is to use Preferences 
> Tools > Configure Proposal Files. Click a template to change the 
order of and click the Edit the Selected Document button. Then 
select the document that this document is to be placed after and 
click the OK button. From now on, the new document ordering will 
be displayed in the Wizard drop down lists and in your proposals. 
For only changing the order of templates it is much easier to use 
Method #3 above. This method is an older screen before the other 
methods were added, now this Configure Proposal Files should 
only be used for making other customizations to individual 
database entries. 
 
PROS: There are no benefits anymore for using this screen solely 
for changing the order of templates. Use Method #3 now. This 
screen is obsolete for this operation (however it is still used for 
making other alterations to the database). 
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CONS: While this method can be used it is an inefficient way to 
only change the order of templates. 
 
METHOD #5  (FOR EXPERT COMPUTER 
ADMINISTRATORS ONLY) 
 
You should not manually edit the INI files unless you know what 
you are doing. Use the Wizard edit screens if at all possible, 
instead. Information is only provided for your benefit. Customer 
service will not be able to assist repairing manually edited 
database files. 
 
The other method is to manually edit the FileList#.ini files. This 
option can be useful if making large numbers of changes. This 
method is only recommended for experienced users as it requires 
manually editing database files which must be done to exact 
standards. When done it is recommended you run the Preferences 
> Tools > Test Database Files function to ensure there are no 
errors or inconsistencies. 
 
You can define your own template order by editing the data files 
the lists are stored in. There are 12 files which will be found in the 
following default folder (unless you changed the default install 
folder for the Wizard or the location of the database files in the 
Wizard preferences): 
 
“C:\ProposalKit\ProposalPack\Database_V#” 

 
There are 12 files in this folder: 
 

 FileList1.ini - The ordering of templates for General Business Proposals. 

 FileList2.ini - The ordering of templates for Grant Proposals. 
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 FileList3.ini - The ordering of templates for Book Publishing Proposals. 

 FileList4.ini - The ordering of templates for Business Plan Proposals. 

 FileList5.ini - The ordering of templates for Resume Proposals. 

 FileList6.ini - The ordering of templates for Short Form Contracts. 

 FileList7.ini - The ordering of templates for Short Form Quotes. 

 FileList8.ini - The ordering of templates for Government Contracts. 

 FileList9.ini - The ordering of templates for Business Documents. 

 FileList10.ini - The ordering of templates for Research Proposals. 

 FileList11.ini - The ordering of templates for RFPs. 

 FileList12.ini - The ordering of templates for user defined documents. 

 
To change the ordering of the documents as they are displayed in 
the drop down lists and how the documents are appended edit the 
sequence of files in the appropriate FileList#.ini file. 
 
The files are ordered based on the File# identifier, which is a 
sequential number. For example, 
 

[SECTION_1] 

SectionHeader=Summary 

File1=Executive Summary,ExecSummary.docx 

File2=Cost Summary,CostSummary.docx 

File3=SWOT Analysis,SWOTAnalysis.docx 

 
File1 is 1st, File2 is 2nd and File3 is 3rd. To make the SWOT 
Analysis document come first renumber the files as follows: 
 

[SECTION_1] 

SectionHeader=Summary 

File2=Executive Summary,ExecSummary.docx 

File3=Cost Summary,CostSummary.docx 

File1=SWOT Analysis,SWOTAnalysis.docx  
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Make a backup copy of your .ini database files before editing 
them. 
 
PROS: This method allows experts to highly customize the Wizard. 
 
CONS: If you screw this one up you are on your own. Long ago 
this was an easy way to customize the Wizard. Now there are 
many cross references between multiple database files that all 
must be updated exactly for the Wizard to operate. 
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HOW DO I IMPROVE THE PERFORMANCE 
OF THE WIZARD? 
 
The Wizard manages a library of thousands of templates (including 
proposals, business plans, business documents and contract 
templates). This large library of templates that must be loaded into 
all the various Wizard interface screens can slow the interface 
down at times, especially on older and slower computers. 
 
Since most people only use a small subset of templates to create 
their documents you can define your own custom lists of files with 
only 50 templates in the list for example. This will dramatically 
speed up the Wizard. 
 
By default, the Wizard uses the “General Business Proposal” as the 
proposal type for new documents. This default setting gives you 
access to the entire library of templates for all types of documents. 
 
By contrast, if you switch to the “Contract” proposal type, the list is 
much smaller, and the interface will run faster if you change your 
default project type to be the “Contract” type. You can make this 
change in the Preferences > Project Settings > Configure Project 
Screen settings. However, your list of templates you will see in the 
interface will be very limited. 
 
The preferred method of speeding up the interface is to select the 
“Custom” proposal type. While you can customize any of the 12 
proposal types, the custom one is set aside specifically for you to 
create your own custom subset of templates out of the entire 
library. 
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Say there are 50 templates you want to frequently have access to 
for creating your documents instead of all of them. Select the 
“Custom” proposal type in the Preferences > Project Settings > 
Configure Project Screen settings.  
 
You can change the title of “Custom” to be anything you like. 
Change this setting in the Preferences > Edit Table of Contents 
Labels > Custom tab. Then in the lower right corner change the 
Project Type Label from “Custom” to “Joel’s List” (for example). 
Now whenever you add a new project you will see “Joel’s List” in 
the drop down list of project types and you can set “Joel’s List” as 
the default list that will be used for all new projects. 
 
Once you have selected one of the custom project types go to the 
Preferences > Project Settings > Configure Template Lists screen. 
This screen will let you efficiently change the default template 
order and add/remove individual templates from the different 
project types. This is also where you can use the custom project 
types to setup your own personalized lists of templates. 
 
For example, if you are only going to deal with 50 potential 
templates in your normal course of writing documents for 
situations that apply to you, you do not need to have the entire 
collection of thousands of chapters in your default list to pick from 
every time you create a project. Instead, configure one of the 
custom project types and add just the 50 templates that you want 
quick access to, then add the most common ones to your own 
custom Top 40 list for that custom project type. Then, whenever 
you start the Wizard, it will only be loading a small set of templates 
into its lists and will run much faster. This will be more noticeable 
on older or slower computers. 
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An efficient way of building up the Custom proposal type is to 
create a project using the default General Business Proposal type 
and select all the templates you want to make use of. Then in the 
Preferences > Project Settings > Configure Template Lists screen 
switch to the Custom proposal type and click the Select Current 
Project's Templates button. This will automatically select all those 
templates in that project and you can move then right over into 
your Custom proposal type. This saves you the time of having to 
manually find each template in the master template list. 
 
IMPROVING FILE ACESS SPEED 
 
Most of the Wizard processing is file based. The Wizard 
reads/writes from many database files and opens/closes and 
processes Word documents and Excel spreadsheets during most 
of its work. The overhead of file processing and the overhead of 
Microsoft Office and Microsoft Windows are the most time 
consuming. 
 
The easiest and best way to get more performance is to run the 
Wizard on a computer with the fastest possible processor and with 
the fastest possible hard drive.  
 
Using a solid state (SSD) hard drive vs a standard disk (HDD) hard 
drive is one the easiest ways to improve performance. Install the 
Proposal Kit template packs and Wizard on a fast SSD drive. 
 
IMPROVING SPEED OF APPLYING COLOR SCHEMES 
 
If applying the color scheme is taking a lot of time it is due to 
applying colors to table cells and table borders. This is an issue 
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with Microsoft Word. Word takes a long time to apply colors to 
individual cells in tables. 
 
By default, we have designed most of the tables in our templates 
to have the same color across entire rows and the Wizard applies 
colors to entire rows at a time which is much more efficient when 
possible. If the Wizard encounters a row with cells that have 
different colors it has to revert to applying the color scheme cell by 
cell to the entire table which can be very time consuming for Word. 
 
The Wizard will also turn off the applying of the color scheme to 
tables when it detects it doesn’t have to such as when using a 
stock Proposal Pack design theme and the user has not changed 
the default color scheme. 
 
If you are using templates or custom tables with colors that are 
different in cells across rows we recommend you edit the stock 
templates and apply all your colors manually then turn off the 
applying of the color scheme to Tables in the Button #1 - 
Document Styles > Edit Style > Colors tab. 
 
IMPROVING SPEED OF DOCUMENT FORMATTING 
 
If the time to format documents is taking too long it could be due 
to just having a very long document that the Wizard must step 
through sentence by sentence to apply consistent formatting and 
converting text URLs to hyperlinks. 
 
By default, all our stock templates have Word 'Styles' applied to 
the text which do not need to be manually reformatted. If you have 
written in a lot of custom text into the stock templates apply our 
Proposal Kit defined Word Styles to the text. 
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You can also try turning off the document reformatting in the 
Preferences > Project Settings > Configure Project Screen. This will 
stop the Wizard from scanning the entire document during the 
assembly process and applying formatting. 
 
IMPROVING SPEED OF DYNAMIC EXCEL LINKING 
 
If adding links to Excel spreadsheets is taking too long it may be 
due to having too many OLE data links between one or more 
spreadsheets and the linked documents. Consider using fewer 
OLE links if possible. 
 
This is a feature of Microsoft Word and Excel where you can put a 
link between a cell in a spreadsheet and a location in a Word 
document such that when the Excel spreadsheet is changed the 
Word document can automatically update. This is useful for things 
such as quotes or a schedule where costs and dates can be 
changing during the process of putting the document together. 
Without the OLE links you must manually edit all your information 
as plain text in the Word document which can result in errors in 
calculations. 
 
The flip side is that using dynamically linked spreadsheets can be 
a higher learning curve with the use of more advanced Microsoft 
Office features. 
 
Any speed issues with OLE links is due to Microsoft Word and 
Excel as these are OLE links between Microsoft products. Our 
Wizard software only makes use of the OLE features in Microsoft 
Office. The dynamic Excel spreadsheet linking is an optional 
feature. You can turn off the use of the OLE links in both the 
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Preferences > Tools > Excel Calculators screen and per individual 
project on the Project screen. 
 
Too many OLE links will cause performance issues with Word 
when opening linked documents and it can cause Word to crash 
as it is very resource intensive. These are issues with the 
limitations of this feature of Microsoft Word and the capabilities of 
your computer system. This feature is not intended to be used with 
hundreds of links. 
 
For many proposals dynamically, linked Excel spreadsheets are 
not needed.  
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HOW DO I ADD A WORD AUTO-GENERATE 
TABLE OF CONTENTS? 
 
https://www.proposalkit.com/htm/videos-how-to-customize-table-
of-contents.htm 
 
The Wizard defaults to creating a true Word auto-updating Table of 
Contents. An auto-updating Word Table of Contents is 
automatically regenerated when you click the object and select 
one of the update options. 
 
You can configure how your Word Table of Contents will appear 
by using the Wizard’s Preferences > Data & Display > Auto Table of 
Contents Display screen. All the options on this screen are 
standard settings for Word’s Table of Contents object. See your 
Word help manual for what these options mean and how they 
impact the look of your Word Table of Contents. This screen also 
allows you to define the look of the page numbers as well as the 
look and settings for the Table of Contents. 
 
You still must manually click the Table of Contents object in your 
document and select the update option. However, you do not 
need to manually renumber the pages or add/remove entries, 
Word will do that for you. 
 
To use a Table of Contents in your project you must add the 
“Table of Contents” template to your project.  
 

https://www.proposalkit.com/htm/videos-how-to-customize-table-of-contents.htm
https://www.proposalkit.com/htm/videos-how-to-customize-table-of-contents.htm
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There are multiple references to Table of Contents in this 
chapter:  
 

 TableContents.docx is the Proposal Pack template that a Table 
of Contents is inserted into. There are no special features or 
TOC object built into the stock default template. 

 Table of Contents generally refers to the Proposal Pack 
template you add to your project. 

 Word auto-generate Table of Contents is a Word specific object 
that will be inserted into the Proposal Pack Table of Contents 
template (i.e. TableContents.docx) by the Wizard when it creates 
your project files. 

 
There are multiple references to Styles in this chapter: 
 

 Proposal Pack Styles refer to the Proposal Pack product 
variations that are graphic skinned versions of our templates. 

 Word Styles refer to the text styles that can be applied to text in 
a Word document. 

 
The Wizard will add a Word specific auto-generate Table of 
Contents that will rebuild itself and update its page numbers to 
your Table of Contents document.  
 
See your Word manual for help with Word auto-generate Table of 
Contents. While the Wizard will add an auto-updating Table of 
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Contents to your documents and provide configuration options to 
control how it appears it is a feature of Microsoft Word and is 
controlled by your Word program. To understand how auto-
updating Table of Contents operate search your Word help for 
these topics: Table of Contents, Styles, and TC Fields.  
 
The Wizard will also configure all your documents as needed so 
your chapters will be included in the Table of Contents object. This 
is done one of two ways, by either applying a Word “Style” (i.e. a 
collection of font settings) to your page headers if you are using 
text headers. The other method is to include “TC Fields” (which are 
hidden fields that define the text to go into the Table of Contents) 
next to the graphic page headers. The Wizard will automatically 
detect if you are using text headers or graphic headers and will 
update them accordingly. 
 
A Word auto-generate Table of Contents requires a couple things. 
First, all the chapter titles that will be included must be in a specific 
Word text style (and that text style should not be used in any other 
text in your documents). If you are using a graphic logo version of 
a Proposal Pack, then TC Fields inserted next to each page header 
graphic are needed. Second, your Table of Contents document 
needs to have a Word auto-generate Table of Contents object 
inserted into it. 
 
STEP #1 
 
Setup your Proposal Pack templates with headers Word can 
recognize for its auto-generate Table of Contents. The Wizard will 
automatically do this as it is generating your documents. The 
“Proposal Kit Page Header” Word Style will be applied to your 
page header text.  
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The Wizard will also automatically insert several pre-defined Word 
Styles into your documents during the assembly process. You can 
configure these font styles in the Wizard Preferences > Data & 
Display > Font Styles screen. If you have disabled the “Proposal Kit 
Page Header” style, the Wizard will default to using the built-in 
Word style “Heading 1”. 
 
To prevent any templates above and including the Table of 
Contents page being included in the Table of Contents, these 
pages will have their page header fonts set to the same visual 
look, however, will not using the actual Word style “Proposal Kit 
Page Header” or “Heading 1”. 
 
For more information on Word Styles read: How do I use the 
MyProjectFiles folder? 
 
The Wizard allows you to copy your own custom files that are not 
part of the Proposal Kit system into each of your new projects 
using the MyProjectFiles folder. 
 
This feature allows you to automatically copy your own content 
such as worksheets, checklists, letters, spreadsheets, forms, etc. 
into each of your new Proposal Pack Wizard project folders. 
 
The MyProjectFiles folder is in the root install folder where the 
Proposal Pack Wizard is installed. This folder by default is: 
 
C:\ProposalKit\ProposalPack\MyProjectFiles 
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Whenever you build a new document in the Wizard a copy of all 
the files in the MyProjectFiles folder will be made into your 
document’s project folder. 
 
You should not name any of your custom files the same file names 
and extensions as any of Proposal Kit’s document file names. 
 
Use the Preferences > Project Settings > Configure MyProjectFiles 
Settings screen to manage adding files, removing files, and setting 
attributes for the custom files in the Wizard database. 
 
You can manually copy files into the MyProjectFiles folder however 
that will not setup any of the attributes such as human readable 
titles for use in the Wizard drop down menus. Use the Wizard’s 
Preferences tool for managing the attributes.  
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How do I Change/Use Word Font Styles? 
 
If you are using a graphic logo version of a Proposal Pack product 
(i.e. any of the hundreds of Proposal Packs that have graphic 
images for the chapter headers at the top of each template) then 
TC Fields will be used instead of Word Styles. 
 
TC Fields are non-printable fields (i.e. they will not be visible when 
you print or convert your document to PDF). They are inserted 
right in front of the graphics in the page headers as follows: 
 
{ TC “Executive Summary” \f T }  
 
You may or may not see the TC Field in your document. If you do 
not see them you can click the paragraph icon in your Word home 
menu to turn on paragraph marks and other hidden symbols. 
 
The use of the \f T flag is important as this ties the TC Field tag 
back to the Table of Contents object. Your Wizard inserted Table 
of Contents object will also have a matching \f T flag and will look 
like this if you toggle the field codes in your document: { TOC \f T 
\h \z \u }  
 
These field codes and Table of Contents setup are all standard 
features of Microsoft Word. 
 
STEP #2 
 
Setup your Proposal Pack Table of Contents template 
(TableContents.docx) to add the Word auto-generate Table of 
Contents object. 
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The Wizard will also automatically insert the Word auto-updating 
Table of Contents into your Table of Contents template (i.e. the 
TableContents.docx file) if one does not already exist in the stock 
template. 
 
If the Wizard deletes the stock text out of the Proposal Pack Table 
of Contents template (i.e. the TableContents.docx file) it will insert 
the following field tag: 
 
{ TOC \f T \h \z \u } 
 
This field tag is not typed text as you see above, it is an inserted 
Word TOC field with those flags inserted. You can see this by 
clicking your mouse on the Table of Contents object and toggling 
the field codes. 
 
This is essentially what happens when you use your Word toolbar 
to insert a Word Table of Contents into a document. 
 
If you have manually edited the TableContents.docx file to insert 
your own Table of Contents object and you forgot to add tags to 
pickup the TC Fields and the Proposal Kit Page Header font style 
the Wizard will update your Table of Contents object to add these 
missing tags. 
 
STEP #3 
 
As you make changes to your document you will need to refresh 
the Table of Contents to update its entries and page numbers. All 
you must do is right click your mouse on the Table of Contents 
object and choose one of the update options. This operation is not 
part of Proposal Pack or the Wizard, it is a Microsoft Word feature. 
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If your Table of Contents shows the text “No table of contents 
entries found”. Right click on the empty Word auto-generate Table 
of Contents object and select the “Update Field” option. The Table 
of Contents template will now include the Word auto-generate 
Table of Contents populated with all your chapters and updated 
page numbers. If you still see the same message, that means your 
page headers are not setup correctly with Word Styles or TC 
Fields. 
 
The Wizard does not have any control over the Word auto-
generate Table of Contents feature. Any instructions given here 
are dependent on your version of Word. Since Word changes with 
each new version consult your Word help manual for information 
on its version of Table of Contents and where the various screens 
and features for editing Word styles are located.  
 
The Wizard only facilitates adding a Word specific Table of 
Contents and has no control over how that Word feature operates. 
 
To change the Page Number styling see these chapters for more 
details: 
 
How do I Add TOC Sub Headers? 
 
How do I Import a Custom Page Footer? 
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HOW DO I ADD TOC SUB HEADERS? 
 
https://www.proposalkit.com/htm/videos-how-to-customize-table-
of-contents.htm 
 
If you want to add sub headers into your Table of Contents all you 
must do is set any text you want added as a sub header to the 
built-in Word Styles Header 1 to Header 9. 
 
The Word Styles for Heading 1 to Heading 9 are part of Microsoft 
Word and are built-in Styles however they may not all be visible by 
default in the Word Styles screen. 
 
The Wizard will make Heading 1 to Heading 5 automatically visible 
each time it creates a Word document. 
 
This makes it easy for you to then select any text in your Word 
document to Heading 1 to Heading 5. Then you must click the 
Word TOC object in the Table of Contents page of the document 
and update the entire TOC object. 
 
This will rebuild the Table of Contents and any sub header text you 
selected will become part of the Table of Contents.  Depending on 
which Header # you selected for the Style will determine the 
indentation level in the Table of Contents. 
 
Because of how Table of Contents are built depending on if you 
are using a text version of a Proposal Pack or a graphic design 
theme Proposal Pack you may want to start with either Heading 1 
or Heading 2 for your sub headers depending on how you want 
the indentation to be set. 

https://www.proposalkit.com/htm/videos-how-to-customize-table-of-contents.htm
https://www.proposalkit.com/htm/videos-how-to-customize-table-of-contents.htm
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You can also change the default font Style settings for Heading 1 
to Heading 9 in the Wizard’s Font Preferences screen if you want 
specific font styling to be always built into your documents. 
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HOW DO I CONFIGURE PAGE 
NUMBERING? 
 
By default, when the Wizard builds a document page numbering is 
turned on using Word’s default settings (i.e. the page number will 
show up in the bottom right corner in a plain design starting at 1). 
 
At any time after a document is created you can completely 
customize it and change the page number settings and styling by 
just using Word’s page numbering templates and options. 
 
If you turn off page numbering this may cause a multi-section 
document that has custom header graphics (like watermarks or 
Title Page backgrounds) to incorrectly replicate the watermark 
graphic from the previous section. Such as replicating the Title 
Page background down into subpages. This is due to how Word 
manages sections that have blank information in the footers. Try 
manually adding an object into the footers (such as a blank image 
or shape object). Having an object in the footer is a workaround for 
this behavior. The Wizard will try to detect this situation and will try 
fixing this automatically. 
 
To make changes to how the Wizard initially creates the page 
numbers you can configure these settings in a couple ways (using 
the Expert Edition of the Wizard). All the page numbering features 
offered in the Wizard are the same options that Word provides for 
page numbering styling and configuration. The Wizard 
configuration options allow you to change the settings before it 
builds your document vs. you having to change the settings and 
styling in Word after a document has been created. 
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Using the Preferences > Data & Display > Auto Table of Contents 
Display screen you can configure the page number settings (such 
as the starting page number and displaying the page number on 
the first body page or not). 
 
The Page Number Styles drop down incorporates three different 
styles of page numbering that you can use. 
 

 The first set of items in the drop down (“Arabic” to “Uppercase 
Roman”) are the basic Word styling options. This allows you to 
make minor changes to the formatting of the default page 
numbers using some built-in Word styling. The default if you do 
not change anything is to use basic styled “Arabic” page 
numbers. 

 The “Use My Custom Footer File” option is selected when you 
are setting up your own custom external file that the Wizard is 
going to load in the footer information from. This allows you to 
create your own custom tailored footer. See this chapter for 
more information: How do I Import a Custom Page Footer? 

 The rest of the items in the drop down are pulled from Word’s 
built-in building blocks template (which varies from version to 
version of Word). This allows you to select a custom page 
number styling from a template that will be inserted into your 
page footers. These options give you the most creative options 
for how you want your page numbers to look. If you cannot get 
the precise positioning or styling you want from using the drop 
downs. Use the “Use My Custom Footer” option instead and 
make a custom footer template. 
 
Some versions of Word do not handle custom page number 
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positioning correctly and your custom page numbers may 
change positions. If this happens use the external page footer 
file to define your custom page numbering. 

 
Use the Horizontal and Vertical position fields to change the 
position of the page numbers from the default bottom right corner 
of the footer. These values are set in points (72 points = 1”) from 
the top left corner of the page. So, to “center” the page numbers 
set the Horizontal value to 288 (which is 4” over and about 
centered on an 8.5x11 page). Then set the Vertical value to 
between 648 to 720 (which is 9” to 10”) depending on where it 
best fits your pages.  
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HOW DO I ADD SUBHEADS TO THE TABLE 
OF CONTENTS? 
 
https://www.proposalkit.com/htm/videos-how-to-customize-table-
of-contents.htm 
 
This chapter is meant for use with the Word Auto-Generate Table 
of Contents.  
 
The Wizard is designed to build the top-level Table of Contents 
based on the large text sentences at the top of each body page of 
your document (i.e. “Executive Summary”, “Cost Summary”, 
“Company History”, and so on). 
 
If you want to add additional subheads under those top-level 
headings in the Table of Contents you must manually set them up 
as follows (the instructions look long but it is a simple process of 
adding some text, setting the text to a font ‘Style’ then updating 
the Table of Contents object): 
 
First, all the Table of Contents building is based on the existing 
features of the Microsoft Word program. The Wizard makes use of 
the existing capabilities and features of your Word program. The 
Wizard does not extend or add any features to Word that do not 
already exist. 
 
Word uses either ‘Styles’ applied to text or embedded TC Fields 
that are tied to the Table of Contents. So, to add subheads is a 
matter of adding text in an appropriate ‘Style’ to your document 
pages and then rebuilding your Table of Contents. 
 

https://www.proposalkit.com/htm/videos-how-to-customize-table-of-contents.htm
https://www.proposalkit.com/htm/videos-how-to-customize-table-of-contents.htm
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When you are using a text based version of Proposal Pack such as 
Proposal Pack for Any Business or Proposal Pack for Government 
Grants the Table of Contents will be generated using the 
predefined Word ‘Style’ labeled “Proposal Kit Page Header”. 
 
If you highlight the Table of Contents object in the Table of 
Content page it will look something like this: 
 
{ TOC \o \h \z \t “Proposal Kit Page Header,1” } 
 
This tells Word to build the Table of Contents only using top-level 
text in the document that has been set to the “Proposal Kit Page 
Header” font ‘Style’. 
 
Now for example, say we want to add a more descriptive sentence 
under our text in each page with a fuller description that we also 
want to show up in the Table of Contents. 
 
Add a sentence to your document and set it to a pre-defined Word 
‘Style’ such as “TOC 2” or “Heading 2”. These are usually pre-
defined in Word already. 
 
Then highlight the Table of Contents object in the Table of 
Contents page and toggle the field codes. In the example above 
we are going to use the “TOC 2” ‘Style’, so we will have to add it to 
the Table of Contents object as a 2nd level header as follows: 
 
{ TOC \o \h \z \t “Proposal Kit Page Header,1,TOC 2,2” } 
 
Now all you have to do is untoggle the Table of Contents field 
code, so you see the actual text of your Table of Contents again. 
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Then update the Table of Contents to update the entire Table of 
Contents. 
 
Your 2nd level text that you added to your documents pages will 
now appear indented under the top level text. 
 
If you are using a Proposal Pack with graphics in the header of 
each page the field code used for the Table of Contents will be 
slightly different. It may look like this: 
 
{ TOC \f T \h \z \u } 
 
This is because the text of the graphics cannot be used to build 
the text in the Table of Contents. The Proposal Pack Wizard will 
insert field codes in front of all the page graphics that will define 
the text to be used in the actual Table of Contents. This text in the 
individual page’s field codes will match the text seen in the page 
header graphics.  
 
To add a 2nd level header is the same as before with text based 
page headers. Simply add your 2nd level header text to your 
document and set it to a pre-defined Word ‘Style’ such as “TOC 2” 
or “Heading 2”. Then change the Table of Contents field code to. 
In this example we will use the “Heading 2” font ‘Style’: 
 
{ TOC \f T \h \z \u \t “Heading 2,2” } 
 
Then rebuild the Table of Contents object and your 2nd level 
subheads will appear. 
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Highlight objects in your document that use field codes and use 
your right mouse button to pick the ‘toggle field codes’ option. 
 
Read your Word manual or contact Microsoft Support for help with 
field codes, Word ‘Styles’ and Tables of Contents questions.  
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HOW DO I CHANGE THE DOCUMENT 
NAMES? 
 
The Proposal Pack Wizard will append your selected documents 
using a predefined ordering and will create a Table of Contents 
using pre-defined document titles. Each major type of proposal (i.e. 
general, grant, business plan, book, and resume) has its own 
predefined document titles. These document titles are also what 
you see in the drop down list boxes when selecting files in the 
Wizard. 
 
METHOD #1 
 
The preferred method of editing a document’s name is to use 
Preferences > Tools > Configure Proposal Files. Select a template 
to change the name of and click the Edit the Selected Document 
button. Here you can change the Short Title of the document and 
the file or document it will be placed after. You can also change 
the description of the document. This will not change the title 
graphic on the actual template. From now on, the new document 
name and ordering will be displayed in the Wizard drop down lists 
and in your proposals. 
 
METHOD #2  (FOR EXPERT COMPUTER 
ADMINISTRATORS ONLY) 
 
You should not manually edit the .ini files unless you know what 
you are doing. Use the Wizard edit screens if at all possible, 
instead. Information is only provided for your benefit. Customer 
service will not be able to assist repairing manually edited 
database files. 
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It is not recommend changing document names by directly editing 
the INI database files. There are cross references between the 
FileList#.ini, Recommend#1.ini PackDesc.ini and Options.ini files. If 
you change a file name description you must also make sure all of 
the .ini files are changed consistently. Using Method #1 above will 
ensure all .ini file cross references are updated consistently. If you 
do manually edit any .ini files, make sure to run the Preferences 
tool Test Data Files to check for any errors or inconsistencies.  
 
You can define your own document titles by editing the data files 
the titles are stored in. There are 12 files which will be found in the 
following default folder (unless you changed the default install 
folder for the Wizard or the location of the database files in the 
Wizard preferences): 
  
C:\ProposalKit\ProposalPack\Database_V# 

 
There are 12 files in this folder: 
 

 FileList1.ini - The templates for General Business Proposals. 

 FileList2.ini - The templates for Grant Proposals. 

 FileList3.ini - The templates for Book Publishing Proposals. 

 FileList4.ini - The templates for Business Plan Proposals. 

 FileList5.ini - The templates for Resume Proposals. 

 FileList6.ini - The templates for Short Form Contracts. 

 FileList7.ini - The templates for Short Form Quotes. 

 FileList8.ini - The templates for Government Contracts. 

 FileList9.ini - The templates for Business Documents. 

 FileList10.ini - The templates for Research Proposals. 

 FileList11.ini - The templates for RFPs. 

 FileList12.ini - The templates for Custom Proposals (user defined). 
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To change the titles of the documents as they are displayed in the 
Wizard drop down list boxes and how the documents are listed in 
the Table of Contents edit the appropriate FileList#.ini file. 
 
For example, starting with the default settings, 
 

[SECTION_8] 

SectionHeader=Qualifications 

File1=Company History,CompanyHistory.docx 

 
To change “Company History” to “XYZ, Inc’s Company 
Background” 
 

[SECTION_1] 

SectionHeader=Summary 

File1= XYZ, Inc’s Company Background,CompanyHistory.docx 

 
You are only changing the descriptive title for display purposes; 
you are not changing the actual document. 
 
Make a backup copy of your .ini database files before editing 
them.  
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HOW DO I ADD THE SAME TEMPLATE 
MULTIPLE TIMES? 
 
https://www.proposalkit.com/htm/videos-make-copies-of-
templates.htm 
 
The Pick Documents screen only allows each selected template 
from the drop down lists to be added once to the proposal, and in 
the pre-defined order of the drop down lists. 
 
Some templates are designed to be used more than once in a 
proposal such as the Tab, Supplied Forms and Worksheet 
templates used for writing government grant proposals. If you are 
writing a proposal which requires adding the same template more 
than once you will have to make some configuration changes to 
the Wizard first. 
 
The preferred method of adding templates to the Wizard menus is 
to use Preferences > Tools > Configure Proposal Files screen.  
 
Click the “Create & Add a New Document” button. Select a 
template to use as a starting point (i.e. Worksheet). Fill in the 
details of your new document and select where in the ordering of 
the templates it will be located and click the OK button.  
 
This will update all the appropriate Wizard data files with your new 
document and the new document will be selectable as a template 
in all the Wizard menus when creating a new proposal, etc. When 
the operation is complete you can then edit the new templates.  
 

https://www.proposalkit.com/htm/videos-make-copies-of-templates.htm
https://www.proposalkit.com/htm/videos-make-copies-of-templates.htm
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This operation will make a new copy of the selected template 
since using the same template multiple times in the same proposal 
typically means each template will be different. For example, if you 
selected Worksheet to be added again as Worksheet_A, you can 
now go to your Document Project and when selecting documents 
for the proposal add the Worksheet twice by selecting 
“Worksheet” and “Worksheet_A”. 
 
Using this method, you can create multiple copies of any template. 
Once the copies are created you can then edit them to make each 
one unique. A good use of this would be having multiple Product, 
Price List or Services templates. 
 
See the chapter How do I Add New Documents to the Interface? 
for additional information.  
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HOW DO I REMOVE TEMPLATES FROM 
THE INTERFACE? 
 
The Proposal Pack Wizard displays all available Proposal Pack 
documents in the drop down lists for use when choosing which 
documents to add to your proposal. Each major type of proposal 
(i.e. general, grant, business plan, book, and resume) has its own 
predefined list. The 12 lists all contain the same actual documents; 
they are just in different orderings. 
 
METHOD #1 
 
The preferred method of removing templates from the Wizard 
menus is to use Preferences > Tools > Configure Proposal Files. 
Select a template or an entire section of templates and click the 
Remove Selected Document or Section button. This will remove 
the template(s) from the Wizard menus, however the actual 
document template file(s) on your hard drive will not be deleted.  
 
METHOD #2  (FOR EXPERT COMPUTER 
ADMINISTRATORS ONLY) 
 
You should not manually edit the INI files unless you know what 
you are doing. Use the Wizard edit screens if at all possible, 
instead. Information is only provided for your benefit. Customer 
service will not be able to assist repairing manually edited 
database files. 
 
If you wish to trim down the lists to only a set of documents, you 
typically will use you can do so by editing the files the lists are 
stored in. This will only affect the list of available files you can 
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select from in the Wizard. The actual Proposal Pack documents 
installed on your hard drive are not affected. 
 
There are 12 files which will be found in the following default folder 
(unless you changed the default install folder for the Wizard or the 
location of the database files in the Wizard preferences): 
 
C:\ProposalKit\ProposalPack\Database_V# 

 
There are 12 files in this folder: 
 

 FileList1.ini - The templates for General Business Proposals. 

 FileList2.ini - The templates for Grant Proposals. 

 FileList3.ini - The templates for Book Publishing Proposals. 

 FileList4.ini - The templates for Business Plan Proposals. 

 FileList5.ini - The templates for Resume Proposals. 

 FileList6.ini - The templates for Short Form Contracts. 

 FileList7.ini - The templates for Short Form Quotes. 

 FileList8.ini - The templates for Government Contracts. 

 FileList9.ini - The templates for Business Documents. 

 FileList10.ini - The templates for Research Proposals. 

 FileList11.ini - The templates for RFPs. 

 FileList12.ini - The templates for Custom Proposals (user defined). 

 
To remove documents so they will not be displayed in the Wizard 
drop down list boxes edit the sequence of files in the appropriate 
FileList#.ini file. 
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The files are ordered based on the File# identifier, which is a 
sequential number. For example, 
 

[SECTION_8] 

SectionHeader=Qualifications 

File1=Mission Statement,MissionStatement.docx 

File2=Qualifications,Qualifications.docx 

File3=Quality Control,QualityControl.docx 

… 

 
To remove the Qualifications document from the lists, delete the 
entire line from the file. The result is as follows: 
 

[SECTION_8] 

SectionHeader=Qualifications 

File1=Mission Statement,MissionStatement.docx 

File3=Quality Control,QualityControl.docx 

… 

 
It is not required that you renumber all of the File sequence 
numbers, so they are sequential without gaps in the sequence, 
however it is recommended as follows: 
 

[SECTION_8] 

SectionHeader=Qualifications 

File1=Mission Statement,MissionStatement.docx 

File2=Quality Control,QualityControl.docx 

… 

 
Make a backup copy of your .ini database files before editing 
them.  
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HOW DO I ADD NEW DOCUMENTS TO 
THE INTERFACE? 
 
https://www.proposalkit.com/htm/video-add-new-documents-to-
wizard.htm 
 
This method is useful for creating multiple product, service and 
contract documents which you can pick and choose from for each 
new proposal.  
 
For example, if you want to have 3 different product documents to 
pick from depending on who you are writing a proposal to, create 
2 new product templates and edit the templates appropriately with 
your product selections. Then whenever you create a new 
proposal, you will now see 3 different product templates to pick 
from. 
 
If you need to make formatting changes or updates to your new 
documents to help transition them to work better within the 
Proposal Kit system you can use the batch processing tool. Read 
this chapter for more details:  
 
METHOD #1 (MAKING EXTRA COPIES OF EXISTING 
DOCUMENTS) 
 
The preferred method of adding templates to the Wizard menus is 
to use Preferences > Tools > Configure Proposal Files. Click the 
Create & Add a New Document button. Select a template to use as 
a starting point (i.e. Products). Fill in the details of your new 
document and click the OK button. This will update all the 
appropriate .ini data files with your new document and the new 

https://www.proposalkit.com/htm/video-add-new-documents-to-wizard.htm
https://www.proposalkit.com/htm/video-add-new-documents-to-wizard.htm
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document will be selectable as a template in all of the Wizard 
menus when creating a new proposal, etc. If the new template 
documents do not exist, refer to the section in this documentation 
on How do I Add Custom Titled Pages/Chapters? When the 
operation is complete you can then edit the new templates.  
 
This method will also make a copy of any Excel spreadsheet that is 
associated with the copied chapter template. For example, if you 
made a copy of the Cost Summary chapter which is 
CostSummary.docx and has an associated 
CostSummaryCalculator.xlsx spreadsheet and your copy was 
named Cost Summary #2 and the new file was 
CostSummary2.docx the Wizard will also make a copy of 
CostSummaryCalculator.xlsx to CostSummaryCalculator2.xlsx. This 
allows you to have separate cost calculators for each copied 
template which also will work with the dynamic Excel linking 
feature. 
 
METHOD #2 (IMPORTING EXTERNAL DOCUMENTS INTO 
THE WIZARD) 
 
The preferred method of adding templates to the Wizard menus is 
to use Preferences > Tools > Configure Proposal Files. Click the 
Create & Add a New Document button. In the first drop down list 
for selecting an existing file, choose the 2nd item down in the list 
titled “Browse to a new custom file not in this list”. Then browse 
your hard drive to locate the file you want to import. 
 
Then give your file a unique document name, title and description. 
The title is what you will see in the Wizard interface screens once 
the new file is imported. The file name must be unique and not a 
file that is already in the Proposal Pack library. If your new 



579 

document is meant to be incorporated as a chapter in a larger 
proposal, check the boxes for Add to Table of Contents, Uses 
Page Number and Combine into Master Proposal. If you want your 
new document to be listed in the Top 40 list, check that box. You 
must have space available in the Top 40 List. You can also use the 
Preferences > Project Settings > Configure Top 40 Lists screen to 
put your new file in one or more Top 40 lists later. 
 
The Wizard will also automatically add the default set of Proposal 
Kit Word Styles to the new document when it is copied into the 
library of Proposal Pack templates. 
 
Once your finish this operation, your custom document will be 
copied into your Proposal Pack’s document folder along with all 
our stock templates and all of the entries will be made into the 
Wizard database so that your imported file will be available for 
selection in the Wizard interface screens. 
 
You can also configure your templates to cause the contents of 
external file to be imported during the assembly process (which 
does not require setting up the file in the Wizard interface). Read 
this chapter for details: How do I Import the Contents of External 
Files? 
 
METHOD #3  (FOR EXPERT COMPUTER 
ADMINISTRATORS ONLY) 
 
You should not manually edit the .ini files unless you know what 
you are doing. Use the Wizard edit screens if at all possible, 
instead. Information is only provided for your benefit. Customer 
service will not be able to assist repairing manually edited 
database files. 
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There are cross references between the FileList#.ini, 
Recommend#.ini, Options.ini and PackDesc.ini data files. It is not 
recommended to manually add new templates unless you really 
know what you are doing. You should use the Method #1 above to 
ensure all the database cross references are correct. If you do 
manually edit the .ini data files, make sure to run the Preferences 
Test Data Files option when done to test for errors and 
inconsistencies. 
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You can add your own documents by editing the data files the lists 
are stored in. There are 12 files which will be found in the following 
default folder (unless you changed the default install folder for the 
Wizard or the location of the database files in the Wizard 
preferences): 
 
C:\ProposalKit\ProposalPack\Database_V# 

 
There are 12 files in this folder: 
 

 FileList1.ini - The templates for General Business Proposals. 

 FileList2.ini - The templates for Grant Proposals. 

 FileList3.ini - The templates for Book Publishing Proposals. 

 FileList4.ini - The templates for Business Plan Proposals. 

 FileList5.ini - The templates for Resume Proposals. 

 FileList6.ini - The templates for Short Form Contracts. 

 FileList7.ini - The templates for Short Form Quotes. 

 FileList8.ini - The templates for Government Contracts. 

 FileList9.ini - The templates for Business Documents. 

 FileList10.ini - The templates for Research Proposals. 

 FileList11.ini - The templates for RFPs. 

 FileList12.ini - The templates for Custom Proposals (user defined). 

 
To add new documents so they will be displayed in the Wizard 
drop down list boxes and be appended together in your final 
proposal edit the sequence of files in the appropriate FileList#.ini 
file. 
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The files are ordered based on the File# identifier, which is a 
sequential number. For example, 
 

[SECTION_8] 

SectionHeader=Qualifications 

File1=Mission Statement,MissionStatement.docx 

File2=Qualifications,Qualifications.docx 

File3=Quality Control,QualityControl.docx 

File4=Case Study,CaseStudy.docx 

File5=Company History,CompanyHistory.docx 

File6=Services Provided,Services.docx 

File7=Products,Products.docx 

File8=Product Visuals,ProductVisuals.docx 

… 

 
To add a new documents, you have created yourself which did not 
come with the Proposal Pack collection of templates add new lines 
for the documents. For example, if you have multiple product lists 
and want to be able to choose from different product lists for 
different proposals put each product list in a new document such 
as (“ProductList2.docx” and “ProductList3.docx”) and then insert 
them into the list as follows: 
 

[SECTION_8] 

SectionHeader=Qualifications 

File1=Mission Statement,MissionStatement.docx 

File2=Qualifications,Qualifications.docx 

File3=Quality Control,QualityControl.docx 

File4=Case Study,CaseStudy.docx 

File5=Company History,CompanyHistory.docx 

File6=Services Provided,Services.docx 

File7=Products,Products.docx  
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File8=Products (Hardware),ProductList2.docx  

File9=Products (Software),ProductList3.docx  

File10=Product Visuals,ProductVisuals.docx  

… 

 
Documents added to SECTION_10 (Presentation), SECTION_11 
(Misc.) and SECTION_12 (Custom) will not be part of the 
FullProposal.docx combined project document. These sections are 
reserved for miscellaneous documents, letters, checklists, custom 
assembled reusable templates, etc. which are part of the 
document project, just not part of the main proposal document. 
These are good sections to add custom documents such as 
contracts, letters, checklists, etc. which are dealt with separately 
from the proposal. 
 
When adding new documents to the middle of a list of existing 
documents you will have to renumber the File# sequence of files. 
Make sure that each row has a unique and sequential number. 
 
In the example above Product Visuals was renumbered from 8 to 
10, and all entries in the section below it must be renumbered as 
well. 
 
The documents you are adding must be Word documents ending 
in the “.docx” file extension and you must add your new Word 
documents to the Proposal Pack folder where the original set of 
Proposal Pack Word documents is stored. If you do not copy your 
new Word documents to the same folder as all the existing 
Proposal Pack documents, you will not see your new documents 
you just added to the FileList#.ini files in the Proposal Pack Wizard 
drop down list boxes. 
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For example, if you have Proposal Pack Classic #1 you will find the 
Word documents folder on your hard drive at: 
 
C:\ProposalKit\ProposalPack\Classic_1_v#\Documents\Word 

 
Copy any new documents to this folder making sure not to 
overwrite any existing Proposal Pack documents. 
 
Make a backup copy of your .ini database files before editing 
them.  
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HOW DO I IMPORT CONTACTS FOR 
BATCHING DOCUMENTS? 
 
https://www.proposalkit.com/htm/videos-how-to-use-batch-
system.htm 
 
The Batch Processing feature allows you to generate the 
documents for multiple Document Projects at the same time. 
 
Before you can start importing data or batching documents you 
must click the button to start the overall batch. This will assign a 
new batch number that will be used to identify all the imported 
data and projects as related to this batch. This will allow you to 
manage the results of the batch more easily. 
 
Typically, the contact information for multiple documents being 
generated is different so the first part of setting up the batch is 
getting all the projects created. The Wizard can batch created 
multiple projects by importing contact data from several data 
sources. Each contact imported will create one Document Project 
in the Wizard’s database. All those Document Projects will then be 
batched to create all their documents at once. 
 
Look in the Wizard Preferences > Project Settings > Configure 
Batch Processing screen for configuration options. There are 
settings to control how duplicate records are handled and how the 
data is imported into the Wizard’s database. 
 
The Wizard can import data from external files and Microsoft 
Outlook. There are configuration screens for those systems in the 
Wizard Preferences > Integrations screen. 
 

https://www.proposalkit.com/htm/videos-how-to-use-batch-system.htm
https://www.proposalkit.com/htm/videos-how-to-use-batch-system.htm


586 

External Files 
 
The Wizard can import contact data from .xlsx, .txt, .csv and .xml 
files. Whichever file format is used the files must essentially be in a 
row/column format and contain a header row that identifies which 
columns contain which types of fields. If you can export your 
contact data from a 3rd party system you can get it in a format that 
can be imported into the Wizard usually with some minor editing of 
the file such as creating a header row and maybe massaging some 
of the data as needed. 
There are several examples of import files in the 
ProposalProjects_V#\BatchImport folder. Look at these samples to 
see what your header row must contain and how to structure the 
data. If you are using duplicate row checking based on the 
company name and/or first name and last name you must have 
those columns defined (CustCompany, CustFirst, CustLastName). 
All other columns are optional. The example .xlsx file will show all 
the tags that can be used. You can also get the list of tags from the 
chapters that talk about mail merge tags. 
 
Using files to import your data also allows you to use all of the 
Wizard’s predefined tags so you can add your own custom 
columns, contract data columns and company information columns 
in addition to the client data columns. 
 
There are 2 special case columns that can be used in the import 
files. 
 
CompanyNickName – This column header allows you to use a 
single nick name to pull in all the fields for a company data record. 
This would only be used if you added company data records to the 
Wizard’s CRM database and then put those nick names into the 
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import file. One use for this would be if you have many documents 
to batch but they are for different sales reps and its one person 
creating all the batched documents. For example, if you have Ian 
and Joel as Company CRM database record nicknames you can 
enter Ian or Joel into this cell and it will pull in all of the company 
fields from that record (title, salutation, first name, last name and so 
on). 
 
StyleName – This column header allows you to set the graphic 
design theme. This is only used if you have multiple design themes 
purchased and installed and you want to change design themes 
during the batch process. The StyleName must be set to the exact 
style name as shown in the Wizard’s style database including the 
version number. 
 
The only difference between .csv and .txt files is that one is tab 
delimited and one is comma delimited. Excel can be used to save 
your file in either of these formats or if you have a system that can 
create export files you can create them in these formats directly. 
 
.xlsx files are standard Excel files. You can add formatting to the 
Excel spreadsheet however when the data is imported only the 
raw text data will be imported. No formatting will be imported (cell 
colors, bolding, underlines, font sizes or styles, etc.). 
 
If any data is blank in a column that is defined in the spreadsheet it 
will overwrite any default data in the Wizard's database or your 
Project Template. To retain any data in the template if a cell in the 
spreadsheet is empty use the text DEFAULT in the cell of the 
spreadsheet.  This will cause the import to not copy over any 
default in the Project Template. 
 



588 

Each imported row will be used to create a new Document Project 
copied from the Batch Project Template. 
 
It is recommended that you use the Dry Run test first to identify 
any problems with the data. A dry run will perform all the 
operations of importing the data including error checking and 
duplicate checking and will produce a detailed report. The Dry Run 
test will not actually make any changes to the Wizard’s databases. 
 

Microsoft Outlook 
 
If you have Microsoft Outlook enabled in the Wizard’s Integration 
preferences the Wizard will load all your address book records into 
a pick list. Select the records you want to load, and the Wizard will 
import each row into a new Document Project. 
 
Each imported row will be used to create a new Document Project 
copied from the Batch Project Template. 
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Select the records you want to load from the pick list you have 
built, and the Wizard will import each row into a new Document 
Project. 
 
Each imported row will be used to create a new Document Project 
copied from the Batch Project Template. 
 
 
Once all your contact data is imported and the projects created 
you will be ready to start the batch process to create all the 
documents. You can also make manual edits to any of the 
imported projects if you need to make custom changes to any of 
them before stating the document batching. 
 
For more information on the actual batch creation of the 
documents for the projects see the chapter: How do I Batch 
Multiple Projects at Once?  
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HOW DO I BATCH MULTIPLE PROJECTS AT 
ONCE? 
 
https://www.proposalkit.com/htm/videos-how-to-use-batch-
system.htm 
 
The Batch Processing feature allows you to generate the 
documents for multiple Document Projects at the same time. 
 
Normally you create one project at a time and generate the 
documents for that project. Batching lets you create the projects 
first then generate the documents for all of them in a single 
operation. 
 
An example for how to use the batch feature is to create a bunch 
of form letters to send to prospects from a list of leads as a batch. 
Then, for any of those that turn into prospects go back to those 
projects and generate a proposal. Then for any of those projects 
that are accepted you can go back and add additional documents 
to the project such as letters or contracts. 
 
You can control some of the Batch Processing using the 
Preferences > Project Settings > Configure Batch Processing 
screen options. 
 
The batch process works by first adding Document Projects to the 
database. These are the same projects as you normally create.  
Once you have projects in the database ready to create 
documents for you can enter the Batch Projects screen. All 
projects in the database that are in the default "Work in Progress" 
or "Ready to Batch" status are available. Any projects in "Ready to 
Batch" status will also be automatically selected. 

https://www.proposalkit.com/htm/videos-how-to-use-batch-system.htm
https://www.proposalkit.com/htm/videos-how-to-use-batch-system.htm
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In addition to manually creating the projects one at a time you can 
also import contact data from a variety of data sources and 
automate creating the projects to be batched. See this chapter for 
details: How do I Import Contacts for Batching Documents? 
 
Once you have all the projects you want to run in the batch 
selected click the OK, Start Batch button. This will run the normal 
document creation process on all the selected projects saving you 
the time of manually doing it for each individual project. 
 
To save additional time locating all the documents created during 
a batch process you can specify a folder in the Preferences for the 
final generated documents. As each batched project is completed 
the documents for that project will be copied into the external 
folder and prefixed with either the project name or project number. 
The original copies of the documents will still exist in the normal 
project folders. 
 
As each project is completed in the batch its status is set to "Batch 
Completed" or you can specify a specific status. The "Batch 
Completed" status will cause batched project to disappear from 
the main project drop downs as those normally show projects in 
"Work in Progress" status.  So, one trick to keep your batched 
projects showing up in the project drop down lists is to set the final 
status to "Work in Progress" in the Preferences screen. Another 
way to accomplish this is to check the box to combine both "Batch 
Completed" and "Work in Progress" projects in the project drop 
downs. Use whichever option works best for your needs. 
 
Every time you run a batch a batch number is incremented and 
assigned to each project in the batch. This allows you to control 
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viewing and operating on all projects used in a batch to help 
manage projects in bulk operations. 
 
The Wizard can recover from batches that are either stopped 
manually or due to Word stopping or a computer being turned off. 
When the Wizard is restarted it will take you back to the Batch 
Projects screen with options to continue where the batch left off, 
stop and cleanup the batch and possibly restart it or remove all 
traces of the failed batch. 
 
The currently selected style at the time each project was created 
will be used as the design theme. This gives you the ability to set 
specific design themes for individual projects in the batch.  
 
TROUBLESHOOTING 
 
Batching lots of projects at once where you are also assembling 
documents from the template library each time can be time 
consuming. If you are using the same layout of chapters for each 
batched document, consider creating a reusable template. A 
reusable template is a single document copied for each project 
that does not have to completely assembled from scratch each 
time. 
 
If Word crashes or otherwise stops processing the batch in 
progress Word may ask you a Yes/No question when restarting 
about how to open a document that was open previously. If Word 
asks this Yes/No question it can cause the batch to not be able to 
be properly restarted. You can stop the Wizard and restart it again 
to keep Word from asking that question again and then restart the 
batch. 
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HOW DO I BATCH UPDATE OLD OR 
EXTERNAL DOCUMENTS? 
 
The batch processing tool is used to help you update a collection 
of old documents or to help get your external documents ready to 
integrate into the Proposal Kit system. For example, if you have 
made changes to the footers or headers you used in the past you 
can update your documents with new headers and footers. Or, if 
you are preparing a set of custom external templates you want to 
add to the Proposal Kit system you can use the batch tool to add 
the Proposal Kit Word Styles to make your fonts consistent or to 
change all your page margins and page sizes to match ours. 
 
There are a wide variety of batch updates that can be made to 
your documents (headers, footers, font styles, meta data, color 
schemes, page settings, URLs and page borders). 
 
The batch tool will use the settings already in place in the Wizard's 
Preferences, MyGraphics folder and the currently selected 'Style' 
depending on which type of updates you have selected. 
 
The Wizard will apply the updates to every Word format document 
it finds in the selected folder. So, if you have a mix of documents 
you need different types of formatting applied to then split them 
up into multiple folders and batch process each one separately. 
 
If you are updating documents that were generated by the Wizard 
in the past check the box to tell the Wizard, they are Proposal Kit 
generated files so the batch process can tailor the updates 
appropriately. For example, our Wizard generated documents use 
multiple sections within each document and sections that hold the 
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Cover Letter, Title Page and Back Page need to be processed 
differently than the section holding all the body pages. If you 
process external documents the batch process will assume that 
there is only one section in the entire document and will make its 
updates to the entire document. 
 

 To use custom headers and footers you have to setup the 
CustomHeader.docx and/or CustomFooter.docx file in the MyGraphics folder. 

 Word Styles are defined in the Preferences > Data & Display > Font Styles 
screen. 

 Meta Data is defined in the Preferences > Project Settings > Configure 
Document Creation screen. 

 The color scheme is defined in the Document Styles > Edit Style > Colors and 
also the Tables screens. 

 The page settings are defined in the Document Styles > Edit Style > Page 
Setup screen. 

 The page border settings are defined in the Document Styles > Edit Style > 
Borders screen. 

 
First make the updates to the settings in whichever Wizard screens 
apply to the batch processing you need to do. For example, to 
apply a custom header make sure you have the 
CustomHeader.docx file updated in the 
c:\ProposalKit\ProposalPack\MyGraphics folder. Or to change the 
color scheme make sure to set the desired colors in the Edit 
Styles’ Color tab. Then return to the batch processing screen 
check those boxes and start processing your documents. 
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The Wizard will make a backup copy in a new folder of all your 
documents so if the batch process did not work as anticipated you 
can copy the backups and try again after adjusting the settings.  
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HOW DO I CLONE A PROJECT? 
 
https://www.proposalkit.com/htm/videos-clone-project-
documents.htm 
 
Cloning a project is a way to make a new document more 
efficiently for an existing client so you can reuse the name/address 
contact data from the past project and perhaps the template list. 
Or you can use it to quickly make a copy of a past projects 
documents, so you can reuse a proposal you have already 
created. 
 
In the first situation, creating a new document for a past client, you 
just clone the project settings. If there are documents created or 
the past project you do not have to also clone the documents. 
After the project is cloned the new project will have a new name 
and folder created for it and all the name/address and template 
data will be copied. Now just edit the project settings and change 
the title and change the selected templates as needed.  
 
If you want to quickly reuse a past proposal by making a copy and 
editing the completed past proposal, then also clone the project 
documents. In this situation you can change the cloned projects 
title (just to make it easier to locate in the project lists later). If you 
are only planning on editing the past projects completed 
documents all you must do is go straight to the Edit Current 
Document screen and open and edit the documents. In this 
situation you will not be using the Wizard to build new documents. 
You would only change the name/address contact data in the 
cloned project if you are going to delete and recreate documents 
or create all new documents to use with the cloned documents. 

https://www.proposalkit.com/htm/videos-clone-project-documents.htm
https://www.proposalkit.com/htm/videos-clone-project-documents.htm
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If you are using dynamically linked spreadsheets (or any other 
dynamic OLE links) in your project documents the links need to be 
updated to the new folder. The Wizard will scan and update any 
fields in the project documents that are OLE links and will update 
the paths from the source folder to the new cloned folder. 
 
Another way of reusing past proposals so you can use an entire 
document created previously as a selectable template for use in 
the Wizard interface. This is different than cloning past projects. 
For this type of document reuse see the manual chapter: How do I 
Reuse a Previous Document Over Again? 
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HOW DO I REUSE A PREVIOUS 
DOCUMENT OVER AGAIN? 
 
The Wizard is initially used to create a complete document by 
assembling several individual chapter templates and mail merging 
data into them to create a complete master document. 
 
While the Wizard can be used in its default configuration for all 
your document projects there are situations where this becomes 
inefficient. The Wizard is meant to be customized to suit each 
user’s unique workflow and business situation. 
 
One of the ways you can optimize the use of the Wizard and the 
Proposal Pack template collections is to pre-assemble one or more 
multi-page documents then reuse them for future documents 
(usually this is done for client proposals where only client specific 
changes are made such as contact information, prices, etc.) 
 
For example, if you will always be selecting the same set of 10 
templates and assembling them in the same order it is easier to do 
it once, then reuse the assembled 10 page document for your 
future documents. Or you might have 5 different variations of your 
multi-page proposal with different services or price lists. You can 
save each copy of your pre-assembled document with the mail 
merge tags and instead of taking the time to assemble them every 
time, do it once. 
 
Another option could be that the first 5 pages of your document 
and the last 5 pages are always the same but the middle pages 
with products, services or other variable information change. In this 
case you can setup multiple pre-assembled documents then just 
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reassemble 3 documents each time you create a new project 
instead of assembling 10+ pages every time.  
 
There are many ways to setup the Wizard and multiple ways the 
same task can be performed to best suit different business 
situations and workflows. 
 
If you are just using Proposal Packs and the Wizard to create a late 
night proposal, report or business plan for the first time, you don’t 
need to use any of the optimization features, you can use it right 
out of the box with the default settings, then customize it later 
when you figure out your workflow for writing future documents. 
 
Some users want to start with a complete written and combined 
master document with mail merge tags and have the Wizard copy 
that master document and merge data with it. 
 
This is relatively easy to accomplish with the Wizard using the 
following steps. 
 
You can create a reusable template either with an already linked 
Excel spreadsheet or unlinked with either the original <<R#C#>> 
tags or with plain text data. If using dynamically linked 
spreadsheets you should remove any unneeded links. Too many 
OLE links in a Word document will lead to slow performance. 
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METHOD #1 (DIRECT FROM EDIT DOCUMENT SCREEN) 
 
This is the easiest and most efficient method to add a reusable 
template to the Wizard database and make it easily available 
without any extra work. This method does most of the work for you 
however, it uses as many default settings and is not as 
customizable. 
 
From the Edit Current Document screen click the Create Reusable 
Template button. 
 
The Wizard will automatically fill in as many details and load the 
Preferences screen for you with all the settings properly set. From 
that screen add the reusable template. The Wizard can also 
automatically set it up in the Custom Top 40 list and will also make 
the Custom Top 40 list the default.  
 
This way your newly added reusable template can be selected for 
your next document project right from the first page of the Add 
Templates tab. 
 
METHOD #2 (MANUALLY CUSTOMIZE) 
 
If you are using any chapters with dynamically linked spreadsheets 
you can first turn off a couple settings in the Wizard’s preferences 
so that your generated template that will be reused gets built with 
the <<R#C#>> tags still intact. This is for when you do not want 
your reusable template to have OLE links already embedded in it. 
 
First, to create a custom reusable template that will also be linked 
to spreadsheets later during assembly of new project documents, 
make sure to disable the Dynamic XLS linking feature and you also 



601 

must disable the replacing of dynamic XLS tags with replaceable 
text. Before generating your custom reusable template click the 
Wizard’s Preferences > Tools > Excel Calculators button. Then on 
the screen uncheck the Enable Excel Dynamic Links to Word 
Documents box and uncheck the If Excel Dynamic Link is turned 
off replace XLS tags with meaningful text from XLSFiles.ini file. 
Then you can build a template in the Wizard, customize the tags 
and rename the files to get them ready to import as a custom 
reusable template. 
 
Second, from the main Wizard screen click Document Projects > 
Add New Project and name it something like Master Proposal or a 
name you will recognize as this document. Select your templates 
using the various tabs in the Pick Documents screen.  
 
Set all the mail merge data fields in the Company Data, Client Data 
and Other Data screens to blank fields (zero length empty data). 
This will cause the Wizard to not remove or replace the mail merge 
tags when you create the document, leaving you with a completely 
assembled document that still has all the mail merge tags in it. Also 
uncheck the box to use dynamic XLS file linking as you do not 
want OLE spreadsheet links in your new master template. 
 
Click “OK, Save Project and Build Documents” to build the project 
documents. Note that you will see a popup message about all the 
mail merge tags that were found without data. This message is 
correct and is what you want to see in this situation. 
 
Third, after the create process has completed click the “Edit 
Current Document” button and complete all your custom edits to 
this master Combined Project Document until it is complete to the 
point of being able to be used for your future documents. Do not 
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replace any of the mail merge tags at this time as that will be done 
by the Wizard for each new project you use this master template 
for. 
 
To associate linked spreadsheets to your Word document in a way 
that the Wizard will recognize them rename the Excel (.xlsx) files in 
your project folder to the same name as the renamed 
FullProposal.docx file and put the word “Calculator” at the end.  If 
there are more than one spreadsheet all others must have an 
incremental number starting with 2 after the word “Calculator”. 
 
For example, if the project used both the Cost Summary and 
Return on Investment templates it would have copied the 
CostSummaryCalculator.xlsx and 
ReturnOnInvestmentCalculator.xlsx spreadsheets into your project 
folder. 
 
In this example you would rename the generated project 
documents FullProposal.docx to a unique name such as 
OurCustomProposalLayout.docx then rename the project 
spreadsheet CostSummaryCalculator.xlsx file to 
OurCustomProposalLayoutCalculator.xlsx and the project 
spreadsheet ReturnOnInvestmentCalculator.xlsx file to 
OurCustomProposalLayoutCalculator2.xlsx 
 
If you are going to create a custom template that also has linked 
spreadsheets there are sample files you can look at based on this 
example.  Look in your Wizard install project folder in the 
CustomizationExamples subfolder.  Unless you changed your 
Wizard’s default install location it will be in the folder: 
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c:\ProposalKit\ProposalPack\ProposalProjects_V#\CustomizationExamples\ReusableTemplat

eWithSpreadsheets 
 
Then you will have to update the <<R#C#>> tags in the renamed 
OurCustomProposalLayout.docx file so the Wizard will know which 
spreadsheet each tag is associated with.  In this example any tags 
in the Return On Investment chapter would have to be changed to 
<<XLS:OurCustomProposalLayoutCalculator2:R#C#>> 
 
Once these customizations are made then you can follow the 
instructions to add your custom multi-spreadsheet associated 
template into the Wizard database as a selectable template.  
 
Fourth, from the main Wizard interface click Preferences > Tools > 
Configure Proposal Files button. Select Proposal Type “Custom” 
from the end of the list. Then, click the Create & Add a New 
Document button.  
 
Click the top drop down that says Pick a Document or Section and 
select “Browse to a new custom file not in this list” then when 
shown the browse file screen locate your master document you 
were editing in the first step above. Based on this example (and if 
you did not install your products in a different location than the 
defaults) you will find your master document in the file:  
 
c:\ProposalKit\ProposalPack\ProposalProjects_V#\Master Proposal\FullProposal.docx 
 
In our dynamically linked spreadsheet example above you would 
select the OurCustomProposalLayout.docx file as the custom 
template to be added into the Wizard database. 
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If you titled the project differently or if you installed the Wizard in a 
different folder locate it wherever you saved it to. If you cannot find 
it, run the Preferences > Tools > File Location Report and look in 
the log file for where your project is stored on your hard drive. 
 
Change the rest of the fields as you see fit such as the name of the 
document file, short title and long description. You must use 
unique names for the document file and title that are not already in 
use in the Wizard. Enter a custom name and file name such as “My 
Master Proposal #1” and a file name like 
“OurCustomProposalLayout.docx”. These are only examples, use 
any meaningful names. Enter a description of the new document, 
you must replace the default description with our own. 
 
For the file or section that the file will be placed after drop down 
list, select “Section 10”, “Section 11” or “Section 12” as the section 
to place the new document under then click the OK button. The 
reason for putting your reusable template in Section 10, Section 11 
or Section 12 is that any templates located in these sections will 
not be put through the process of being recombined; they will only 
be copied into your new project folder as stand-alone documents 
(however they will still be processed to replace mail merge tags 
with your custom data, etc.). Depending on your business situation 
and workflow, you could setup a reusable document and place it in 
Sections 1 to 9 which gives you the ability to prepend or append 
additional templates to it. Set up the options as your situation 
dictates. 
 
Check the Show on Top 40 Tab box if you want quick access to 
this template. If you are adding this file to a Proposal Type that 
already has 40 templates in its Top 40 list, you will have to go to 
the Preferences > Project Settings > Configure Top 40 Lists screen 
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and remove one of the other Top 40 templates otherwise there 
will not be room on the Pick Documents Top 40 tab for this one.  
 
Remember to switch to the appropriate Proposal/Project Type in 
the Top 40 configuration screen to see your new reusable 
template. If you added your new reusable template to the Custom 
type, you must select the Custom type when you get to the Top 40 
configuration screen, and you will also need to change your 
proposal type to Custom when creating a new document. 
 
Set the Custom type as your default for all new proposals in the 
Preferences > Project Settings > Configure Project Screen and 
change the drop down for the default document project type to 
Custom. By default, it is set to General Business Proposals. This 
will also give you the benefit of optimizing the performance of the 
Wizard while it is running since the Custom type will only be 
working with a very small set of templates vs. the default setting 
which has to manage the entire library of templates. You can 
switch back to using the General Business Proposal type when 
you want access to all the templates to create new reusable 
templates. 
 
When the custom template is added to the Wizard database the 
Wizard will copy it into the documents folder where the rest of the 
stock Proposal Pack templates are located. The Wizard will also 
copy any associated spreadsheets it finds in the same folder into 
the Proposal Pack stock spreadsheets folder. Therefore, you must 
follow the naming rules, so the Wizard knows to copy them and 
make the database associations otherwise only the Word 
document will be added to the system. 
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Once the add process is complete you will see a list of files to edit. 
For every Proposal Pack style, you have purchased you will see a 
new file. If you have purchased more than one Proposal Pack style, 
your document will have been copied into every Proposal Pack 
style’s document folder. Note this is only a management issue for 
users who have installed multiple sets of our Proposal Pack 
templates. You might want to delete the extra copies and just use 
one copy in one of your Proposal Pack styles. You do not need to 
edit the master template currently. Click OK and go back out to the 
Wizard home screen. 
 
If you have selected a Cover Letter and will be creating a Master 
Cover letter that you want to use with the Master Proposal, do the 
same steps as above starting with the second step. In step 3 you 
will select the coverletter.docx rather than the fullproposal.docx. 
 
Fifth, remember to turn back on the dynamic Excel linking feature 
if you disabled it in the Wizard’s Preferences > Tools > Excel 
Calculators screen. Save the Wizard preferences and exit back to 
the Wizard home screen. 
 
Your complete master template is now selectable as a new 
document in the Proposal Pack Wizard menus as follows: 
 
Sixth, Click the Document Projects button on the main Wizard 
screen and click Add New Project. Give the project a name such 
the name of the company you are submitting the proposal to. 
Select “Custom” as the project type (unless you have already set 
“Custom” as your default project type.  
 
Next click the Pick Documents button and select from the “Stock 
Proposals” menu your newly created master template “My Master 
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Proposal #1” (or whatever you titled it). If you added this as a Top 
40 selection you will see it on the Top 40 page as well. 
 
Fill out the mail merge data for this project and click OK, Save 
Project and Build Documents. Your new document will now have 
been created more efficiently using your reusable master 
template. 
 
Steps 1 to 3 above only need to be done once. Every time you 
create a new document reusing this master template you only 
need to repeat this fourth step. 
 
If you used the “General Business Proposal” type instead of the 
“Custom” for example, make sure to select that proposal type to 
find your custom document and look in appropriate section 
(presumably you put it in “Section 10”, “Section 11” or “Section 12”). 
 
For each new document repeat this step. You can also create 
multiple complete templates to choose from or even completely 
independent documents such as individual custom contracts using 
this method. 
 
If you are using the dynamic Excel linking feature and have 
associated one or more Excel spreadsheets in the database with 
your custom template, they will all be copied into your project 
folder just by selecting your custom named template from the 
Wizard interface. If you added <<R#C#>> tags to the custom 
template the Wizard will replace them with OLE links to the 
spreadsheets when you generate your project documents. 
 
This does have implications for upgrading to future versions of 
Proposal Packs and the Wizard. Because the databases are so 
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configurable, and you are making complex changes to the system 
you will have to manually copy your reusable templates to new 
Wizard versions in the future and you will have to go through the 
steps above to add them back to future Wizard databases. The 
only step you will not have to redo migrating to a future release is 
that you do not have to rebuild the reusable templates again. The 
Wizard does include a migration tool that will assist in finding 
custom documents and where they should be copied to. See the 
migration documentation for details: How do I Migrate from a 
Previous Version?  
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HOW DO I TEST MY MANUAL INI 
DATABASE EDITS? 
 
Most of the Wizard data resides in a collection of INI database files. 
While you can edit the data manually by editing the INI files, it is 
recommended you use the Wizard Preferences screens. 
 
Some edits are relatively easy, others such as those involving 
proposal document names use cross references between multiple 
files which must all match. 
 
You can test the integrity of the Wizard database files for errors 
and inconsistencies by running the Test Data Files in the Tools tab 
of the Wizard Preferences screen. 
 
This tool will perform extensive checks on the database and will 
create a report outlining its findings. 
 
Use this report to help repair your INI files or to send to our 
technical support department if assistance is required. 
 
You can repair many settings by using the “Reset to Default” 
buttons on the various Wizard Preferences screens. 
 
Some settings such as those related to the lists of proposal files 
and file attributes may require manually editing the INI files to 
repair the problems. As a last resort you can try to manually copy 
the FileList*.ini and Recommend*.ini files from the backup folder 
located on your hard drive. This is a manual operation you need to 
perform using your Windows desktop. 
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If the damage is too extensive or difficult to repair, you may have 
to uninstall and reinstall the Wizard. 
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HOW DO I CREATE MULTIPLE (PRODUCT, 
ETC) TEMPLATES? 
 
https://www.proposalkit.com/htm/videos-make-copies-of-
templates.htm 
 
Many people have different product selections, service plans, 
contracts, etc. they want to pick from depending on who they are 
writing a proposal for. 
 
The Proposal Packs come with a single template for Products, a 
single template for Services, a single template for Contract and 
Terms, etc. 
 
You can make multiple copies of any template with new names 
and populate the new templates with your custom text, images, 
etc. Then, for each new proposal you can select which of your 
Products, Services or other templates to use. 
 
For example, you have 3 products templates unique to your 
company, Software Products, Hardware Products and Distributor 
Product List. Our Proposal Pack has a single template called 
Products. 
 
Run the Wizard and click Preferences >Tools > Configure Proposal 
Files button. Click the Create & Add a New Document button. Now 
click the first list box and select the “Products” template as the 
source document. The Wizard will now be populated with the 
information from the default Products template and given a unique 
name. Change the file name to “SoftwareProducts.docx” and the 
title to “Software Products” and click the OK button. You will then 

https://www.proposalkit.com/htm/videos-make-copies-of-templates.htm
https://www.proposalkit.com/htm/videos-make-copies-of-templates.htm
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be given the option to edit the new template. Open the template 
and edit it like you would any Word document, if you have text for 
your own custom template already written you can paste it in and 
save the file. Repeat these steps adding the other 2 new product 
templates. 
 
Now, when you create a new proposal you will see your new 
product templates as selectable documents in the Wizard. 
 
You can use this method to create multiple copies of any template 
and name them as you see fit. 
 
For example, if you have a standard web site development 
contract, software development contract and web site hosting 
contract you can create multiple proposal contract templates by 
copying the standard “Contract and Terms” proposal template and 
pasting in your contract text.  
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HOW DO I DO PROJECT TRACKING AND 
REPORTING? 
 
https://www.proposalkit.com/htm/videos-how-to-use-tracking-
reporting.htm 
 
The Project Status tracking feature allows you to further manage 
your document projects by updating the status through the various 
stages of the process. 
 
The default status for each new project is "Work in Progress" and 
is set to the date that the project was added to the system.  The 
fields in this form are only used for your convenience to help keep 
track of your projects.  The data is not used anywhere else. 
 
For example, when you have finished writing your document and 
have submitted it, set the project status to "Submitted" and update 
the date field.  Later if the proposal is accepted update the status 
to "Accepted" and update the date field.  Each of these status 
dates is individually stored in the project database. 
 
Moving completed projects to different statuses will also reduce 
the clutter of having many open projects to pick from in your work 
in progress projects. 
 
If you have only selected one project, then all its fields will be filled 
in the project status form. If you have selected multiple projects 
then all fields on the form will be blank unless the data is the same 
in every selected project, in which case it will be displayed on the 
form. Only fields you change on the form will be updated back to 
the selected project(s). If you change a field on this form and you 

https://www.proposalkit.com/htm/videos-how-to-use-tracking-reporting.htm
https://www.proposalkit.com/htm/videos-how-to-use-tracking-reporting.htm
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have selected more than one project, then that field will be 
updated into every selected project.  
 
The status fields are set in the Project Status screen which is a 
button on the Manage Projects screen. 
 
To generate a report in an Excel compatible XML file you can 
select one or more records from the Manage Project screen and 
click the Output to Report button. 
 
This will generate a report of your selected projects and all 
tracking status dates for those projects. 
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HOW DO MULTIPLE PEOPLE EDIT THE 
SAME DOCUMENT? 
 
https://www.proposalkit.com/htm/videos-how-to-use-team-editing-
mode.htm 
 
The Wizard is installed by default in single person editing mode. 
This means when a proposal is created all the individually selected 
templates are combined into a single master proposal. The single 
master proposal titled FullProposal.docx is then edited by a single 
person typically. 
 
THERE IS NO PROTECTION AGAINST MULTIPLE PEOPLE 
ACCESSING THE DOCUMENTS OR DATA AT THE SAME TIME 
AND OVERWRITING EACH OTHERS WORK.  
 
If you are going to setup the Proposal Packs and/or Proposal Pack 
Wizard, you are responsible for setting up procedures to ensure 
users will not cause problems such as not allowing the ability to 
change the Wizard database or not allowing edits to root 
documents. 
 
You must have the appropriate number of licenses for the number 
of users and type of environment (single user or networked).  
 
Proposal Pack Wizard also supports team editing where multiple 
people can be editing the same proposal at the same time. This is 
done by leaving the individual proposal templates as separate 
documents and each person is assigned to work on specific 
templates. For example, one person edits the Executive Summary 

https://www.proposalkit.com/htm/videos-how-to-use-team-editing-mode.htm
https://www.proposalkit.com/htm/videos-how-to-use-team-editing-mode.htm
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and Cost Summary, and another person edits the Products and 
Services.  
 
To enable Team Editing mode, turn on the option in the 
Preferences screens under the General Settings tab. 
 
Then, after you create your proposals, do not edit the combined 
master proposal (FullProposal.docx). Instead click the Team Editing 
tab. When all the editing is done, click the Recombine ALL 
Templates button. When the process is complete, you can then 
view, edit and print the FullProposal.docx by clicking the Open 
Document(s) button on the Edit Your Current Documents screen. 
 
When you combine the individual templates into a new master 
proposal, the original master proposal will be overwritten. Do not 
edit both the master proposal and the individual templates at the 
same time. 
 
Another important safety feature built into the Wizard to prevent 
your edits from being overwritten is if you add more templates and 
create your proposal again, any existing templates will not be 
overwritten. This also means that if you have changed document 
styles or mail merge data, the new data or style will not overwrite 
or affect any existing templates. If you have not started editing any 
of your proposal documents, you can clear out the old files and 
start the proposal generation over completely by clicking the 
Delete Old Files button in the Document Project screen. 
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HOW DO I INSTALL AND CONFIGURE FOR 
USE ON A NETWORK? 
 
First you need to have purchased enough licenses to cover the 
number of individual users and computers the software will be 
used by. Each purchased license will cover 5 users/computers.  
 
Once you have the appropriate licenses and serial numbers it is 
important that while Proposal Packs and Proposal Pack Wizard can 
be used in a networked environment with multiple people 
operating on the same set of documents and a common database 
for the Wizard the software is not specifically designed as a 
client/server or other specially designed multi-user system. 
 
You must grant full read/write permission to the files and folders 
being used to hold the Proposal Kit templates and document 
projects.  
 
THERE IS NO PROTECTION AGAINST MULTIPLE PEOPLE 
ACCESSING THE DOCUMENTS OR DATA AT THE SAME TIME 
AND OVERWRITING EACH OTHERS WORK. IT IS YOUR 
RESPONSIBILITY TO SETUP POLICIES AND PROCEDURES TO 
SUPPORT HOW MULTIPLE USERS WILL ACCESS SHARED FILES. 
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If you are going to setup the Proposal Packs and/or Proposal Pack 
Wizard, you are responsible for setting up procedures to ensure 
users will not cause problems such as not allowing the ability to 
change the Wizard database or not allowing edits to root 
documents. 
 
We only offer suggestions on setting up the software to help point 
you in the right direction and do not guarantee they will always 
work in all environments or configurations and there are many 
ways to setup the system depending on where you want the 
various files located. 
 
There are several paths stored in the Wizard’s Windows registry 
and in the Wizard’s INI database files. Double check all the paths 
to ensure everything is pointing to the proper location.  
 
SUGGESTION #1 
 
Proposal Pack installed on Server, Wizard installed on each 
user’s computer. Each user has their own project folder for new 
proposals. 
 

 First ensure you have one license for every (5) five users. For 
the first license you will number the users 1 to 5, for the 2nd 
license 6 to 10 and so on. 

 On each computer map a network drive letter to the location on 
the server so you can access the Proposal Pack installation 
folder on the network via a mapped network drive (i.e. 
“Z:\ProposalKit”). 
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 From the first computer, install the Proposal Pack on the 
network server to the mapped drive. 

 Install the Wizard on each user’s computer. In the Wizard’s 
Preferences > General Settings screen enter the multi-user 
serial number to enable the “User ID Number” field. Make sure 
each Wizard has a unique User Id generated. 

 In each users Wizard, go to the main screen and click the 
“Document Styles” button, click the “Search for Styles” button, 
then browse to the folder on the network where you installed 
the Proposal Pack(s) (i.e. “Z:\ProposalKit”). Note on the first 
computer that the Proposal Pack/Pro kit was installed on this will 
happen automatically. All other computers will use the Search 
for Style button. 

 
If your mapped drive letter does not show up in the list of drives in 
the Proposal Pack installer’s browse screen you may have to 
configure your Windows operating system to show the mapped 
drive letters. There can be multiple things that cause mapped drive 
letters to not show up so if the following tip does not work consult 
your Windows help or search for other solutions online. 
 
Run the Windows regedit utility program and in the 
HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\Current
Version\Policies\System key add a DWORD entry of 
EnabledLinkedConnections and set it to 1 then restart your 
computer. This should cause your mapped drive letters to show up 
in the installers. Rerun the installer and select your mapped drive 
and a folder to install into. 
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Proposal Pack Wizard must be configured to use drive letters (i.e. 
use a mapped network drive such as Z:\ProposalKit instead of 
\\MYNETWORKEDCOMPUTER\My C Drive\ProposalKit ). The 
Wizard will not operate properly with UNC or HTTP paths. 
 
In this configuration each user has their own copy of the Wizard 
database and their own project folder that each new proposal will 
be created in. The only part that is accessed via the network are 
the Proposal Pack templates. 
 
The administrator can set Wizard preferences to enable Novice 
mode and disable editing of the default project settings as you see 
fit. 
 
Proposal Kit does not offer technical support for individual users 
when you are setting up a networked environment. Contact your 
network administrator for assistance. 
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SUGGESTION #2 
 
Proposal Pack installed on Server, Wizard installed on each 
user’s computer. All users use a common network folder for new 
document projects. 
 

 First ensure you have one license for every (5) five users. For 
the first license you will number the users 1 to 5, for the 2nd 
license 6 to 10 and so on. 

 On each computer map a network drive letter to the location on 
the server so you can access the Proposal Pack installation 
folder on the network via a mapped network drive (i.e. 
“Z:\ProposalKit”). 

 From the first computer, install the Proposal Pack on the 
network server to the mapped drive. 

 Install the Wizard on each user’s computer. In the Wizard’s 
Preferences > General Settings screen enter the multi-user 
serial number to enable the “User ID Number” field. Make sure 
each Wizard has a unique User Id generated. 

 In each users Wizard Preferences > Files and Folders screen, 
change the “Default Project Folder” to a location on your 
network (i.e. “Z:\ProposalKit\ProposalProjects”). 

 In each users Wizard Preferences > Files and Folders screen 
check the box “Disable Archive Orphaned Project Folders 
option in Manage Projects delete screen”. This is required to 
ensure one user doesn’t accidentally archive another user’s 
project folders. This is also why this configuration is not 
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recommended anymore. It is preferable for each users to have a 
unique project folder on the network. 

 In each users Wizard, go to the main screen and click the 
“Document Styles” button, click the “Search for Styles” button, 
then browse to the folder on the network where you installed 
the Proposal Pack(s) (i.e. “Z:\ProposalKit”). Note on the first 
computer that the Proposal Pack/Pro kit was installed on this will 
happen automatically. All other computers will use the Search 
for Style button. 

 
Proposal Pack Wizard must be configured to use drive letters (i.e. 
use a mapped network drive such as Z:\ProposalKit instead of 
\\MYNETWORKEDCOMPUTER\My C Drive\ProposalKit ). The 
Wizard will not operate properly with UNC or HTTP paths. 
 
In this configuration each user has their own copy of the Wizard 
database. The only part that is accessed via the network are the 
Proposal Pack templates and the created project documents. 
 
Users will also have to ensure that they do not create new projects 
with the same folder names as someone else in this configuration. 
 
If you are working in a team environment where multiple people 
are working on parts of the same proposal, then set all their root 
project folders to the same place. You should put your own 
procedures in place to ensure that only one person creates project 
folders and ensure that multiple people don’t work on editing the 
same files at the same time (remember there are no protections in 
place in the Proposal Pack or Proposal Pack Wizard to prevent 
this). This situation comes in handy when a team is working on a 
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large proposal and different people are assigned to work on 
different parts of the proposal. Each part of the proposal is 
maintained in separate templates, and you wait to combine them 
into a single document until everyone is finished with their parts. 
 
The administrator can set Wizard preferences to enable Novice 
mode and disable editing of the default project settings as you see 
fit. 
 
Proposal Kit does not offer technical support for individual users 
when you are setting up a networked environment. Contact your 
network administrator for assistance. 
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SUGGESTION #3 
 
Proposal Pack installed on Server, Wizard databases and project 
folders to be setup on the Server. All users use a common 
network folder for new document projects. 
 
This option is better used by a single person using multiple 
computers or when only one person at a time will be generating 
documents in the Wizard software. 
 
The Wizard software is not a real-time multi-user system. It can be 
used by multiple people at once with some caveats. When making 
changes to the shared databases and files such as adding new 
projects, configuring Preferences, etc. all other copies of the 
Wizard should be restarted to ensure they pick up the changes 
and do not overwrite each other. 
 

 First ensure you have one license for every (5) five users. For 
the first license you will number the users 1 to 5, for the 2nd 
license 6 to 10 and so on. 

 On each computer map a network drive letter to the location on 
the server so you can access the Proposal Pack installation 
folder on the network via a mapped network drive (i.e. 
“Z:\ProposalKit”). Because paths are set in the server side 
databases and files this will only work for multiple users if each 
user has the same mapped drive letter and directory structure. 

 From the first computer, install the Proposal Pack on the 
network server to the mapped drive. 
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 Install the Wizard on each user’s computer. In the Wizard’s 
Preferences > General Settings screen enter the multi-user 
serial number to enable the “User ID Number” field. Make sure 
each Wizard has a unique User Id generated. 

 In each users Wizard Preferences > Files and Folders screen, 
change the “Default Project Folder” to a location on your 
network (i.e. “Z:\ProposalKit\ProposalProjects”). 

 Also change the “Settings Database Folder” and “Project 
Database Folder” folders to be the database folder created 
during the Wizard installation on the server (i.e. 
“Z:\ProposalKit\ProposalPack\Database_V##”). 

 In each users Wizard Preferences > Files and Folders screen 
check the box “Disable Archive Orphaned Project Folders 
option in Manage Projects delete screen”. This is required to 
ensure one user doesn’t accidentally archive another user’s 
project folders. This is also why this configuration is not 
recommended anymore. It is preferable for each users to have a 
unique project folder on the network. 

 Close all the individual user’s Wizards if they are still running. 

 In the first user’s Wizard, go to the main screen and click the 
“Document Styles” button, click the “Search for Styles” button, 
then browse to the folder on the network where you installed 
the Proposal Pack(s) (i.e. “Z:\ProposalKit”). Note on the first 
computer that the Proposal Pack/Pro kit was installed on this will 
happen automatically. All other computers will use the Search 
for Style button. 
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 Run the Wizard on each user’s computer and they should now 
all be initializing with common set of networked database files 
and templates. 
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SUGGESTION #4 
 
Proposal Pack installed on Server, each user with their own 
database settings. Project folders to be setup on the Server. All 
users use a common network folder for new document projects 
with their own personal subfolder. 
 
This option is better used by a multiple people where all projects 
are kept in a master server folder, but each user has their own 
subfolder to prevent any projects from interfering with each other. 
 
This is the easiest setup to manage multiple users at once without 
risking people having multi-user conflicts. The Wizard software is 
not a real-time multi-user system. It can be used by multiple people 
at once with some caveats. 
 

 First ensure you have one license for every (5) five users. For 
the first license you will number the users 1 to 5, for the 2nd 
license 6 to 10 and so on. 

 Each user installs the Wizard to their default C:\ProposalKit 
folder. 

 The first user changes the Preferences > Files and Folders 
screen “Default Project Folder” path to the networked drive. 
This must not be the root of the drive.  For example, 
Z:\ProposalKit\ProposalProjects. Note this first user is not 
creating a subfolder for themselves in this step. This is required 
so the Wizard can create the starting directory structure. 

 The 2nd, 3rd and so on users set the Preferences > Files and 
Folders screen “Default Project Folder” path to the networked 
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drive with a subfolder added. For example, 
Z:\ProposalKit\ProposalProjects\Bob, 
Z:\ProposalKit\ProposalProjects\Sue, etc. 

 The 1st user can then set their Preferences project path to a 
subfolder such as Z:\ProposalKit\ProposalProjects\John 

 In the Wizard’s Preferences > General Settings screen enter the 
multi-user serial number to enable the “User ID Number” field. 
Make sure each Wizard has a unique User Id generated. 

 In each user’s Wizard, go to the main screen and click the 
“Document Styles” button, click the “Search for Styles” button, 
then browse to the folder on the network where you installed 
the Proposal Pack(s) (i.e. “Z:\ProposalKit”). Note on the first 
computer that the Proposal Pack/Pro kit was installed on this will 
happen automatically. All other computers will use the Search 
for Style button. 

 
 
Run the Wizard on each user’s computer and they should now all 
be initializing with common set of networked database files and 
templates and each will have their own individual workspace on 
the network. 
 
Proposal Pack Wizard must be configured to use drive letters (i.e. 
use a mapped network drive such as Z:\ProposalKit instead of 
\\MYNETWORKEDCOMPUTER\My C Drive\ProposalKit ). The 
Wizard will not operate properly with UNC or HTTP paths. 
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In this configuration each user is using a common database (i.e. 
lists of available templates, document projects created by any 
user, etc.).  
 
If you are working in a team environment where multiple people 
are working on parts of the same proposal, then set all their root 
project folders to the same place. You should put your own 
procedures in place to ensure that only one person creates project 
folders and ensure that multiple people don’t work on editing the 
same files at the same time (remember there are no protections in 
place in the Proposal Pack or Proposal Pack Wizard to prevent 
this). This situation comes in handy when a team is working on a 
large proposal and different people are assigned to work on 
different parts of the proposal. Each part of the proposal is 
maintained in separate templates, and you wait to combine them 
into a single document until everyone is finished with their parts. 
 
The administrator can set Wizard preferences to enable Novice 
mode and disable editing of the default project settings as you see 
fit. 
 
Proposal Kit does not offer technical support for individual users 
when you are setting up a networked environment. Contact your 
network administrator for assistance. 
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SUGGESTION #5 
 
Proposal Pack installed on cloud drive (i.e. OneDrive), only one 
copy of the installer files and database exists on cloud drive. 
Wizard setup on other computer using the same cloud drive 
files. 
 
This option is better used by a single person with multiple devices 
using a cloud drive so they can work from different devices and 
maintain a single copy of their files. 
 
The Wizard software is not a real-time multi-user system. It can be 
used by multiple people at once with some caveats. 
 

 First ensure you have one license for every (5) five devices. For 
the first license you will number the devices 1 to 5, for the 2nd 
license 6 to 10 and so on. 

 During install of the Proposal Pack product(s) and Wizard 
change the install folder to the cloud drive using a path that will 
be the same across all devices the Wizard will be run on ( i.e. 
C:\Users\UserName\OneDrive\ProposalKit ). 

 On your other devices make sure they have Office installed and 
that the OneDrive folder has synced and you see all of the 
installed Proposal Kit files. It may take awhile before all the files 
show up on the other devices. You must be able to see all the 
files before running the Wizard otherwise file not found errors 
will occur. 

 Open the Windows S Mode copy of the Wizard document 
“ProposalPackWizard_Win_V#.docm” and enable the macros 
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then click the Add-Ins tab and the Run Wizard button. This will 
start the Wizard manually. Since the EXE version of the installer 
was not run on the other computers there will not be 
components yet setup for running the full version of the Wizard 
so you must run the S Mode copy first. The Wizard will detect 
that the registry settings do not exist and will set them up the 
first time as well as double checking that the root install path 
matches. Once setup you can run the Wizard from the OneDrive 
from multiple computers using these steps. 

 
 
Proposal Pack Wizard must be configured to use drive letters (i.e. 
use a mapped network drive such as Z:\ProposalKit instead of 
\\MYNETWORKEDCOMPUTER\My C Drive\ProposalKit ). The 
Wizard will not operate properly with UNC or HTTP paths. 
 
With OneDrive or other cloud drives you may have to wait for files 
to sync to the computer which may cause delays. 
 
In this configuration each user is using a common database (i.e. 
lists of available templates, document projects created by any 
user, etc.).  
 
If you are working in a team environment where multiple people 
are working on parts of the same proposal, then set all their root 
project folders to the same place. You should put your own 
procedures in place to ensure that only one person creates project 
folders and ensure that multiple people don’t work on editing the 
same files at the same time (remember there are no protections in 
place in the Proposal Pack or Proposal Pack Wizard to prevent 
this). This situation comes in handy when a team is working on a 
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large proposal and different people are assigned to work on 
different parts of the proposal. Each part of the proposal is 
maintained in separate templates, and you wait to combine them 
into a single document until everyone is finished with their parts. 
 
The administrator can set Wizard preferences to enable Novice 
mode and disable editing of the default project settings as you see 
fit. 
 
Proposal Kit does not offer technical support for individual users 
when you are setting up a networked environment. Contact your 
network administrator for assistance. 
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HOW DO I USE THE CLOUD OR 
ONEDRIVE? 
 
If you use a desktop and laptop/tablet computer for your proposal 
writing there is a good chance you need to work efficiently both in 
the office and while traveling. 
 
One method is to transfer your working documents to your 
laptop/tablet every time you leave – this can be a nuisance if you 
must do this often. Or you can store your working files on a USB 
flash drive, this can be problematic as well since you can risk 
losing the USB drive or forget to take it with you. 
 
One solution is to leave your working files on a cloud drive such as 
Windows OneDrive. Since a OneDrive is mapped to a standard 
drive letter this makes it easy to setup your Proposal Pack Wizard 
and Proposal Kit products on multiple computers and keep your 
working files in a central location accessible from anywhere you 
have an Internet connection. 
 
Any cloud based storage solution will work if you can map a 
Windows drive letter to the storage system. OneDrive does this 
automatically by letting you use the C:\Users\Your 
Name\OneDrive\Documents folder. 
 
While the Wizard allows you to set the paths to many components 
of the Proposal Kit system (your database files, your working 
projects, your source templates and graphics) it is usually easiest 
to only move your projects folder onto the cloud drive.  
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If you move your Wizard database files onto the cloud drive this 
also requires that every computer using that cloud version of the 
database has all the exact same Proposal Kit products installed in 
the exact same locations. While you can also move your Proposal 
Kit products onto the cloud drive as well this can introduce 
additional problems. Such as if you wind up working somewhere 
without an Internet connection you would be unable to work.  
 
If you only put your working database on the cloud drive, you still 
can create new projects and proposals without access to the 
Internet by changing the project folder in the Wizard preferences 
back to a local drive. If you customize any of the stock Proposal Kit 
product templates, you just must make sure to sync those 
manually between multiple computers to ensure when you build 
projects, they are consistently created using the same templates. 
 
To move your project folder onto a cloud drive first create a new 
folder in your cloud drive such as “ProposalProjects” and then edit 
the Wizard’s Preferences > Files and Folders screen and change 
the “Default Project Folder” to the new folder in your cloud drive 
such as:  
 
C:\Users\YourName\OneDrive\Documents\ProposalProjects  

 
Do this on each computer that the Wizard and other Proposal Kit 
products are installed on. 
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Now, every time you create a proposal it will be created on your 
cloud drive. When you switch to working on your other computer 
such as your laptop/tablet and run the Wizard you will be able to 
open and work on the project files and proposals created from the 
first computer. This will ensure you won’t forget to take files or 
sync folders before you leave the office. All you need is an Internet 
connection to access the cloud drive (so it is wise to periodically 
backup your working files to a local copy on your travel computer 
in case you wind up having to work without a cloud connection). 
 
The Wizard does not automatically reload its database lists while it 
is running. This method of using a cloud drive to allow someone to 
access the same files from multiple computers requires that only 
one Wizard is running at a time to access the files. For example, if 
you are working on a proposal in the office first close that Wizard 
then run the Wizard on your remote computer to ensure it loads all 
the changes you applied to the files located on the cloud drive. 
 
If you have multiple people working on the same cloud drive, it is 
best to have each person using their own subfolder in the cloud 
drive project folder to ensure nobody interferes with another 
person’s work. If multiple people are working on the same project 
you need to setup your own protocol for managing multiple people 
writing to the same files. The Wizard does not lock files or in any 
way manage multi-user access to files at the same time. 
 
If you move all your stock templates to your cloud drive, you 
should also keep a backup copy on your local hard drive on your 
travel computer. If you lose your cloud drive access you will still be 
able to build new proposals and documents from your local copy 
of the templates. This can be helpful when working during flights 
or other times when your cloud drive is not available. 
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Read the chapter How do I Install and Configure for Use on a 
Network? for additional details on setting up Proposal Kit products 
for use on a network. 
 
While the Wizard does its best to detect inaccessible drives and 
files, the Wizard does not treat cloud or network drives any 
differently than local drives. It is your responsibility to make sure 
drives are available and files are properly synced when working 
locally then later the cloud drive.  
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HOW DO I INSTALL ON A REMOVABLE 
DRIVE (USB)? 
 
Proposal Kit products can be installed on a removable drive such 
as a USB stick or removable USB drive. 
 
This allows you to take your entire Proposal Kit installation 
including the Wizard software on a portable drive and plug it into 
other computers. 
 
Due to path names stored in the Wizard databases that will be on 
the portable drive it is a requirement that the exact same drive 
letter is used on every computer you will plug the drive into. 
Because drive letters in use will vary from computer to computer 
and the lower drive letters are the most used you should map a 
new drive letter before you install Proposal Kit products to the 
removable drive and pick a drive letter that is higher in the 
alphabet. 
 
For example, if your default drive letter for your removable drive is 
E:\ that is a lower drive letter that may already be in use on other 
computers. Change your removable drive letter higher in the 
alphabet like R:\ or X:\ for example using your Windows system 
tools. 
 
It is important to note that you may just be guessing that these 
drive letters will be available on unknown computers you may be 
planning on plugging your removable drive into. If this happens 
you may have to rename a drive on a new computer you plug your 
removable drive into to run the Wizard. 
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The other requirement is that any computer you plan on running 
the Wizard on from your removable drive must also have Microsoft 
Office installed. 
 
Once you determine your drive letter run the Proposal Kit product 
installers and change the drive letter from the default 
C:\ProposalKit\ProposalPack to your removable drive such as 
R:\ProposalKit\ProposalPack. 
 
Note that the Proposal Kit product installers won’t allow installation 
into the root of a drive so only change the drive letter in the folder 
to install into. 
 
Once installed on the first computer and you have run the setup 
and your Wizard is running properly you can unplug the removable 
drive and plug it into another computer. 
 
When plugging into a new computer there will be a couple things 
missing that are normally done by the Windows exe installers.  
 
The Windows desktop shortcut icons won’t exist on the new 
computer so you will have to manually open the Wizard’s Word 
document on the removable drive and run it from the Add-Ins tab. 
 
Find the ProposalPackWizard_Win_V##.docm file and open it in 
Word on the new computer. Click the Enable Content button to 
enable the macros. Then click the Add-Ins tab and then click the 
RunWizard button. 
 
Once you have the Wizard running you can use the Preferences 
features for setting up the DLLs on the new computer if you need 
the 3rd party integration features. 
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The Wizard will startup and it will detect its being run from a 
removable drive on a new computer. It will double check the drive 
mapping is correct and it will recreate the Windows registry key 
settings from a backup copy that is stored on the removable drive. 
 
It will also ask if you want to create the Windows desktop shortcut 
icons. If you will use this computer frequently you can create the 
shortcuts to save time. Otherwise, if this is a temporary use on this 
computer you may want to skip creating the shortcut icons as they 
will not work once you disconnect the removable drive. 
 
If you will be adding your own content such as links to logos, the 
Multiple Choice database content, etc. make sure to locate all your 
content on the removable drive. 
 
With a removable drive installation you can travel without the need 
of carrying a computer and keep all of your proposals and 
documents securely on your own portable hard drive. 
 
Because the Wizard performs a lot of read/write operations while 
processing documents and while running the highest speed 
removable drive you can use the better. For example, a high 
speed USB SSD drive will perform much faster than a USB 2.0 
flash stick. 
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HOW DO I TURN ON/OFF THE VARIOUS 
PICK DOCUMENTS TABS? 
 
When you add templates to a project you use the Pick Documents 
screen. This screen has several tabs for different types of 
operations involved in adding or removing templates from the 
project. 
 
Regardless of which tabs and options you use in this screen, the 
result is having a selection of templates in an order that will be 
used to create the documents for the project. 
 
This is a handy configuration tool for an administrator or consultant 
setting up the Wizard for specialized situations. You can restrict 
access to certain screens and ensure the end user only has access 
to what they need. 
 
Some of the tabs are always displayed, others are dynamic and 
only displayed in appropriate situations. You can always override 
the default tab displays in the Wizard preferences to turn on a tab 
at all times or turn off a tab. Depending on what mode the Wizard 
is in (Demo, Novice, Expert) and which template products are 
installed (Contract Packs, Proposal Packs, limited versions) 
different tabs will be displayed depending on the circumstances. 
 
Using the Wizard Preferences > Project Settings > Configure 
Document Selection Screen options in the Configure Tabs on Pick 
Documents Screen section you can override these defaults to 
always turn on/off a particular tab. 
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First, select the Proposal Type you want to edit the screen display 
for. There are 12 Proposal Types (General Business Proposals, 
Grant Proposals, Business Plan Proposals, RFP, Custom, etc.). You 
can change the settings for all 12 types at once or just a single 
type. 
 
Second, pick the tab you want to change the display behavior for. 
The various tabs and what they are used for are listed below. 
 
Third, pick the desired behavior. You can turn the display of a tab 
on or off completely, or let it be displayed dynamically (the default 
behavior). For example, since the Auto Recommend tab 
disappears in certain situations, you can force it to always be 
displayed by changing it to “Always Display”. If you do not ever 
want to see the Presets tab, you can set it to “Never Display”.  
 
There is one special case for the Add Template tabs. Since these 
are really 3 tabs in 1, you can define which one you want to be 
shown first on entry into the Pick Documents screen. For example, 
if you always want the Top 40 tab to show first when you click the 
Add Templates tab you can set its behavior to “Always Display 
(Top Add Tab)”.  
 
Here is the list of all available tabs and what they are used for: 
 

 Remove Templates 
 
This tab is very straight forward. It contains all the currently 
selected templates. You can remove templates by selecting 
them from the list and removing them. 
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 Add Templates – By Category 
 
There are three different Add Templates tabs, but only one is 
displayed at a time. This version shows you all available 
templates broken up into major categories. Templates are 
displayed in the lists in a general order of how they usually fit 
together. 

 Add Templates – By Top 40 
 
This version shows you the Top 40 most commonly used 
templates all on one screen with checkboxes. This makes it 
more efficient to quickly select the most common templates. 
Note that you can also customize the Top 40 lists to show your 
own custom tailored Top 40 set of templates. 

 Add Templates – By Alphabetical 
 
This version shows you all available templates in alphabetical 
order. This can make it easier to locate a specific template out 
of a large collection than using the category listing. 

 Search by Name 
 
This tab allows you to search for a specific template out of the 
all that are available in the library. This may be the most efficient 
way to locate a template when you might only know one word 
to describe it. Such as searching for “summary” to locate the 
Product Cost Summary or searching for “history” to locate the 
“Company History” template. This tab can also be used to show 
you other templates that are related to this one or that are 
alternative versions that might be more suited to your specific 
situation. This tab may be turned off in some situations, such as 
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if you are using a very small collection of templates that doesn’t 
make sense to need search options to find templates in that 
small of a list. 

 View Samples 
 
This tab allows you to select one of the completed samples and 
build a list of templates for your project using the same 
templates that were used to create that sample. This only adds 
the same templates to your project that were used to create the 
sample, it does not copy any of the actual text from the sample 
into your project unless you click the button to import the 
content of the sample. This can make it more efficient to setup a 
proposal for a specific situation. For example, if you are selling 
accounting services you can select the “Accounting and Payroll 
Services Proposal” from the samples list then click the “Import 
Content from Selected Sample” button and all 9 templates used 
in that sample will automatically be added to your project. You 
can also build up your list by adding templates from multiple 
samples to your project. This tab may be turned off in some 
situations, such as using custom project types with small 
collections of templates. 

 Auto Recommend 
 
This tab is primarily used as a training tool. It is similar to the 
View Samples tab, but it is simpler and more generic. Beginners 
can use it to get a general idea of what kinds of templates could 
be used for a variety of types and sizes of projects. Once you 
switch from Novice training mode to Expert mode this tab is 
turned off by default. 
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 Add a Contract 
 
This tab is used when you have a Contract Pack template 
collection installed. Contract Packs and Proposal Packs are 
separate products. While Proposal Pack template products do 
include a handful of basic and generic contracts and work 
orders, the Contract Pack template products contain large 
collections of very specialized contract documents. Use this tab 
to add a detailed contract to your project. There are also 
options to have the contract inserted into your main proposal or 
to have the contract created as a separate document from the 
main proposal. If this tab has been disabled and you later 
purchase and install a Contract Pack template product, this tab 
will be turned back on automatically. 

 Presets 
 
This tab is used to create and load preset collections of 
templates you have created. You can select a collection of 
templates, organize them in any order you like, even add a 
Contract Pack contract and save them all as a preset. You can 
even set one of your presets to auto-populate every new 
project with. For example, if every one of your proposals is 
virtually the same you can save time even having to come to the 
Presets tab and load the files from the preset by setting that 
preset to auto-populate new project with. Then, every time you 
add a new project it will already have those templates pre-
selected. You can have 40 different Presets for each of the 12 
project types (i.e. General Business Proposals, Grant Proposals, 
Business Plan Proposals, RFP, Custom, etc.). 
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 Title Page 
 
This tab is used to manage the add-on Title Page Pack 
products. You can select an alternate Title Page design and 
color theme from multiple installed Title Page Packs. 

 Quick Start 
 
This tab is used to quickly load your project with a set of 
templates already pre-selected for hundreds of business 
situations.  
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HOW DO I CONFIGURE THE AUTO 
RECOMMEND SCREEN? 
 
When you create a new proposal and are selecting templates you 
are using the Pick Documents screen and the Auto Recommend 
tab on that screen. This screen allows you to have the system 
select templates for you based on the type of the proposal (grant 
vs. business plan, etc.) and the size of the proposal (3-4 pages vs. 
20-30 pages, etc.). 
 
The Auto Recommend tab in the Pick Documents screen is 
primarily intended for use as a training tool for beginners. This tab 
is disabled in some of the proposal types and it is hidden once you 
switch from Novice training mode to Expert mode. You can 
override the default tab hiding in the Wizard Preferences to turn 
back on this tab in Expert mode if you have need for it. 
 
By default, the Auto Recommend uses preset selections of 
templates, these settings are contained in the database files 
Recommend#.ini. 
 
There are a few ways to configure how the Auto Recommend tab 
operates. 
 
First, you can preset what options the screen will open with every 
time by editing the Project Settings tab of the Preferences screen. 
This will save you time by always having the screen open with your 
most commonly used settings. 
 
Second, you can alter the default system selections for the Auto 
Recommend by editing the Proposal Pack files attributes. For 
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example, if you want to alter the templates in the General Business 
Proposal “Small” recommendation list by adding a new file. Go to 
Preferences > Tools > Configure Proposal Files. Then select the 
template you want to add to the Auto Recommend selections and 
click the Edit the Selected Document button. On the edit screen 
check the Auto Recommend attributes for Small proposals and 
click the OK button to save the edits. Now, whenever you create a 
new proposal and select the default “Small” proposal size, that 
new template will be part of the selection list. You can also remove 
recommended templates from any category by un-checking the 
attribute for that file. 
 
Third, if you are using the custom project type (i.e. “Custom”) and 
you have included a smaller selection of templates into that project 
type that you want to always select (similar to the use of the 
Presets), you can enable the “Everything” recommendation setting 
in the Wizard Preferences. Then for a new project you can select 
the “Everything” auto-recommendation size and have all templates 
for that project type automatically added to your project. This 
capability is disabled by default to prevent people from 
automatically adding every template in the library to a project and 
bogging down the Wizard with an unmanageable project that 
would take a very long time to build. This is only meant for use in 
customized Wizard configurations for specialized situations. Note 
that if you are using the Custom project type you will also have to 
turn back on the display settings for the Auto Recommendation tab 
as that tab is not displayed by default. 
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The Auto Recommend screen is primarily meant for use by 
beginners to get a general idea of what kinds of templates can be 
used for different types of projects. These selections are very 
general and are mostly used as a training tool. 
 
For more specialized recommendations use the other tabs such as 
“View Samples” and “Quick Start”.  
 



649 

HOW DO I CHANGE THE DATE FORMAT? 
 
The Wizard allows you to merge dates into your proposals when 
you create them. This is part of the mail merge feature. See the 
chapter on using mail merge tags for more information. 
 
The steps for using automated date formats in your proposals are 
as follows: 
 
First, go to Preferences > Data & Display tab, then click the Edit 
Mail Merge Fields button. Next, click the Dates tab which is the last 
tab on the screen. 
 
Here is where you configure how the date will be formatted and 
merged into your proposal. The screen supports international 
translation of months and days as well as configuring the actual 
date format as follows: 
 
The date format can be any combination of M,MM,MMM,MMMM 
D,DD,DDD,DDDD and Y,YY,YYYY separated by / (slash), - (dash), . 
(period) or a blank space or a space with a comma.  
 
Note that you can only include the M, D or Y strings once each. 
 
D = single digit (1), DD = 2 digits (01), DDD = short day (Mon), DDDD = full name (Monday) 

 

M = single digit (3), MM = 2 digits (03), MMM = short month (Mar), MMMM = full name (March) 

 

Y or YYYY = 4 digits (2006), YY = 2 digits (06) 
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Examples 
 

 M/D/Y    becomes 3/1/2006 

 YYYY-MM-DD   becomes 2006-03-01 

 YYYY.M.D   becomes 2006.3.1 

 YY-M-D    becomes 06-3-1 

 YYYY-M-DDDD   becomes 2006-3-Monday 

 MMMM DD, YYYY becomes January 01, 2006 

 
  
Second, you have to setup the mail merge data in your document 
project to use the dates. You can have all new proposals pre-
populated with date data by using the Default fields in the mail 
merge label edit screen. 
 
Use the following values in the Default fields 
 

 CURRENTDATE  - Defaults to the custom date format set above. 

 SYSTEMDATE  - Uses your computers system date format. 

 CURRENTDAYSTR - Uses only the current day name (i.e. Monday) 

 CURRENTDAYNUM - Uses only the current day number (i.e. 1) 

 CURRENTDAYNUMSTR - Uses the current day number as a string (i.e. 1st) 

 CURRENTMONTHSTR - Uses only the current month name (i.e. June) 

 CURRENTMONTHNUM - Uses only the current month number (i.e. 6) 

 CURRENTYEARYY - Uses only the current year number (i.e. 06) 

 CURRENTYEARYYYY  - Uses only the current year number (i.e. 2006) 

 
 
When you create a new proposal and you have set the 
Preferences customer field for the current date to be 
“CURRENTDATE”, your actual data value in your proposal mail 
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merge fields will be set to the current date (i.e. 3/1/2006), or 
whatever date format you have defined. 
 
Third, to have the current date embedded in your proposal, there 
must be a mail merge tag embedded in your document. Some 
Proposal Pack documents are pre-defined with the current date 
mail merge tag. For example, the Title Page document 
(TitlePage.docx) has the tag <<CurrentDate>> embedded in the 
document. 
 
When the Wizard creates the proposal and you have selected the 
Title Page, the tag <<CurrentDate>> will be replaced with the 
actual date (i.e. 3/1/2006) 
 
You can also embed date tags into any of your proposal templates 
as needed. This can come in handy for contract start dates and 
end dates using the contract mail merge tags.  
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HOW DO I CHANGE MY FINAL 
DOCUMENT’S PROPERTIES? 
 
Word documents have properties such as the Author, Subject, 
Company, Keywords, Title, Comments, etc. 
 
Document properties are also referred to as meta-data and are 
usually hidden in the document. You can view these properties in 
Word by clicking your Word toolbar File > Properties. Note that 
different versions of Word may have properties located in different 
places. Refer to your Word documentation on where to find the 
document properties as this is a feature of Word, not our Wizard. 
 
There are many different properties that can be set in a document. 
The Wizard allows you to set the six most common and relevant 
properties with your own custom data. 
 
If you do not enter any data into these fields they will be filled in 
with default data or will retain the default properties of the original 
Proposal Pack templates. 
  
In the Wizard go to Preferences > Project Settings > Configure 
Document Creation 
 
On this screen fill in the six fields with any information you want 
inserted into your proposal and contract documents. Note that this 
information will be inserted into every document the Wizard 
creates for you. You cannot customize the properties to be 
different for specific documents (unless you manually edit them 
yourself after the Wizard creates the documents). 
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 Author 
 
Author is typically the person writing or owning the created 
documents such as “Jane Doe”. If you do not enter anything in 
this screen it will default to the first/last name used in each 
projects company data. So, this field will be filled in for you on a 
per-project basis if you do not override it here. 

 Subject 
 
Subject is typically a general subject such as “Proposal by 
Widgets, Inc.”. If you do not enter anything in this screen it will 
default to a generic Proposal Pack subject. 

 Company 
 
Company is typically the company writing the proposals such as 
“Widgets, Inc.”. If you do not enter anything in this screen it will 
default to the company name used in each projects company 
data. So, this field will be filled in for you on a per-project basis if 
you do not override it here. 

 Keywords 
 
Keywords can be any keywords relevant to your company or 
proposals you want embedded in the document to assist in 
searching for documents in the future. If you do not enter 
anything in this screen it will default to a generic Proposal Pack 
keyword. 
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 Title 
 
Title is typically the title of this document. If you do not enter 
anything in this screen it will default to the title used in each 
projects data. So, this field will be filled in for you on a per-
project basis if you do not override it here. 

 Comments  
 
Comments can be any general comments you want included in 
all your documents. If you do not enter anything in this screen it 
will default to a generic Created by Proposal Pack Wizard 
comment.  
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HOW DO I CHANGE THE URL IN THE 
PROPOSAL FOOTERS? 
 
By default, the <<Domain>> tag is used in the footers of all the 
stock Proposal Pack templates. When the Proposal Pack Wizard 
assembles your proposal, this tag is replaced with your URL. 
 
You can configure the Wizard to use alternate text in the page 
footer. 
 
First, go to the main Wizard screen and click the “Preferences” 
button. Then click the “Project Settings Tab”. Type in your 
alternate text into the “Alternate Footer Text” field then click the 
OK button to save the settings. 
 
Your alternate text can be your company name or other contact 
information for example. 
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HOW DO I TRANSLATE INTO FOREIGN 
LANGUAGES? 
 
Proposal Pack Wizard includes translation support features that 
assist in creating your proposals and documents in foreign 
languages. 
 
The following languages are currently supported: 
 

 Canadian English 

 British (UK) English 

 Australian English 

 Spanish 

 Portuguese 

 Dutch 

 Italian 

 French 

 German 

 Romanian 

 Russian 

 Chinese 

 Korean 

 Japanese 

 Arabic 

 
The translation features do not translate the entire body of text of 
the documents. Only page headers, table of contents and a variety 
of short phrases with the documents are translated. The body text 
of the templates is primarily fill-in-the-blank instructional text and 
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example text that you will replace with your own language when 
you are editing the assembled document. 
The Wizard is only replacing strings using search and replace and 
performing double-byte Unicode encoding and decoding of 
strings. This is all natively supported by Word and should work for 
any Unicode languages. The Wizard does not manage display 
issues. It is your responsibility to ensure you are using font types 
that can support proper display of translated text. All the currently 
supported languages should work with the default settings and 
font types. The Proposal Kit does not include any extra fonts or 
system files for supporting foreign languages. It makes use of the 
existing fonts and system settings that you have configured on 
your Windows operating system and Word/Office software. Your 
final document look in a foreign language may depend on how 
your system is configured and you may need to further customize 
and reformat the document. 
 
INCLUDED TRANSLATED SAMPLES 
 
The Proposal Pack template collections also include a completed 
sample of one of our proposals that has been translated into a 
variety of languages. These samples were created by a 
combination of these Wizard translation features and human 
translation of the body text. Reference the translated samples to 
see the results of how the same Proposal Pack and Wizard can be 
used to create documents in many languages. 
 
HOW TO START TRANSLATING YOUR DOCUMENTS 
 
To turn on translation during your document assembly process all 
you must do is select the translation language in your document 
project screen (the screen you see when you add a new document 
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project or edit an existing project). Change the default American 
English to another language in the project screen. When the 
Wizard assembles your document, it will perform the translation on 
the appropriate terms and short phrases. 
 
WHAT HAPPENS WITH GRAPHIC PAGE HEADERS? 
 
The Wizard can only operate on actual text, just as Word can only 
operate on actual text. Neither Word nor the Wizard can edit 
graphics. 
 
Because of this the plain text versions of Proposal Pack (i.e. 
Proposal Pack for Any Business and Proposal Pack for 
Government Grants) are the recommend Proposal Packs to use for 
foreign language translations since they are the most 
customizable. 
 
All the other Proposal Packs (i.e. the Proposal Graphics Packs) use 
custom graphics for the page headers and the Title Page 
“Proposal” and “Description”. These graphics visually look like 
text, but they are imported graphics. 
 
The Wizard’s translation feature will delete these graphics and 
replace them with actual text, and that actual text will be translated 
into the foreign language. 
 
What you will be missing after the translation is complete is the 
custom logo graphics that were part of the page headers and the 
Title Page words that went with the “Proposal” and “Description” 
graphics. Also, the translated text will be in the default Word Style 
defined in the Wizard which will be a black font using a common 
font type such as Arial or Arial Black. 
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Since the custom graphic headers in American English use font 
types that do not support many foreign language character sets 
you may not be able to replicate the custom “look” of the graphic 
header exactly as you may have to use different font types that 
support your foreign language character set. You can still match 
the original colors by editing the Word Style settings. 
 
To replace the look of the logo from the graphics versions of the 
Proposal Pack is possible with a little extra manual work. Each 
Proposal Pack includes a version of the page header logo that 
does not have any text. You can manually position this logo in your 
page headers by inserting into your document and setting the 
graphic positioning to be “Behind Text” and then drag it to the 
correct position in your page headers. 
 
Another option is that Proposal Kit does have a custom design 
service where we can create custom versions of our Proposal 
Graphics Packs (for a fee). We can create custom versions of our 
Proposal Packs in foreign languages. See this page for details: 
https://www.proposalkit.com/htm/service.htm 
 
AFTER THE TRANSLATIONS ARE COMPLETE 
 
Since foreign language translations may cause phrases to become 
longer than the original American English phrase you may have to 
modify the font of the page headers. For example, German 
phrases tend to be longer and may cause page headers to 
overflow onto a 2nd line. 
 
You can easily modify the font settings consistently across all 
pages by changing the Word Style settings. Since all text in 

https://www.proposalkit.com/htm/service.htm
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Proposal Pack documents uses Word Styles click the Modify 
button on the Word style such as “Proposal Kit Page Header” and 
change the font size. You can also modify other font settings such 
as colors and font types to further customize your document. 
 
Due to sizing differences in logos and text fonts you may also 
need to reposition page header logos and translated text on the 
document pages to improve the look of the layout. This is all basic 
word processing using Word to move the objects. 
 
You can have the Wizard always apply the desired font Style 
settings by editing the Word Style settings in the Wizard 
Preferences > Data & Display > Font Styles screen. See this 
chapter for details: How do I use the MyProjectFiles folder? 
 
The Wizard allows you to copy your own custom files that are not 
part of the Proposal Kit system into each of your new projects 
using the MyProjectFiles folder. 
 
This feature allows you to automatically copy your own content 
such as worksheets, checklists, letters, spreadsheets, forms, etc. 
into each of your new Proposal Pack Wizard project folders. 
 
The MyProjectFiles folder is in the root install folder where the 
Proposal Pack Wizard is installed. This folder by default is: 
 
C:\ProposalKit\ProposalPack\MyProjectFiles 
 
Whenever you build a new document in the Wizard a copy of all 
the files in the MyProjectFiles folder will be made into your 
document’s project folder. 
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You should not name any of your custom files the same file names 
and extensions as any of Proposal Kit’s document file names. 
 
Use the Preferences > Project Settings > Configure MyProjectFiles 
Settings screen to manage adding files, removing files, and setting 
attributes for the custom files in the Wizard database. 
 
You can manually copy files into the MyProjectFiles folder however 
that will not setup any of the attributes such as human readable 
titles for use in the Wizard drop down menus. Use the Wizard’s 
Preferences tool for managing the attributes.  
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How do I Change/Use Word Font Styles? 
 
CONFIGURING TRANSLATION SETTINGS 
 
The translation features can be configured in the Preferences > 
Translations screen. 
 
You can completely disable the translation features which can help 
speed up the build process as well as hide the translation drop 
down from the project screen. This is useful for administrators who 
want to configure the Wizard and remove certain features from use 
by end users. 
 
You can change the default language that will always be applied 
to each new project. The default is American English. 
 
Some languages have different phrases for use when a masculine 
or feminine wording is needed. For example, Spanish has different 
phrases for the “Prepared By” and “Prepared For” text in the Title 
Page. The Wizard will let you pick what the default usage will be 
for each new project (which you can always change for each new 
project). 
 
Arabic is typically formatted to read right-to-left. The Wizard will 
reformat some sections as it is translating text to be left justified 
and set to a Left to Right reading order. One example is the Table 
of Contents page. 
 
When page headers need to be translated in a Proposal Pack that 
uses graphics, the graphic headers must be deleted and replaced 
with text. The Wizard can be configured how it handles dealing 
with the graphic page headers. 
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The Title Page uses text objects for holding the “Proposal” and 
“Description” text. Since translations of these terms can result in 
larger text blocks the Wizard allows you to configure the size of 
these text blocks. Increase the sizes here if the translated Title 
Page terms for these 2 phrases need to be larger. You can 
manually drag the object corners to enlarge the text objects after a 
document has been assembled. 
 
THE DATA ENTRY FIELDS 
 
The Wizard interface has also been updated to display foreign 
language characters (in Unicode) in the data entry fields. This way 
you can enter data for your project such as names and addresses 
in any language.  
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Not every screen or database file is designed for working with 
Unicode data. Only the screens that would contain data that would 
make its way into your document are designed for use with 
Unicode data. Such screens are the project data entry screens for 
name and address contact data. 
 
RIGHT-TO-LEFT LANGUAGES 
 
Languages such as Arabic are typically formatted to read right to 
left. The Wizard will reformat some parts of the document as it is 
translating to Right-to-Left. One example is when the Table of 
Contents is being created. For Arabic it will be created right 
justified in R-to-L paragraph formatting. You will have to manually 
reformat the rest of the document as you are filling in the 
templates as needed. 
 
TRANSLATIONS SUPPORTED IN OTHER WIZARD 
FEATURES 
 
The foreign language translations have also been supported in 
other Wizard features dealing with importing and exporting data.  
 
When you export project tracking data to an external spreadsheet 
the data will be exported in Unicode format so foreign language 
text will display properly in the spreadsheet. 
 
The Presets in the Document Project screen support saving which 
language translation was used in the project. This way you can 
predefine presets for different language translations. 
 
CUSTOMIZING THE TRANSLATIONS 
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All the translations are stored in the Wizard database folder in a 
series of Translations#.ini files. Each language is stored in its own 
file. You must keep the American English versions of the phrases 
as-is, otherwise the Wizard will not locate the matching American 
English phases in the documents while it is processing them. 
 
You can modify the foreign language text if you want to alter the 
translations. Make sure when you save the file that the file is 
encoded in the “UTF-8-No-BOM” encoding. Any translations 
stored in UTF-8 format will already have this encoding set in the 
text file. 
 
You can also extend the translations by adding your own items to 
the database lists. 
You can add your own custom language translation as well by 
creating a new Translation#.ini file (change # to the next 
sequential number available) and add an entry for it into the 
Translations.ini file. 
 
DATABASE ENCODING 
 
All the Wizard database files must be encoded with “UTF-8-No-
BOM” encoding. If you manually edit any of the Wizard’s INI 
database files with foreign language text you must ensure that this 
is the encoding used otherwise the foreign language text may not 
be readable. If you do see non-displayable or incorrect characters 
displayed in the interface or documents make sure the appropriate 
Translations#.ini file and PackDst.ini file is properly encoded. 
 
CURRENCY TRANSLATION 
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The Wizard can also translate the United States Dollar ($) symbols 
used in the templates to international currency codes or Unicode 
symbols. 
 
See this chapter for more details: How do I Translate Currency 
Symbols?  
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HOW DO I TRANSLATE CURRENCY 
SYMBOLS? 
 
The Expert Edition of the Wizard can translate currency symbols to 
make conversion of the templates to international use easier. 
 
The system defaults to leaving the United States Dollar ($) 
currency symbols in any templates and spreadsheets that use 
them (such as many of the financial templates and calculators). 
 
When you create a project, you can set the currency symbol to any 
number of international symbols or 3 character currency codes by 
selecting the currency symbol drop down. 
 
When a different currency symbol than the default United States 
Dollar is selected the Wizard will search and replace any $ 
symbols in the Word templates being assembled and will replace 
them with the selected symbol. 
 
Using the Wizard Preferences, you can also set the default 
currency symbol to be used for every new project as well as 
changing the replacement from using symbols to using 3 character 
codes. 
 
For example, you can choose between replacing the ($) symbol in 
the templates with the United Kingdom Pound symbol (£) or the 
code (GBP), the Euro symbol (€), etc. 
 
All the currency codes are also configurable if you need to change 
the list of codes or symbols. Open the Translations.ini database file 
and edit the list of currency values as needed. 
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Since the symbols are all standard Unicode characters the symbol 
translation should always work with the default fonts. If a currency 
symbol does not display correctly make sure the font type you 
have selected for your text supports that symbol. 
 
The currency codes settings are also supported in the Presets and 
Import Lists features. 
 
This feature replaces any instances of the $ character found in the 
text as the templates are being assembled. It does not perform any 
financial calculations or currency conversions on any numbers. 
 
If you are using the Expert Edition the Wizard will change the 
currency symbol and format of any currency cells in Excel 
Spreadsheets for the project being created. If Dynamic Excel 
Spreadsheet linking is being used this will allow your documents 
to display alternate currencies from the linked cells. 
 
You will have to have the proper font types installed to see foreign 
language currency symbols. If you see a question mark (?) 
character in place of a currency symbol it is due to not having 
compatible font types installed in your Windows OS or due to a 
limitation of Words OLE linking not supporting some currency 
symbols. One fix is to turn on the 3 character codes instead of 
using the currency symbols (i.e. BTC instead of ₿ ). 
 
Due to the many variations of Microsoft Word, Windows, language 
packs, foreign language editions, typefaces, etc. not all symbols 
may display properly on all systems without some customization. 
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A quick fix for symbols that do not display are to switch to using 3 
character currency symbols in the Wizard’s Preferences. 
 
If you have manually edited the stock spreadsheets to change the 
currency formats you should turn off the conversion of currency 
symbols for Excel spreadsheets in the Preferences. 
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HOW DOES THE WIZARD USE THE 
WINDOWS REGISTRY? 
 
The Wizard stores some information in the Windows registry in the 
following key: 
 
HKEY_CURRENT_USER\Software\ProposalPackWizV# 

 
Note that the # in the key is replaced with the major version 
number of the Wizard you have installed. 
 
This key is created by the Wizard installer program and must be 
accessible to any user who is running the Wizard. The Wizard is 
also able to build the registry key itself if it is missing. 
 
If you experience any errors reading or writing to the registry such 
as profile string read or write error messages this is most likely due 
to not getting your user permissions configured correctly.  
 
If you installed the Wizard under one user login then try to run the 
Wizard from a different user login that does not have read/write 
access to this registry key can cause this type of problem. 
 
If this happens you can run the Windows regedit program, find that 
key in the registry then grant the other user the appropriate access 
rights to that key. The access rights can be found by right clicking 
your mouse on the registry key in the regedit program. 
 
Consult your Windows help for how to use the regedit program 
and how user access rights are managed. 
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WHAT ADMINISTRATOR FEATURES ARE IN 
THE WIZARD? 
 
The Wizard has several settings meant for administrators or 
consultants setting up the Wizard for sales or office staff. Enter the 
Preferences screen to access all the Wizard configuration settings.  
 
There are also a wide variety of customizations possible that are 
not available via the Preferences screens and tools. It is possible 
to further customize the Wizard by manually editing the various 
database files. Database files are in INI format text files. Consulting 
services are available to assist in specialized customizations of the 
Wizard: How do I get Help Configuring the Wizard? 
 
There are 3 administrator features for setting default settings and 
then locking the other users out of altering those settings. 
 
The first major setting is Expert vs. Novice Mode. In Novice Mode 
the more advanced configuration settings are disabled to prevent 
accidental changes or confusion over which features to use. As an 
administrator you can temporarily enable Expert Mode, configure 
the Wizard with the settings your staff are supposed to always use 
then enable Novice Mode again to lock in the settings. 
 
In the Project Settings tab there is a checkbox to turn off the ability 
of the user to alter the default project settings for each new 
proposal. An administrator can set the default project settings then 
lock those settings by checking the “Do not allow editing…” 
checkbox. 
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In the General Settings tab the Enable Team Editing is disabled by 
default, if your users will have multiple people editing the same 
proposal, turn on the Enable Team Editing checkbox, and read the 
chapter How do I do Project Tracking and Reporting? 
 
https://www.proposalkit.com/htm/videos-how-to-use-tracking-
reporting.htm 
 
The Project Status tracking feature allows you to further manage 
your document projects by updating the status through the various 
stages of the process. 
 
The default status for each new project is "Work in Progress" and 
is set to the date that the project was added to the system.  The 
fields in this form are only used for your convenience to help keep 
track of your projects.  The data is not used anywhere else. 
 
For example, when you have finished writing your document and 
have submitted it, set the project status to "Submitted" and update 
the date field.  Later if the proposal is accepted update the status 
to "Accepted" and update the date field.  Each of these status 
dates is individually stored in the project database. 
 
Moving completed projects to different statuses will also reduce 
the clutter of having many open projects to pick from in your work 
in progress projects. 
 
If you have only selected one project, then all its fields will be filled 
in the project status form. If you have selected multiple projects 
then all fields on the form will be blank unless the data is the same 
in every selected project, in which case it will be displayed on the 
form. Only fields you change on the form will be updated back to 
the selected project(s). If you change a field on this form and you 
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have selected more than one project, then that field will be 
updated into every selected project.  
 
The status fields are set in the Project Status screen which is a 
button on the Manage Projects screen. 
 
To generate a report in an Excel compatible XML file you can 
select one or more records from the Manage Project screen and 
click the Output to Report button. 
 
This will generate a report of your selected projects and all 
tracking status dates for those projects. 
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How do Multiple People Edit the Same Document? 
 
Use the rest of the Preferences screens to configure all aspects of 
the Wizard such as the default settings to use for new proposals, 
how the Auto Recommend screen selects templates for different 
types and sizes of proposals, custom graphic logos to be 
embedded in your proposals Title Pages, mail merge tags and 
labels, date formats, Table of Contents headers, changing the 
ordering of templates in the proposals and Table of Contents, 
removing templates, adding your own custom templates, etc. 
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HOW DO I DISABLE ACCESS TO 
FEATURES AS AN ADMIN? 
 
If you are customizing the Wizard to be used in a more controlled 
environment, such as setting up a team of salespeople or other 
end users and you do not want them changing the Wizard 
preferences or other configuration settings. These features will 
only be disabled in the Expert edition of the Wizard. 
 
You can completely disable the user’s ability to access those major 
configuration and Preferences screens by setting the following 
flags in the Wizard’s Options.ini database file. This must be done 
manually as once you disable access to the Wizard preferences; 
you will not be able to use the Wizard configuration screens to 
change that access. These flags are special flags that cannot be 
changed via the Wizard Preferences screens. You must manually 
edit the Options.ini file. These flags are found in the [SETTINGS] 
section: 
 
DisableStyles=1 

 
When you disable the Styles the “Document Styles” button on the 
Wizard home screen will be disabled and the user will not be able 
to change the Proposal Pack style or edit the preferences for the 
selected style. If you only have 1 Proposal Pack style enabled, you 
can use this flag to prevent users from entering that screen. If you 
have multiple Proposal Pack styles but you want to completely 
disable access to the Preferences screen and restrict access to the 
“Edit Style” configuration screen you can leave the Styles enabled 
but disable the Preferences (below). 
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DisablePreferences=1 

 
When you disable the Preferences the “Preferences” button on the 
Wizard home screen will be disabled. Also, any other Wizard 
configuration screens such as editing mail merge tag labels in the 
Project screen and the various “Edit Style” and “Delete Style” 
buttons will be disabled in the Document Styles screen. This 
setting will also turn off the links in the Document Styles screen for 
purchasing additional styles from our web site. 
 
DisableUpdates=1 

 
When you disable the updates, this only disables the “Check for 
Updates” button on the Wizard home screen to prevent your end 
users from checking for new Wizard release on our web site. 
 
DisableProducts=1 

 
This option will cause the lists of add-on Proposal Kit products to 
not be displayed in the Document Styles screens and in the Pick 
Documents tabs for Add a Contract and Title Pages. Also, the 
product comments and links to the product pages will be turned 
off on the Pick Documents tabs. 
 
DisableAutoBuild=1 

 
This option will cause the Yes/No popup question that asks if you 
want to start the build process immediately upon saving your 
proposal to be disabled. The Wizard will return to how past 
versions operated by the user having to manually click the Build 
button and then the Edit button. 
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DisableHelp=1 

 
This option will cause the 3 help related buttons on the Wizard 
home screen to be hidden. These are the “Help”, “View Manual” 
and “Read How-To Articles” buttons. 
 
 
Another administrator setting that can be used to restrict access to 
certain features is in the Preferences > Project Settings > Configure 
Project Screen settings. 
 
The “Do not allow editing of the default document project settings 
by the user when creating a new document project” can be 
checked. When checked this will lock the various drop down lists 
and checkboxes on the Project screen. The user will not be able to 
change them, and you can force them to use specific preset 
defaults you have setup. 
 
You can also remove specific screens from being displayed in the 
Pick Documents screen using the Preferences > Project Settings > 
Configure Document Selection Screen settings. Using this screen, 
you can turn on/off the display of specific screens when the user is 
in the Pick Documents screen. 
 
This gives an administrator the ability to create a very customized 
Wizard to suit their specific business needs, then lock down the 
changes and prevent end users from changing them by using the 
registry flags above.  
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WHAT ARE THE 12 PROPOSAL/PROJECT 
TYPES? 
 
The Wizard supports 12 different types of projects (also referred to 
as proposal types, even though not all projects are for proposals, 
you can also create business documents, contracts, etc., with the 
Wizard). Each type of proposal is for a different purpose and may 
have a different organization and selection of documents than 
another proposal type. In the past Proposal Packs and Proposal 
Pack Wizard were only used for writing proposals, over the years it 
has been expanded to cover other situations such as contracts, 
reports, studies, plans and other complex business reports. While 
there are many references to “Proposals” and “Proposal Types” 
there are also references to “Projects” and “Project Types”. These 
terms in this context (i.e. the Wizard interface and documentation) 
all mean the same thing. 
 

 1 - General Business Proposals. 

 2 - Grant Proposals. 

 3 - Book Publishing Proposals. 

 4 - Business Plan Proposals. 

 5 - Resume Proposals. 

 6 - Contracts. 

 7 - Short Form Quotes. 

 8 - Government Contracts. 

 9 - Business Documents. 

 10 - Research Proposals. 

 11 - RFPs. 

 12 - Custom Proposals (for you to customize for your unique situation). 
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For example, grant proposals and business plan proposals 
typically include more financial related templates than a general 
business proposal. A short form contract or quote will have very 
few templates compared to a general business proposal. Business 
documents include studies, plans, reports, etc. 
 
Most of the Proposal Pack templates are applicable to any 
proposal type such as the Title Page, Executive Summary, Cost 
Summary, etc. 
 
Some of the Proposal Pack templates are very specific to a 
proposal type such as the Cover Sheet meant for grant proposals 
and the Author’s Bio meant for book publishing proposals. 
 
When you are creating a new proposal select the proposal type 
which best matches the type of proposal you are writing. The 
Wizard will then order the templates and show you specific 
templates for that type of proposal. 
 
While you can customize any of the 12 project types, there are 2 
custom types specially set aside for you to configure for your own 
unique situation, these are the 2 custom types at the end of the 
list. It is much easier to start with the custom projects types and 
add just the templates you want vs. starting with say the General 
Business Proposal type and must remove a very large set of 
templates. 
 
The Proposal Pack Wizard has default orderings and selections 
already setup for you. You can edit the order of templates and 
which ones are shown for any of the 12 proposal types by using 
the Preferences screens. 
 



680 

Project Types are nothing more than 12 different ways of showing 
you the same collection of underlying documents. For example, 
when you see Executive Summary in both the General Business 
Proposals type and the Business Plan Proposal type, they are both 
referring to the exact same ExecSummary.docx template. 
 
One of the purposes of the 12 Project Types is that it tailors the full 
collection of templates you see for a more specialized situation. 
For example, there are multiple cover letter templates. The 
General Business Proposal type will show you the general Cover 
Letter; the Government Grant Proposal type will show you the 
Cover Sheet instead of the more generic Cover Letter. The 
Business Plan Proposal type will show you the Cover Letter 
(Business Plan) instead of the more generic Cover Letter, and so 
on. 
 
The Custom type is set aside for you to customize as much as you 
want to create your own personalized organization of the 
underlying collection of available templates.  
 
A hundred different people using Proposal Packs and the Wizard 
will have a hundred different ideas on what templates are most 
important to their specific situation. The Wizard is designed to 
show you everything available in 10 different general types of 
situations (General Business, Grants, Business Plans, Resumes, 
etc.) then allow you to optimize and tailor your own lists that are 
specific to you.  
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WHAT IS MAIL MERGE AND TAGS? 
 
https://www.proposalkit.com/htm/videos-how-to-use-data-merge-
tags.htm 
 
The Proposal Pack documents are plain text documents with 
common information in plain text tags (i.e. <<FirstName>>, 
<<Company>>, etc.).  
 
This means that there are tags in the documents such as 
<<FirstName>>, which are replaced with your own personalized 
information.  
 
Only tags enclosed in <<>> brackets are intended to be replaced 
with data. Some contracts and agreements include text such as 
“Company”, which is not a mail merge tag and is intended to be 
left as-is. 
 
Automating the process using the mail merge feature will help 
keep common information consistent across multiple documents. 
Every word processor has a proprietary mail merge system which 
may or may not be compatible with other systems. Proposal Pack 
templates use plain text tags which will be viewable and editable 
in any word processor. You can convert our tags to proprietary 
tags yourself and tie them to a database, your email address book, 
contact manager, etc. Consult your word processor help for setting 
up a database for mail merge.  
 
The number of tags in our documents is minimal, so manually 
replacing them is quick and easy. Just search the document for 
any occurrence of “<<” to find the tags and replace them. You can 

https://www.proposalkit.com/htm/videos-how-to-use-data-merge-tags.htm
https://www.proposalkit.com/htm/videos-how-to-use-data-merge-tags.htm
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either replace the tags by applying a merge data file or manually 
type over them. There is no need to learn complex software. If you 
use our add-on Proposal Pack Wizard software the wizard will 
automatically update all your documents in a single operation. 
 
There are two types of tags in the Proposal Pack documents. 

 Data Tags 
 
These are common tags for contact information. 
 
For example, <<Domain>>, <<FirstName>>, <<Company>>. 

 Standard Text Tags 
 
These are easily replaced by manually over-typing. Using the 
example of, <<Insert company history here>>, this type of tag 
will be replaced with details about your company. This can be 
done as easily as cutting and pasting it from other existing 
collateral material. Such tags are generally meant to be free 
form text specific to your situation (company, client, project, 
contract, etc.). 

 Dynamic Spreadsheet Linking Tags 
 
Any tags in the format <<R#C#[S#]>> are used by the dynamic 
spreadsheet linking features and are replaced by the Wizard 
with OLE links to spreadsheet cells. These types of tags are 
typically found in templates with financial or scheduling 
calculations. See this chapter for more details: How do I Add 
Dynamically Linked Spreadsheet Calculations? 
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The following is a list of the actual mail merge tags used in 
Proposal Packs and Proposal Kit documents: 
 
YOUR COMPANY’S TAGS 
 

 <<Salutation>>  Your title (Mr., Mrs.) 

 <<FirstName>>  Your first name 

 <<LastName>>  Your last name 

 <<JobTitle>>  Your job title (President, Project Manager) 

 <<Company>>  Your company name 

 <<Address1>>  Your address 

 <<Address2>>  Your address 

 <<Address3>>  Your address 

 <<City>>   Your city 

 <<State>>   Your state 

 <<PostalCode>>  Your zip or postal code 

 <<Country>>  Your country 

 <<County>>  Your county 

 <<Fax>>   Your fax number 

 <<WorkPhone>>  Your work phone 

 <<MobilePhone>> Your mobile phone  

 <<Email>>   Your e-mail address 

 <<Domain>>  Your website URL 

 <<SocialMedia1>> A social media link (Facebook, LinkedIn, etc.) 

 <<SocialMedia2>> A social media link (Facebook, LinkedIn, etc.) 

 … 

 <<SocialMedia10>> A social media link (Facebook, LinkedIn, etc.) 
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YOUR CUSTOMER’S TAGS 
 

 <<CustTitle>>  Customer job title (President, Project Manager) 

 <<CustFirst>>  Customer first name 

 <<CustLastName>> Customer last name 

 <<CustDomain>>  Customer domain (new or existing URL) 

 <<CustCompany>> Customer company name 

 <<CustAddress1>> Customer address 

 <<CustAddress2>> Customer address 

 <<CustAddress3>> Customer address 

 <<CustCity>>  Customer city 

 <<CustState>>  Customer state 

 <<CustPostalCode>> Customer zip or postal code 

 <<CustCountry>>  Customer country 

 <<CustCounty>>  Customer county 

 <<CustFax>>  Customer fax 

 <<CustWorkPhone>> Customer phone 

 <<CustMobilePhone>> Customer mobile phone 

 <<CustEmail>>  Customer e-mail 

 <<CustSalutation>> Customer title (Mr., Mrs.) 

 <<ProposalNumber>> The unique identifier for each proposal you send 

 <<ProposalTitle>> The title of this proposal 

 <<CurrentDate>>  Date the proposal was created 

 
 CONTRACT RELATED TAGS 
 

 <<HourlyRate>>  Your hourly service billing rate  

 <<FixedRate>>  Your fixed billing rate 

 <<HostCompany>> Company hosting client’s website  

 <<HostSetupFee>> Setup fee for website host account  

 <<HostMonthlyFee>> Monthly ISP charges 
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 <<DomainRegFee>> Domain registration fee 

 <<RegisteredWith>> Company URL registered with  

 <<YearlyDomainFee>> Yearly fee for domain name  

 <<Reference>>  Unique contract reference number 

 <<WorkOrder>>  Contract or work order unique identifier code 

 <<StartDate>>  Contract start date 

 <<EndDate>>  Contract end date 

 <<CurrentYear>>  Current year 

 <<CurrentDay>>  Current day 

 <<CurrentMonth>> Current month 

 <<DeliveryDate>> Date contract is to be delivered by 

 <<ContractCompany>> Company name on the contract document 

 <<ContractFirstName>> First name of person on the contract document 

 <<ContractLastName>> Last name of person on the contract document 

 <<ContractJobTitle>> Job title of person on the contract document 

 <<InsuranceCoverageAmount>> Amount of insurance coverage required 

 <<Credits>>  Photographers or authors credits 

 <<SSN>>   Social Security Number 

 <<Approver>>  Person authorized to make approvals 

 <<Supervisor>>  Employee or contractor supervisor name 

 <<Department>>  Employee or contractor company department 

 <<Month>>  A month  

 <<Amount>>  A dollar amount 

 <<HREmail>>  Email address of the Human Resources department 

 <<HRPhone>>  Phone number of the Human Resources department 

 <<HRContactName>> Persons contact name in the HR department 

 <<TimeZone>>  Time zone that the contract applies to 

 <<Date>>   A date as applies in the context of the used clause 

 <<Minutes>>   A time in minutes  

 <<Hours>>   A time in hours  

 <<Days>>    A time in days  
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 <<Months>>   A time in months 

 <<Years>>   A time in years  

 <<Weeks>>   A time in weeks  

 <<EffectiveDate>> Effective date that an agreement is entered into 

 
CUSTOM DEFINED TAGS 
 

 <<Custom1>>  Reserved for any use 

 <<Custom2>>  Reserved for any use 

 <<Custom3>>  Reserved for any use 

 <<Custom4>>  Reserved for any use 

 <<Custom5>>  Reserved for any use 

 … 

 <<Custom50>>  Reserved for any use 

 
You can alter the labels and tags for the custom fields from the 
Project screen. For example, you can change the default 
<<Custom1>> to <<work order #>>. Then, type the text <<work 
order #>> into the document. Then, in your Project data enter a 
number (12345 for example) in the data field for your custom 
merge information. When you run the configuration operation, your 
data (12345) will replace the merge tag (<<work order #>>). 
 
While you can reconfigure all the mail merge tags there are some 
that are required for certain features to work properly. The 
<<CustFirst>>, <<CustLastName>>, <<CustCompany>>, 
<<FirstName>>, <<LastName>>, <<Company>> are required for the 
Client and Company CRM database feature. If any of these tags 
are renamed that feature will be disabled. 
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Tags used for email addresses and web site domains such as 
<<Domain>>, <<Email>>, <<CustDomain>>, <<CustEmail>> will be 
converted to clickable hyperlinks when the data is merged if the 
data appears to be a URL or email format. The Wizard will apply 
the Proposal Kit URL Style to the inserted hyperlink. If the data for 
a URL does not include a preceding http: or https: then the Wizard 
will add https:// to the beginning of the clickable URL but will 
display the original data in the text. If your domains do not use 
https:// you can change the Wizard’s default prefix in the 
Preferences. 
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WHY DIDN’T MY MAIL MERGE UPDATES 
WORK? 
 
The symptom 
 
You created a proposal the first time. Then you decided to change 
the mail merge data and ran the generation option a second time, 
but your mail merge data changes did not show up in the proposal. 
 
The reason 
 
This is a safety feature built into the Wizard to prevent people from 
losing their edits when they create a proposal, edit a template, 
then recreate the proposal again. The Wizard will only overwrite 
your proposal and templates if the files do not exist.  
 
This allows you to add new templates to an existing proposal 
without losing any previous edits to your work. 
 
The one unavoidable issue that this can create is if you change the 
mail merge data and recreate the proposal. Since the templates 
have already been created once for your proposal they will not be 
overwritten, hence the data changes will not be applied. 
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The solution 
 
If you have not started editing the templates after creating the 
project documents, you can go back to your Document Project and 
click the Edit Current Project button. Click the button to “Delete 
Old Files” and all the templates for this project will be deleted. 
Then save the project and build the documents again. Your 
document will be recreated, and all your changed mail merge data 
will be applied. 
 
The Wizard was not intended to be used much after you have 
started editing your proposal. The Wizard is used to help you 
setup the proposal and create the documents. After that you use 
Word to edit and complete the proposal. 
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WHERE ARE THE FILES ON MY HARD 
DRIVE? 
 
The Proposal Pack Wizard makes use of many files installed on 
your hard drive (or a network drive). 
 
By default (if you did not change any of the default install options) 
when you installed your products all will be in this root folder on 
your hard drive: 
 
c:\ProposalKit 

 
Since the Wizard can be configured to store files in many locations 
outside of this (or alternately to this) folder there is a Wizard tool 
for helping you locate all the files. 
 
From the main Wizard screen click the “Preferences” button. Then 
click the “Tools” tab and then click the “File Location Report” 
button. 
 
A report will be created which will show you the locations of all the 
folders the various files used by the Wizard are located, including: 
 

 The locations of each of your created projects. 

 The locations of the stock templates for each Proposal Pack style 

 The locations of any detected Contract Pack documents 

 The locations of the Wizard database files 

 The Windows registry key used by the Wizard. 
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ADJUSTING PAGE BORDERS IF NOT 
PRINTING 
 
Some Proposal Pack styles have a colored page border included 
in the style. The page borders are completely optional to use 
depending on the look and feel you want to create for your own 
company. For example, the "Entertainment #1" style has a thin red 
border around every template page while the "Classic #1" style has 
no border. 
 
On some computers, your printer may not be able to print the 
lower part of the page border due to the unprintable border area 
defined by individual printer drivers. All page border issues are 
related to Word and your printer driver. See your Word help 
manual and your printer driver for details on the unprintable border 
area of your printer. 
 
To edit page borders in Word 
 

 Click the "Format" menu option 

 Click the "Borders and Shading" menu option 

 Click the "Page Border" tab in the dialog box 

 
There are a few options to alter the templates to change the page 
borders. Depending on your printer, the style of page border, 
accent graphic sizes, etc. you may need to try several adjustments. 
The easiest option is to turn off the page borders as it will not 
detract from your proposal. 
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Other options would be to 
 

 Remove the page borders by clicking the "None" option in the dialog box. 

 Remove the bottom page border, or both the top and bottom borders (only 
keeping the side borders). 

 Click the "Options" button and change the "Measure From" setting to measure 
from the text instead of the edge of the page. Also turn off the option to 
"Surround Footer". This may require manually adjusting the positioning of the 
page footer graphic. Use the "View > Header and Footer" option in Word to 
make changes to the document footer.  

 Remove the document footer accent graphic and text (it may pull the border 
up into the printable area) 
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ADJUSTING PAGE FOOTERS IF NOT 
PRINTING 
 
Most Proposal Pack templates have a footer which includes an 
accent graphic and your company URL. These are designed to be 
changed if you so desire. There is no rule that this information 
must be in the footer. For example, you can remove the footer, 
change the accent graphic to your own company logo, change the 
URL to your company name or remove it. 
 
Various combinations of accent graphics, URLs and fonts as well 
as the addition of a page border (see previous page) can cause 
parts of the footer to not be printed. This is dependent on the 
printer driver as the printer driver on your computer defines the 
non-printable border. 
 
After you have finished adjusting the footers to suit your needs 
check to see if the footers fall in the printable area. If any part of 
the footer is cut off, you can try readjusting the footer. 
 
In Word, select the “Page Setup” option. Click the “Layout” tab. 
Then change the “From Footer” setting. For example, if it is set to 
.25 inches from the edge, try setting it to .3, .4, .5 or .6 inches. 
 
You can also try adjusting the settings in the “Format > Borders 
and Shading > Page Border” Word dialog box options. 
 
These settings can also be set for each style in the Proposal Pack 
Wizard style settings to be applied to each proposal automatically. 
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CHANGING THE PAPER SIZE 
 
You can have the Wizard change the paper size as it is copying 
and combining your documents. The available paper sizes are: 
Letter, Legal, Executive, A4, B5, Letter (landscape) and A4 
(landscape). In the Style settings click the page setup tab then 
select the paper size. Each Proposal Pack style can have a 
different paper size setting. This performs the same operation as 
manually selecting the paper size from the Word > Page Setup 
screen. 
 
The Proposal Pack templates are designed using the Letter format 
(8.5 x 11). If you change the paper size, you may have to manually 
cleanup some formatting. Due to the margins being resized some 
header graphics may not fit depending on the Proposal Pack style. 
Some Proposal Pack styles also include page borders which may 
fall outside of the printable area of the page. In these cases, you 
may have to experiment with border settings, turn off borders or 
edit the graphic headers to resize them. 
 
The Wizard uses points by default in all its calculations and page 
settings to avoid use of floating point numbers (1 inch = 72 points, 
so a page width of 8.5 inches is defined as 612 points). 
 
The Wizard will automatically resize the Title Page background 
graphic and reposition the body watermark background graphics 
based on the page size as best possible. You may still have to 
reposition some objects in the document manually when using 
different page sizes.  
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COMBINING TEMPLATES INTO A MASTER 
DOCUMENT 
 
Automating Combining files using the Wizard 
 

 By default, the Proposal Pack Wizard will combine all your 
selected files into a single master proposal document 
(FullProposal.docx). You may use the individually copied and 
merged documents or the combined document once the 
configuration process is complete. If you need to manually 
insert additional documents, see the instructions below. 

 To change the order of templates, see this chapter for details: 
How do I Change the Order of Documents? 

 
Manually Combining files in Word by Inserting from File 
 

 Position your cursor where you want to insert the new file. 

 Click Insert > Break > Page Break > OK 

 Click Insert > File, then browse to the Word folder containing all 
the Proposal Pack templates, select your file to insert, click 
“Insert” 

 Note that Word may change the formatting of parts of the 
document 

 Edit final document manually 
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 Set the page numbers and update the Table of Contents (if 
being used) This method is not recommended for large 
proposals as it can cause a lot of manual editing of the final 
combined document. See this chapter for how to create a Word 
auto-generated Table of Contents: How do I Add a Word Auto-
Generate Table of Contents? 

 If you purchase the full version of Adobe Acrobat, you can 
convert your final proposal to a PDF file and save and even e-
mail it right from within Word.  

 
If you are only printing your proposal in-house for delivery you do 
not need to combine the individual proposal documents into a 
single file. Simply print each individual document separately. You 
only need to combine them into a master file if you are delivering 
your proposal digitally. If you are delivering your proposal digitally 
you should use a PDF format to prevent easy manipulation of the 
document, efficient transfer speed and for cross-platform 
compatibility (Word documents with embedded graphics can be 
extremely large and may not display the same on your prospect’s 
computer).  
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HOW DO I CONFIGURE THE ARTICLES 
DATABASE? 
 
The Wizard now includes a screen that displays lists of online 
articles you can open and search right from the Wizard home 
screen. 
 
The database and fields that the articles screen is built from can 
be completely customized for your own use. 
 
One example would be to remove all the pre-loaded Proposal Kit 
articles and load the database with links to your own internal 
company resource pages that your end user who is running the 
Wizard can make use of from the Wizard interface. 
 
The articles database is stored in the Wizard’s default database 
folder and is titled “Articles.ini” 
 
The database file is in text format and can be manually edited. 
 
You can change the default text fields and text of the buttons by 
adding custom text to the appropriate database fields. 
 
There are 4 drop down lists that are loaded with the contents of 
the database fields. 
 
The file format is self-explanatory and easy to edit. 
 
Simply replace our URL’s, titles, summaries and images with your 
own. 
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The important part to get right is that the name tags must be 
sequentially numbered. The Wizard will stop scanning when it sees 
a gap in the sequential numbering of the entries.  
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EASILY CREATE YOUR OWN GRAPHIC 
STYLE 
 
The Proposal Packs are designed to be used as-is with pre-
designed layouts and graphics. If you are in a hurry to create a 
proposal (as many of our users are) you do not need to create your 
own custom graphics to use the Proposal Pack materials. 
However, you can also modify our styles for your own personal 
use by creating your own custom variations on the graphics as 
follows: 
 
All our template material is copyrighted and on file with the US 
Copyright Office. You may only create custom variations of this 
material for your own business or personal use. Templates may 
not be distributed, resold or otherwise posted. Only your final 
proposals may be distributed to your clients or internally within 
your company using Proposal Kit material. 
 
Creating your own custom version of the graphics is an optional 
and advanced feature of the Proposal Packs. If you do not have 
any experience using a graphics program, we recommend that you 
have a graphic designer create the custom versions of the 
graphics. While it is a simple task as far as graphic design work 
goes (for some tasks such as editing text), it requires the use of 
your own graphics program and may involve the separate 
purchase and installation of a new font if you do not have the font 
type already installed.  
 
The following is a recommended method used to create custom 
graphics. Use the following tips as you see fit. 
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 Open any one of the existing Adobe Photoshop (.PSD) or Adobe 
Illustrator (.EPS) graphics to start with (for example, 
"PageTitle.PSD". If you do not have either of these programs, 
just open the PNG version of the "Blank Template Header 
(without text)" graphic from the graphics list below. The file 
name installed on your hard drive is 
"PageHeader_NOTEXT.png". 

 From within your graphics editor with the select graphic 
opened, edit or erase our default graphic and replace it with 
your own company logo or graphic of your choice. 

 Resize the graphic (if needed) to fit. Do not make it too large, 
otherwise it will be too large when embedded back in Word. 
Also remember to keep the file at least 150 dpi resolution so it 
prints clean and crisp. Do not paste in low resolution .JPG or 
.GIF files as they may look fine on the screen but may not print 
very well. 

 Save your default graphic, without any text as a backup before 
you make changes. 

 Create a text element in your graphic, pick a font, font size and 
color to match your own style and adjust the layout until it is 
exactly what you want. Save your layered image as a backup. 

 Save a copy as a 150 dpi PNG file (.PNG extension). You should 
save all your custom created graphics in a new folder using the 
same file names as the documents they will be inserted into.  
 
For example, for the ExecSummary.docx Word document, you 
need to make a graphic header with text such as “Executive 
Summary” and save it as ExecSummary.png 
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For the Products.docx Word document, you need to make a 
graphic header with text such as “Products” and save it as 
Products.png  
 
Repeat for each document you want to replace the header 
graphics in. You do not need to replace the graphics in every 
template in the library, only create custom graphics for the 
templates you will be using. 

 Print a paper copy of the .PNG version as a test to make sure it 
prints high quality. 

 Now you are done creating your header graphics.  

 In your Word documents highlight the header graphic, delete it, 
then click "Import from File" in Word's toolbar, pick the new 
graphic you just created, and your new header will be inserted. 
Do this for each of the stock templates you will be using. At the 
same time, you may also change other elements such as colors 
of bullet points, colors of the page border and/or remove the 
page borders.  

 
This covers creating brand new graphic headers and manually 
inserting them into the templates. 
 
Another method of branding the documents with your own custom 
logos and graphics is to use the MyGraphics folder and create a 
complete set of graphics that the Wizard will automatically load 
into your documents. Read this chapter for details: How to Import 
Custom Graphics Using the MyGraphics Folder? 
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HOW DO I CREATE A 2ND COPY OF THE 
PROPOSAL PACK? 
 
https://www.proposalkit.com/htm/videos-how-to-clone-proposal-
pack.htm 
 
Normally you install one copy of the Proposal Pack templates and 
all your proposals and documents are created from that one library 
of templates. 
 
In some situations, you may want to have more than one set of our 
Proposal Pack templates (without purchasing a whole new 
Proposal Pack with a different design theme). 
 
You can clone one of your existing installed Proposal Packs 
creating a 2nd set of all its templates as a new selectable style in 
the Wizard’s Document Styles screen. 
 
The clone feature is found in the Document Styles > Edit Style > 
Manage Templates tab. Click the Clone Proposal Pack button. The 
clone feature is only available in the Expert Edition of the Wizard. 
 
Once you have cloned your existing Proposal Pack you will have a 
duplicate set of its library of templates that you can completely 
customize differently than the original set. 
 
This feature is useful if you want to create different visual design 
themes or other customizations to many different templates that 
would be too cumbersome to manage using just the original set of 
templates.  
 

https://www.proposalkit.com/htm/videos-how-to-clone-proposal-pack.htm
https://www.proposalkit.com/htm/videos-how-to-clone-proposal-pack.htm
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REPAIR THE ‘RUN PROPOSAL PACK 
WIZARD’ DESKTOP SHORTCUT 
 
https://www.proposalkit.com/htm/videos-how-to-repair-desktop-
shortcut.htm 
 
The Proposal Pack Wizard installer program creates a shortcut link 
on your Windows desktop labeled “Run Proposal Pack Wizard”. 
 
This shortcut opens the Wizard’s Word document and runs the 
Wizard program that is contained within that Word document. 
 
The shortcut icon’s properties are specific to the version of 
Microsoft Word you have installed and where your Word 
executable program is installed on your computer. 
 
If you upgrade your version of Word, the Wizard desktop shortcut 
will still be pointing to your old version of Word. Which also may 
not exist anymore if you uninstalled your old version of Word. 
 
The Wizard can rebuild this desktop shortcut if it was deleted or is 
not operable anymore due to system changes you made to your 
Word software. 
 
Run the Proposal Pack Wizard and click the Preferences > Tools > 
Repair Tools buttons. On the Repair Tools screen click the button 
to repair your desktop shortcut and answer Yes to the prompt. 
 
The Wizard will check your system for what version of Word you 
are running now and will create a new shortcut icon based on the 
most recent version of Word it locates.  

https://www.proposalkit.com/htm/videos-how-to-repair-desktop-shortcut.htm
https://www.proposalkit.com/htm/videos-how-to-repair-desktop-shortcut.htm
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TROUBLESHOOTING 
 
We do not provide technical support for 3rd party applications 
such as Microsoft Word or your graphics program. Please consult 
your Word manual and our on-line tutorials for mail merge use. 
Consult your Word manual for all other word processing issues. 
Consult your graphics program for text editing and graphics help. 
 
For up-to-date troubleshooting information see the 
troubleshooting web page at 
https://www.proposalkit.com/htm/troubleshooting.htm 
 
Q: The Wizard does not run! 
 
A: If you are experiencing error messages running the Wizard it is 
possible that your Microsoft Office / Microsoft Word installation has 
been corrupted. Most cases of error messages occurring while 
trying to run the Wizard can be resolved by reinstalling your Word 
or Office software using the “repair” feature or doing a custom 
install and just reinstalling the VBA component of Word/Office. 
Most likely something else that was installed on your computer 
after you installed Word or Office overwrote part of your software 
with an outdated version of a DLL or other component. First, insert 
your Office or Word CD-ROM and run the setup program. Choose 
the “repair” option. Also check to make sure you have a full 
installation and that all the Visual Basic for Applications 
components are installed. If there are any Service Packs for your 
version of Word from Microsoft, make sure to install them as well. 
 

https://www.proposalkit.com/htm/troubleshooting.htm
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Q: Where are the files on my computer? 
 
A: When first installing the Proposal Pack Wizard, you were 
prompted to choose a location for installation and all associated 
files. This is where files are located. No desktop icon or application 
is launched during installation. All files are contained on your hard 
drive in the original folder you chose. The default install folder is 
“C:\Proposal Kit\Proposal Pack”. Run the Preferences tool “File 
Location Report” to get a detailed report of where all the Wizard 
related files are located on your hard drive. 
 
Q: Why is the border not printing? 
 
A: Your printer has a non-printable border. The size of the border 
is defined by your printer and driver and can be adjusted in the 
Word templates. The borders in the templates (if used) are 
standard Word borders (see your “Borders and Shading” option in 
Word). Your options are to turn off the borders, adjust the border 
settings and/or adjust the page footer accent graphic and other 
trailer tags and positioning. 
 
Another option is to (in Word) click “Borders and Shading”, then 
“Page Border”, then click “Options”. In the Options dialog, pick 
“Measure from Text” from the drop down measure field, then 
uncheck the “Surround Footer” box. This will cause the page 
border to fit closer in on the page and on top of the footer. If the 
border is now too close to the text, adjust the top/bottom/left/right 
fields to higher numbers until the border prints on your printer on 
all sides without overlapping the footer or anything else. 
 



706 

Q: What if I don’t have an Internet connection? 
 
A: The materials are all installed on your hard drive and there is no 
need to have an Internet connection when using the Proposal 
Pack Wizard. Any web site links included in the material are either 
optional or for information purposes only. 
 
Q: Why is my computer locking up when using the Proposal 
Pack Wizard? 
 
A: Over time your computer may be having its memory fragmented 
by running numerous programs. This can happen very frequently 
or over the course of hours depending on the system. Low 
memory conditions caused by fragmentation (regardless of how 
much RAM you have installed) can cause problems with any 
running software (such as your word processor). Simply close 
everything and reboot your computer to free up resources lost to 
memory leaks caused by the various software running on your 
computer. 
 
Low memory conditions on your system can also cause 
unexpected and unpredictable behavior. If you experience such 
behavior, first try rebooting your computer and running the Wizard 
again. 
 
Another possible cause is clicking a link to a Word document from 
a web page. In some cases, a web browser version is run which 
may have memory problems. Run Word by itself first instead of 
clicking the document links in the web browser interface, and then 
open the Proposal Pack documents. You may want to do this 
anyway as you will have access to all of Word’s features. 
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If you are creating a very large proposal using many documents 
the document creation operation can take several minutes to 
complete and may appear to be locked up. Be patient and wait for 
the process to complete. If your system appears to have locked 
up, stop the Wizard and restart. Pick a small collection of templates 
and rerun the document creation process. A smaller collection will 
run faster and help determine if your system is just running slowly 
or has encountered a problem.  
 
Q: The option to replace the Title Page graphic does not work? 
 
A: Make sure you are not using the Proposal Pack for Any 
Business or Proposal Pack for Government Grants. These are the 
only Proposal Packs which does not use graphics. If you are using 
one of these styles, manually edit the text of the Title Page. 
 
If you have edited the original Proposal Pack Title Page document 
and have made changes to the structure of the document, it is 
possible the Wizard cannot locate the Project graphic. This could 
happen if you have inserted a new graphic or a “shape” into the 
Title Page. 
 
Q: When I create the proposal my changes are not showing up? 
 
A: This can happen if you have previously created a proposal for 
the same project and are now trying to make changes such as 
selecting a different Proposal Pack style, adding or removing 
documents, changing the Title Page project graphic and/or 
changing the mail merge database fields. 
 
Proposal Pack has a safety feature built into the proposal creation 
process because many people mistakenly try to add new 
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documents to an existing proposal they are currently editing by re-
running the creation process. The current version of Proposal Pack 
will not overwrite any existing files in your document project’s 
folder when you run the creation process multiple times. 
 
This means if you are making changes that could affect existing 
documents such as changing your name in the database form, or 
changing the graphic theme, etc. you will not see the changes in 
any existing documents. The only change that is allowed in this 
case is if you have added new documents to the proposal. The 
new documents will be copied to your document project folder, 
however since your existing FullProposal.docx combined project 
document counts as an existing document, the safety feature will 
not add those templates to your current document. 
 
Only if you have not started to manually edit this project, you can 
go to the Document Project form from the Wizard main interface, 
then Edit the proposal and click the “Delete Old Files” button. This 
will delete all the documents from the previous configuration 
process. Do not click the delete button if you have existing work 
you have been editing for this proposal, otherwise it will be 
deleted. 
 
Q: Page numbers are showing up in the front Cover Letter 
and/or Title Page that should not be there? 
 
A: If you have edited any of the stock templates and completely 
removed the stock footer information, this can cause page 
numbers to show up in your introduction pages (i.e. the Cover 
Letter and/or Title Page). This is caused by how Word processes 
empty page footers vs. page footers that have something in them 
(like a picture, text tag, text box, etc). Word is seeing a blank footer 
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when it inserts the first body page of your document and it relinks 
the section footers together, causing page numbers to show up.  
 
This can be fixed easily by inserting anything back into the 
template page footer. If you removed the stock “<<Domain>> tag, 
just replace it with some different text, or if you want the page 
footers to be empty, just insert a blank text box into the footer 
instead of the “<<Domain>>” tag. 
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PROPOSAL WRITING RESOURCES 
 
Successful proposal writing requires much more than just filling out 
some documents. There are many issues that can affect how 
successful you are, such as: 
 

 Using just the right wording 

 Pitching to the right person 

 Making the pitch at the right time 

 Using proper spelling and grammar 

 Addressing the prospect’s fears and objections 

 Personal appearance and presentation 

 Internal politics at the prospect’s company 

 Hidden agendas at the prospect’s company 

 How many proposals you send out 

 Having a right price, not necessarily the lowest price 

 How persistent you are with the same prospect 

 How you stack up against the competition on various levels 

 Miscommunication between parties 

 Competitors trashing your solution in their proposals 

 A consultant at the client with ties to one of your competitors 

 The prospect wants the “safe” choice, not the “best” choice 

 And so on… 

 
See our appendix of resources page for recommended books on 
proposal writing that cover these topics and more in detail at: 
 
https://www.proposalkit.com/htm/append.htm 
 
  

https://www.proposalkit.com/htm/append.htm
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PROPOSAL DISTRIBUTION 
 
Print, e-mail and web-based delivery are several ways in which to 
distribute a proposal. Proposals should always be delivered in print 
and then optionally followed up with an e-mailed version in PDF 
format. Digital delivery may be fast and convenient, but it still does 
not beat a high quality printed and hard bound copy delivered 
directly to the client.  
 
Print your proposals on high quality paper using a quality printer. 
Insert into a quality binder and ship priority overnight unless 
personally delivering it. Never use cheap, flimsy paper or staples. 
Also print and bind enough copies to give each person reviewing 
your proposal his/her own copy. 
 
If you cannot avoid sending a digital proposal, save your full 
proposal as a single Adobe PDF file which can be easily e-mailed. 
Your client will be able to view it on any platform and can print it 
out as well.  
 
We do not recommend sending Word documents to clients for 
your proposal. The documents are typically too large to send by e-
mail and are prone to not display as intended. 
 
You should save your final digital distribution versions in Acrobat 
PDF format to ensure your end reader can view it as you intended 
and to prevent misuse and unauthorized editing (as best possible). 
Read this chapter for more details: How do I Save in PDF Format? 
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TIPS AND TRICKS 
 

 You will stand a better chance of winning proposals if you take 
the time to create client-centered proposals specific to each 
client rather than recycling old proposals and just changing the 
client contact information. 

 Avoid writing a lot of fluff without saying anything. Keep the 
proposal easy to read. Our templates are designed to use lots 
of bullet points for easy reading and is a major reason why we 
do not include a lot of generic pre-written content. This is 
especially important when submitting a proposal where there 
are many bidders. Yours should stand out as being easy to read 
and understandable. 

 Try filling out all or most of the relevant templates for each 
proposal even if the final proposal will not include all of them. 
This exercise will help uncover things that may have been 
missed and can help improve the final proposal. 

 Spell and grammar check your proposal, and have it reviewed, if 
possible, by someone not close to the chalkboard. If it is in your 
budget, hire an editor. 

 Judge your proposal size by the size of the project and 
prospective client. For example, a $300 Mom & Pop static web 
site might only be 2-3 pages for the proposal. Do not hand them 
a 30-page proposal. A larger corporate or government project 
may require a 40 to 100 page proposal or more. Handing them a 
5 page proposal will most likely not get you the job. There are 
no rules as to the size of the proposal or what sections to use. 
Let common sense, study and experience be your guide. You 
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may also consider hiring an experienced proposal writer to 
assist. 

 What if you don’t get the job? It is to be expected. The more 
proposals you write the more you will lose. You must be able to 
fine-tune your proposals over time. Whenever possible, 
interview the prospect when he/she declines the proposal to 
find out why you were not chosen. Adjust your business and 
proposal writing as needed to improve your chances on the 
next proposal. 

 Do not include extraneous information. If you have multiple 
products or services, include only those that relate to the client’s 
needs. If responding to an RFP, follow their guidelines and only 
include the proposal sections requested. If you need to add 
sections or change section titles, use the original graphics 
supplied with the Proposal Pack to create new graphic headers. 

 If you are responding to an RFP which includes instructions on 
how to submit the proposal, you must follow the instructions to 
the letter. If you deviate from the instructions even the most 
minor alteration can cause your entire proposal to be 
disqualified. If the instructions say there is a 10 page limit, do not 
send 11 pages. If the instructions say not to include collateral 
material, do not send your product brochures. Strive to make it 
very easy for the proposal reviewers to find all of the 
information required in the RFP and make that information easy 
to read and understand. 

 Don’t give away the farm in the project section of the proposal. 
If you give up too much specialized knowledge in the proposal 
and design, your prospect could take your upfront design and 
give it to a lower bidder. Keep the proposal manageable. You 
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may have pages of development checklists and steps; keep the 
actual steps short and digestible in the proposal. See our 
Proposal Kits for pre-contract agreements for web professionals 
to protect your upfront proposal designs if they are very 
involved. The Proposal Pack come with non-disclosure forms 
you can use to help protect your work.  

 Make sure to include a financial incentive in the proposal for 
choosing you for the job. Use the templates to demonstrate how 
using you will have positive financial effects on the client’s 
business. There are sections in various templates to add this 
information (e.g. the Executive Summary, Cost/Benefit Analysis 
or Expected Results). 

 Do not underbid a project. Do not bid on projects you cannot 
complete. You may be responsible for completing them 
regardless of your capabilities. Learn when to pass on a project 
and when to accept projects that will allow you to make a profit. 

 Your odds of success may increase as you specialize and 
specifically target a niche. See the various Proposal Packs for 
styles and designs tailored to appeal to specific niches.  

 Pick a style and design for the Proposal based on the 
prospective client’s preferences. For example, if you have a very 
conservative prospect, use one of the Classic styles, not an 
Artsy style. If you are not sure, play it safe: use a Classic style. 

 Be persistent – some of our biggest deals took six ‘not 
interested’ brush-offs by the prospect before they became a 
client on the seventh try. Many times, a “no” is really just “no – 
not right now”. The more expensive or complex the service or 
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product, the more you need multiple follow-ups to clinch the 
sale. 

 If possible, sell yourself to the “right” person such as a C-Level, 
VP or President. Managers and gatekeepers may screen you for 
many reasons.  

 The Proposal Pack templates are purposely designed with 
minimal pre-written text as most of what needs to be entered is 
content specific to your company, your project and your client. 
The templates are designed with many bullet points and clearly 
defined sections of information. This approach minimizes the 
“fluff” content and helps you create an easy to read and more 
importantly an easy to skim document. Make as much use of the 
bullet points as possible and keep the generic fluff to a 
minimum. Make your point clear, concise and do not waste the 
reader’s time with a lot of “words” that really don’t say anything. 
Time is more precious than ever for busy executives and 
decision makers. Your proposal will be more appreciated if it 
comes to the point quickly, is easy to follow and easy to read. 

 Focus on the key benefits to the client and back them up with 
the reasons why your proposal should be chosen. The proposal 
should be predominately focused on the client, not on yourself. 
Our layouts are designed to put the client information first, the 
project information second and your company information last.  

 Use a lot of summaries and bullet points in the proposal. 
Summarize what you will say in the Executive Summary, provide 
details in sections that follow, and then use the Project 
Summary to summarize what you told them. If there are multiple 
layers of people between you and the ultimate authority who 
will accept the proposal, you will have to write in a way to get 
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past each layer. Gatekeepers and busy executives may only 
read the summaries. If it passes the first reviews it may be 
turned over to other individuals who will read the details. 

 Repeat the most important selling points outlined in the 
Executive Summary throughout the proposal. Repetition will 
make the point stick. However, do not just type the same 
sentences over and over. Repeat your key points by rephrasing 
them in the context of each section of the proposal. The key 
points should revolve around the client’s needs, your benefits 
and how your benefits will meet or exceed those needs. 
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